
Los contenedores de la ventana de 
proyecto

La ventana de proyecto incluye una zona de contenedores en la que se 
muestran los contenedores que se hayan añadido al proyecto. Esta zona se 
encuentra en el lado inferior izquierdo de la ventana y puede ser ocultada o 
redimensionada. Cuando dentro de un contenedor hay otro u otros 
contenedores, se muestra una estructura jerárquica de los mismos similar a la 
estructura jerárquica de los directorios y subdirectorios de un disco duro.

A. Minivisor B. Contenedores C. Clip D. Buscar E. Nuevo contenedor F. Crear elemento G. 
Borrar elementos seleccionados H. Redimensionar la zona de contenedores I. Vista Icono J. 
Vista Miniaturas K. Modo de Lista L. Información del Clip M. Menú de la ventana de proyecto

Para ocultar o mostrar la zona de contenedores:

Elija Hide Bin Area o Show Bin Area del menú de la ventana de proyecto.

Para redimensionar la zona de contenedores:

Arrastre el botón "Redimensionar" (Botón H en el gráfico) a la derecha (para 
ampliar) o a la izquierda (para reducir). El tamaño mínimo de esta zona es el de 
los cuatro botones que se encuentran bajo ella. Para agrandarla es posible que 
primero se deba agrandar la propia ventana de proyecto.

Para añadir o borrar un contenedor:

Para borrar uno o más contenedores, selecciónelos y pulse el botón Vorrar 
elementos seleccionados ( ) (Marcado como G en el gráfico). Para añadir un 
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contenedor, haga click en el botón Nuevo contenedor ( ) (Marcado como E en 
el gráfico superior).

Para mostrar el contenido de un contenedor:

Seleccionelo. Si en el contenedor hay subcontenedores, haga click en el 
triángulo que se encontrará a la izquierda del nombre para mostrar los 
subcontenedores. A continuación seleccione el subcontenedor cuyo contenido 
se desea ver
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Usar librerías de versiones previas 
de Premiere

En versiones previas de Premiere era posible utilizar unos contenedores 
llamados "Librerías" que se usaban para almacenar clips de uno o varios 
proyectos. Estas librerías se almacenaban como un fichero independiente del 
fichero del proyecto.

Aunque Premiere 6.0 no soporta directamente estas librerías, si es posible 
abrirlas, en cuyo caso la librería se convertirá en un contenedor.

La utilidad que antes proporcionaban las librerías (almacenar un conjunto de 
clips de tal modo que estén disponibles para otros proyectos), ahora se obtiene 
mediante la posibilidad de almacenar directamente los contenedores en disco 
(Project > Export bin from project). Véase Los contenedores de la ventana de 
proyecto.

Para importar una librería creada con una versión anterior, elija File > Open, y 
luego localice y seleccione el fichero de librería (extensión .PLB).
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Vistas y personalización de la 
ventana de proyecto

En la ventana de proyecto (o en la de un contenedor abierto en ventana 
propia), de cada clip se indica su nombre de fichero, el tipo de fichero y su 
duración.

El tipo de información que para los clips se muestra, así como la forma de 
mostrarla puede ser personalizado aplicando, a cada ventana individual, 
distintas opciones.

A. Zona de contenedores B. Botón Redimensionar

Existen tres formas básicas de mostrar los clips: Como iconos, como miniaturas 
o en forma de lista. A cada una de estas formas se las denomina: vistas

Para cambiar el aspecto de una ventana de proyecto o de contenedor:

Pulse los botones con los icono Vista Icono ( ), Vista Miniatura ( ), o Modo de 
Lista ( ) en la parte inferior de la ventana.

Para ordenar los elementos en las vistas Miniatura y Modo de Lista:

Realice una de las siguientes acciones:
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• Haga click en la cabecera de la columna por la que se quiere ordenar los 
elementos. 

• Para invertir el orden, haga click en la cabecera de la columna de nuevo 
• Para cambiar la posición de las columnas, en el Modo de Lista, arrastre 

la cabecera de la columna a izquierda o derecha. 
• Para redimensionar la zona de contenedores, arrastre el botón 

Redimensionar ( ) a izquierda o derecha. 

Para personalizar el modo de Vista Icono:

1 Elija Window > Window Options > Project Window Options.

2 En la parte superior del cuadro de diálogo elija Icon View.

3 Elija el tamaño deseado (size)

4 Marque Snap to Grid si desea que los iconos se alineen de acuerdo con una 
cuadrícula invisible.

5 Marque Draw Icons para hacer los iconos visibles. Si esta opción no está 
marcada no se mostrarán los iconos y así la ventana se mostrará con mayor 
rapidez.

Para personalizar el modo de Vista Miniatura:

1 Elija Window > Window Options > Project Window Options.

2 En la parte superior del cuadro de diálogo elija Thumbnail View.

3 Elija el tamaño deseado (Icons)

4 Marque Draw Icons para hacer los iconos visibles. Si esta opción no está 
marcada no se mostrarán los iconos y así la ventana se mostrará con mayor 
rapidez.

5 En el apartado Fields puede escribir un nombre personalizado para cuatro 
campos de información definidos por el usuario.

6 Elija un campo de ordenación de los clips en el cuadro de lista inferior 
denominado Sort By.

Para personalizar la vista en Modo de Lista:

1 Elija Window > Window Options > Project Window Options.

2 En la parte superior del cuadro de diálogo elija List View.

Podrá entonces marcar los campos que desee que se muestren para cada clip. 
Entre ellos se encuentran cuatro etiquetas personalizables, es decir: cuatro 
campos de información cuyo nombre es definido por el usuario.
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Podrá, asimismo, indicarse el campo de ordenación de los clips en la ventana.

Para reorganizar los iconos en la Vista Icono:

Cuando está activa la vista Icono, es posible que éstos se superpongan o que 
unos iconos oscurezcan a otros. En tal caso, para reorganizarlos, elija la opción 
Clan Up View del menú de la ventana de Proyecto.

6



Ver la información de un clip en la 
ventana de proyecto

En la parte superior de la ventana de proyecto (o de una ventana de 
contenedor) se encuentra un Visor Miniaturizado, que puede usarse para 
realizar una vista previa de los clips individuales.

Este visor utiliza por defecto el primer fotograma de un clip como icono. Este 
fotograma se denomina Poster, y pero es posible cambiarlo, de modo que el 
Poster represente cualquier otro fotograma del clip.

El fotograma Poster del clip será el que se utilizará cuando se active la vista en 
los modos de Icono o de Miniatura, también se utilizará este fotograma como 
fotograma de ejemplo para la ventana de Título (Ver Importación de un 
fotograma de ejemplo).

Para ver un clip y su información en la ventana de Proyecto:

1 Seleccione el clip en la ventana de Proyecto. Premiere mostrará la 
información del clip junto al visor en miniatura, en la esquina izquierda superior 
de la ventana de proyecto.

Nota El flujo medio de datos (bit-rate) se muestra para todos los video clips. 
Esta información es útil para el vídeo analógico, puesto que manteniendo el 
mismo flujo de datos para todos los clips en un proyecto, la reproducción desde 
la ventana de construcción será mucho más fluida.

2 Para ver el clip, pulse el botón Play ( ) en el visor en miniatura. Para detener 
la reproducción, pulse de nuevo el botón Play.

3 Seleccione el modo de lista si es necesario, y desplácese a la derecha de la 
ventana, para ir viendo todas las columnas de información.

4 Elija Clip > Properties.

Para cambiar el fotograma Poster de un clip:

1 Seleccione el clip en la ventana de proyecto.

2 Pulse el botón Play ( ) o arrastre a traves de la barra inferior del visor en 
miniatura hasta encontrar el fotograma que desea mostrar como icono.

3 Pulse el botón Establecer Fotograma Poster ( ) (Set Poster Frame).
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Campos del Modo de Lista

Cuando en la ventana de proyecto se activa el Modo de Lista, están disponibles 
los siguientes campos de información para cada clip:

Name Por defecto muestra el nombre del fichero del clip. Es posible cambiar el 
nombre que el clip usará dentro del proyecto (sin cambiar el nombre del fichero 
en disco). Para más información vea Renombrar, buscar y borrar elementos.

Date La fecha de la última modificación del fichero que contiene al clip.

File Path Localización del fichero en el disco, expresada como una ruta de 
acceso.

Log Comment Si el fichero fue capturado utilizando Premiere, este campo 
mostrará el texto que se escribió durante la captura en el campo Log.

Media Type El tipo de fichero, como, por ejemplo, película, imagen fija, título, 
etc.

Video Info Las características de un clip de vídeo, como, por ejemplo, el 
tamaño de fotograma.

Audio Info Las características de un clip de audio, como, por ejemplo, 
frecuencia, stereo o mono, etc.

Video Usage El número de veces que un clip de vídeo se ha incluido en la 
ventana de construcción.

Audio Usage El número de veces que un clip de audio se ha incluido en la 
ventana de construcción.

Duration Duración del clip, expresado en la unidad de visualización de tiempo 
que se haya indicado en las opciones de configuración general del proyecto.

Timecode El código de tiempo del primer fotograma, para los clips de vídeo 
que han sido capturados desde una vídeo-cinta.

Reel Name Si el clip fue capturado usando la captura por lotes de Premiere, el 
nombre que se le asignó durante la captura.

Notes Comentarios escritos para este campo. Es posible cambiar el nombre 
del campo.
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Labels Campos adicionales para etiquetas que pueden ser usadas para 
identificar y ordenar los clips. Es posible cambiar el nombre de estos campos. 
Véase Vistas y personalización de la ventana de proyecto.

En la vista de iconos, es posible reordenar los iconos simplemente 
arrastrándolos. Si se seleccionan y arrastran varios iconos a la vez hasta la 
ventana de construcción, se insertarán en ella en el mismo orden en que se 
encontraran en la ventana de Proyecto
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Renombrar, buscar y borrar 
elementos

Tanto los clips de un proyecto como otros elementos del mismo pueden ser 
gbestionados usando las herramientas para renombrarlos, buscarlos y 
borrarlos.

Cualquier clip existente en el proyecto (incluyendo el vídeo DV capturado 
mediante Premiere, que se incluye automáticamente en el proyecto tras la 
captura) debe existir en el disco duro como un fichero. En el proyecto de 
Premiere en realidad sólo se añade una referencia al fichero original, de tal 
manera que cuando se renombra, edita o borra un clip, el fichero original 
permanecerá intacto.

Para renombrar y borrar elementos del proyecto:

Realice alguna de las siguientes acciones:

• Para renombrar un clip, selecciónelo y elija Clip > Set Clip Name Alias. 
Escriba el nuevo nombre y pulse OK. (Esta opción también aparece en 
el menú contextual). 

• En el modo de lista también es posible seleccionar el nombre y escribir 
uno nuevo. 

• Para renombrar un contenedor, selecciónelo, haga click sobre el viejo 
nombre, o pulse la tecla retroceder sobre él, y escriba el nuevo nombre. 

• Para ver el nombre original de un clip, o cambiar su alias, selecciónelo y 
elija Clip > Set Clip Name Alias. Escriba un nuevo nombre o pulse None 
para eliminar el alias. 

• Para renombrar el fichero fuente original en el disco, cierre Premiere y 
renombre el fichero usando el Explorador de Windows. La próxima vez 
que abra el proyecto que usaba el fichero renombrado, Premiere le 
preguntará dónde localizarlo (Vea Abrir un proyecto y localizar los 
ficheros que lo componen) 

• Para borrar un elemento del proyecto, selecciónelo y pulse la tecla Supr. 
• Para borrar del proyecto todos los elementos que no están usados en la 

ventana de construcción, elija Project > Remove Unused Clips (vea 
también Depurar un proyecto eliminando los fotogramas no usados) 

Nota: Como Premiere almacena simples referencias a los clips, borrando un 
clip del proyecto, se elimina de él, y, por tanto, también de la ventana de 
construcción (si se había utilizado en ella), pero no se borra del disco duro el 
fichero original que correspondía a dicho clip.
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Para buscar un clip en una ventana:

Para encontrar un elemento en el proyecto, seleccione la ventana en la que 
desea buscar y elija Edit > Find (o, si desea buscar en la ventana de proyecto, 
pulse el botón Buscar ( )). Aparecerá la ventana de búsqueda, que tiene el 
siguiente aspecto:

En ella es posible indicar hasta dos criterios simultáneos de búsqueda. En la 
primera columna elija el campo de información por el que desea buscar (Ver 
Campos del modo lista) en la tercera columna escriba el texto a buscar, y en la 
segunda columna elija "that contain" si desea buscar los clips donde aparezca 
el texto introducido, o "that not contain" si lo que desea es localizar los clips en 
donde no aparezca el texto introducido.

Si desea añadir un criterio adicional de búsqueda, realice la misma operación 
en la segunda fila, y tras ello pulse Find. Si se localiza algún clip que reuna los 
requisitos, se mostrará y el botón Find pasará a denominarse Find Next, 
pudiendo pulsarlo de nuevo para localizar el próximo clip que cumpla con los 
requisitos.
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Creación de un listado de los 
archivos del proyecto

Para documentar el contenido de un proyecto, puede crear un archivo de texto 
en el que figure una lista de todos los clips utilizados en él. La lista muestra los 
nombres de archivo originales de los clips, los nombres de los contenedores y 
su contenido en el orden en que aparece en una ventana de proyecto o de 
contenedor. Si una ventana de contenedor está activa al crear el listado, 
Premiere genera un listado del proyecto que incluye el contenedor y su 
contenido. En Windows, la lista de archivos contiene la vía de acceso al 
archivo. En Mac OS, puede elegir si desea incluir la vía de acceso completa.

Para exportar una lista de archivos:

1 Active la ventana de proyecto.

2 Elija File > Export Timeline > File List.

3 Especifique una ubicación y escriba un nombre para el listado.

4 (Sólo en Mac OS) Seleccione Incluir nombres de vías de acceso completas si 
desea incluir la vía de acceso completa a la carpeta para cada archivo de la 
lista.

5 Haga click en Save.
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Captura e importación de Clips

Obtención de material de origen para el proyecto
Preparación general y métodos de captura
Edición en línea y fuera de línea
Conexión de una fuente de vídeo analógico
Conexión de una fuente de vídeo digital
Digitalización de vídeo analógico como DV
Grabar o reemplazar el código de tiempo (Sólo DV)
Tamaño máximo de fichero
Preparación de la captura analógica
Preparación de la captura de DV
Uso de la ventana de captura
Captura de clips sin control de dispositivo
Captura de clips con control de dispositivo
Captura de vídeo por lotes
Captura de una animación de cámara de truca
Lectura del código de tiempo del vídeo de origen
Captura de audio analógico
Importación de audio digital
Acerca de D1, DV y varias proporciones de aspecto de pixel
Importación de clips
Importación de otro proyecto
Análisis de las propiedades y flujo de datos de un clip
Uso de archivos de referencia
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Obtención de material de origen para 
el proyecto

Es posible importar clips desde cualquier origen (cintas de vídeo, películas, 
audio, imágenes fijas) siempre que estén en soporte digital y almacenados 
como archivos en el disco. El material de origen puede adoptar dos formas:

• Digital (DV), medios almacenados en formato de archivo que el 
ordenador puede leer y procesar directamente. Muchos de los aparatos 
de vídeo, audio y cámaras fotográficas más modernos, así como todas 
las vídeo cámaras digitales, pueden guardar imágenes y sonidos en 
formato digital. Los medios digitales almacenados en cinta se deben 
transferir a disco para que Premiere pueda utilizarlos en un proyecto. 
También se puede utilizar Premiere para capturar vídeo digital desde 
una cinta y guardarlo en disco como clips que luego se pueden añadir al 
proyecto. 

• Analógica, estos medios deben digitalizarse o convertirse en formato 
digital para que el ordenador pueda almacenarlos y procesarlos. Como 
ejemplos de medios analógicos cabe citar las películas, cintas de audio y 
diapositivas convencionales. Puede utilizar Premiere para digitalizar 
cintas de vídeo analógicas tales como cintas en Super 8 y guardarlas en 
disco como clips que luego puede añadir al proyecto. 

Aunque los equipos de medios digitales son cada vez más comunes, una gran 
cantidad de vídeos y audios se siguen grabando y almacenando en equipos 
analógicos. Por esta razón, es posible que sea necesario capturar vídeo y 
audio analógico como parte del trabajo.

En Premiere puede digitalizarse vídeo analógico directamente utilizando 
hardware de digitalización para conectar al ordenador un magnetoscopio (VCR) 
o cámara analógicos. Algunos ordenadoress personales incorporan hardware 
de digitalización de vídeo pero, por lo general, es preciso añadirlo al sistema 
mediante la instalación de una tarjeta específica de captura.

Una lista de las tarjetas compatibles con Premiere se encuentra en 
http://www.adobe.com/premiere.
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Preparación general y métodos de 
captura

Conecte la vídeo-cámara digital o dispositivo a su sistema. Consulte 
Conexión de una fuente de vídeo analógico o Conexión de una fuente de vídeo 
digital.

Configure Premiere para la captura. Consulte Digitalización de vídeo 
analógico como DV o Preparación de la captura de DV.

(Sólo para DV) Si piensa utilizar la captura por lotes, pero no grabó 
correctamente el código de tiempo, consulte Grabar o reemplazar el código de 
tiempo (DV only).

Es posible capturar vídeo usando uno de los siguientes métodos:

· Para capturar vídeo manualmente, consulte Uso de la ventana de captura de 
vídeo.

· Para capturar vídeo manualmente con control de dispositivo, consulte Captura 
con control de dispositivo.

· Para capturar vídeo automáticamente con control de dispositivo, consulte 
Captura de vídeo por lotes.

· Para capturar fotogramas individuales y crear posteriormente una animación, 
consulte Captura de fotogramas para animaciones.

Si el código de tiempo del vídeo capturado no es correcto, consulte Lectura 
del código de tiempo del vídeo fuente.

Puede capturar material adicional usando uno de los siguientes métodos:

· Para capturar audio de una fuente analógica, consulte Captura de audio 
analógico.

· Para importar audio desde un CD u otra fuente digital, consulte Importación de 
audio digital.

· Para importar imágenes fijas, animaciones o secuencias, consulte Importación 
de clips.

· Para importar un proyecto, consulte Importación de otro proyecto.
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Para reservar espacio a ficheros no localizados, consulte Uso de ficheros de 
referencia.

Para analizar un clip consulte Análisis de las propiedades de un clip y flujo de 
datos.
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Edición en línea y fuera de línea

Dependiendo del nivel de calidad que necesite y de las capacidades del 
equipo, se puede utilizar Premiere para la edición en línea y fuera de línea. Las 
configuraciones de captura especificadas se verán afectadas según se desee 
editar el programa fuera de línea o en línea.

Nota: Toda edición de clips en formato de Vídeo Digital (DV) es en línea. En el 
momento de redactarse esta guía, el formato DV no permitía la creación de 
versiones de baja resolución al importar. No obstante, la compresión de DV 
hace posible utilizar el DV estándar en muchos sistemas.
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Acerca de la edición en línea

La edición en línea consiste en la práctica de realizar toda la edición (incluidos 
los esbozos) en el mismo ordenador que producirá el fichero final.

En el pasado, la edición en línea se tenía que realizar en estaciones de trabajo 
de alta gama diseñadas para satisfacer la calidad de imagen y los requisitos de 
procesado de datos de transmisión de vídeo de calidad. Los editores con 
requerimientos de alta gama que no podían permitirse un sistema en línea 
adecuado tenían que alquilarlo por horas a las productoras que disponían de 
dicho equipo. A medida que los ordenadores personales han ido ganando 
rapidez, la edición en línea se ha hecho factible para una amplia variedad de 
producciones. Con ordenadores personales de alta gama, la edición en línea es 
posible para producciones tanto de programas de televisión como de películas.

Para la edición en línea, los clips se capturarán al nivel de calidad más alto que 
el ordenador y los periféricos puedan gestionar.
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Acerca de la edición fuera de línea

En la edición fuera de línea, la edición de vídeo se realiza con copias de más 
baja calidad de los clips originales y la versión final se produce en un sistema 
de alta gama.

La edición fuera de línea se desarrolló para ahorrar dinero al realizarse en una 
instalación más económica. Si bien la edición fuera de línea puede ser tan 
sencilla como anotar puntos de tiempo para las escenas mientras se ven en un 
magnetoscopio, cada vez se utilizan más los ordenadores personales y 
Premiere.

Las técnicas de edición fuera de línea pueden ser recomendables incluso si se 
dispone de un ordenador capaz de editar con la calidad final deseada. Y ello 
porque mediante la captura por lotes de vídeo usando configuraciones de baja 
calidad es posible que la edición sea más rápida, al usar ficheros más 
pequeños.

Cuando se digitaliza vídeo para la edición fuera de línea, hay que especificar 
una configuración en la que la velocidad de la edición sea más importante que 
la calidad de la imagen. En muchos casos es suficiente con tener una calidad 
que permita identificar los fotogramas inicial y final correctos para cada escena. 
Tras terminar la edición, antes de generar el fichero final, bastará con 
redigitalizar el vídeo con la calidad final deseada. Consulte Digitalización de 
vídeo analógico como DV y Creación de una lista de captura para redigitalizar 
los clips de un proyecto.

Una vez que se ha terminado la edición fuera de línea en Premiere, se crea 
una tabla de secuencias de escenas denominada lista de decisiones de edición 
o EDL. A continuación, la EDL se traslada a un ordenador de más alta gama, 
que aplica la secuencia elaborada en Premiere a los clips originales de alta 
calidad. De este modo, el trabajo de edición realizado en la estación de trabajo 
más barata se utiliza para crear el fichero final en la estación de trabajo de alta 
calidad, que es más cara.

Puesto que se genera una EDL a partir de las ediciones, es conveniente 
asegurarse de que todos los clips se capturan con el código de tiempo de 
precisión de fotograma que corresponda exactamente al código de tiempo del 
vídeo de origen de alta calidad que se utilizará para la edición final en línea. Si 
tiene previsto editar fuera de línea utilizando copias VHS de los clips de origen, 
asegúrese de insertar en cada copia el código de tiempo (haga visible el código 
de tiempo en una ventana en la película). Estos pasos garantizan que la EDL 
que se elabora pueda utilizarse cuando se transfiera al sistema en línea o a la 

19

file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c02pi28.htm
file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c02pi28.htm
file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c02pi9.htm
file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c02pi9.htm


mesa de edición convencional y que las ediciones tengan precisión de 
fotograma. Consulte Lectura del código de tiempo del vídeo de origen.
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Conexión de una fuente de vídeo 
analógico

Para capturar vídeo analógico, primero debe conectarse la vídeo-cámara o 
dispositivo a la tarjeta de captura instalada en el sistema. Dependiendo de cuál 
sea esta tarjeta y de sus especificaciones es posible que se disponga de más 
de un formato para la transferencia de vídeo y de audio, incluyendo vídeo 
compuesto y S-Vídeo.

Consulte las instrucciones del dispositivo a conectar y de la tarjeta capturadora.

A. Conexión S-Vídeo  B. Conexión de vídeo compuesto y de los canales izquierdo y derecho 
de audio.
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Conexión de una fuente de vídeo 
digital

Para capturar vídeo digital (DV) el ordenador debe disponer de un puerto IEEE 
1394 (Fire Wire/i.Link). Para instrucciones detalladas sobre coómo conectar su 
dispositivo, consulte la documentación de éste.

Los codecs DV incorporados a Premiere soportan el DV que soporte el propio 
sistema operativo. Para proporcionar soporte DV a su sistema operativo 
Microsoft y Apple requieren que la interfaz IEEE 1394 se acomode a la 
especificación OHCI. Algunos ordenadores incluyen puertos IEEE 1394 
adaptados a la especificación OHCI, y la mayoría de las actuales tarjetas Fire 
Wire también están adaptadas a dicha especificación. Las interfaces IEEE 
1394 que no están directamente soportadas por el sistema operativo requieren 
sus propias preconfiguraciones, drivers y plug-ins para poder ser usados con 
Premiere.

Si su ordenador carece de un puerto fire-wire adecuado, puede adquirir una 
tarjeta que se lo proporcione. Consulte la documentación de su ordenador para 
más información.

El primer paso para capturar vídeo DV es conectar la vídeo-cámara o 
dispositivo al puerto IEEE 1394 de su sistema. Conecte el cable primero al 
dispositivo externo y luego al puerto del ordenador.

Conexión de un puerto IEEE 1394 (FireWire/i.Link) al ordenador

Algunas vídeo cámaras digitales requieren una conexión a su adaptador de 
energía para activar el puerto fire-wire. Otras pueden caer en el modo de 
espera o en el modo de prueba si no detectan actividad durante cierto tiempo. 
Para evitar estos problemas conecta la vídeo cámara en el momento de 
prepararse para la captura.
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Digitalización de vídeo analógico 
como DV

Si se quiere añadir vídeo analógico a un proyecto DV, pueden evitarse muchos 
problemas de compatibilidad digitalizando el vídeo analógico como si fuera DV. 
Hay varios modos para hacer esto:

• Use una vídeo cámara digital con entrada de vídeo analógico: Grabe el 
vídeo analógico en su cámara y después capture en el ordenador la 
copia digital. 

• Si la cámara soporta el modo E E, en el que las entradas y las salidas 
están electrónicamente conectadas, conecte la señal de vídeo analógico 
en la entrada analógica de la vídeo cámara y, simultáneamente, conecte 
la vídeo-cámara con el ordenador a través del puerto firewire. Active el 
modo E E en el menú de la vídeo cámara y conecte la fuente del vídeo 
analógico al tiempo que empieza a capturar desde el ordenador. 

• Utilice un conversor de señal como el Sony DVMC-DA1 para digitalizar 
el vídeo analógico a formato DV sin utilizar una vídeo cámara. 

Los métodos que se acaban de describir ofrecen la ventana de su velocidad, 
pues digitalizan la señal analógica y la envían directamente al ordenador. Si se 
quiere usar la utilidad de Premiere de captura por lotes mediante control de 
dispositivo, es preciso que el código de tiempo se haya grabajo en la cinta.

Nota: Algunas tarjetas de captura soportan tanto la captura analógica como la 
digital. Y en algunos de estos modelos es posible capturar como DV lo que 
entre por la entrada analógica.

En fin: también es posible, si no se dispone de ninguno de los métodos 
anteriores, capturar el vídeo digital y convertirlo, desde el mismo Premiere a 
DV, aunque ese proceso puede llevar mucho tiempo pues obliga a renderizar 
todo el clip.
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Grabar o reemplazar el código de 
tiempo (Sólo DV)

En ciertas circunstancias es importante que el código de tiempo de la cinta esté 
libre de lapsos o errores. Un código de tiempo contínuo es esencial, por 
ejemplo, si se quiere usar algunas funciones de Premiere como la captura por 
lotes o la depuración del proyecto que requieren que los puntos de inicio y fin 
de escena, así como la duración, sean consistentes.

Las vídeo cámaras digitales están diseñadas para crear una pista con un 
código de tiempo continuo incluso si se deja de grabar y se vuelve a empezar. 
Los lapsos y huecos en el código pueden, no obstante, producirse si se quita la 
cinta de la cámara y se reinserta después, o si se rebobina la cinta (para ver lo 
ya grabado) y se empieza a grabar en un punto distinto de aquel por el que se 
había detenido la anterior grabación.

Puede intentar arreglar el problema de un código temporal no uniforme, tanto 
antes como después de filmar (mejor antes, más fácil), pero, sea cual sea el 
remedio elegido, el código temporal debe ser continuo antes de capturar el 
vídeo al ordenador.
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Grabar un código temporal continuo 
mientras se filma

Si en el fotograma inmediatamente anterior a aquel en el que se empieza a 
filmar hay un código de tiempo válido, las grabaciones posteriores partirán de él 
y lo continuarán de manera uniforme.

Para tener la certeza de que siempre se filma con un código de tiempo 
continuo, practique los siguientes procedimientos durante la grabación:

• Antes de sacar la cinta, bobinarla, rebobinarla o reproducirla, grabe 
cinco segundos de vídeo vacío. Cuando vuelva a grabar, inicie la 
grabación al menos un segundo antes de que termine la última 
grabación. 

• Mantenga activa en la pantalla de la vídeo-cámara la visualización del 
código temporal para asegurarse de que no se han producido 
discontinuidades. 

• Si el código de tiempo vuelve a marcar 00:00:00:00, detenga la 
grabación y rebobine hasta un segundo antes de que terminara la última 
grabación. Después de ello puede seguir grabando. 
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Grabar el código temporal antes de 
la filmación

También es posible asegurarse de que una cinta contiene un código de tiempo 
válido antes de utilizarla, simplemente grabando toda la cinta antes de su 
primer uso.

Si decide utilizar este procedimiento, asegúrese de que no cambia las opciones 
de la cámara antes de grabar, pues en otro caso pueden resultar 
discontinuidades en la cinta. Por ejemplo, si se ha pregrabado una cinta con el 
audio establecido a 32 KH y, justo antes de grabar, se cambia el audio a 48 KH 
es posible que se produzca una discontinuidad en la frecuencia de audio en la 
cinta. Cuando esto ocurre la captura digital puede no funcionar correctamente, 
siendo preciso capturar la cinta como si fuera analógica.

Para grabar el código de tiempo en la cinta antes de la filmación:

1 Introduzca una cinta en su cámara digital o dispositivo y asegurese de que se 
encuentra totalmente rebobinada.

2 Si se está usando una vídeo-cámara, cubra completamente la lente utilizando 
su tapa u otro material opaco.

3 Empiece a grabar hasta que la cinta entera haya sido grabada.

4 Asegúrese de que la configuración de su cámara permanece igual antes de 
empezar a filmar.
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Reemplazar el código temporal

Si su cinta no contiene un código temporal continuo, es posible crear una copia 
de ella, y grabar en ella un nuevo código de tiempo.

Para reemplazar el código de tiempo de una cinta:

1 Cargue la cinta que tiene el código temporal erróneo en su cámara o 
dispositivo. Asegúrese de que se encuentra totalmente rebobinada.

2 Ponga la cámara en modo Play.

3 Cargue una nueva cinta en una segunda cámara o dispositivo.

4 Si el segundo dispositivo incluye una opción para grabar vídeo con el código 
temporal de la cinta original, asegúrese de que dicha opción está desactivada.

5 Conecte los dos dispositivos mediante un cable IEEE 1394.

6 Conecte en el segundo dispositivo el modo de grabación, y empiece la 
reproducción en el primero. Espere hasta que toda la cinta original se haya 
copiado.
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Tamaño máximo de fichero

Los límites al tamaño de ficheros no los establece Premiere, sino la tarjeta de 
captura, el sistema operativo, o la capacidad del disco duro.

Los únicos límites que Premiere establece son:

• En la ventana de construcción no se puede contener más de tres horas 
de vídeo. 

• Premiere no puede realizar capturas de vídeo analógico que impliquen 
un fichero de más de 2 GB 

A los ficheros de más de 2 GB se les denomina "Ficheros grandes". 
Compruebe la documentación de su tarjeta de captura, disco duro y sistema 
operativo para obtener información sobre el tamaño máximo de fichero.
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Uso de ficheros grandes en Mac OS

Para capturar, exportar, importar, renderizar, previsualizar o imprimir a vídeo 
fichero grandes (superiores a 2 GB) en Premiere, se necesita la versión 9.0.4 
del SO, Quicktime 4.1.2 o posterior y Mac OS Extended volume format (HFS+)

Si uno de estos componentes no está presente y se intenta capturar un fichero 
grande, Premiere generará una "Película referenciada" en lugar de un fichero 
grande.

Una película referenciada consiste en una serie de ficheros, cada uno de ellos 
de tamaño inferior a 1'99 GB, y cada una de ellos con una referencia al 
próximo. Estos ficheros referenciados comparte un nombre común; por 
ejemplo: Mifichero, Mifichero01, Mifichero02, Mifichero03...

Es posible abrir o importar el primer fichero (o fichero padre) de una película 
referenciada, y los restantes ficheros (ficheros hijos) se abrirán 
automáticamente.

Pero si se intenta abrir un fichero hijo directamente, Premiere mostrará un 
mensaje de error.
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Uso de ficheros grandes en 
Windows

El soporte para ficheros grandes (superiores a 2 GB) en Windows varía debido 
a los numerosos sistemas operativos de windows y formatos de disco.

Para usar ficheros grandes en Windows es preciso que el disco esté 
formateado como FAT 32 (Win9x o WinMe) o NTFS (Win NT ó 2000). Si se 
está usando un hardware de captura basado en Quicktime, también se 
necesitará la versión 4.0 o posterior de QuickTime.

Para capturar, exportar, renderizar, o previsualizar ficheros de más de 2 GB es 
preciso tener instalado Windows 98 SE, Windows 2000 o Windows ME. En 
windows 98SE y WindowsMe, el tamaño máximo de fichero es de 4 GB. En 
windows 2000 no hay límite de tamaño, si el disco duro está formateado como 
NTFS.
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Preparación de la captura analógica

Premiere se vende con muchas tarjetas de captura de vídeo, que suelen incluir 
software no Premiere escrito por el fabricante de la tarjeta para controlar el tipo 
de tarjeta específico. Por comodidad, la mayoría del software de captura de 
vídeo está diseñado para que sus controles aparezcan dentro de Premiere, a 
pesar de que gran parte del procesado de vídeo actual tiene lugar en la tarjeta, 
fuera de Premiere. Esta compleja relación entre tarjeta de captura de vídeo y 
Premiere puede hacer difícil identificar qué parte del sistema se encarga de una 
opción o problema determinado.

Adobe, al igual que la mayor parte de los fabricantes de tarjetas de captura, 
proprciona documentación en línea sobre problemas típicos que pueden 
ayudarle a determinar si cierta opción o problema es causado por la tarjeta y su 
software o por Premiere. Tales documentos en línea pueden también ayudarle 
a resover cuestiones técnicas que tal vez se produzcan al utilizar la tarjeta de 
captura junto con Premiere. Consulte la página Web de Premiere 
(http://www.adobe.com/premiere) para encontrar enlaces sobre solución de 
problemas. Si la cuestión está relacionada con la tarjeta de captura de vídeo, 
consulte la documentación proporcionada por el fabricante, o su página Web.

La mayoría de las tarjetas de captura soportadas por Premiere proporcionan un 
fichero de configuración (preset) que puede seleccionarse desde el cuadro de 
diálogo "Cargar configuración". Estas configuraciones automáticamente 
establecen todas las opciones de captura para un funcionamiento óptimo. Por 
ello Adobe recomienda que se seleccione tal configuración para aquellos 
proyectos en los que se pretende capturar clips, o importar clips capturados 
con dicha tarjeta, y que no se cambien tales opciones de captura.

La mayor parte de las opciones que controlan cómo es capturado un clip desde 
una cámara o dispositivo, se encuentran en la sección de Configuración de 
captura del cuadro de diálogo de "Configuración del proyecto".

Los formatos de captura disponibles varían dependiendo del tipo de tarjeta de 
captura instalada. Premiere también proporciona algunas opciones 
relacionadas con la captura en la sección de "Discos de trabajo y control de 
dispositivo" del cuadro de diálogo de preferencias.

Puede abrirse el cuado de diálogo de configuración de captura, haciendo click 
en el botón Edit de la ventana de captura de vídeo. Puede ser preciso antes 
seleccionar la opción Expand Window del menú de la ventana de captura de 
vídeo
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La configuración varía dependiendo del formato de captura seleccionado. En la imagen se 
muestra la pantalla cuando se elige capturar "Vídeo para Windows". Los formatos de captura 
también pueden variar dependiendo del tipo de tarjeta de captura instalada.

Para prepararse a capturar vídeo analógico:

1 Especifique el disco donde se almacenarán las películas capturadas. 
Consulte Especificación de los discos de trabajo de Premiere.

Nota: El tamaño de un clip capturado puede verse limitado por el tamaño 
máximo de archivo del sistema operativo. Para más información, consulte 
Tamaño máximo de fichero.

2 Configure la fuente de vídeo. Para QuickTime en un Mac OS, elija 
Project > Project Settings > Capture, haga click en Video, elija Source, y 
seleccione una fuente de vídeo del menú de digitalización (Digiliter). Para un 
modo de edición proporcionado por una tarjeta de captura, consulte la 
documentación incluída con ella.

3 Con cuidado compruebe otras opciones en el panel de Captura (explicado 
más abajo). - Debe hacerse notar que muchas configuraciones de captura son 
específicas para un determinado formato de captura.

Capture Format Seleccione el formato de fichero deseado. Al cambiar el 
formato de captura cambian tanto las opciones disponibles en el cuadro de 
diáologo de configuración de la captura como los cuadros de diálogo que se 
mostrarán si se pulsan los botones Vídeo, Audio y Advanced.

Capture Video Selecciónelo para activar la captura de vídeo.

Size (Sólo en QuickTime) Escriba el tamaño en pixels de los fotogramas 
(ancho y alto) y seleccione Constrain para restringir la proporción a 4:3. Si se 
quiere capturar vídeo para windows, el tamaño de fotograma se especifica en 
la sección Configuración de vídeo.

Rate (Video para Windows) Si está activado este menú, elija un número de 
fotogramas por segundo para el vídeo digitalizado. Para NTSC, elija 29.97 fps; 
para PAL y SECAM, elija 25 fps.
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Video, Audio, Advanced, VFW Settings Si estos botones están activados, 
púlselos para establecer las opciones proporcionadas por el software que se 
instala con el hardware de captura, incluyendo, normalmente, el tipo y tamaño 
de la compresión. Comprender bien estas opciones, específicas de la tarjeta, 
es esencial para capturar con éxito. Consulte la documentación de su tarjeta de 
cpatura para ello.

Capture Audio Seleccione esta opción para activar la captura de audio. Para 
la captura en formato QuickTime, o si esta opción no está activada, pulse Audio 
para especificar la configuración de audio. Para captura en formato vídeo para 
Windows, especifique opciones para Rate (la frecuencia de muestreo para el 
audio digitalizado utilizado por su dispositivo de captura), y Type (el método de 
compresión para el audio digitalizado). Si se elige un formato de captura 
distinto de QuickTime o Vídeo para Windows, y la configuración de Audio no 
está activada, ello significa que será controlada por el software que viene con el 
hardware de captura de audio; Haga click en Audio, o en Advanced para 
especificar la configuración de audio. Consulte Captura de audio analógico y la 
documentación de su hardware de captura.

Report Dropped Frames Marque esta opción si desea que Premiere muestre 
una ventana, al terminar la captura, advirtiéndolo en el caso de que uno o más 
fotogramas hayan sido solapados (no capturados).

Abort on Dropped Frames Marque esta opción si desea que Premiere 
detenga automáticamente la captura cuando se haya perdido un fotograma 
durante la digitalización.

Capture Limit Marque esta opción y escriba una duración temporal (en 
segundos) que actúe como límite de tiempo para la captura en una sóla sesión. 
Consulte Tamaño máximo de fichero.

Preroll Time Cuando se captura con control de dispositivo, esta opción 
especifica Cuánto antes del punto de inicio de la captura debe rebobinarse la 
cinta. El valor apropiado varía dependiendo del tipo de dispositivo o cámara 
que se esté usando. Consulte la documentación de su dispositivo o cámara.

Timecode Offset Cuando se captura con control de dispositivo, esta opción 
permite indicar el número de cuartos de fotogramas necesarios para ajustar el 
código de tiempo estampado en el vídeo capturado para que se corresponda 
con el fotograma correcto de la cinta original. Consulte Lectura del código de 
tiempo del vídeo origen.

Log Using Reel Name Cuando se captura con control de dispositivo, esta 
opción permite utilizar el nombre de la cinta especificado en la lista de captura 
por loetes. Para más información sobre cómo capturar por listas, consulte 
Configuración de la lista de captura.

Para ayudar a determinar el efecto de las configuraciones de compresión 
en el flujo de datos del vídeo capturado, utilice el gráfico de Flujo de Datos de 
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Premiere tal y como se explica en Análisis de las propiedades y el flujo de 
datos del clip.
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Preparación de la captura de DV

La captura de vídeo digital difiere de la de vídeo analógico en varios aspectos. 
Como el vídeo digital es convertido directamente a formato digital en la vídeo 
cámara, está preparado para ser almacenado en un disco duro, y no necesita 
ser digitalizado en el ordenador. Por tanto el DV no requiere ser capturado en 
el mismo sentido que el vídeo analógico; sino que simplemente se necesita 
transferirlo al ordenador. Para transferir DV en Windows o Mac OS, es preciso 
que en el ordenador se haya instalado una tarjeta de cpatura con una interfaz 
adaptada a OHCI.

El ordenador también necesita un codec DV, que es proporcionado en software 
como parte del sistema operativo, o en forma de chip de hardware en algunas 
tarjetas de captura. Premiere incluye soporte para codecs DV y puede leer 
vídeo de origen digital sin necesidad de conversión. Ahora bien, aun así es 
posible que se pierdan algunos fotogramas, para evitarlo hace falta un disco 
duro capaz de manejar el flujo de datos del DV: 3'6 MB por segundo.

Una diferencia esencial entre la captura de vídeo analógico y la de vídeo digital 
se encuentra en cómo hay que configurar Premiere antes de empezar a 
capturar. Por ello para capturar vídeo digital es preciso hacerlo en un proyecto 
preparado para DV.

Nota: Si el vídeo que se está capturando fue filmado en formato 16:9, usando 
una lente anamórfica, asegurese de elegir una preconfiguración DV de pantalla 
panorámica (cinemascope, widescreen). También se necesitará establecer la 
proporción de pixel para cada clip individual después de la importanción. Si no 
se hace Premire tratará el vídeo como si estuviera en formato 4:3, resultando 
distorsiones graves.

Preparación para la captura de vídeo DV:

1 Conecte el dispositivo DV a su ordenador usando un puerto IEEE 1394. El 
punto de conexión en su dispositivo Dv debe ser marcado como DV IN/OUT o 
IEEE 1394.

2 Conecte el dispositivo DV y pongalo en el modo VTR (o play: modo 
reproducción, no grabación). Si el dispositivo se apaga o deja de estar en modo 
reproducción, se interrumpirá la transferencia de audio y vídeo.

3 Inicie Premiere. Cuando aparezca el cuadro de diálogo Load Project Settings, 
seleccione la preconfiguración DV adecuada de la lista de preconfiguraciones. 
Para ello tenga en cuenta el formato standard de su país (NTSC o PAL) y la 
frecuencia de muestreo de audio (32 Kh o 48 Kh) que se usó al realizar la 
filmación original. Si no está seguro, compruebe la documentación de la vídeo-
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cámara digital teniendo en cuenta que el audio DV normalmente se establece 
como 16-bit stereo. Pulse OK.

Nota: Cuando en un proyecto se usa una preconfiguración DV por defecto, o la 
preconfiguración suministrada por el fabricante de la cámara o de la tarjeta 
firewire, no es conveniente cambiar ninguna de las configuraciones relativas a 
la captura.

4 Tras abrir el proyecto, elija Project > Project Settings > General. Pulse 
Playback Settings. Cuando se selecciona una preconfiguración DV, el modo de 
edición automáticamente se establece a reproducción DV (Windows) o 
QuickTime (Mac OS). Cualquiera de ellos proporciona opciones de 
configuración adicionales.

5 Seleccione entre las siguientes opciones y pulse OK:

• Playback on DV Camcorder/VCR (Sólo Windows) Reproduce todos los 
clips DV- en el vídeo monitor (NTSC/PAL) o en la pantalla LCD de la 
vídeo cámara. (Requiere tener el DV-IN activado, supongo) 

• Playback on Desktop (Sólo Windows) Reproduce todos los clips DV en 
la ventana de monitor o ventana independiente de clip (en el ordenador, 
pero no en la vídeo-cámara). 

• Output Device (Sólo en Mac OS) En este caso los clips DV no se 
reproducen en el ordenador, sino que la reproducción es directamente 
redirigida exclusivamente a la cámara o dispositivo digital conectado. 

• Output Mode (Sólo Mac OS) Refleja la selección de dispositivo de 
salida, de tal manera que si hay un puerto firewire, puede elegirse entre 
los modos NTSC y PAL. El tamaño de fotograma y flujo de datos 
automáticamente aparecerá debajo. 

• Play Audio on Output Device Only (Sólo Mac OS) Seleccione esta 
opción para reproducir audio a través del dispositivo de salida 
seleccionado. Si se ha seleccionado Fire Wire, el audio se envía a través 
del dispositivo; si se selecciona Desktop, el audio se reproduce desde el 
ordenador. Si esta opción no se marca el audio sonará siempre en el 
ordenador. 

Nota: El audio y el vídeo pueden no estar sincronizados si se 
reproducen en dispositivos diferentes.

• Sample Rate (Sólo Mac OS) Seleccione la frecuencia de muestreo 
usada por su cámara DV. Si se ha elegido la preconfiguración correcta, 
el valor que aparezca aquí por defecto será el adecuado. La mayoría de 
las cámaras DV usan una frecuencia de muestreo de 32 Kh o 48 
Kh; algunas cámaras pueden trabajar a 44.1h Kh. Compruebe la 
documentación de su cámara DV respecto de las configuraciones de 
audio soportadas. 

Nota: Capture y edite usando siempre la misma frecuencia de muestreo. 
No mezcle distintas frecuencias en la misma cinta ni en el mismo 
proyecto.
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• Play Also on Desktop When Playing to the Output Device (Sólo Mac 
OS) Marcando esta opción los clips en formato DV se reproducirán tanto 
en su monitor como en el dispositivo conectado por el puerto firewire. 
Cuando esta opción no está marcada Premiere sólo muestra el primer 
fotograma del vídeo clip en el monitor del ordenador. Si se está volcando 
a cinta una edición, es conveniente desactivar esta opción pues con ella 
activada la CPU tiene doble trabajo al enviar simultáneamente a dos 
dispositivos. 

Nota: Aunque esta opción no este seleccionada la reproducción de 
barrido aparecerá tanto en el monitor del ordenador como en el 
dispositivo conectado.

• Render Scrub to Output Device Seleccione esta opción para mostrar 
en el dispositivo de salida seleccionado los fotogramas renderizados 
cuando se realiza un barrido rápido. Para ello pulse Alt (Windows) o 
Opción (Mac OS) mientras se arrastra el cursos por la regla de tiempo 
en la ventana de construcción. 

• High-Quality Playback and High-Quality Scrubbing (Sólo Mac OS) 
Deje esta opción sin seleccionar para una reproducción o barrido más 
rápida y un menor impato en la CPU. Estas opciones no se encuentran 
seleccionadas por defecto, con lo que se obtiene un mejor rendimiento 
en todos los sistemas. 

• Deinterlace Desktop Playback (Sólo Mac OS) Seleccione esta opción 
si desea que Premiere desentrelace el vídeo antes de mostrarlo en la 
ventana de clip o de monitor. 

• Show Marker Comments (Sólo Mac OS) Seleccione esta opción para 
mostrar comentarios de marca en la ventana de monitor. Consulte Uso 
de marcas en la ventana de construcción para comentarios. 

6 Si su cámara DV soporta y graba audio a 44.1 kHz, y el proyecto se ha 
establecido a tal frecuencia, seleccione Audio Settings del menú de 
configuraciones generales, y después seleccione 44100 Hz desde el menú de 
frecuencia.

7 Pulse OK para cerrar el cuadro de diálogo de configuración del proyecto.

8 Elija Edit > Preferences > Scratch Disks and Device Control. Compruebe en 
la página web de Adobe Premiere (http://www.adobe.com/premiere) la lista de 
los dispositivos soportados.

9 Seleccione DV Device Control y pulse Options. Seleccione su modelo de 
cámara. Si no apararece en la lista, consulte en la págia web de Premiere para 
comprobar si se ha añadido recientemente un perfil para su cámara.

10 En el cuado de diálogo de opciones de control de dispositivo, compruebe la 
opción Check Status. Si Premiere informa de que el dispositivo no está 
preparado (offline), compruebe todas las conexiones y configuraciones. Si el 
status es Detected, significa que Premiere ha podido acceder al dispositivo, 
pero no puede controlar la cinta, tal vez porque no haya cinta insertada. Si el 
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status es Online, significa que Premiere ha podido acceder al dispositivo y 
controlar la cinta sin problemas.

11 Especifique el disco de trabajo para las películas capturadas. Consulte 
Configuración de los discos de trabajo de Premiere.

Nota: El tamaño de un clip capturado puede estar limitado por el tamaño 
máximo de fichero admitido por el sistema operativo. Compruebe Límites de 
tamaño de fichero.
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Evitar problemas de captura DV

Si se produce algún problema durante la captura de vídeos DV, en primer lugar 
consulte la ayuda en línea de Premiere, o la documentación de la tarjeta de 
captura, cámara o dispositivo. También es conveniente visitar la página web de 
Adobe para información técnica.

Los problemas más corrientes, y su solución, son los que se exponen en el 
presente tema de ayuda.

Si la cámara o dispositivo entra en el modo de espera

En este caso es posible que la ventana de captura no funcione correctamente. 
Para solucionar el problema deberá cerrar la ventana de captura, apagar la 
cámara, volver a encenderla y, a continuación volver a abrir la ventana de 
captura. A veces no hay que apagar la cámara y basta con cerrar y volver a 
abrir la ventana de captura.

De todas formas, como en la mayoría de las cámaras es posible desactivar el 
modo de espera conectándola a la red y sacando la cinta, puede ser 
conveniente hacerlo así para evitar que el problema llegue a ocurrir.

Si el vídeo capturado se ve con granos en la ventana de 
captura

Para evitar este efecto, conecte un monitor de vídeo a la cámara, y utilícelo, en 
lugar de la ventana de captura, para ver lo que se está capturando.

El granulado puede aparecer porque, durante la captura, Premiere muestra el 
vídeo en el monitor con baja calidad para incrementar la velocidad de 
descompresión. Pero la calidad a la que se muestra no afecta a la calidad a la 
que se graba, que es la máxima calidad. Cuando el vídeo se muestra en un 
monitor distinto del monitor del ordenador, siempre se muestra con la máxima 
calidad que dicho monitor admita.

Si la imagen de vídeo no aparece en la ventana de captura

En tal caso verifique el control del dispositivo y la configuración de la captura. 
Para acceder a las opciones de configuración desde la ventana de captura, 
pulse el botón Edit, y después pulse Options en el cuadro de diálogo de 
Preferencias. Aparecerá el cuadro de diálogo de opciones de control de 
dispositivo. Asegúrese en él de que la opción Check Statuso está establecida 
como Online. Fe no ser así, asegúrese de que el resto de las opciones están 
correctamente establecidas, y que el dispositivo está conectado, funciona bien 
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y de que las conexiones con el puerto firewire están bien hechas y los cables 
no están sueltos.

Para asegurarse de que Premiere tiene acceso al dispositivo, cierre Premiere, 
deje el dispositivo conectado y después reinicie Premiere. Tras ello abra de 
nuevo la ventana de captura pulse el botón Play ( ), y haga click dentro del 
área de previsualización de la imagen.

Si la imagen se ve distorsionada en la ventana de captura

Pruebe a redimensionarla para forzar a que la imagen se redibuje.

Si el audio y el vídeo no van sincronizados

Asegúrese de que la configuración de audio del proyecto se corresponde con la 
del dispositivo al reproducir, y con la que se utilizó al grabar la cinta. Asegúrese 
también de que no se grabarón secciones en blanco en la cinta. Los espacios 
en blanco en una cinta pueden ocasionar interrupciones en la cuenta de tiempo 
de la cámara, de tal manera que, al capturar un área en blanco la cámara no 
transmitirá fotogramas válidos.

Para asegurarse de que el código de tiempo va correctamente, consulte Grabar 
o reemplazar el código de tiempo.
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Uso de la ventana de captura

La ventana de captura se utiliza para capturar vídeo analógico o digital. 

Esta ventana incluye un área de previsualización, que muestra el vídeo que 
actualmente se está reproduciendo, controles para grabación con o sin control 
del dispositivo, un panel de configuración para ver y editar las configuraciones 
actuales de captura, y un panel donde se anotan las configuraciones para la 
captura por lotes.

Sólo usando el control de dispositivo es posible marcar clips para la captura por 
lotes.

Nota: La ventana de captura sólo se debe abrir para capturar desde Premiere, 
en otro caso debe estar cerrada porque, mientras está abierta, retiene el foco 
principal del sistema. Si se deja abierta mientras se edita o previsualiza el 
programa de vídeo, se desactiva la salida al dispositivo DV (en 
previsualización) y se puede reducir sensiblemente el rendimiento del sistema.

A. Zona de previsualización B. Panel de informe C. Panel de configuraciones D. Menú de la 
ventana de captura E. Controles

El menú de la ventana de captura muestra opciones que dependen del formato 
de captura que se esté usando. Por ejemplo: en el formato de captura de 
quicktime se incluye entrada de vídeo, entrada de audio y opciones avanzadas 
de configuración; opciones todas estas que no existen cuando se captura en el 
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formato de vídeo para windows. El menú puede usarse para personalizar la 
ventana de captura de las siguientes maneras:

• Para cambiar la configuración de captura, elija Capture Settings, 
seleccione sus opciones en el cuadro de diálogo de configuración de 
captura y pulse OK. 

• En Mac OS, para cambiar la entrada de vídeo, la entrada de audio o la 
configuración avanzada de captura, seleccione la opción adecuada, 
cambie la configuración y pulse OK. 

• Para eliminar los paneles del lado derecho de la ventana, elija Collapse 
Window. 

• Para mostrar los paneles del lado derecho de la ventana, elija Expand 
Window. 

• Para cambiar el tamaño y proporción de la imagen, hasta que ocupe 
toda la zona de previsualización, seleccione Fit Image in Window, 
aunque algunas tarjetas de captura no soportan la reproducción a 
tamaño completo. Si está utilizando una de estas tarjetas dicha opción 
no estará disponible. 

• Para mantener el tamaño y proporción original de la imagen, elija de 
nuevo Fit Image in Window. 
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Captura de clips sin control de 
dispositivo

La ventana de captura se puede usar para capturar vídeo analógico o digital 
incluso aunque no se disponga de un dispositivo de reproducción controlable 
por el ordenador.

En este caso, mientras se está viendo la imagen en la ventana de captura, 
deberá controlar manualmente el dispositivo de disposición y los controles de 
Premiere para grabar los fotogramas deseados.

La mayoría de los magnetoscopios y las vídeo cámaras digitales, así como los 
televisores conectados mediante una tarjeta sintonizadora, no son dispositivos 
controlables.

A. Capturar vídeo B. Capturar audio C. Grabar

Para capturar un clip sin un dispositivo controlable:

1 Asegúrese de que el dispositovo se encuentra correctamente conectado a su 
ordenador.

2 Elija File > Capture > Movie Capture.

3 Use los botones del dispositivo para rebobinar la cinta a un punto que se 
encuentre varios segundos antes del punto en el que quiere empezar a 
capturar. Esto es importante porque los dispositivos rara vez tienen precisión 
de fotograma y, además, algunos requieren cierto tiempo para empezar a 
reproducir a la velocidad correcta.

4 Presione el botón de reproducción del dispositivo, y, a continuación, pulse el 
botón Record en la ventana de captura de vídeo.
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5 Al llegar al punto en el que se quiere detener la grabación, espere unos 
segundos, para proporcionar los fotogramas adicionales necesarios para la 
edición, y después haga click con el ratón o pulse la tecla Escape (Esc) para 
detener la grabación.

Nota: Si durante la grabación hace click con el ratón, esta se detendrá.

6 Cuando aparezca el cuadro de diálogo Guardar Fichero, especifique el 
nombre y ruta de acceso deseado, y pulse el botón Save. 

Si en el momento de realizar la captura había abierto un proyecto, el fichero 
capturado aparece inmediatamente en él sin necesidad de importarlo.
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Captura de clips con control de 
dispositivo

Se denomina control de dispositivo a la posibilidad de controlar el 
magnetoscopio o la cámara desde Premiere mientras se capturan clips. Este 
procedimiento se puede usar para capturar tanto vídeo analógico como digital, 
y sólo requiere que el dispositivo sea controlable, lo cual depende tanto del 
dispositivo en sí mismo considerado como del hardware con el que se conecte 
al ordenador.

Si el control de dispositivo es posible, Premiere lo detectará y en la ventana de 
captura aparecerán los controles necesarios para operar en el dispositivo 
desde Premiere. La mayoría de los dispositivos que se conectan mediante un 
puerto fire-wire admiten este tipo de control. Sus ventajas son, entre otras:

• Se puede controlar el magnetoscopio o dispositivo reproductor de vídeo, 
y ver el vídeo reproducido directamente desde Premiere sin tener que 
cambiar entre Premiere y los controles del magnetoscopio. 

• Se pueden utilizar las ventanas Captura de clips o Captura por lotes 
para crear una lista de puntos IN (código de tiempo inicial) y puntos OUT 
(código de tiempo final) para cada clip y luego grabar automáticamente 
todos los clips de la lista. 

• Se puede capturar el código de tiempo existente en la cinta para que 
Premiere pueda utilizarlo durante la edición. 

A. Fotograma anterior B. Próximo fotograma C. Parar D. Reproducir E. Reproducción lenta en 
sentido inverso F. Reproducción lenta G. Zona de previsualización H. Arrastre de fotograma I. 
Cambio de velocidad J. Capturar vídeo K. Capturar Audio L. Rebobinar M. Avance rápido N. 
Pausa O. Grabar P. Establecer punto inicial Q. Establecer punto final R. Código de tiempo S. 
Capturar desde el punto inicial al punto final
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Para asegurarse de que la captura con control de dispositivo funcionará, 
verifique los siguientes aspectos:

• Dispone del equipo necesario. Necesitará un magnetoscopio con 
precisión de fotogramas al que pueda acoplarse un control remoto 
externo, un cable para conectar el magnetoscopio al ordenador, un plug-
in compatible con Premiere para poder controlar el magnetoscopio 
directamente desde Premiere y cintas de vídeo de origen grabadas con 
código de tiempo. 

• La mayor parte de los dispositivos DV cumplen estos requerimientos sin 
necesidad, además, de plug-ins externos. Premiere está preparada para 
trabajar directamente con ellos. 

• Defina las opciones generales del control de dispositivo para capturar 
conforme se explicó en la sección anterior. 

• Use los siguientes procedimientos para configurar Premiere de tal modo 
que pueda reconocer el dispositivo, establecer las opciones de captura y 
capturar vídeo. 

Nota: Las capacidades de control de dispositivo varían según la marca y el 
modelo del dispositivo de reproducción que vaya a controlar. Para más 
información, consulte la documentación que viene con el dispositivo o con su 
software de control de dispositivo.

Para especificar el dispositivo de captura y sus opciones:

1 Abra el cuadro de diálogo de preferencias de discos de trabajo y control de 
dispositivo realizando alguna de las siguientes acciones:

• Elija Edit > Preferences > Scratch Disks and Device Control. 
• En la ventana de captura, pulse la pestaña Settings y después el botón 

Edit. 

2 En la sección Device Control, seleccione un dispositivo, como un dispositivo 
del menú. Numerosos dispositivos vienen con un plug-in compatible con 
Premiere que, una vez instalado correctamente, muestra el nombre del 
dispositivo en este menú

3 Pulse Options, seleccione las opciones adecuadas y pulse OK.

Nota: Si el plug-in de su dispositivo incluye una opción de Modelo de 
dispositivo, asegúrese de elegir correctamente el número de modelo de la 
vídeocámara o dispositivo. Este número de modelo es el más largo de varios 
números de modelo que pueden aparecer en el dispositivo, y normalmente 
suele encontrarse en la parte inferior o trasera de la cámara o dispositivo.

4 Pulse OK para cerrar el cuadro de diálogo de Preferencias.
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Para capturar un clip usando control de dispositivo:

1 Elija File > Capture > Movie Capture.

2 Si el control de dispositivo no se ha establecido, pulse Enable Device Control 
y después siga el procedimiento anterior "Para especificar el dispositivo de 
captura y sus opciones"

3 Compruebe los botones de control del dispositivo, para verificar que 
funcionan correctamente y que se puede ver el vídeo en el área de 
previsualización.

4 Escriba el nombre de la cinta en el cuadro Reel Name (nombre del carrete). 
Puede ser que se le pregunte el nombre de la cinta cada vez que se inserte 
una nueva cinta, dependiendo del software de control de dispositivo y del 
dispositivo o cámara de que se trate.

5 Utilice los controles de la ventana de captura para colocarse en el punto de la 
cinta en el que desea empezar la captura del clip, y pulse el botón Set In ( ).

6 Utilice los controles de la ventana de captura para colocarse en el punto de la 
cinta en el que desea terminar la captura del clip y pulse el botón Set Out ( ).

7 Para moverse o reproducir respecto de los puntos In y Out que se acaban de 
establecer, puede realizar una de las siguientes acciones:

• Para llevar la cinta al punto In, pulse Alt (Windows) o Option (Mac OS) 
mientras hace click sobre el botón Set In ( ). 

• Para ir al punto de la cinta donde marcó el punto Out, pulse la tecla Alt 
(Windows) u Option (Mac OS) mientras hace click sobre el botón Set Out 
( ). 

8 Utilice los controles de la ventana de captura para realizar las siguientes 
acciones:

• Arrastre el jog control (arrastre de cuadro) ( ) un pixel a la izquierda o 
a la derecha para retroceder o avanzar un fotograma. 

• Arrastre el shuttle control ( ) para cambiar la velocidad de la cinta, 
según la distancia entre el control y el punto central. Dependiendo del 
dispositivo, por este procedimiento, se puede mover la cinta a una 
velocidad que oscila entre cuatro y 15. 

• Pulse el botón Previous Frame ( ) para retroceder un fotograma. Si el 
dispositivo no está reproduciendo, Premiere empieza a reproducir y 
rebobina un fotograma. 

• Pulse el botón Next Frame ( ) para avanzar un fotograma. Si el 
dispositivo no está reproduciendo, Premiere empieza a reproducir y 
avanza un fotograma. 

• Pulse el botón Stop ( ) para detener la reproducción. 
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• Pulse los botones Play ( ), Play Slowly ( ), o Play Slowly in Reverse (
) para, respectivamente, reproducir, reproducir a cámara lenta, o 

reproducir a cámara lenta hacia atrás. 
• Pulse el botón Rewind ( ) para rebobinar la cinta. Si se rebobina 

mientras la cinta estaba detenida, será a toda velocidad. Pero si se hace 
mientras la cinta está reproduciendo o en modo pausa, el dispositivo 
rebobinará tan rápido como pueda seguir mostrando vídeo. También se 
puede pulsar la tecla J en el teclado para mover la cinta hacia atrás a 
doble velocidad. 

• Pulse el botón Fast Forward ( ) para avanzar rápidamente la cinta.Si 
esto se hace mientras la cinta estaba detenida, será a toda velocidad. 
Pero si se hace mientras la cinta está reproduciendo o en modo pausa, 
el dispositivo avanzará a la mayor velocidad en la que pueda seguir 
mostrando vídeo. También se puede pulsar la tecla L en el teclado para 
avanzar la cinta a doble velocidad. 

9 Para capturar en el ordenador el contenido de la cinta, realice alguna de las 
siguientes acciones:

• Pulse el botón Record ( ) para grabar un clip desde el punto que se 
está reproduciendo en ese momento. 

• Mantenga pulsada la tecla Alt (Windows) u Option (Mac OS) mientras 
pulsa el botón Record ( ), o pulse el botón Capture In/Out. Entonces 
Premiere mueve automáticamente la cinta hasta el Pre-roll especificado 
antes del punto IN, pone en marcha la cinta, empieza a capturar en el 
punto IN y para de capturar en el punto OUT 

• Si se especificó un nombre en el panel Logging al nuevo clip se le 
asignará dicho nombre automáticamente. 

10 Una vez que Premiere completa la captura aparece el cuadro de diálogo 
Guardar Fichero: Especifique un nombre y ruta de acceso y pulse Save. Si 
tiene abierto un proyecto el clip capturado se incorporará a él sin necesidad de 
importarlo de forma expresa.
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Captura de vídeo por lotes

Si tiene la configuración del control de dispositivo adecuada y dispone de una 
cinta de vídeo grabada con código de tiempo, puede configurar Premiere para 
que capture automáticamente varios clips desde la misma cinta. Esto se 
denomina captura por lotes. Liste, o cree una lista de, las porciones que desee 
capturar desde la cinta. Esta lista, denominada lista de captura o lista de código 
de tiempo, se crea en la ventana Captura por lotes. La lista de captura se 
puede crear listando clips visualmente con el control remoto o introduciendo de 
forma manual los puntos IN y OUT. Una vez elaborada la lista de captura, haga 
click en un botón para capturar los clips de la lista. La captura por lotes es 
posible tanto con vídeo analógico como digital, siempre que esté habilitado el 
control de dispositivo.

Nota: La captura por lotes no se recomienda para los primeros y últimos 30 
segundos de la cinta, porque puede haber errores de localización y de código 
temporal. Por ello estos fragmentos es recomendable que sean capturados 
manualmente.

A. Columna de comprobación B. Botón para ordenar por el punto In C. Botón de captura D. 
Botón para añadir una nueva entrada E. Botón para eliminar la entrada seleccionada

La columna de comprobación, en el lado izquierdo de la ventana, muestra el 
status de un clip:

• Si la columna no tiene iconos, quiere decir que no se ha capturado el clip 
ni se ha establecido que se capture. 

• El diamante ( ) indica que este clip se capturará cuando haga click en el 
botón Capturar ( ) de la ventana Captura por lotes. Haga click para 
activar o desactivar el diamante. 

• La marca de verificación ( ) indica que este clip se ha capturado 
• El icono X ( ) indica que se ha producido un error al capturar un clip 
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Cuando se pulsa el botón Capture ( ), Premiere comprueba la lista de ficheros, 
y analiza el disco duro buscando otros ficheros con el mismo nombre. Si existe 
un duplicado, Premiere añade el icono de duplicado ( ) junto al nombre del 
fichero en la ventana. Se puede entonces elegir entre reemplazar los ficheros 
existentes en el disco con los nuevos ficheros que se van a capturar, o se 
puede renombrar los ficheros en la lista de captura.

Pulsando el botón Add ( ) se creará una nueva entrada en la lista, y pulsando 
Delete ( ) se eliminará de la lista la entrada seleccionada. Si hace doble click 
se editarán los parámetros de captura (tales como el nombre de fichero, o el 
nombre de cinta). Se pueden ordenar las entradas de la lista según el punto In 
de su código de tiempo pulsando el botón Sort ( ). Pero, en todo caso, cuando 
se empieza la captura, Premiere automáticamente reordena las entradas 
atendiendo al nombre de la cinta y el código de tiempo de su punto In.

Nota de Quinurio: A diferencia de otras ventanas de Premiere, la ventana de 
captura por lotes no es única, sino que se pueden abrir tantas ventanas 
distintas como se desee, manteniendo en cada una de ellas una lista de 
captura diferente. Por eso, cuando en los próximos temas de ayuda se diga 
algo así como que hay que abrir la ventana de captura por lotes que se quiere 
modificar, lo que se quiere decir es que hay que abrir una ventana de captura 
por lotes y en ella se debe cargar la lista de captura a modificar.

50



Registro de clips en una lista de 
captura

Especifique qué escenas desea utilizar de las cintas de origen registrando 
escenas (introduciendo la hora inicial y final) en una lista de captura. Si el 
ordenador está conectado a un dispositivo controlable, puede crear una lista de 
captura de clips automáticamente utilizando los controles de registro de clips de 
Premiere y, a continuación, utilizar Premiere para capturar automáticamente 
todos los clips de la lista. Controle la cinta desde Premiere y marque las 
escenas conforme las ve. Éste es el método más fácil y directo que existe.

Es posible que a veces desee capturar vídeo utilizando un dispositivos 
controlado por Premiere pero que no tenga acceso permanente al ordenador 
conectado a ese aparato. Esto es así porque los dispositivos controlables son 
más caros. Por ejemplo, quizá utilice un dispositivo controlable en un estudio 
de edición que alquila por horas, o bien es posible que muchos editores 
compartan el mismo aparato equipado con control remoto en una compañía o 
institución docente. En estos casos puede registrar los clips manualmente. 
Puede utilizar un equipo tan sencillo como un magnetoscopio doméstico, una 
copia de la cinta de origen con código de tiempo incrustado (visible) y una hoja 
de papel. Con este método, registrará a mano los números de los fotogramas y 
más tarde introducirá la lista manualmente en la lista de captura de Premiere 
para utilizarla durante la sesión de captura con un dispositivo controlable.

Para añadir entradas de lista de captura utilizando control de dispositivo:

1 Asegúrese de que las configuraciones del control remoto están 
correctamente especificadas. Consulte Captura de clips con control de 
dispositivo.

2 Elija File > Capture > Movie Capture.
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3 Pulse en la pestaña Logging, escriba el nombre de la cinta. Es posible que se 
le pida que especifique el nombre de la cinta cada vez que inserte una cinta 
nueva, dependiendo del software del control remoto y del dispositivo.

4 Utilice los controles del cuadro de diálogo Captura de clips para ir al lugar de 
la cinta de vídeo donde desea empezar a capturar el clip y haga click en Mark 
In ( ). Según el dispositivo es posible que no pueda capturar entra los 4 y 10 
primeros segundos de una cinta digital.

Nota: Para marcar los puntos In y Out de la captura es indiferente hacerlo 
desde el cuadro de diálogo de la pestaña de registro o con los botones Mark In 
( ) y Mark Out ( ).

5 Utilice los controles del cuadro de diálogo Captura de clips para ir al lugar de 
la cinta de vídeo donde desea parar la captura y haga click en Mark Out ( ).

6 Haga click en Log In/Out, después escriba un nombre de fichero si no quiere 
usar el nombre por defecto, escriba los comentarios que desee añadir y haga 
click en OK.

7 Repita los pasos 4 a 6 para cada clip que desee capturar desde esta cinta.

8 Cierre la ventana Captura de vídeo.

9 Si dispone de otra cinta que quiere capturar, insertela, modifique el nombre 
de cinta en la ventana de captura por lotes, y repita los pasos 2 a 8.

10 Asegúrese de que la ventana Captura por lotes está activa y elija File > 
Save. Si es necesario, especifique una ubicación y un nombre de archivo y 
después haga click en OK.

Para añadir entradas de lista de captura manualmente:
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1 Abra una lista nueva o existente, realizando alguna de las siguientes 
acciones:

• Para crear una nueva lista de captura, elija File > Capture > Batch 
Capture. Después elija File > Save As. Especifique una ruta de acceso, 
escriba un nombre y haga click en Save. 

• Para abrir una lista existente, elija File > Open, seleccione la lista y pulse 
Open. 

2 Pulse Add New Item ( ), y especifique las siguientes opciones:

• En Reel Name, escriba el nombre de la cinta desde la que pretende 
capturar el clip. 

• En File Name, escriba un nombre para el fichero de vídeo que se creará 
tras la captura. 

• En Comment, escriba cualquier otra información que desee proporcionar 
sobre el clip. 

• En In Time, escriba el código de tiempo del punto de inicio de grabación. 
Si sustituye puntos por comas o escribe números sin puntuación, en la 
parte derecha de la visualización de esta opción se le indicará cómo 
interpreta Premiere los números que escriba como horas, minutos, 
segundos y fotogramas. 

• En Out Time, escriba el código de tiempo en el que se debe detener la 
grabación. 

• En Frame Rate, seleccione la velocidad de fotogramas por segundo de 
la cinta original. 

• En Format, seleccione Drop Frame o Non Drop-Frame. Esta opción solo 
está disponible si se selecciona 30 fps en la opción Frame Rate. 

3 Pulse OK, y después elija File > Save.

4 Repita los pasos 2 y 3 para cada uno de las entradas de la lista que desee 
añadir.
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Cómo guardar, exportar e importar 
listas de captura

Puede guardar una lista de captura en disco. Así mismo, puede exportar e 
importar una lista de captura como archivo de texto. Al guardar una lista de 
captura y exportarla se crean dos archivos muy diferentes:

• Al guardar una lista de captura se conservan todas las entradas y sus 
configuraciones de captura (descritas en la siguiente sección) en un 
formato de archivo que sólo puede leer Premiere. 

• Al exportar una lista de captura se crea un archivo de texto ASCII 
delimitado por tabulador que enumera todas las entradas pero no retiene 
las configuraciones de captura. No obstante, el archivo de texto es útil 
para trasladar las entradas de una lista de captura a otra. Por ejemplo, 
puede añadir entradas de una lista de captura a otra exportándolas e 
importándolas. También es posible exportar una lista de captura como 
archivo de texto para editarla en programas de edición de texto o en 
sistemas de edición de vídeo que lean listas de captura de texto. El 
orden de las columnas de un archivo de texto se puede controlar. 

El menú de la ventana de captura por lotes contiene comandos que se pueden 
usar para gestionar las configuraciones de una lista de captura.

Para guardar una lista de captura:

1 Active la ventana Captura por lotes que desee guardar y realice una de las 
siguientes acciones:

• Para un nuevo fichero, elija File > Save As. Especifique una ubicación y 
un nombre de archivo y haga click en Save. 

• Para un fichero existente elija File > Save. 

Para exportar una lista de captura como un archivo de texto de registro de 
código de tiempo:

1 Active la ventana Captura por lotes que desea exportar.

2 En el menú de la ventana elija Import/Export Settings.
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3 Arrastre cada columna para volver a ordenarla como desee y haga click en 
OK.

4 En el menú de la ventana elija Export to Text File. Especifique una ubicación 
y un nombre de archivo y haga click en Save.

Para importar una lista de captura de registro de código de tiempo:

1 Active la ventana Captura por listas donde desea recibir la lista.

2 En el menú de la ventana elija Import from Text File. Localice y seleccione el 
archivo y haga click en Open.

Una vez registrada una cinta que contiene comentarios, puede guardar la 
lista de captura en un disco y almacenar el disco con la cinta de vídeo. Ello 
facilitará volver a digitalizar clips de esa cinta en el futuro.

Movimiento de entradas de captura entre diferentes listas:

1 Abra dos o más ventanas de captura por lotes simultáneamente realizando 
alguna de las siguientes acciones:

• Elija File > Capture > Batch Capture para abrir una nueva ventana de 
captura por lotes. 

• Elija File > Open para abrir un fichero de texto existente de captura por 
lotes. 

2 Arrastre el nombre de un fichero de una a otra lista.
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Especificación de las 
configuraciones de la lista de 
captura

Por defecto, las configuraciones que Premiere utiliza para capturar clips en una 
captura por lotes, son las mismas usadas en el proyecto que estaba abierto en 
el momento en que se registraron las entradas de la lista de captura.

Si se desea cambiar estas configuraciones utilice, en el menú de la ventana de 
captura por lotes, las opciones Capture Settings (Windows) o Recording 
Settings, Video Input, Audio Input, o Advanced options (Mac OS). Los cambios 
realizados se aplicarán a todos los clips en la lista, a no ser que para una 
entrada individual se vincule un fichero de configuraciones.

El uso de configuraciones diferentes para entradas individuales de la lista de 
captura exige que se graben diferentes ficheros de configuración. Consulte 
Grabar y cargar configuraciones de proyecto.

También es posible especificar un número de fotogramas extra que serán 
capturados antes del punto In o después del punto Out en cada clip, y 
seleccionar una entrada de la lista de captura para verla realizar con ella una 
captura individual en la ventana de captura de vídeo.

Se puede modificar la configuración de las entradas de una lista de captura por 
lotes de las siguientes maneras:

• Para adjuntar un archivo de configuraciones a una entrada de lista de 
captura individual, seleccione la entrada y elija Attach Settings del menú 
de la ventana de captura por lotes. Localice y seleccione el archivo de 
configuraciones que desea utilizar y, a continuación, haga click en Open. 

• ara eliminar un archivo de configuraciones de una entrada de lista de 
captura individual, elija Remove Settings del menú de la ventana. 

• Para especificar los fotogramas adicionales a capturar al final de cada 
entrada de lista de captura, elija Handles del menú de la ventana. 
Introduzca el número de fotogramas adicionales que desea capturar 
antes del punto IN y después del punto OUT del clip y haga click en OK. 
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Captura de vídeo desde una lista de 
captura

Una vez terminado el diseño de la lista de captura, está preparado para 
capturar el vídeo. Al capturar una lista de captura, Premiere aplica las 
configuraciones actuales de grabación, compresión, entrada de vídeo y entrada 
de audio a no ser que haya adjuntado un archivo de configuraciones de captura 
específico para una o más entradas. Consulte Especificación de las 
configuraciones de la lista de captura.

Para empezar a capturar vídeo:

En una ventana de captura por listas, realice una de las siguientes acciones:

• Para capturar uno o más clips directamente desde la ventana Captura 
por lotes, asegúrese primero de que los clips que desea capturar están 
marcados con un diamante ( ) en la columna de verificación del 
extremo izquierdo de la ventana; si es necesario, haga click en la 
columna de verificación para activar el icono diamante de una entrada, o 
haga click en el encabezado de la columna para poner todas las 
entradas en on o en off. Haga click en el botón Capture ( ). 

• Para capturar un sola entrada de lista de captura en la ventana de 
captura de clips, seleccione la entrada y elija Send In/Out to Movie 
Capture en el menú de la ventana y pulse el botón Capture ( ). 

Una vez terminada la captura, pueden importarse los ficheros capturados en un 
proyecto utilizando el comando File > Import.

Para cancelar una captura por lotes:

Mientras un clip está siendo capturado, pulse la tecla Escape (Esc), haga click 
con el ratón o pulse Command+period (solo Mac OS).

Nota: Si se intenta cancelar una captura por lotes mientras el dispositivo está 
buscando el próximo código de tiempo, la captura no se cancelará, y Premiere 
provocará un error. Espere hasta que el dispositivo esté reproduciendo para 
cancelar la captura por lotes.
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Creación de una lista de captura 
para volver a digitalizar clips de 
proyecto

Puede volver a digitalizar clips de un proyecto existente utilizando la captura 
por listas, de tal modo que cuando a los clips capturados se les cambien los 
puntos IN u OUT en la ventana de construcción, automáticamente se registren, 
en la lista de captura, los nuevos puntos de inicio y terminación.

Esto es útil, por ejemplo si originalmente se utilizaron clips de baja resolución 
para una edición más rápida y ahora está listo para volver a digitalizar los clips 
a alta resolución para la versión final. Al volver a capturar únicamente los 
segmentos esenciales de las cintas de origen originales, podrá mantener los 
archivos con un tamaño mínimo. El procedimiento siguiente no sustituye a los 
clips en el proyecto actual, sino que crea un proyecto nuevo.

Nota: Si sabe que volverá a digitalizar los clips, asegúrese de capturar los clips 
originales con código de tiempo utilizando el control de dispositivo. Esto 
garantiza que los clips tendrán nombres de cinta y código de tiempo válidos. 
Premiere no puede utilizar una lista de captura para digitalizar clips si no se ha 
especificado código de tiempo en la lista de captura o si la cinta de vídeo de 
origen no contiene código de tiempo.

Para preparar una lista de captura para volver a digitalizar 
automáticamente:

1 Con un proyecto abierto, elija Project > Utilities > Project Trimmer.

2 Seleccione Create Trimmed Batch List, y desactive Copy Trimmed Source 
Files.

3 En Keep _ Frame Handles, introduzca el número de fotogramas que desea 
capturar antes del punto IN y después del punto OUT de cada clip. Especifique 
fotogramas suficientes para tener flexibilidad en las ediciones que deban ser 
muy precisas.

4 Pulse Create Project.

5 Cuando se le pida, especifique la ubicación y el nombre del proyecto nuevo 
basado en los clips recortados y, a continuación, haga click en Save.

6 Cuando se le pida, especifique la ubicación y el nombre del archivo de la lista 
de captura que está creando y haga click en Save.
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7 Asegúrese de que el dispositivo y la cinta de vídeo de origen están 
configurados apropiadamente para la captura y haga click en Capturar en la 
ventana de Captura por lotes que aparece.

Para volver a digitalizar manualmente:

1 Si los clips que se quieren recapturar están todavía en su ordenador, cierre el 
proyecto y borrelos, cambieles el nombre o muévalos a otro directorio (Solo 
Windows).

2 Abra el proyecto, y cuando aparezca el cuadro de diálogo de búsqueda de 
ficheros, seleccione Offline All (Windows) o All Offline (Mac OS).

3 Si, después de haber empezado el proyecto, se cambió su configuración, elija 
Project > Project Settings > General, pulse Save, y guarde su configuración 
actual como un fichero de preconfiguración. Consulte Grabar y cargar 
configuraciones de proyecto.

4 Elija File > Capture > Batch Capture para abrir la ventana de captura por 
lotes.

5 En la ventana de proyecto, seleccione todos los clips que desea redigitalizar, 
y arrástrelos a la ventana de captura por lotes. Repita la operación para cada 
contenedor donde haya clips que quiere redigitalizar.

6 En la ventana de captura por lotes, seleccione todos los clips y después elija 
Attach Settings del menú de la ventana.

7 En el cuadro de diálogo "Abrir fichero" que aparece, localice la 
preconfiguración utilizada para el proyecto (consulte el paso 3), y pulse Open. 
(Por defecto los ficheros de preconfiguración se ubican en la carpeta de 
Premiere de nominada Settings folder.)

8 Estando activa la ventana de captura por lotes, elija File > Save; escriba un 
nombre para la lista de captura y pulse Save.

9 Cierre el proyecto. Si no lo hace los clips recapturados se importarán en el 
proyecto actual como nuevos clips, sin reemplazar a los anteriores.

10 Asegúrese de que el dispositivo y la cinta de origen están correctamente 
configurados para la captura, y después pulse el botón Capture ( ) en la 
ventana de captura por lotes.

11 En el cuadro de diálogo que aparece para localizar los ficheros, seleccione 
un fichero de contenedor previamente almacenado y pulse Open, o haga click 
en New, escriba un nombre de fichero y pulse Save. Este contenedor será 
utilizado para almacenar los clips capturados.
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12 Premiere empieza automáticamente a capturar los clips de la lista de 
captura. Para cancelar el proceso pulse la tecla Escape (Esc) una o más veces, 
según sea necesario.

13 Cuando la captura se haya completado, abra el proyecto.

14 En el cuadro de diálogo que aparece para localizar los ficheros, seleccione 
los ficheros que se acaban de capturar, que se encontrarán en el disco y 
directorio especificado en las preferencias generales para la captura de vídeo. 
Consulte Configuración de los discos de trabajo de Premiere.

15 Una vez que todos los clips han sido abiertos en el proyecto, elija File > 
Save.
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Captura de una animación de 
cámara de truca

Nota de Quinurio: Como no tenía ni idea de cómo traducir el término original 
"Stop-motion animation" (literalmente: animación de movimiento-parada) he 
decidido utilizar el término que utilizaba la versión 5 de Premiere en español. 
Tampoco es que sea muy clara (salvo, claro, que en el mundo de la edición de 
vídeo eso sea muy conocido, y yo no tuviera ni idea). En un diccionario inglés 
de edición de vídeo he leído: Stop-Motion: Una forma de animación en la que 
los objetos se filman fotograma a fotograma y alterados ligeramente en cada 
uno.

La función Cámara de truca permite realizar manualmente capturas de 
fotogramas cada cierto tiempo desde una cámara conectada, o desde una cinta 
en un dispositivo o vídeo cámara. Por ejemplo, puede enfocar la cámara hacia 
un edificio sin terminar y utilizar la función de lapso de tiempo para capturar 
fotogramas periódicamente a medida que se va terminando el edificio. Puede 
utilizar la función cámara de truca con una cámara para crear animaciones en 
plastilina, o capturar un solo fotograma y guardarlo como una imagen fija.

En Premiere, la cámara de truca no requiere control de dispositivo y es posible 
utilizarla tanto para fuentes de vídeo analógicas como digitales.

Se puede utilizar cualquier fotograma de película como guía visual de 
posicionamiento durante la captura de cámara de truca. El procedimiento para 
configurar una imagen de fondo funciona del mismo modo para la ventana de 
cámara de truca que para la ventana de título; consulte Importación de un 
fotograma de muestra.

Cuando esté preparando una captura de cámara de truca, siga los siguientes 
consejos para una captura más exitosa:

• Desconecte las utilidades de ajuste automático que su cámara pueda 
tener, y realice los ajustes y configuraciones necesarios de forma 
manual. Esto es recomendable porque las fluctuaciones graduales 
ocasionadas por la auto exposición o la función auto focus de las 
cámaras, cuando la captura no es continuada sina cada lapso de tiempo, 
se pueden ver como cambios repentinos y bruscos que resultan 
demasiado evidentes en el vídeo final. 

• Conecte la cámara al adaptador de corriente, y extraiga la cinta, para 
evitar que en la cámara se pueda activar automáticamente el modo de 
espera. 
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• Si es posible, desconecte en su cámara el modo Demo. Este modo (que 
existe en algunas cámaras) se activa automáticamente cuando 
transcurre cierto periodo de tiempo sin que se haya insertado una cinta y 
la cámara se encuentra en el modo de grabación. 

Para capturar animaciones de cámara de truca:

1 Elija File > Capture > Stop Motion.

2 En el menú de la ventana que aparece (ventana de cámara de truca -- stop 
motion), elija Stop Motion > Capture Options (Windows) o Stop Motion > 
Recording Settings (Mac OS).

3 Realice una de las siguientes acciones dependiendo de la plataforma:

• En Windows: Elija un tipo de captura según desee capturar un solo 
fotograma (Still Image), controlar la cámara de truca haciendo click en el 
botón Capturar de la ventana Cámara de truca (Manual Capture), o bien 
capturar fotogramas de cámara de truca a intervalos de tiempo 
periódicos (Time Lapse). 

• En Mac OS, seleccione Manual Recording para controlar la cámara de 
truca haciendo click en un botón de la ventana Cámara de truca o 
seleccione Time Lapse para capturar fotogramas de cámara de truca a 
intervalos de tiempo regulares. 

Nota: Según el tipo de captura que elija, es posible que no estén disponibles 
algunas de las configuraciones que se tratan a continuación.

4 Realice una de las siguientes acciones dependiendo de la plataforma:

• En Windows: 
o Introduzca las dimensiones horizontales y verticales de los 

fotogramas a capturar en el cuadro Size _ x _ box. 
o Seleccione Constrain para ajustar los valores al ratio de aspecto 

que utiliza el hardware de captura. 
• En Mac OS: 

o Seleccione Record at Current Size para capturar fotogramas a las 
dimensiones actualmente mostradas en la ventana Cámara de 
truca; o seleccione Record At e introduzca las dimensiones 
horizontales y verticales de los fotogramas a capturar, en píxeles. 

o Seleccione 4:3 para mantener una proporción entre el tamaño 
horizontal y el vertical de 4:3 (que es la proporción de una 
pantalla standard de televisión). Cuando se selecciona esta 
opción, cada vez que se introduce un valor para la resolución 
horizontal, cambia automáticamente el valor de la resolución 
vertical para ajustarlo a la proporción; y viceversa. 
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5 Sólo en Windows, introduzca un valor para Final Movie Will Play Back _ fps 
para definir los fotogramas por segundo del vídeo capturado.

6 Si ha seleccionado Time Lapse, introduzca un valor de tiempo y seleccione 
una unidad de tiempo para Capture _ Frames per _ (Windows) o _ Frames 
per _ (Mac OS). Sólo en Windows, también puede limitar el número de 
fotogramas capturados seleccionando Límite de captura e introduciendo un 
número de fotogramas.

7 En Minimum Disk Free Space _ K (Windows) o en Stop When Disk Space 
Falls Below _ K (Mac OS), introduzca un valor que especifique hasta dónde 
puede descender el espacio libre en disco antes de que Premiere detenga 
automáticamente la captura de cámara de truca. El disco controlado para este 
valor es el especificado para captura de vídeo en el cuadro de diálogo 
Preferences > Scratch Disk and Device Control.

8 Sólo en Windows, haga click en los botones situados en la esquina superior 
derecha del cuadro de diálogo (si están disponibles) para definir las opciones 
que proporciona el software que viene con el hardware de captura de vídeo. Se 
puede acceder a estos mismas configuraciones desde del panel 
Configuraciones de captura del cuadro de diálogo Configuraciones de proyecto 
(consulte Digitalización de vídeo analógico como DV). También puede elegir 
estas opciones en el menú de la cámara de truca en la barra de menús.

9 Sólo en Mac OS, seleccione Stabilize Image Jitters para reducir al mínimo las 
señales de vídeo inestables de algunos dispositivos.

Para crear una imagen fija, también puede capturar vídeo de la forma 
habitual y luego utilizar File > Export > Frame. Para más información, consulte 
Exportación de un fichero de imágenes para su edición con Adobe Photoshop.

10 Haga click en OK. Conecte la cámara, magnetoscopio u otro origen de vídeo 
y en la ventana Cámara de truca haga click en Start.

11 Realice una de las siguientes acciones:

• Si en el paso 3 seleccionó Manual Capture (Windows) o Manual 
Recording (Mac OS), pulse Start para empezar y después pulse Step 
cada vez que desee capturar un nuevo fotograma. También puede 
pulsar un número del teclado para capturar el número especificado de 
fotogramas consecutivos o pulsar Delete ara eliminar el último fotograma 
capturado. 

• Si en el paso 3 seleccionó Time Lapse, pulse Start. Premiere captura 
fotogramas a la velocidad especificada. Haga click en Stop cuando 
desee detener la captura. 
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• (Sólo en Windows) Si en el paso 3 seleccionó Still Image, espere hasta 
que el origen de vídeo muestre el fotograma que desea y haga click en 
Capture. 

12 Elija Save As, especifique una ubicación y un nombre para el clip y haga 
click en OK.

Para gestionar la animación de cámara de truca (sólo en Mac OS):

Realice alguna de las siguientes acciones:

• Para capturar una serie de fotogramas consecutivos durante una cámara 
de truca, elija Stop Motion > Grab Frames. Especifique el número de 
fotogramas consecutivos a capturar y, a continuación, haga click en OK. 

• Para eliminar fotogramas del final de una secuencia de cámara de truca 
capturada, elija Stop Motion > Truncate Movie. Arrastre el potenciómetro 
para buscar el fotograma donde debe empezar el truncamiento. Se 
eliminarán todos los fotogramas situados después del fotograma 
especificado. Haga click en Truncate. 

• Para mostrar una estela del fotograma anterior durante la captura, elija 
Stop Motion > Show Previous. Este comando resulta útil para centrar 
con más exactitud el tema del fotograma actual a la vista del contenido 
del fotograma capturado anteriormente. La estela no se convierte en 
parte del archivo capturado. 

• Para eliminar un clip de fondo, elija Stop Motion > Remove Background 
Clip. Este comando sólo está activo si se añade un clip de fondo para 
ayudar a situar el asunto que se está capturando. Para más información 
sobre cómo añadir clips de fondo, consulte Importación de un fotograma 
de muestra. 
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Lectura del código de tiempo del 
vídeo de origen

En la mayoría de los magnetoscopios domésticos, el contador de cinta no hace 
un seguimiento de fotogramas específicos, por ejemplo, los contadores de 
muchos magnetoscopios se ponen a cero cada vez que se cambia la cinta o se 
apaga o se enciende el aparato.

Por el contrario los magnetoscopios y las cámaras profesionales de alta gama 
pueden grabar y leer código de tiempo en y desde una cinta de vídeo, 
marcando fotogramas específicos con lo que es posible localizar, editar y 
sincronizar con exactitud fotogramas de vídeo y la pista de audio. Al capturar 
vídeo, normalmente se quiere capturar el código de tiempo asociado a cada 
clip si el vídeo de origen contiene código de tiempo. El código de tiempo es 
esencial si tiene previsto crear una lista de decisiones de edición a fin de crear 
el programa de vídeo final en una mesa de edición convencional en línea de 
alta gama y no en Premiere. El uso del código de tiempo SMPTE garantiza 
precisión de fotograma.

Cuando capture vídeo con código de tiempo, tenga en cuenta lo siguiente:

• El código de tiempo de un vídeo de origen se captura cuando se utiliza 
control de dispositivo. Este tipo de captura requiere el código de tiempo. 
Consulte Uso de la ventana de captura de vídeo.) 

Si dispone de control de dispositivo, puede utilizar el código de tiempo de la cinta de vídeo 
(izquierda) para editar con precisión programas en Premiere (derecha).

• El código de tiempo sólo es visible en los contadores de cinta de los 
equipos que pueden reconocer código de tiempo, a no ser que el código 
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de tiempo se haya grabado sobre la imagen en una copia de la cinta. La 
mayoría de los magnetoscopios domésticos no pueden leer ni escribir 
código de tiempo. 

• Si tiene previsto capturar toda una cinta, durante la captura sólo será 
necesario reconocer el punto IN de la película. Una vez grabado el punto 
IN, un magnetoscopio con precisión de fotograma capturará 
correctamente todos los fotogramas siguientes. El punto OUT 
predeterminado está situado más allá de la longitud de la cinta; de este 
modo, puede capturar toda la cinta sin definir un punto OUT 

Nota: La captura de código de tiempo con dispositivos controlables depende de 
la precisión del magnetoscopio. Si éste no puede leer código de tiempo 
correctamente, es posible que tenga que calibrar el sistema o asignar 
manualmente código de tiempo a la película haciendo coincidir fotogramas.
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Ajuste manual de código de tiempo 
de un clip

Una copia de cinta de vídeo puede no contener código de tiempo en la pista de 
vídeo pero si una ventana de copia o de grabación, superpuesta en cada 
fotograma de vídeo. Esta ventana de copia permite ver el código de tiempo en 
los magnetoscopios que no leen código de tiempo invisible. El código de tiempo 
de la ventana de copia también se denomina código de tiempo de grabación o 
visual. Puesto que las cintas de vídeo con código de tiempo de grabación no 
suelen incluir código de tiempo invisible, los clips capturados de esa cinta no se 
marcan con código de tiempo en el ordenador. No obstante, es posible ajustar 
manualmente el código de tiempo en cada clip capturado. Puesto que para ello 
es necesario hacer referencia a la cinta de vídeo original, es mejor hacerlo 
inmediatamente después de capturar el clip.

Para ajustar manualmente el código de tiempo de un clip:

1 Realice una de las siguientes acciones:

• Active la ventana de clip que contiene el clip que desea ajustar. 
• Abra el clip en la vista de origen. 
• Active la ventana de proyecto o la del contenedor donde esté el clip que 

desea ajustar y, a continuación, seleccione el clip. 

2 Elija Clip > Advanced Options > Timecode, especifique las opciones 
siguientes y haga click en OK:

• En la primera opción, introduzca el código de tiempo que se ve en el 
fotograma actual del clip. 

• En Frame Rate y Format, elija las opciones del menú que se ajusten a la 
cinta de vídeo. 

• En Set Timecode At, pulse File Beginning si ha introducido el código de 
tiempo para el primer fotograma del clip o, en caso contrario, haga click 
en Current Frame. 

• En Reel Name / Description, escriba el nombre de la cinta de vídeo del 
clip. 
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Captura de audio analógico

Si desea utilizar audio que aún no está en formato digital, tendrá que 
capturarlo. Con la tarjeta de captura de audio o de vídeo apropiada, Premiere 
puede capturar audio sincronizado con su vídeo de origen o 
independientemente de éste.

La calidad del audio digitalizado y el tamaño del archivo de audio depende de 
la frecuencia de muestreo, o del número de muestras por segundo, y de la 
profundidad de bits, o del número de bits por muestra del audio digitalizado. 
Asimismo, la digitalización de audio estéreo requiere mucho más espacio en 
disco que el audio mono.

Estos parámetros, controlados en la sección Configuraciones de captura del 
cuadro de diálogo Configuraciones de proyecto, determinan con qué precisión 
se representa la señal de audio en forma digital. Cuanto más elevada sea la 
frecuencia de muestreo y mayor la profundidad de bits, mayor será la calidad 
de reproducción del sonido, aunque con tamaños de archivo mayores. Si tiene 
previsto exportar o reproducir el corte final desde Premiere, capture audio con 
los ajustes de calidad más elevados que pueda gestionar el ordenador, aunque 
dichos ajustes sean más elevados que los que especificará para la exportación 
o la reproducción final. Esto proporciona espacio extra, o datos adicionales, 
que ayudarán a conservar la calidad si ajusta la ganancia de audio o aplica 
filtros de audio como la ecualización o la compresión/expansión de rango 
dinámico; consulte Aplicación y control de efectos.

Para establecer la localización en el disco de un fichero capturado de una 
fuente sólo de audio:

1 Elija Edit > Preferences > Scratch Disks and Device Control.

2 En Captured Movies, dentro de la sección Scratch Disks, seleccione una ruta 
de acceso y pulse OK.

Para capturar un origen de audio (Windows):

1 Elija File > Capture > Audio Capture.

2 Localice y seleccione el programa de captura que desea utilizar y haga click 
en OK. Si no ha adquirido un programa de captura de audio independiente, 
puede utilizar la Grabadora de sonidos de Windows (sndrec32.exe) que se 
encuentra en la carpeta donde se haya instalado Windows. A continuación, 
haga click en OK.
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3 Utilice el programa de captura de audio para grabar un archivo de audio. 
Consulte la documentación o la ayuda en línea del programa de captura. 
(Premiere recuerda el programa seleccionado para la grabación de audio. La 
próxima vez que elija Capture > Audio Capture, Premiere niciará 
automáticamente el mismo programa de audio.)

Nota: En Windows, las opciones de entrada de audio se verán afectadas por 
las configuraciones del panel de control de multimedia del programa de captura 
que utilice. Para más información, consulte la Ayuda en línea de Windows y del 
programa de captura.

Para capturar un origen de audio (Mac OS):

1 Elija File > Capture > Audio Capture.

2 Elija Audio Capture > Sound Input.

3 Seleccione un origen del menú. Las opciones disponibles dependen del 
hardware de audio que se utilice. Por ejemplo, el software de la tarjeta de audio 
puede añadir opciones a este cuadro de diálogo.

4 En Sample Rate, seleccione el número de muestras por segundo. Los CD de 
audio se graba a una frecuencia de 44.1 Hz. Tratándose de grabaciones de voz 
humana puede ser suficiente 11025 Hz y para la reproducción de música de 
calidad media basta con 22050. No obstante, para obtener los mejores 
resultados, se recomienda elegir la frecuencia de muestreo que corresponda 
con el resto del audio del proyecto. Por ejemplo, si el proyecto contiene 
básicamente audio digital, elija 48 Hz.

5 En Format, realice las siguientes acciones:

• Seleccione una profundidad de bits del menú de la izquierda. El sonido 
de 8 bits es suficiente para voz y para música de calidad media; el audio 
de los discos compactos se almacena a 16 bits. El audio estéreo 
requiere el doble de espacio en disco y de procesado que el audio 
mono.

• Seleccione el uso de canal que desee en el menú de la derecha. 

6 En Speaker, seleccione cómo desea que funcionen los altavoces mientras 
graba.

7 En Volume, arrastre el potenciómetro para amplificar o reducir la señal de 
audio entrante.

8 Si está disponible, haga click en Options, especifique cualquiera de las 
opciones proporcionadas por el hardware de audio y haga click en OK.

9 Pulse OK para cerrar el cuadro de diálogo de configuración del sonido.
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10 Pulse Record.

Nota: Si no se graba ningún audio o no puede oír el audio de origen, intente 
reproducir el audio mediante el sistema de altavoces del ordenador sin grabar. 
Si sigue sin poder oírlo, puede que el origen de audio no esté conectado 
correctamente. Verifique las conexiones del hardware, las configuraciones en el 
panel de control de multimedia (Windows) o los paneles de control de sonido y 
monitores (Mac OS) y la documentación que viene con el ordenador y con la 
tarjeta de sonido.
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Importación de audio digital

Premiere puede importar clips de audio digital almacenados como archivos o 
pistas de audio en archivos de vídeo. El audio digital se almacena como datos 
binarios que pueden leer los ordenadores. La mayor parte del audio digital se 
almacena en los discos duros de los ordenadores, discos compactos de audio 
(CD) o cintas de audio digital (DAT). Si dispone de hardware de captura que 
pueda leer directamente datos de audio digital, como una conexión IEEE 1394 
(FireWire/i.Link) puede conservar la calidad del origen de audio digital. En estos 
casos se puede capturar audio digital directamente en Premiere desde la 
ventana de captura de vídeo, para lo cual debe asegurarse de desconectar la 
opción Capturar vídeo (Take video), y establecer la configuración del origen de 
audio en el menú de la ventana de captura de vídeo.

Muchos ordenadores en su configuración estándar importan audio mediante 
conectores de entrada analógicos; el audio digital se convierte en analógico al 
utilizar los conectores de entrada del equipo de audio y se convierte 
nuevamente en digital al capturarlo. Esta conversión digital-analógica-digital 
adicional reduce algo la calidad del audio.

El audio de las pistas individuales de un CD está escrito con el formato de 
fichero CDA (Compact Disc Audio). Premiere no soporta directamente este 
formato, por lo que, antes de usarlo, deberá convertirlo a un formato soportado. 
Una vez que el audio digital está en un formato que Premiere puede leer, 
inclúyalo en su proyecto mediante el comando Importar. Consulte Importación 
de clips.

Nota: Asegúrese de que dispone de derechos suficientes para copiar las pistas 
de audio de un CD comercial.
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Uso de audio CD en Windows

En Windows es posible reproducir ficheros de audio de un CD; pero antes de 
poder importarlos a Premiere, es necesario convertirlos a un formato de fichero 
soportado. La conversión se puede hacer utilizando numerosos programas de 
conversión como WaveStudio de Creative Labs Inc, Sound Forge de Sonic 
Foundry, o Audio Grabber de Audio Grabber.

Una vez convertido el fichero de audio a los formatos WAV o AIFF, se podrá 
importar utilizando el comando File > Import.
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Uso de audio CD en Mac OS

En Mac OS, es posible importar pistas de audio cd como ficheros AIFF o WAV, 
sin pérdida de calidad, utilizando un conversor incorporado a QuickTime.

Nota: Aunque el formato DV puede grabar dos pares de canales de audio 
stéreo independiente, no es posible capturar en Windows los dos canales, y 
tampoco en Mac OS se pueden capturar los dos canales independientemente. 
Tampoco Premiere soporta actualmente la creación de cintas con cuatro 
canales de audio.

Para importar una pista de Audio-Cd (Sólo en Mac OS):

1 En Premiere, elija File > Open. Localice y selección el CD de audio y pulse 
Open.

2 Seleccione una de las pistas y pulse Options.

3 Pulse Play para asegurarse de que ha seleccionado la pista correcta.

4 Especifique las siguientes opciones:

• En Rate, seleccione el número de muestras por segundo. La calidad 
standard de los CD es de 44.1 kHz. 

• En Size, seleccione la profundidad de bits para el audio. La calidad 
standard de los CD es de 16 bits 

• En Use, seleccione si la pista se debe importar como mono o como 
stéreo. 

5 Si solo desea importar una porción de la pista, realice una combinación de las 
siguientes acciones en la sección de Audio Selection section y después pulse 
OK:

• En Start y End, escriba los tiempos relativos a la duración de la pista. 
• Arrastre los potenciómetros de principio y final. 

6 Especifique una localización y nombre de fichero para almacenar la pista 
convertida, y pulse OK.
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Los proyectos de Premiere que contengan audio con diferentes 
frecuencias de muestreo, requieren un tiempo extra de renderización. Para 
evitar esto, reconstruya el audio en los clips que usen frecuencias diferentes, a 
la frecuencia que tengan la mayoría de los clips del proyecto, y después 
reemplace los clips. Para reconstruir un clip de audio con otra frecuencia puede 
utilizar un programa independiente de tratamiento de audio, o, en Premiere, 
importarlo a un proyecto separado, exportar dicho proyecto como película con 
la frecuencia deseada y después importar la nueva película en el proyecto.
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Acerca de D1, DV y varias 
proporciones de aspecto de pixel

Los píxeles en la pantalla pueden tener distintas proporciones, al igual que los 
fotogramas. Por proporción de aspecto se entiende la relación entre la anchura 
y la altura. Así por ejemplo, el formato DV NTSC tiene una proporción de 
fotograma de 4:3, lo que significa que el fotograma será siempre más ancho 
que alto en una cuarta parte. De este modo se especifica un tamaño en 
términos relativos, independiente del tamaño en términos absolutos.

Con un ejemplo se ve claro: Imaginemos distintas pantallas, de diferentes 
tamaños, y que podemos proyectar la imagen para llenar la pantalla. Pues si, 
por ejemplo, una pantalla tiene 40 centímetros de ancho, la imagen tendrá 40 
centímetros de ancho y treinta de alto. Y si la pantalla tiene cuatro metros de 
ancho, la imagen tendrá cuatro metros de ancho y tres metros de alto. Es 
decir: con independencia de la unidad de medida, la proporción 4:3 siempre se 
mantendrá.

Lo mismo ocurre con los píxeles. Y así, por ejemplo, cuando se dice que en el 
formato DV NTSC la proporción de aspecto de pixel es de 0.9 se quiere decir 
que por cada unidad de altura se tendrán 0.9 unidades de anchura.

Izquierda: Una proporción de fotograma de 4:3 (standard en televisión). Derecha: una 
proporción de fotograma de 16:9 (standard para pantallas anchas)

Muchos formatos de vídeo utilizan la misma proporción para los fotogramas 
(normalmente 4:3) pero diferentes proporciones para los píxeles. Por ejemplo, 
muchas tarjetas de captura NTSC producen vídeo con una proporción de 
fotograma de 4:3, con píxeles cuadrados (proporción 1.0) y una resolución de 
640 x 480. El formato DV NTSC tiene la misma proporción para el fotograma, 
pero usa píxeles rectangulares (0.9 de proporción), y una resolución de 720 x 
480.

Los píxeles DV son siempre rectangulares, y se orientan verticalmente en 
sistemas NTSC y horizontalmente en sistemas PAL.
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Si en un monitor de píxeles cuadrados se muestran píxeles rectangulares sin 
alteración, las imágenes y el movimiento aparecerán distorsionadas, y así, por 
ejemplo, los círculos se mostrarán como óvalos. No obstante, cuando esa 
misma imagen se muestre en otro monitor, las imágenes se verán de forma 
correcta.

A. Píxeles cuadrados y proporción de fotograma de 4:3 B. Píxeles no cuadrados y proporción 
de fotograma de 4:3 C. Píxeles no cuadrados mostrados en un monitor de píxeles cuadrados

Cuando se importa o captura vídeo DV, en un sistema D1 o DV la imagen 
aparentará ser ligeramente más ancha de lo que en realidad es. El efecto 
contrario sucede cuando se captura o importa un metraje anamórfico 
(anamórfico = preparado para pantalla ancha, con un 33% más de resolución 
de lo corriente) usando proporciones de pantalla ancha de D1/DV NTSC o 
D1/DV Pal. La proporción standard para pantalla ancha es de 16:9

Si un fichero usa píxeles rectangulares, Premiere muestra la proporción de 
aspecto del pixel junto a la miniatura del fichero en la ventana de proyecto. Se 
puede cambiar la proporción de aspecto de pixel para ficheros individuales en 
el cuadro de diálogo Pixel Aspect Ratio. Aasegurándose así de que todos los 
clips serán interpretados correctamente es posible combinar clips con 
diferentes proporciones de píxel en el mismo proyecto, y generar ficheros de 
salida que se reproduzcan correctamente.

Premiere establece la proporción de píxeles de un proyecto según la 
preconfiguración que se haya elegido al empezar el proyecto. Esta 
configuración se puede cambiar antes de empezar la edición; pero una vez que 
la edición ha empezado, cambiar la proporción de píxeles puede ocasionar 
problemas.

Al capturar o importar vídeo, tanto si es con la resolución standard para D1 
(720 x 486) o con la propia del DV NTSC (720 x 480), Premiere 
automáticamente establece la proporción de aspecto de los píxeles para dicho 
fichero a D1/DV NTSC (0.9). Pero cuando se importan clips con la resolución 
propia de D1 o DV para PAL (720 x 576), Premiere automáticamente establece 
la proporción de pixel para dicho fichero a D1/DV PAL (1.067). Por ello es una 
buena idea asegurarse de que todos los ficheros han sido interpretados 
correctamente, comprobando la proporción en la ventana de proyecto o en el 
cuadro de diálogo Pixel Aspect Ratio.
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Nota: Asegúrese de restaurar la proporción de pixel a píxeles cuadrados 
cuando se importe un fichero con píxeles de este tipo que, sin ser D1 o DV, 
tengan la misma resolución. Por ejemplo una imagen de Adobe Photoshop 
image con una resolución de 720 x 480.

Nota aclaratoria de Quinurio: El sistema de televisión norteamericano y 
japonés se denomina NTSC, frente al sistema europeo que es el PAL. Ambos 
sistemas difieren en muchos aspectos, especialmente fotogramas por segundo 
y resolución standard de la pantalla: En NTSC hay más fotogramas por 
segundo que en PAL, pero una menor resolución.

Este tema de ayuda Adobe lo ha escrito pensando en un público básicamente 
norteamericano, por lo que muchas veces se dice que la resolución propia del 
DV es de 720 x 480 (ó 486). Téngase en cuenta que en sistemas PAL (Europa 
y américa latina) la resolución es de 720 x 576. Yo he intentado aclararlo, y 
cuando se citaba una resolución a secas he añadido NTSC. Pero el resultado 
tal vez sea confuso. Por eso esta aclaración.
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Establecimiento de la proporción de 
aspecto de píxel

Es importante establecer la proporción de aspecto de píxel para un fichero igual 
a la proporción original y no a la del fichero de salida.

En el cuadro de diálogo de configuración general del proyecto, y en el cuadro 
Clip > Advanced options > Pixel Aspect Ratio, el menú de proporción de 
aspecto de píxel ofrece varias opciones: en la siguiente tabla se indica cuál es 
la proporción de aspecto de píxel para cada una de ellas, y en qué casos se 
recomienda su utilización:

Opción del menú
Proporción de 

aspecto de 
píxel

Cuando utilizarlo

Square Pixels 1.0 Vídeo con resoluciones de 640 x 480 o 648 x 486.

D1/DV NTSC 0.9 Vídeo con resoluciones 720 x 480 o 720 x 486 y salida 
con proporción 4:3

D1/DV NTSC 
(WideScreen) 1.2 Vídeo con resoluciones 720 x 480 o 720 x 486 y salida 

con proporción 16:9

D1/DV PAL 1.0666 Vídeo con resoluciones 720 x 576 y salida con 
proporción 4:3

D1/DV PAL 
(WideScreen) 1.4222 Vídeo con resoluciones 720 x 576 y salida con 

proporción 16:9
Anamorphic 2:1 2.0 Vídeo filmado con lentes anamórficas

D4/D16 Standard 0.9481481 Vídeo con resoluciones de 1440 x 1024 o 2880 x 2048 
y salida con proporción 4:3

D4/D16 Anamorphic 
8:3 1.8962962 Vídeo con resoluciones de 1440 x 1024 or 2880 x 2048 

y salida con proporción 8:3
Para establecer la proporción de aspecto de píxel en ficheros importados:

1 Seleccione el fichero en la ventana de proyecto.

2 Elija Clip > Advanced Options > Pixel Aspect Ratio.

3 Seleccione una proporción de aspecto del menú Pixel Aspect Ratioy pulse 
OK.

Si está pensando en exportar a la misma proporción de aspecto de píxel que 
sus clips, también será preciso establecer el valor de la proporción de aspecto 
de pixel para el proyecto.
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Para establecer la proporción de aspecto de píxel para un proyecto:

Realice una de las siguientes acciones:

• Elija la preconfiguración adecuada al empezar el proyecto 
• Si el proyecto está ya abierto, elija Project > Project Settings > Video, y 

seleccione una proporción del menú Pixel Aspect Ratio; después pulse 
OK. 
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Uso de metraje con píxeles 
cuadrados para salida a DV

En un proyecto DV es posible utilizar clips con píxeles cuadrados y generar una 
salida que no se vea distorsionada. Premiere incrementará o reducirá la 
resolución de los ficheros incluidos en el proyecto que no tengan la misma 
resolución fijada para el proyecto. 

Cuando la resolución es reducida, no suele haber pérdida de calidad. Pero 
cuando hay que ampliarla, Premiere tiene que rellenar más espacio con los 
mismos píxeles que había en menos espacio; es decir: lo normal es que se 
produzca una pérdida de calidad. Por ello es preferible crear ficheros que sean 
más grandes que la resolución fijada para el proyecto: de esta manera 
Premiere no tendrá que ampliar la resolución, y no habrá pérdida de la calidad 
de imagen.

Para usar ficheros con píxeles cuadrados en un proyecto D1 o DV:

1 Prepare el metraje con píxeles cuadrados utilizando uno de los siguientes 
métodos:

• Si la salida final será DV (NTSC), genere el metraje con una resolución 
de 720 x 540 para evitar un posterior aumento de resolución, o a una 
resolución de 640 x 480 para evitar distorsiones de campo cuando se 
realice un fichero de campos renderizados (como una animación 3D) 

• Si la salida final será DV (PAL), genere el metraje con una resolución de 
768 x 576 para evitar que, en la renderización, Premiere tenga que 
aumentar la resolución y distorsiones de campos en ficheros de campos 
renderizados (como una animación 3D). 

• Si la salida final será D1 (NTSC), genere el metraje con una resolución 
de 720 x 540. 

2 Capture o importe el fichero en Premiere.

3 Si no le es posible usar el método del paso 1, realice alguna de las siguientes 
opciones si es necesario:

• Si el fichero con píxeles cuadrados fue creado y grabado con una 
resolución poco corriente, o con una resolución inferior a la usada en el 
proyecto (por ejemplo, si se importa un logo de 400 x 400 preparado con 
Adobe Illustrator, o una imagen escaneada que se pretende 
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supoerponer sobre el vídeo), selecciónelo y pulse Clip > Video Options > 
Maintain Aspect Ratio. Esta opción evita que la imagen sea 
redimensionada hasta el tamaño del fotograma del proyecto, y hace que 
Premiere reconstruya la imagen usando la misma proporción de aspecto 
de píxel que en el proyecto. 

• Si el fichero fue creado y grabado con una resolución standard (como 
640 x 480 o 720 x 540), Premiere escalará la imagen de modo que la 
proporción de aspecto de píxel, la proporción de fotograma y la 
resolución coincidan con las del proyecto. Para obtener los mejores 
resultados debe crear ficheros en los que al menos una de las 
dimensiones (horizontal o vertical) coincida con las dimensiones del 
proyecto y la otra sea más grande que la del proyecto. Y ello porque en 
estos casos Premiere reducirá la resolución. 

• Si el fichero fue creado y grabado con la resolución utilizada por el 
proyecto (como 720 x 480), puede ser buena idea rediseñar la imagen 
con un tamaño de fotograma distinto (como 720 x 540). 
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Importación de clips

Puede importar clips a Premiere de varias formas. Puede importar directamente 
a la ventana de proyecto un solo clip, varios clips o una carpeta de clips entera. 
Si desea examinar el clip antes de importarlo al proyecto, puede abrirlo primero 
en una ventana de clip y después moverlo a la ventana de proyecto o de 
construcción.

Los clips no pueden exceder de los 4000 píxeles de alto por 4000 píxeles de 
ancho. Si el software utilizado para crear ilustraciones no permite especificar 
píxeles como unidad de medida, quizá baste con especificar puntos. Si el 
fichero no incluye información sobre la proporción de aspecto de píxel, 
Premiere utiliza la interpretación establecida en el fichero Rules.txt, que puede 
ser personalizada para determinar la proporción de aspecto de píxel basándose 
en los codecs, tamaño de imagen u otros parámetros.

De forma predeterminada, Premiere modificará el tamaño y el ratio de aspecto 
de los clips de vídeo o de las imágenes fijas para que coincidan con los del 
fotograma de vídeo especificado para el proyecto. Premiere muestra las 
imágenes con su correcta proporción de fotograma en las ventanas de monitor 
y de recorte. Para más información sobre las proporciones de aspecto, consulte 
Acerca de D1, DV y varias proporciones de aspecto de pixel.

Premiere puede importar los siguientes formatos de vídeo, audio e imagen:

Formatos de Vídeo: AVI tipo 2, MOV, y Open DML (Sólo en Windows)

Nota: Los clips en AVI tipo 1 deben ser renderizados antes de poder ser 
previsualizados en un dispositivo DV. Para renderizar un clip AVI tipo 1, 
añádalo a la ventana de construcción en un proyecto DV y construya un fichero 
de previsualización de dicha sección de la ventana de construcción.

Formatos de audio: AVI, MOV, AIFF, WAV (Sólo en Windows), el formato de 
sonido de Macintosh, (Sólo en Mac OS), y Sound Designer I & II (Sólo en Mac 
OS)

Imagen fija y formatos de secuencia: AI y secuencias AI, PSD y secuencias 
PSD, GIF y GIF animados, Filmstrip, JPEG, PICT y secuencias PICT, TGA y 
secuencias TGA, TIFF y secuencias TIFF, PCX (Sólo en Windows), FLC/FLI 
(Sólo en Windows), BMP y secuencias BMP (Sólo en Windows), y animaciones 
PICS (Sólo en Mac OS)
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El soporte de los formatos de fichero se proporciona mediante módulos de 
software plug-in. Esto significa que, con el tiempo pueden estar disponibles 
más formatos.

Para importar uno o más clips al proyecto:

Realice una de las siguientes acciones:

• Para importar un solo clip elija File > Import > File. Localice y seleccione 
el fichero y pulse Open. 

• Para importar varios clips en Windows, elija File > Import > File. 
Mantenga pulsada la tecla Control mientras selecciona los ficheros que 
desea importar, o mantenga pulsado Shift y haga click en el primer y el 
último fichero (se seleccionarán todos los ficheros intermedios). Tras ello 
pulse Open. 

• Para importar varios clips en Mac OS, elija File > Import > File. 
Mantenga pulsada la tecla Shift mientras selecciona los ficheros que 
desea importar. Pulse Open. 

• Para importar una carpeta de clips, elija File > Import > Folder. Localice 
y seleccione la carpeta que desea importar y después pulse OK 
(Windows) o Seleccione foldername (Mac OS). 

Para examinar un clip antes de añadirlo al proyecto:

1 Elija File > Open.

2 Localice y seleccione el fichero que desea examinar y después pulse Open. 
El clip aparecerá en la vista de origen de la ventana de monitor, o en una 
ventana independiente para el clip.

3 Examine el clip. Si decide añadirlo al proyecto, coloque el puntero sobre la 
zona de visualización del clip y arrastrelo a la ventana del proyecto o elija Clip > 
Add Clip to Project.

Nota: Para controlar la ventana en la que se abre el clip, elija Edit > 
Preferences > General and Still Image, active o desactiva la opción Open 
Movies in Clip Window y pulse OK.
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Importación de imágenes fijas

Puede importar imágenes fijas individuales o convertir una secuencia 
numerada de imágenes fijas en una sola animación conforme la importa 
(consulte Importación de una animación o secuencia de imágenes). 

Cuando importa una imagen fija individual, Premiere utiliza la duración 
especificada en el cuadro de diálogo que aparece al elegir Edit > Preferences > 
General and Still Image. Puede cambiar la duración de las imágenes fijas 
después de importarlas.

Para cambiar la duración por defecto de las imágenes fijas:

1 Elija Edit > Preferences > General and Still Image.

2 En la sección Still Image, especifique el número de fotogramas que desea 
que constituya la duración por defecto de una imagen fija.

Nota: El cambio de la duración por defecto de las imágenes fijas no afecta a la 
duración de las imágenes fijas que formen parte de una secuencia.

Para cambiar la duración de una imagen fija que ya ha sido importada:

Seleccione el clip y elija Clip > Duration. Introduzca la nueva duración y pulse 
OK.

Por defecto Premiere alterará el tamaño y proporción de la imagen para que 
coincida con las especificaciones del proyecto. Puede, no obstante, indicarse 
que las imágenes retengan su proporción original (consulte Mantenimiento de 
la proporción original de un clip). También es posible escalar la imagen a un 
tamaño distinto del tamaño del fotograma (Consulte Ajuste de la escala de un 
clip).

Si se piensa utilizar varias imágenes que tienen proporciones diferentes a la del 
proyecto, puede bloquear la proporción de las imágenes antes de importarlas.

Para bloquear la proporción de las imágenes antes de su importación:

1 Elija Edit > Preferences > General and Still Image.

2 Seleccione Lock Aspect para preservar las proporciones de una imagen en 
Premiere. Cuando esta opción se desactiva y se importa una imagen, Premiere 
la redimensiona hasta el tamaño del fotograma.
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Si se importa un fichero con píxeles de proporción no cuadrada que haya 
sido creado con una resolución poco habitual, o con una resolución inferior a la 
utilizada por el proyecto (por ejemplo 400 x 400), selecciónela y elija Clip > 
Video Options > Maintain Aspect Ratio. Después, con el fichero aun 
seleccionado, elija Clip > Advanced Options > Pixel Aspect Ratio, elija Square 
Pixels del menú Pixel Aspect Ratio, y pulse OK. Estableciendo estas dos 
opciones se evita que Premiere redimensione la imagen y la reconstruya para 
ajustar la proporción de aspecto de pixel a la del proyecto.
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Importación de ficheros de Adobe 
Illustrator

Puede importar un archivo de imagen fija de Adobe Illustrator directamente a 
un proyecto de Premiere. Premiere convierte las ilustraciones de Illustrator 
basadas en líneas al formato de imagen basado en píxeles que utiliza 
Premiere; este proceso se denomina rasterización.

Premiere aplica automáticamente anti-alias o suaviza los bordes de las 
ilustraciones de Illustrator. Premiere también rasteriza todas las áreas vacías 
de un archivo de Illustrator con un canal alfa premultiplicado con blanco, lo que 
significa que puede convertirse en transparente al superponerlo sobre otros 
clips, aunque para ello debe aplicar el tipo de transparencia Alfa sobre blanco. 
Consulte Uso de claves para superponer y crear composiciones y Uso de las 
claves Canal alfa sobre negro y Canal alfa sobre blanco.

Puede importar ilustraciones de Illustrator de hasta 2000 píxeles de ancho por 
2000 píxeles de alto. Si desea definir las dimensiones de la ilustración de 
Illustrator que Premiere rasteriza, utilice el programa Illustrator (que se vende 
por separado) para establecer marcas de recorte en el archivo de Illustrator. 
Para más información sobre cómo definir marcas de recorte en Illustrator, 
consulte Adobe Illustrator User Guide.

Para rasterizar e importar un fichero de Adobe Illustrator:

Elija File > Import > File. Localice y seleccione un fichero de Illustrator y pulse 
Open.
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Importación de ficheros de Adobe 
Photoshop

Se pueden importar ficheros de Photoshop 3.0 o posterior, a pesar de que 
Premiere no soporta las imágenes TIFF de 16 bits creadas por Photoshop y por 
otras aplicaciones gráficas.

importar una capa individual de un archivo de capas múltiples de Photoshop. Si 
el archivo de Photoshop utiliza un canal alfa para transparencia, Premiere lo 
mantiene. Si superpone el archivo de Photoshop sobre otra pista en Premiere, 
podrá ver las áreas transparentes que marca el canal alfa. Para más 
información sobre los canales alfa y las superposiciones, consulte Uso de la 
trasparencia canal alfa.

Nota: Si se tienen problemas importando un fichero de Photoshop que use una 
máscara de capas o múltiples capas, combine las capas en el fichero 
photoshop antes de importarlo a Premiere; para información al respecto 
consulte la documentación de Photoshop.

87

file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c07st13.htm
file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c07st13.htm


Importación de una animación o 
secuencia de imágenes fijas

Se puede importar una animación contenida en un solo fichero, como un GIF 
animado. Una animación difiere de un video en que es generada de forma 
sintética, y no grabando de la vida real.

Premiere también puede importar una secuencia de archivos numerados de 
imágenes fijas y combinarlos automáticamente en un solo clip; cada archivo 
numerado representa un fotograma. Algunos programas pueden generar una 
serie de secuencias de imágenes fijas numeradas, como por ejemplo Adobe 
After Effects y Adobe Dimensions. Las imágenes en una secuencia de 
imágenes fijas, no pueden incluir capas, por lo que deberá de acoplar las 
imágenes que formarán parte de una secuencia. Para más información sobre 
capas y acoplamiento, consulte la documentación de la aplicación con la que 
se creó el archivo.

Nota: El cambio de la duración por defecto de las imágenes fijas en el cuadro 
de diálogo de Preferencias, no afecta a la duración de las imágenes fijas que 
sean parte de una secuencia.

Al crear imágenes tridimensionales o animaciones que serán importadas en 
Premiere, siga las siguientes instrucciones en la medida de lo posible:

• Use filtros de color broadcast-safe 
• Use la proporción de aspecto de pixel y el tamaño de fotograma 

especificados en la preconfiguración de proyecto que será usada en 
Premiere. 

• Use las configuraciones de campo apropiadas para que se ajusten con 
las del proyecto. 

Para importar ficheros de imágenes numeradas y compilarlas en un sólo 
clip:

1 Realice una de las siguientes acciones:

• En Windows, asegúrese de que cada nombre de archivo de imágenes 
fijas tiene la extensión de archivo correcta y de que todos los nombres 
de archivos de la secuencia contienen un número igual de dígitos al final 
del nombre de archivo, pero antes de la extensión del nombre de archivo 
—por ejemplo, archivo000.bmp, archivo001.bmp, etc. 
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• En Mac OS, asegúrese de que todos los nombres de archivos de la 
secuencia contienen un sufijo de un punto seguido de un número igual 
de dígitos —por ejemplo, archivo.000, archivo.001, etc. Se puede 
insertar un espacio entre el punto y el número del archivo —por ejemplo, 
archivo. 000, archivo. 001 y etc. 

2 Elija File > Import > File.

3 Localice y seleccione el primer archivo numerado de la secuencia y 
seleccione Numbered Stills, tras ello pulse Open.
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Importación de otro proyecto

Puede añadir el contenido de un proyecto existente a un proyecto abierto. Por 
ejemplo, puede dividir un proyecto grande en proyectos más pequeños y 
manejables y después importar cada proyecto al proyecto principal para crear 
el programa de vídeo final.

Al importar un proyecto a un proyecto abierto, los clips del proyecto importado 
se añaden a la ventana de proyecto en un contenedor que lleva el nombre del 
proyecto importado. 

Puede importar el contenido de la ventana de construcción de un proyecto al 
inicio, final o punto de edición en la ventana de construcción del proyecto 
abierto. Todos los efectos especiales del proyecto importado, tales como 
transiciones y filtros se incluyen. Si en el proyecto importado hay pistas que no 
coinciden con los nombres de pista del proyecto abierto, se añaden a la 
ventana de construcción.

Premiere importa el proyecto como una edición de inserción: los clips de todas 
las pistas en o después del punto de inserción se retrasan en una cantidad 
correspondiente a la duración del proyecto importado. Si importa un proyecto 
en el punto de edición, éste bisecciona los clips que se encuentren en este 
punto. Antes de importar un proyecto, puede examinar ambos proyectos para 
anticipar posibles conflictos de pista y guardar el proyecto de destino en el caso 
de que la importación del proyecto produzca resultados no anticipados.

Nota: No es posible importar directamente un proyecto de Premiere 5.0 o 
anterior, debido a las diferencias entre las versiones. Para importar un proyecto 
de una versión anterior, primero conviértalo en un Proyecto de Premiere 6.0 
abriéndolo y grabándolo en Premiere 6.0 (Consulte Apertura de un proyecto). 
Asegúrese de que los dos proyectos tienen la misma base de tiempo.

Los proyectos creados en Premiere 5.1 o posterior sí pueden ser directamente 
importados a un proyecto de Premiere 6.0.

Para combinar un proyecto con otro proyecto actualmente abierto:

1 Asegúrese de que el proyecto de destino está abierto.

2 Elija File > Import > Project.

3 Localice y seleccione el proyecto y, a continuación, haga click en Open.
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4 Haga click en Beginning, Edit Line, o End para especificar en que parte de la 
ventana de construcción desea que aparezca el proyecto importado y, a 
continuación, haga click en OK.
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Análisis de las propiedades y flujo 
de datos de un clip

Premiere incluye herramientas para analizar los clips, que se pueden usar para 
evaluar un fichero en cualquier formato soportado, dentro o fuera de un 
proyecto. Por ejemplo, tras producir un clip de vídeo para ser colocado en un 
servidor Web, puede usarse la herramienta de análisis de clips para determinar 
si el clip que se ha exportado tiene un flujo de datos apropiado para su 
distribución por Internet.

La utilidad "Propiedades" (Properties) proporciona información detallada sobre 
cualquier clip. Para ficheros de vídeo las propiedades analizadas pueden incluir 
el tamaño del fichero, número de pistas de vídeo y de audio, duración, 
promedio de fotogramas, flujo de datos de audio y de vídeo y configuración de 
la compresión. También es posible comprobar las propiedades para advertir de 
la presencia de fotogramas perdidos en un clip que se acaba de capturar.

Para ver las propiedades de un clip:

1 Realice una de las siguientes acciones:

• Si el clip se encuentra en la ventana del proyecto, selecciónelo para 
mostrar un subconjunto de sus propiedades en la parte superior de la 
ventana. 

• Si el clip se encuentra en las ventanas de proyecto, monitor o 
construcción, seleccionelo, elija File > Get Properties For, y seleccione el 
nombre de fichero del clip. 

• Si el fichero no forma parte aun del proyecto, elija File > Get Properties 
For > File. Localice y seleccione el clip que se quiere analizar y pulse 
Open. 

2 Para salvar la ventana de propiedades como un fichero de texto, elija File > 
Save As, especifique una ruta de acceso y nombre de fichero y pulse Save.

3 Para ver un gráfico del flujo de datos, pulse Data Rate.

El gráfico de flujo de datos se puede usar para evaluar si el fichero de salida 
cumple los requerimientos del medio al que está destinado. En él se mapea 
cada fotograma de un fichero de vídeo para mostrar la tasa de keyframes, la 
diferencia entre la compresión de los keyframes y el resto de los fotogramas, y 
los niveles de flujo de datos de cada fotograma. El gráfico incluye lo siguiente:
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• Data rate: La línea blanca representa el flujo medio de datos. 
• Sample size: Las barras rojas representan el tamaño de muestreo de 

cada fotograma marcado como keyframe. 
• Differenced frames sample size: Las barras azules representan el 

tamaño de muestreo de los fotogramas colocados entre keyframes. 

4 Al terminar, cierre la ventana de gráfico de flujo de datos y la de propiedades.

También es posible ver las propiedades de un clip en cualquier ventana 
que lo contenga, haciendo click con el botón derecho del ratón (Windows) o 
presionando Control mientras se hace click sobre el clip (Mac OS) y eligiendo 
Get Properties.
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Uso de archivos de referencia

Premiere crea automáticamente un archivo de referencia, o reserva de espacio, 
para los archivos de origen utilizados en el proyecto que no se pueden localizar 
al abrir el proyecto. También puede crear un archivo de referencia en cualquier 
momento. Por ejemplo, si tiene previsto utilizar clips de vídeo que aún no se ha 
capturado, puede crear un archivo de referencia como sustituto temporal del 
vídeo que falta durante la edición. Cuando disponga del vídeo real, puede 
sustituir rápidamente todas las copias del archivo de referencia existentes en el 
proyecto por el vídeo real. Consulte Apertura de un proyecto.

Para crear un fichero de referencia:

1 Elija File > New > Offline File.

2 Escriba un nombre de archivo. Por regla general, utilice el nombre de archivo 
del vídeo de origen real que falta.

3 En Duration, ntroduzca la longitud del archivo de referencia.

4 En Timecode, introduzca el valor de código de tiempo del punto IN del vídeo 
de origen que falta.

5 En Reel Name, escriba el nombre de la cinta que contiene el vídeo de origen 
que falta..

6 Elija un formato de tiempo del menú Formatque corresponda al vídeo de 
origen.

7 Elija un valor de fotogramas por segundo del menú Speed.

8 Seleccione Has Video o Has Audio, o bien ambas, según el contenido del 
fichero que falta fuera sólo de vídeo, sólo de ambos, o contuviera vídeo y 
audio. A continuación, haga click en OK.

Para reemplazar un fichero de referencia con el clip original:

1 En un proyecto o ventana de contenedor, seleccione el fichero de referencia.

2 Elija Project > Replace Clips.

3 Localice y seleccione el archivo real de vídeo de origen y haga click en OK.

Nota: Si no consigue localizar el fichero, pulse la tecla Escape para abandonar 
el cuadro de diálogo y dejar el proyecto en su estado original.
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Edición de vídeo

Uso de la ventana Monitor
Selección de un estilo de edición
Uso de la ventana de construcción
Edición de los puntos In y Out
Uso de clips duplicados con nombre y de copias de clips sin nombre
Uso de marcas
Edición de clips
Edición de un programa de vídeo
Creación de una cuenta atrás
Creación de barras de color y de un tono de 1 Kh
Creación de vídeo negro
Previsualización del programa de vídeo
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Uso de la ventana Monitor

La ventana de monitor muestra los fotogramas individuales de los clips y el 
vídeo editado.

Usando el área de trabajo de Edición en una sola pista (Window > Workspace 
> Single-Track editing), la ventana de monitor es parecida a los monitores 
utilizados en las mesas de edición convencionales, con un monitor para el 
origen, o clip de origen, y otro para el programa, o vídeo editado, tal y como se 
muestra en la imagen inferior.

La pantalla de la izquierda (en la que se ve el clip original) se denomina Vista 
de Origen, y la de la derecha (donde se ve el vídeo editado) Vista de Programa.

Los controles de la parte inferior de la ventana de monitor son como los 
controles de edición de una mesa de estas características. Es posible editar 
vídeo tanto en la ventana de Monitor como en la ventana de construcción. 
Consulte Edición de un programa de vídeo. (Un clip de origen es un clip que 
está fuera de la ventana de construcción o vista de origen de la ventana de 
monitor; un clip de programa es un clip que está en la ventana de construcción 
o vista de programa de la ventana de monitor.)

Esta ventana puede mostrarse en distintos modos:

• Vista dual: En ella se muestran la Vista Origen y la Vista de Programa, 
es decir: el clip origen y el editado se muestran juntos. A la izquierda el 
clip original, y a la derecha el editado (añadiendo todo lo que se le haya 
añadido en la ventana de construcción). 

• Vista singular: En ella sólo se ve el vídeo editado (Vista de Programa). 
Es el modo por defecto cuando se selecciona, como área de trabajo el 
de A/B Editing. 

• Modo de recorte: Proporciona un control más preciso sobre el recorte del 
clip. Consulte Uso de la vista de recorte. 

97

file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c03ev50.htm
file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c03ev6.htm
file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c03ev36.htm


Si se prefiere usar una ventana similar a las de las versiones previas de 
Premiere, es posible cambiar el diseño de la ventana.
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Visualización de un clip

Para ver un clip:

Realice una de las siguientes acciones:

• Para ver un clip en la pantalla de origen, haga doble click sobre el clip en 
la ventana de proyecto, de contenedor o en la de construcción. Premiere 
mostrará el clip y añadirá su nombre al menú "Clip" que hay bajo la vista 
de origen. 

• Para ver cualquiera de los 35 clips últimos que se han visto ya desde 
que se abrió el proyecto, puede elegir el nombre del menú "Clip" bajo la 
ventana de monitor. 

Seleccionar un clip del menú "Clip"

Para añadir simultáneamente varios clips al menú "Clip", puede seleccionarlos 
todos y arrastrarlos a la vista origen, o seleccionarlos todos y hacer doble click 
sobre cualquiera de ellos, o incluso puede arrastrar todo un contenedor, a la 
vista Origen. 

Para cambiar la visualización del tiempo en la vista origen, 

elija Monitor Window Options, del menú de la ventana Monitor. En el apartado 
Source Options, elija una forma de contar el tiempo del menú "Count". Estas 
maneras de contar el tiempo indican el formato en que se mostrará el código de 
tiempo del clip. Seleccione Zero Based si desea que el código de tiempo del 
clip en cero, en lugar de en el primer fotograma del clip. Tras ello pulse OK.
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Abrir un clip en su propia ventana

Para abrir el clip actualmente visible en su propia ventana, presione Alt 
(Windows) u Option (Mac OS) al tiempo que hace doble click en el clip en la 
vista Origen.

También es posible que por defecto los clips se abran en su propia ventana, y 
no en la vista origen de la ventana Monitor. Para ello elija Edit > Preferences 
> General & Still Image, y seleccione la opción "Open Movies in Clip Window". 
En tal caso los clips, por defecto no se abrirán en la ventana monitor. Podrá no 
obstante abrirlos en ella por dos vías:

• Arrastrando el clip desde la ventana de proyecto a la ventana monitor 
• Pulsando la tecla Alt (Windows) u Option (Mac OS) al tiempo que hace 

doble click sobre un clip para abrirlo. 

Es decir las teclas Alt u Option hacen que el clip se abra en el lugar contrario al 
indicado en Preferences.
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Ver los márgenes seguros de la 
imagen

La televisión ajusta el tamaño de una imagen de vídeo a las proporciones de la 
pantalla, cortando aquellas zonas que caen fuera de las esquinas de la 
pantalla. Este efecto es conocido como Overscan. La parte de imagen que se 
puede perder varía según el televisor de que se trate.

Este efecto debe ser tenido en cuenta, porque se pueden perder partes 
importantes de la imagen, sobre todo cuando se trata de mover títulos. De ahí 
la importancia de la utilidad que ofrece Premiere de mostrar los márgenes 
seguros: los que con certeza se verán en la pantalla del televisor.

Los márgenes seguros pueden verse en la ventana de Monitor (tanto en la vista 
origen como en la vista de programa).

Premiere distingue dos márgenes seguros diferentes: Uno para acciones (en 
movimiento) y otro para títulos (estáticos). Por ello, cuando se muestran los 
márgenes seguros aparecen dos recuadros: el externo es el margen seguro de 
las acciones y el interno el de los títulos.

Nota de Quinurio: Los márgenes seguros que muestra Premiere sólo son 
verdaderamente seguros en sistemas NTSC. En un sistema PAL o SECAM, 
sirven sólo como guía aproximada.

Para ver las zonas seguras en la ventana Monitor:

En el menú de la ventaja elija Safe Margins for source side (para la vista 
origen), o Safe Margins for Program Side (para la vista de programa). Esta 
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opción funciona como un conmutador, es decir: activa la función si estaba 
desactivada, o la desactiva si estaba activada.

Para cambiar las dimensiones de los márgenes seguros:

Es posible que las dimensiones standard para los márgenes seguros previstas 
por Premiere no sean suficientes para su televisor, o descarten una excesiva 
cantidad de imagen. En estos casos puede cambiar la dimensión de los 
márgenes. Para ello.

1 En el menú de la ventana de monitor, elija Monitor Window Options.

2 Introduzca nuevos valores para Action-Safe Margin y Title-Safe Margin. Estos 
valores representan el porcentaje no incluido en las zonas seguras. Tras ello 
pulse OK.
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Controles de la ventana Monitor

La ventana de monitor incluye unos controles similares para las vistas de 
origen y de programa. Los controles se utilizan para ver y buscar fotogramas de 
un clip o de un programa de vídeo. Muchos de estos controles funcionan como 
los controles de arrastre de cinta de un magnetoscopio.

Utilice los de controles de la vista Origen para reproducir o ver los fotogramas 
de un clip de origen y para especificar los puntos de origen IN y OUT del clip 
que definen la parte del clip que se va a añadir al programa. (El primer 
fotograma que se añadirá es el punto IN de origen, mientras que el último 
fotograma a añadir es el punto de origen OUT.)

Utilice los controles de la vista programa para reproducir o ver el programa de 
vídeo en la ventana de construcción y para especificar los puntos IN y OUT del 
programa, que definen las posiciones de los puntos de origen IN y OUT en la 
ventana de construcción. 

Antes de usar los controles de una de las vistas, hay que asegurarse de que 
dicha vista se encuentre activa. Para saberlo hay que comprobar:

• El visor de código de tiempo: Estará de color verde cuando la vista esté 
activa. 

• El contorno de la vista debe tener el color que en su ordenador tengan 
asignadas las ventanas activas. 

En la esquina inferior derecha de cada vista se encuentra un número que 
representa la posición de tiempo para el fotograma que actualmente se está 
mostrando. En la esquina inferior izquierda se encuentra un número precedido 
por el símbolo delta ( ) que representa la diferencia de tiempo entre el punto 
IN y el punto OUT del clip o programa de vídeo.

En la ventana de monitor, puede cambiar entre las diferentes opciones de 
visualización de tiempo pulsando Control (Windows) o Comando (Mac OS) 
mientras hace click en el visor del código de tiempo. Las opciones de 
visualización del tiempo cambian en el orden en el que aparecen en el menú 
Count (disponible al seleccionar Window > Monitor Window Options estando 
activa la ventana de monitor).

Para personalizar la vista de la ventana de Monitor:

Realice una de las siguientes acciones:

• Para definir la vista y controles activos, haga click en la vista de origen o 
en la vista de programa. 
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• Para limitar la vista a programa, haga click en el Botón Vista Singular (  
Single View) que se encuentra en la parte superior de la ventana. 
También es posible obtener este efecto eligiendo Single View del menú 
de la ventana. 

• Para volver a la vista dual, pulse el botón Vista Dual (  Dual View), en la 
parte superior de la ventana, o elija Dual View del menú de la ventana). 

Para reproducir la vista origen o la vista de programa:

Realice una de las siguientes acciones:

• Para reproducir, pulse el botón Play ( ). 
• Para detener la reproducción, pulse el botón Stop ( ). 
• Para reproducir desde el punto In hasta el punto Out, pulse el botón Play 

in to Out ( ). 
• Para reproducir desde el punto actual hasta el punto Out, pulse el botón 

Play In to Out ( ), mientras mantiene pulsada la tecla Alt (Windows) u 
Opción (Mac OS). 

• Para reproducir en bucle, pulse el botón Loop ( ). (NOTA: Al reproducir 
en bucle, la reproducción vuelve a comenzar automáticamente cuando 
se llega al final). 

• Para reproducir en sentido inverso, pulse Ctrl + Alt y haga click en el 
botón Play (Windows), o pulse Comando + Opción y haga click en el 
botón Play (Mac OS). 

• Para reproducir más rápido, pulse el botón Play repetidamente. Cada 
vez que se pulsa se incrementa la velocidad. 

• Para reproducir incluyendo pre-roll y post-roll, pulse Alt y pulse el botón 
Play. Pre-roll inicia la reproducción desde un momento anterior al punto 
In. Post-roll la termina en un momento posterior al punto Out. Cuántos 
segundos antes o después dependen del valor introducido en las 
opciones preroll y postroll existentes en Edit > Preferences > General & 
still image. 

Para ver un fotograma diferente:

Tras asegurarse de que está activa la vista que usted quiere visionar, realice 
una de las siguientes acciones:

• Para ir a un fotograma concreto: Escriba el tiempo ( directamente en el 
teclado numérico (no necesita introducir los dos puntos, puesto que 
Premiere directamente traduce el número introducido). También puede 
hacer click sobre el contador de tiempo y escribir el nuevo código de 
tiempo al que quiere ir (en el teclado numérico o en el teclado normal). 

• Para mostrar en la vista de programa el fotograma que se está 
mostrando en la vista origen, asegúrese de que la vista de origen está 
activa, y que en la vista de programa se está viendo el mismo clip (para 
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lo cual debe hacer click sobre él en la ventana de construcción). Tras 
ello pulse la tecla T (a mi no me funciona). 

• Para mostrar en la vista de origen el fotograma mostrado en la vista de 
programa, asegúrese de que la vista de programa está activa (o la 
ventana de construcción), y pulse la tecla T. (tampoco me funciona). 
Esto mostrará el fotograma correspondiente en la vista origen, no su 
instancia en la ventana de construcción. 

• Para adelantar un fotograma pulse el botón Frame Forward ( ), o pulse 
la tecla Flecha a la derecha. 

• Para adelantar cinco fotogramas, pulse Shift mientras hace click en el 
botón Frame Forward ( ), o pulse Shift - Flecha derecha. 

• Para retroceder un fotograma pulse el botón Frame Back ( ), o la tecla 
Flecha Izquierda. 

• Para retroceder cinco fotogramas, mantenga pulsada Shift mientras 
hace click en el botón Frame Back ( ), o pulse Shift-Flecha izquierda. 

• Para ir al punto previo de edición en una pista de audio o vídeo, pulse el 
botón Previous Edit ( ) en la vista de programa (hay un punto de edición 
siempre que un clip del programa empieza o termina en la pista de auido 
o vídeo). 

• Para ir al próximo punto de edición en una pista de audio o vídeo, pulse 
el botón Next Edit ( ) en la vista de programa 

Nota: En el modo de edición Single-Track Editing, los botones Previous 
y Next también se detienen en el punto de corte de cada transición, 
cuando la pista de Vídeo 1 está expandida, así como en los cortes de 
audio.

• Para ir al primer fotograma del programa de vídeo, pulse la tecla Flecha 
arriba. Para ir al último fotograma, pulse Flecha abajo. 

Para más información, consulte Navegar por la ventana de construcción.

Los controles de la ventana de monitor también incluyen un control de avance 
paso a paso y un control de avance rápido. El control de avance rápido es más 
sencillo de comprender (el potenciómetro indica la posición de un fotograma en 
relación al principio y final del clip (en la vista de origen) o de la ventana de 
construcción (en la vista de programa). No obstante, debido a que el control de 
avance rápido tiene un ancho fijo, resulta menos preciso con clips o programas 
largos. En estos casos el control de avance paso a paso resulta de mayor 
utilidad, ya que permite navegar en incrementos menores en un clip o en un 
programa que con el control de avance rápido.

Para saltar o avanzar rápidamente entre los fotogramas:

Realice una de las siguientes acciones:

• Haga click en algún lugar del control de avance rápido. 
• Arrastre el control de avance paso a paso hacia la izquierda o la 

derecha, si es necesario sobrepasando el borde del control hasta 
alcanzar el fotograma deseado. Si arrastra el cursor hasta el borde de la 
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pantalla y no se ha llegado al final del clip o del programa de vídeo, 
puede continuar desde la misma posición, arrastrando de nuevo desde 
el principio. 

Si intenta encontrar un fotograma y conoce su posición aproximada en el 
clip, haga primero click en el control de avance rápido en la posición 
aproximada del fotograma y arrastre el control de avance paso a paso para 
realizar una búsqueda detallada en dicha área.
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Selección de un estilo de edición

El estilo de edición que se debe usar cuando se trabaja en Premiere depende 
de la tarea que se esté ejecutando, que puede requerir una mayor o menor 
precisión. Premiere proporciona estilos de edición predeterminados que de 
forma rápida y sencilla se pueden configurar para obtener el estilo que se 
desee usar.

En cada estilo de edición varían las ventanas existentes por defecto, y su 
funcionamiento. Por ello a cada estilo de edición corresponde un "área de 
trabajo" diferente (NOTA: En aplicaciones informáticas se suele denominar 
área de trabajo a la composición de las ventanas y subventanas de una 
aplicación).

Inicialmente hay disponibles cuatro áreas de trabajo: A/B Editing, Single-Track 
Editing, Effects, and Audio.

• El modo A/B Editing está pensado para editores que desean trabajar 
arrastrando clips desde la ventana de Proyecto a la de construcción. 
Este modo asemeja el método convencionalmente llamado A/B roll  
editing, que usa dos pistas de vídeo (A y B) y, entre ellas, una pista para 
transiciones. Cuando se selecciona este estilo se producen las 
siguientes consecuencias: 

o En la ventana de monitor se selecciona vista singular (no dual) 
o Los clips se abren en una ventana separada 
o En la ventana de construcción, la pista de vídeo 1 muestra tres 

subpistas: Video 1A, 1B, y la pista de transiciones. 
o Todas las paletas están disponibles, con las paletas de control de 

efectos, navegador y transiciones, activas. 

• El modo de edición Single-Track Editing está pensado para recortar y 
colocar clips estableciendo sus puntos In y Out en la Vista Origen de la 
ventana Monitor, e insertando o superponiendo los clips ya recortados 
en la ventana de construcción. Para programas de vídeo básicos, como 
por ejemplo los que simplemente recorten y ordenen los clips, sin 
transiciones, puede ser preferible este estilo. En él todas las 
herramientas actuan sobre las tres subpistas como si fuera una sola 
pista. Cuando se selecciona este estilo, se producen las siguientes 
consecuencias: 

o En la ventana de monitor se selecciona la vista dual 
o Los clips se abren por defecto en la vista Origen de la ventana de 

monitor 
o En la ventana de construcción, las pistas de vídeo 1A, 1B y 

transiciones, se combinan en una sola. 
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• El estilo Effects está pensado para acceder con facilidad a los efectos de 
vídeo y de auido. Al seleccionarlo se producen las siguientes 
consecuencias: 

o En la ventana de monitor se selecciona Vista singular. 
o Los clips se abren en una ventana separada. 
o La paleta de información se agrupa con la de control de efectos, y 

las paletas de transiciones, vídeo y audio, están separadas y 
activas. 

• El estilo Audio está pensado para acceder rápidamente a las 
herramientas necesarias para editar las pistas de audio. Al seleccionarlo 
se establecen las mismas consecuencias que cuando se selecciona el 
estilo Effects, salvo en que se abre también la ventana de mezcla de 
audio. 
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Gestión del estilo de edición

La primera vez que se ejecuta Premiere, o tras borrar o renombrar el fichero de 
Preferencias, se solicita que se seleccione un estilo de trabajo para edición. No 
obstante el estilo de edición se puede cambiar mientras se está trabajando en 
un proyecto. También es posible crear una disposición personalizada de 
ventanas, almacenarla en disco y recuperarla para aplicarla después a 
cualquier proyecto.

Cuando se almacena un estilo de edición, se graba la localización de las 
ventanas de Proyecto, Monitor, Construcción y Mezclador de audio. Otras 
ventanas, como las de clips, no se salvan, así como tampoco sus opciones de 
configuración.

Nota: No es recomendable cambiar entre los modos A/B Editing y Single-Track 
Editing mientras se trabaja con un proyecto, pues en el modo A/B es posible 
colocar los clips en posiciones que no existen en el modo Single-Track.

Para grabar una disposición personalizada de ventanas:

1 Coloque las ventanas de proyecto, monitor, construcción y la de mezclador 
de audio en la posición en que quiere conservarlas, incluyendo el tamaño, lugar 
y configuración.

2 Elija Window > Workspace > Save Workspace.

3 Escriba un nombre para el área de trabajo y puse Save. El nuevo área de 
trabajo se añadirá al menú de áreas de trabajo.

Para seleccionar o borrar un estilo de edición personalizado:

Para seleccionarlo, elija Window > Workspace y después pulse el nombre del 
área de trabajo a seleccionar 

Para borrar un estilo de edición elija Window > Workspace > Delete 
Workspace, y después escoja un nombre y pulse Delete.

Cómo los nuevos estilos de edición aparecen en el submenú Window > 
Workspace submenu, también es posible añadir un estilo de edición a la paleta 
de comandos. Consulte Uso de la paleta de comandos.
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Uso de la ventana de construcción

La ventana de construcción (Timeline) es una vista de su programa, basada en 
la ordenación temporal de clips. En ella puede seleccionar, ordenar y modificar 
las instancias de los clips originales usados en el programa de vídeo.

La ventana de construcción muestra gráficamente la colocación de cada clip, 
en qué momento empieza, su duración, y su relación con los restantes clips del 
programa.

Los clips se pueden ver con mayor o menor detalle, dependiendo de la unidad 
de tiempo que se elija que se elija.

A. Marcador de área de trabajo B. Indicador de área de previsualización C. Barra de área de 
trabajo D. Indicador del punto de edición E. Banda para el área de trabajo F. Menú de la 
ventana de construcción G. Caja de herramientas H. Pista superpuesta I. Exluir/Ocultar pista J. 
Pistas de Vídeo 1 K. Pista de audio L. Botones de cabecera de pista M. Icono de bloqueo N. 
Menú de unidad de tiempo O. Opciones de pistas P. Alineación con los bordes Q. Ver Bordes 
R. Cambiar modo de inserción S. Modo de sincronización.

Nota de Quinurio: Se ha traducido el nombre de los botones y zonas de la ventana de 
construcción, y para cada uno de ellos hay un enlace al primer tema de ayuda que los 
menciona.

Nota2: Para una descripción más detallada de la ventana de construcción, con explicación 
sobre todas sus herramientas y botones, véase: Herramientas y botones de la ventana de 
construcción.
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Personalización de la ventana de 
construcción

Puede personalizar el aspecto de la ventana de construcción, incluyendo la 
forma en que se representan los clips al verse o editarse en sus pistas. Para 
más información acerca de cómo personalizar las pistas de la ventana de 
construcción, consulte Personalización del aspecto de las pistas.

Para personalizar la ventana de construcción:

1 En el menú de la ventana elija Timeline Window Options.

2 En la sección Tamaño del icono, seleccione el tamaño del icono del previo 
que desee para la ventana de construcción. Si piensa utilizar muchas pistas o 
trabajar en un monitor pequeño, puede utilizar un icono pequeño para ver un 
número mayor de pistas.

3 En la sección Formato de pista, seleccione una opción:

• La primera opción muestra fotogramas de ejemplo mientras dura el clip. 
Aunque esta opción facilita la búsqueda de fotogramas, ralentiza la 
visualización y no incluye el nombre del archivo. 

• La segunda opción muestra los fotogramas inicial y final del clip y el 
nombre del archivo. 

• La tercera opción muestra el fotograma inicial y el nombre del archivo. 
• La cuarta opción muestra sólo el nombre del archivo. Es la opción más 

rápida. 

4 En la sección de Audio escoja una opción del menú autodesplegable. Esta 
opción indica a partir de qué nivel de zoom temporal se dibujará la forma de la 
onda de audio en la ventana de construcción. (NOTA: El zoom temporal se 
refiere a la unidad de tiempo de la ventana de construcción)

5 En la sección Options, especifique las siguienes opciones si lo desea, y 
después pulse OK:

• En el menú Count seleccione la unidad de tiempo mostrada en la 
ventana de construcción. Especifique Zero Point si desea que el tiempo 
inicial no sea 00:00:00:00. Esta opción también afecta al tiempo inicial 
cuando se exporta un EDL. 

• En On Insert seleccione Shift Material in All Unlocked Tracks si desea 
que al insertar un clip en la ventana de construcción, se desplacen los 
clips de todas las pistas para ajustarse al nuevo clip. Si desea que sólo 
se desplacen los clips de la pista donde se realizó la inserción, 
seleccione Shift Material Only in Target Tracks if you want only the target 
tracks to be affected when you insert a clip. Para alternar entre estos dos 
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modos de inserción, puede pulsar el botón Toggle Shift Tracks Options 
(cambiar modo de inserción) ( ) en la parte inferior de la ventana de 
construcción. 

• Seleccione Show Markers para ver las marcas del clip y de la ventana 
de construcción. Deseleccione esta opción si la ventana de construcción 
contiene muchas marcas y desea verla más despejada. Consulte Uso de 
marcadores. 

• Seleccione Block Move Markers para desplazar las marcas de la 
ventana de construcción si mueve al menos dos pistas de vídeo 
mediante la herramienta para seleccionar varias pistas, que mueve 
todas las pistas desbloqueadas. Deseleccione esta opción si desea que 
las marcas de la ventana de construcción permanezcan en sus 
posiciones. Esta opción no afecta a las marcas de clip. 

En la ventana de construcción, puede alternar entre las diferentes 
visualizaciones de tiempo pulsando Control (Windows) o Comando (Mac OS) 
mientras hace click en la regla de tiempo. Las diferentes opciones de 
visualización van cambiando en el orden en el que aparecen en el menú Count 
del cuadro de diálogo Opciones de la ventana de construcción, descrita 
anteriormente en este apartado.

112

file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\Timeline06.htm
file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c03ev21.htm
file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c03ev21.htm


Personalización del aspecto de las 
pistas

Dependiendo del estilo de edición elegido, la pista de Vídeo 1, se puede 
mostrar de dos maneras, en el estilo A/B, se muestra como tres subpistasVideo 
1A, 1B, y la pista de transiciones. En el estilo Single-Track Editing mode, estas 
tres subpistas están combinadas en una solo. En este estilo la pista de Vídeo 1 
se puede mostrar colapsada o desplegada. Cuando está colapsada, todos los 
clips y transiciones se combinan en una sola pista. Cuando está despelegada, 
el aspecto se parece al del estilo A/B, escepto en el hecho de que no se 
pueden supoerponer los clips, y las pistas separadas se mantienen como una 
sola pista. Es decir: simplemente se obtiene una representación visual de la 
superposición. La vista desplegada es conveniente para observar con más 
precisión las superposiciones de las transiciones. Puede cambiar entre la vista 
colapasada o desplegada, pulsando el botón Track Mode. Consulte Selección 
de un estilo de edición. La configuración del botón Track Mode se almacena en 
el fichero de proyecto y en el fichero de preferencias de Premiere.

En ambos modos de edición, la pista 2 de Vídeo, por defecto, está disponible 
para superponer clips sobre los existentes en la pista de Vídeo 1; y se pueden 
añadir más pistas para diseños adicionales o vídeo superpuesto. Asímismo es 
posible usar múltiples pistas de audio para la superposición de sonido. Para 
añadir pistas de vídeo y de audio, ver Añadir, renombrar y borrar pistas.

Se puede colocar un vídeo de clip en una pista de vídeo, y un clip de audio en 
una pista de audio. No obstante, para usar una transición, debe haber un clip 
de vídeo en la pista de vídeo 1 (sea 1A ó 1B). Cualquier vídeo superpuesto 
debe colocarse en una pista de vídeo QUE NO SEA LA PISTA 1.

Si en el proyecto se usan más pistas de las que la ventana de construcción 
puede mostrar, es posible redimensionarla, o desplazarse por ella 
verticalmente para ver las pistas no visibles. También es posible controlar la 
proporción de espacio ocupado por las pistas de vídeo y audio, y condensar el 
espacio vertical de las pistas contrayéndolas u ocultándolas. Finalmente, puede 
evitar que se incluya algunas pistas mientras previsualiza, reproduce o exporta 
el programa de vídeo

Para colapsar y desplegar la pista Vídeo1 en el modo de edición Single-
Track:

Pulse el botón Track Mode ( ) a la derecha del nombre de la pista.
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Nota: En Premiere 5.0, estos modos se seleccionaban usando el triángulo en 
la cabecera de la pista. Dicho triángulo es usado en esta versión para mostrar u 
ocultar los marcos clave y los controles de volumen de audio.

Izquierda: Botón Track Mode en el estilo Single-Track colapsado. Derecha: Botón Track Mode 
en el estilo Single-Track desplegado.
Para redimensionar la sección de cabecera de la pista:

Coloque el puntero sobre la esquina derecha de la cabecera de la pista, hasta 
que aparezca la herramienta Redimensionar ( ). Tras ello arrastre a derecha o 
izquierda.

La sección de cabecera de la pista: siendo redimensionada (izquierda) y después de ser 
redimensionada (derecha)
Las herramientas de edición, en la esquina superior izquierda, limitan la 
anchura mínima de la cabecera de la mista.

Para cambiar la proporción de las pistas de vídeo y audio:

Arrastre la barra de división horizontal de la ventana, localizada en el lado 
derecho entre las pistas de vídeo1 y Audio 1. Esta utilidad trabaja mejor cuando 
hay varias pistas de vídeo o audio en una ventana de contrucción grande.
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Ocultar y excluir pistas

Es posible marcar cualquier pista como "Tenue", lo que significa que puede ser 
ocultada. Marcando una pista como tenue, ésta no es inmediatamente 
ocultada, sino que es preciso elegir el comando Hide Shy Tracks (ocultar pistas 
tenues) para ocultar o mostrar, simultáneamente, todas las pistas marcadas.

Debido a que esta configuración sólo afecta a la visualización de la ventana de 
construcción, no afecta a la hora de importar ni exportar. Las pistas tenues se 
incluyen en el programa de vídeo, aunque no estén visibles en la ventana de 
construcción.

También es posible excluir una pista del programa. Para ello haga click en el 
icono del ojo (para vídeo) o del altavoz (para audio) de la parte izquierda de 
una pista. Una pista excluida sigue apareciendo en la ventana de construcción, 
pero no se incluye en el vídeo exportado al previsualizar o limpiar de elementos 
la ventana de construcción.

Excluir una pista sirve para comprar entre diferentes versiones del programa.

Al ocultar o excluir pistas se reduce el desorden en la ventana de construccióny 
se incrementa el rendimiento de desplazamiento vertical y de previsualización.

Las pistas tenues, exluidas y ocultas pueden ser editadas como pistas 
normales. Para asegurarse de que no se incluirán por error nuevos clips en una 
pista excluida u oculta, puede bloquearla. Consulte Bloqueo y desbloqueo de 
pistas.

Para ocultar y mostrar pistas:

1 Realice una de las siguientes opciones:

• Para marcar una pista como Tenue pulse Control mientras hace click en 
el icono del ojo ( ) (para vídeo) o en el del altavoz ( ) (para audio) en la 
esquina izquierda de la pista. El icono entonces se mostrará atenuado. 

• Para marcar una pista como no tenue, repita la acción anterior sobre los 
iconos atenuados. 

• Para marcar como tenues (o no tenues) todas las pistas de vídeo 
superpuesto o todas las pistas de audio, presione Control + Akt mientras 
hace click sobre el icono del ojo o del altavoz de cualquier pista (salvo la 
pista de vídeo 1). 

2 En el menú de la ventana de construcción elija Hide Shy Tracks o Show Shy 
Tracks.
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Para excluir o incluir una pista:

Haga click para ocultar o mostrar el icono del ojo o el del altavoz, en el lado 
izquierdo de una pista.

Para, simultáneamente, excluir o incluir todas las pistas salvo la de Vídeo 
1:

Pulse Alt al tiempo que hace click para ocultar o mostrar el icono del ojo o el del 
altavoz. Esto exluirá o incluirá todas las pistas superpuestas de vídeo, o todas 
las pistas de audio.

Las pistas de vídeo 1A y 1B pueden ser incluidas o excluidas separadamente.

116



Navegación por la ventana de 
construcción

La regla de tiempo, en la parte superior de la ventana de construcción, muestra 
la duración de la película, así como el momento en donde se encuentra el 
punto de edición y cualquier marcador que se haya colocado (consulte Uso de 
marcadores). Desde esta regla de tiempo es posible ver la posición de los 
puntos In y Out de cada clip y la duración completa del programa de vídeo. 
Cuando se realiza cualquier acción que mueva el punto de edición, se cambia 
también el fotograma actual en la vista de programa de la ventana Monitor.

Para mover el punto de edición:

Realice una de las siguientes acciones:

• En la ventana de construcción, arrastre el punto de edición o haga click 
en la regla en el lugar donde desea colocar el punto de edición. 

• En la ventana de monitor, escriba un código de tiempo con el teclado 
numérico o arrastre el control de avance paso a paso o el control de 
avance rápido. 

• En la ventana de monitor, haga click en los botones Frame Back, Frame 
Forward, Next Edit, o Previous Edit. Consulte Uso de los controles de la 
ventana de monitor. 

• En la paleta de navegador, mantenga pulsada la tecla Mayúsculas y 
arrastre dentro de la representación de la ventana de construcción; o 
bien, haga click en el código de tiempo y escriba uno nuevo con el 
teclado numérico. 

Para mostrar la ventana de construcción con más detalle:

Realice una de las siguientes acciones:

• Elija Timeline > Zoom In (o Timeline > Zoom Out) 
• Seleccione la herramienta de zoom ( ) y haga click (o marque un 

rectángulo) en la parte de la ventana de construcción que desee centrar 
en la nueva vista. 

• En la paleta de navegador, arrastre el potenciómetro hacia la derecha o 
haga click en el icono de amplificación ( ). 

• Seleccione un incremento de tiempo menor en el menú de unidad de 
tiempo situado en la parte inferior de la ventana de construcción. 

Para mostrar una parte mayor del programa de vídeo:
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Realice una de las siguientes acciones:

• Seleccione la herramienta de zoom ( ) y pulse Alt (Windows) u Opción 
(Mac OS) mientras hace click en la parte de la ventana de construcción 
que desee centrar en la nueva vista. 

• En la paleta de navegador, arrastre el potenciómetro hacia la izquierda o 
haga click en el icono de reducción ( ). 

• Seleccione un incremento de tiempo mayor en el menú de unidad de 
tiempo situado en la parte inferior de la ventana de construcción. 
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Añadir, renombrar y borrar pistas

La ventana de construcción puede contener hasta 99 pistas de vídeo y audio. 
Puede añadir o quitar pistas en cualquier momento, salvo las pistas Vídeo 1, 
Transición, y Audio 1 a Audio 3, que no se pueden eliminar. Las pistas nuevas 
de vídeo aparecen sobre las pistas de vídeo existentes, mientras que las pistas 
de audio nuevas aparecen debajo de las pistas de audio existentes. Al suprimir 
una pista se eliminan todas las apariciones de un clip en ella, pero no afecta a 
los clips de origen almacenados en la ventana de proyecto. También puede 
modificar el nombre de cualquier pista de vídeo o audio. La pista Transición no 
se puede eliminar ni cambiar de nombre.

Para añadir una pista:

En el menú de la ventana de construcción, elija Add Video Track o Add Audio 
Track.

Para añadir, borrar o renombrar varias pistas:

1 En el menú de la ventana de construcción elija Track Options, o pulse el 
botón Track Options Dialog ( ) en la parte inferior de la ventana de 
construcción.

2 Realice una de las siguientes acciones y pulse OK:

• Para añadir pistas, haga click en Add, escriba en Add _ Video tracks el 
número de pistas de vídeo que desea añadir, y en Add _ Audio track, el 
número de pistas de audio. 

• Para eliminar pistas, seleccione la pista o pistas que desee eliminar y 
haga click en Suprimir. 

• Para cambiar el nombre de una pista, selecciónela, haga click en Name, 
escriba un nuevo nombre y, a continuación, haga click en OK. 

Nota: La pista de vídeo 1B no se puede renombrar.
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Especificar pistas de origen y de 
destino en la ventana de Monitor

Al arrastrar un clip a la ventana de construcción, éste se añade a la pista y en 
la posición de tiempo donde se suelta. No obstante, si se añaden clips a la 
ventana de construcción mediante los controles de la ventana de monitor o 
mediante el teclado, Premiere no puede saber exactamente dónde desea 
añadirse el clip. En estos casos, debe especificarse previamente la forma en la 
que deben añadirse las pistas de vídeo y audio a la ventana de construcción. 
De manera predeterminada, se añaden tanto el audio como el vídeo de origen. 
En la ventana de construcción, las pistas Vídeo 1A y Audio 1 son las de destino 
predeterminadas. En la ventana de construcción, los nombres de las pistas de 
vídeo y audio de destino aparecen en negrita.

Puede controlar la forma de añadir el vídeo y audio de origen a la ventana de 
construcción mediante los iconos Usar y los menús Destino:

• Los iconos Usar vídeo ( ) y Usar audio ( ) controlan los clips de 
origen. Evitan que se añada una determinada pista de audio o vídeo del 
clip de origen a la ventana de construcción. Por ejemplo, si un clip 
contiene vídeo que no desea utilizar, puede especificar que el clip de 
origen proporcione sólo audio a la ventana de construcción.

• Los menús Destino de vídeo y audio controlan el programa de vídeo de 
la ventana de construcción. Determinan qué pista de vídeo o audio de la 
ventana de construcción recibirá el clip de origen. Es posible no utilizar 
ninguna pista de la ventana de construcción como receptora de vídeo o 
audio. Por ejemplo, si crea un esbozo de un vídeo musical y el único 
audio que desea utilizar es un clip musical separado de cualquiera de 
sus clips de vídeo, puede no establecer como destino ninguna pista de 
audio para que el programa no reciba audio de ningún clip de vídeo de 
origen. En este ejemplo no se añade audio al programa, 
independientemente de cómo estén definidos los iconos Usar del origen. 
Lo mismo se aplica para las pistas de vídeo de destino.

• Con vistas a obtener resultados predecibles, compruebe que las 
configuraciones de las pistas de destino coincidan con las del vídeo y 
audio de origen. Por ejemplo, si activa Usar vídeo y desactiva Usar 
audio para el clip de origen, pero las pistas de la ventana de 
construcción están destinadas a vídeo y a audio, el vídeo va a la pista de 
vídeo de destino, tal y como se esperaba, pero la duración del audio del 
clip de origen se inserta en la pista de audio de destino en forma de 
espacio vacío. Esto es así porque al seleccionar como destino una pista 
siempre se añade la duración del clip de origen, incluso si la pista de 
origen correspondiente (audio o vídeo) no está disponible para el 
destino. Si no desea la parte de audio vacía, no especifique pistas de 
audio de destino. 
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La forma exacta en la que se añaden los clips a la ventana de construcción 
depende no sólo de la interacción de los iconos Usar y las pistas de destino, 
sino también de los estados actuales de las opciones de otras pistas y clips. 
Algunas combinaciones de estos factores pueden provocar un desplazamiento 
de tiempo en algunas pistas. Para información sobre cómo reenlazar clips que 
se han desincronizado, consulte Enlace de los clips de vídeo y audio en la 
ventana de construcción.

Nota: Los iconos Usar vídeo y Usar audio y los menús Destino afectan sólo al 
clip durante el proceso de adición a la ventana de construcción. No cambian el 
estado los clips de ninguna otra manera.

Para configurar los iconos Usar Video y Usar Audio y las pistas de 
destino del programa:

Realice una de las siguientes acciones para especificar la forma en la que 
añaden las pistas de vídeo y audio a la ventana de construcción:

Nota: Un icono de Usar vídeo o de Usar audio que esté desactivado tiene una 
línea diagonal roja.

• Para incluir la pista de vídeo de origen, asegúrese de que el icono Usar 
vídeo ( ), situado debajo de la vista de origen, no está tachado (si lo 
está, haga click en el icono para activarlo). A continuación, compruebe 
que hay una pista de vídeo seleccionada en el menú Destino que hay 
debajo de la vista de programa. En caso necesario, seleccione una pista 
de vídeo. 

• Para incluir la pista de audio de origen, asegúrese de que el icono Usar 
audio ( ), situado debajo de la vista de origen, no está tachado (si lo 
está, haga click en el icono para activarlo). A continuación, compruebe 
que hay una pista de audio seleccionada en el menú Destino que hay 
debajo de la vista de programa. En caso necesario, seleccione una pista 
de audio. 

• Para incluir sólo vídeo de origen, asegúrese de que el icono Usar vídeo (
), situado debajo de la vista de origen, no está tachado (si lo está, 

haga click en el icono para activarlo). Seleccione una pista de vídeo de 
destino del primer menú Destino (vídeo) que hay debajo de la vista de 
programa y, a continuación, compruebe que ha seleccionado None en el 
segundo menú Destino (audio). 

• Para incluir sólo el audio de origen, asegúrese de que el icono Usar 
audio ( ), situado debajo de la vista de origen, no está tachado (si lo 
está, haga click en el icono para activarlo). Seleccione None en el primer 
menú Destino (vídeo) que hay debajo de la vista de programa y, a 
continuación, seleccione una pista de audio de destino en el segundo 
menú Destino (audio). 
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También puede especificar una pista de destino haciendo click en el 
nombre de una pista en la ventana de construcción, de forma que aparezca en 
negrita. Hacer click en un nombre en negrita (la pista de destino actual), es lo 
mismo que seleccionar Ninguno en el menú de pista de destino: la pista ya no 
será el destino y su nombre ya no aparecerá en negrita.
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Bloquear y desbloquear pistas

El bloqueo de una pista completa resulta útil para evitar cambios en cualquier 
clip de la pista mientras se trabaja en otras partes del programa. Las pistas 
bloqueadas también se incluyen al previsualizar o exportar el programa. Si 
bloquea la pista de destino, ésta pierde tal propiedad, de forma que no podrá 
añadir clips de origen hasta que no la desbloquee y vuelva a especificarla como 
de destino. Una pista bloqueada se identifica por un icono con un lápiz tachado 
junto al nombre de la pista. Si coloca el puntero o una herramienta sobre una 
pista bloqueada, el puntero muestra el icono de bloqueo ( ) para recordarle 
este estado. Las pistas bloqueadas aparecen en gris en los menús Destino 
situados debajo de la vista de programa. Si desea bloquear tanto la pista de 
vídeo como la pista de audio correspondiente, debe bloquearlas por separado.

También puede bloquear un clip. Esto resulta de utilidad si no desea bloquear 
una pista completa. Consulte Bloqueo y desbloqueo de clips.

Para bloquear o desbloquear una pista:

Haga click para mostrar u ocultar el icono de bloqueo ( ) junto al nombre de la 
pista.

Herramientas y botones de la ventana de construcción
Nota de Quinurio: Los siguientes temas de ayuda los he escrito yo para 
sistematizar la información sobre la ventana de construcción; porque la ayuda 
de Premiere en este punto deja, en mi opinión, mucho que desear. Hay 
herramientas de esta ventana que ni se mencionan; otras se mencionan en 
algunos apartados, pero no en todos aquellos en los que son utilizables... Y, en 
definitiva, el manejo de Premiere pasa por conocer a fondo, y entender, la 
ventana de construcción. 

Para explicar correctamente las herramientas y partes de la ventana de 
construcción, conviene separarla en apartados, según el siguiente gráfico:
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A: Caja de herramientas. B: Pistas de vídeo. C: Pistas de Audio. D. Menú de unidad de tiempo. 
E: Botones. F: Regla de tiempo. G: Area de trabajo.

Véase:

La caja de herramientas
Las pistas de vídeo
Las pistas de audio
El menú de unidad de tiempo
Botones de la ventana de construcción
La regla de tiempo
La barra de área de trabajo.
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La caja de herramientas

La caja de herramientas contiene las herramientas básicas de Premiere. Su 
aspecto es el siguiente:

A. Herramienta de selección. B. Herramientas de selección múltiple. C. 
Herramientas de tipo de edición. D. Herramientas para cortar. E. 
Herramienta Mano. F. Herramienta Zoom. G. Herramientas varias. H. 
Herramientas de marcado de puntos In y Out.

Las herramientas B, C, D, G y H son varias, Para 
seleccionar una de ellas hay que mantener pulsado el ratón sobre el icono de la 
que esté activa, hasta que se muestre el resto de las herramientas del grupo.

La herramienta de selección:

Es la herramienta normal para selecionar clips en la ventana de construcción. 
Si está activa, cada vez que se hace 
click sobre un clip, este pasará a ser el 
clip seleccionado. Con esta herramienta 
se pueden seleccionar varios clips, si se 
mantiene pulsada la tecla Control 
mientras se hace click sobre ellos. 
Sobre 

el uso de esta herramienta hay varios temas de ayuda. 
Especialmente: Selección de clips.

Herramientas de selección múltiple:

Estas herramientas son las siguientes cuatro:

A) Herramienta de selección de rango (range select tool). B) Herramienta de selección de 
bloques (Block Select Tool). C) Herramienta de selección de pista (track select tool) y 
D) Herramienta de selección multipista (Multitrack select tool).

• La herramienta de selección de rangos permite trazar un rectángulo 
sobre la ventana de construcción, de tal manera que queden 
seleccionados todos los clips existentes dentro del rectángulo trazado. 

• La herramienta de selección de pista selecciona todos los clips que se 
encuentran en la pista sobre la que se haga click, a partir del lugar en 
donde se realice el click. Es decir: si en una pista hay cinco clips y, con 
esa herramienta, hacemos click sobre el tercero, se seleccionarán los 
clips tercero, cuarto y quinto. 
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• La herramienta de selección multipista selecciona todos los clips que 
se encuentren, en cualquier pista, a partir del lugar donde se haga click 
con ella. 

Sobre el uso de estas herramientas consulte: Selección de clips.

Herramientas de tipo de edición:

Estas herramientas son las siguientes cinco:

A. Herramienta de edición de enrollado (rolling edit tool). B. Herramienta de edición de rizo 
(ripple edit tool). C. Herramienta para modificar la velocidad (rate strech tool). D. Herramienta 
de edición de desplazamiento (Slip tool). E. Herramienta de edición de deslizamiento (Slide 
tool)

Sobre el uso de las herramientas A, B, D y E, consulte Edición de un clip que 
se encuentra entre otros clips de la ventana de construcción, y sobre la 
herramienta para modificar la velocidad consulte Cambio de la duración y 
velocidad del clip.

Herramientas para cortar

Las herramientas para cortar son las siguientes:

A. Herramienta para cortar (razor tool). B. Herramienta de corte múltiple (multiple razor tool). C. 
Herramienta para insertar puntos adyacentes (fade scissors tool)

• La herramienta para cortar divide un clip en el lugar donde se haga click 
sobre él, de tal manera que el clip pasa a convertirse en dos clips 
distintos y autónomos. 

• La herramienta de corte múltiple corta todos los clips de todas las 
pistas por el punto en el que se haga click. 

• La herramienta para insertar puntos adyacentes se utiliza con las 
líneas de volumen y de balance de los clips de audio, y con la línea de 
opacidad de los clips de vídeo. Su efecto es el de crear dos puntos de 
control adyacentes, lo que permite introducir cambios bruscos en el 
volumen, balance u opacidad. Sobre su uso consulte: Ajuste de los 
niveles de audio en la ventana de construcción, y Uso de la línea de 
nivel de opacidad. 

Sobre el uso de las herramientas para cortar y de corte múltiple, consulte 
División de un clip.

Herramienta mano:

En la ayuda de Premiere no se menciona para nada a esta herramienta. Yo he 
probado a utilizarla, y su efecto aparente es el de desplazar por la línea de 
tiempo simultáneamente todos los clips. Para ello altera la duración del primer 
clip , siempre que ello sea posible. Es decir.
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Herramienta Zoom:

Esta herramienta aumenta el nivel de detalle de la ventana de construcción, al 
tiempo que centra en ella la zona donde se hizo click. Es decir: su efecto es 
similar al del menú de unidad de tiempo, con la diferencia de que en ese menú 
se puede elegir directamente el nivel de detalle y la herramienta zoom lo va 
aumentando progresivamente. Consulte: Navegación por la ventana de 
construcción.

Herramientas varias:

Se contienen aquí varias herramientas utilizables sobre todo con las líneas de 
volumen, balance y opacidad:

A. Herramienta para encadenados (cross fade tool). B. Herramienta para mover segmentos 
(fade adjustment tool). C. Herramienta para vincular/desvincular (ling/unlink tool).

Las dos primeras herramientas se utilizan en las líneas de control de volumen, 
balance y opacidad.

• La herramienta para encadenados permite encadenar el volumen u 
opacidad de dos clips consecutivos que se solapen parcialmente. 
Consulte Ajuste de los niveles de audio en la ventana de construcción, y 
encadenado de pistas vinculadas a vídeo. No se habla de esta 
herramienta en el tema relativo a la línea de opacidad, pero también se 
puede utilizar en ella. 

• La herramienta para mover segmentos se utiliza en combinación con la 
herramienta para insertar puntos de control adyacentes. Permite mover 
un segmento entero de las líneas de control de volumen, balance u 
opacidad. Consulte Ajuste de los niveles de audio en la ventana de 
construcción, y Uso de la línea de nivel de opacidad. No se habla de ella 
en la ayuda sobre la línea del nivel de balance, pero también es 
utilizable. 

En cuanto a la herramienta para vincular/desvincular clips permite vincular o 
desvincular dos clips de audio. Consulte Vincular clips de vídeo y audio en la 
ventana de construcción.

Herramientas de marcado de puntos In y Out:

Estas herramientas permiten marcar los puntos In y Out en la ventana de 
construcción sin necesidad de arrastrar los bordes del clip. Seleccionada la 
herramienta, el punto In o el punto Out se fijará automáticamente en el lugar 
donde se haga click.
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Las pistas de vídeo

Las pistas de vídeo se dividen en dos partes: El encabezado de la pista y la 
pista propiamente dicha. Los clips se colocan en la pista propiamente dicha, 
pero las características del clip o de la propia pista son manejables desde el 
encabezado.

El encabezado de la pista puede estar colapsado o expandido:

Cuando está colapsado tiene el siguiente aspecto:

A. Botón Excluir/Ocultar. B. Botón Bloquear. C. Botón Expandir. D. 
Nombre de la pista.

Los tres botones (A, B y C) actúan como conmutadores, es 
decir: Pulsándolos se cambia al estado contrario al que 

tenían.

• El botón Excluir/Ocultar (haciendo click sobre él excluye la pista, y 
haciendo Alt-Click la oculta) permite excluir u ocultar una pista. Consulte 
Ocultar y excluir pistas. Cuando la pista ha sido excluida u ocultada, 
desaparece el icono del ojo del botón. 

• El botón bloquear, bloquea la pista de tal modo que en ella no se puedan 
incluir nuevos clips. Consulte Bloqueo y desbloqueo de pistas. Cuando 
la pista está bloquedada aparece el icono de un candado. 

• El botón Expandir, expande la pista para poder ver el resto de sus 
botones y utilidades. 

• El nombre de la pista se puede cambiar. Consulte Añadir, renombrar y 
borrar pistas. 

El botón expandir muestra otros controles de la pista de vídeo. Tras pulsarlo el 
aspecto del encabezado pasa a ser el siguiente:

A. Ver línea de Keyframes. B. Ver línea de opacidad. C. Botones de 
navegación por los keyframes.

• Si se pulsa el botón Ver línea de keyframes, en la 
parte inferior del clip se mostrará la línea de 
keyframes que permite ajustar los efectos especiales 
de vídeo aplicados a los clips que se encuentren en 

dicha pista. Consulte, al respecto, Qué son los keyframes. Este botón no 
aparece en la pista de vídeo 1. 

• El botón ver línea de opacidad hace que en la parte inferior del clip se 
muestre la línea de control de la opacidad. Consulte Uso de la línea de 
nivel de opacidad. Este botón tampoco aparece en la pista de vídeo 1, 
pues en ella no hay línea de opacidad. 

Nota: Los botones A y B actúan conjuntamente. Es decir: en la parte inferior del 
clip se verá o bien la línea de keyframes, o bien la de opacidad.
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• Los botones de navegación por lo keyframes sólo se muestran si se está 
mostrando la línea de keyframes (por haberse pulsado el botón A) y, 
además, a algún clip de la pista se le ha aplicado algún efecto que se 
pueda controlar mediante keyframes. Respecto del uso de estos botones 
consulte Uso del navegador de keyframes. 

Nota: Como en la pista de vídeo 1 no existe línea de opacidad, en esta pista no 
existen los botones A y B. Es decir: cuando se expande la pista de vídeo 1 sólo 
es posible mostrar la línea de keyframes. Se mostrarán pues en esta pista 
exclusivamente los botones de navegación por los keyframes, siempre que a 
algún clip de la pista se le haya aplicado algún efecto controlable mediante 
keyframes.
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Las pistas de audio

Las pistas de audio se dividen en dos partes: El encabezado de la pista y la 
pista propiamente dicha. Los clips se colocan en la pista propiamente dicha, 
pero las características del clip o de la propia pista son manejables desde el 
encabezado.

El encabezado de la pista puede estar colapsado o expandido:

Cuando está colapsado tiene el siguiente aspecto:

A. Botón Excluir/Ocultar. B. Botón Bloquear. C. Botón Expandir. D. 
Nombre de la pista.

Los tres botones (A, B y C) actúan como conmutadores, es 
decir: Pulsándolos se cambia al estado contrario al que 

tenían.

• El botón Excluir/Ocultar (haciendo click sobre él excluye la pista, y 
haciendo Alt-Click la oculta) permite excluir u ocultar una pista. Consulte 
Ocultar y excluir pistas. Cuando la pista ha sido excluida u ocultada, 
desaparece el icono del altavoz del botón. 

• El botón bloquear, bloquea la pista de tal modo que en ella no se puedan 
incluir nuevos clips. Consulte Bloqueo y desbloqueo de pistas. Cuando 
la pista está bloquedada aparece el icono de un candado. 

• El botón Expandir, expande la pista para poder ver el resto de sus 
botones y utilidades. 

• El nombre de la pista se puede cambiar. Consulte Añadir, renombrar y 
borrar pistas. 

El botón expandir muestra otros controles de la pista de audio. Tras pulsarlo el 
aspecto del encabezado pasa a ser el siguiente:

A. Mostrar/Ocultar forma de onda. B. Ver línea de keyframes. C. 
Ver línea de volumen. D. Ver línea de Balance. E. Botones de 
navegación por los keyframes. F. Indicador de canal izquierdo de 
audio. G. Indicador de canal derecho de audio.

Los botones A, B, C y D afectan a qué se verá en la 
parte inferior del clip de audio.

• El botón A determina que se muestre (o no) la forma de onda del sonido. 
Ver la forma de onda ayuda a detectar visualmente los picos del sonido, 
pero, a cambio, exige más memoria y puede determinar que la ventana 
de construcción tarde más tiempo en redibujarse. 

• Si se pulsa el botón B Ver línea de keyframes, en la parte inferior del clip 
se mostrará la línea de keyframes que permite ajustar los efectos 
especiales de audio aplicados a los clips que se encuentren en dicha 
pista. Consulte, al respecto, Qué son los keyframes. 
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• El botón C ver línea de balance hace que en la parte inferior del clip se 
muestre la línea azul de control de balance del clip. Consulte Fijar el 
balance en la ventana de construcción. 

• El botón D ver línea de volumen hace que en la parte inferior del clip se 
muestre la línea roja de control de volumen del clip. Consulte Ajuste de 
los niveles de audio en la ventana de construcción. 

Los botones de navegación por keyframes (E) sólo se muestran si se producen 
dos circunstancias:

• Se está mostrando la línea de keyframes (se pulsó el botón B). 
• A algún clip de audio de dicha pista se le ha aplicado un efecto 

controlable por keyframes. 

Respecto del uso de estos botones de navegación, consulte Uso del navegador 
de keyframes.

Por último, los indicadores F y G sólo se muestran cuando se está mostrando 
la línea de balance, y sirven de recordatorio de que desplazando dicha línea 
hacia arriba (indicador F) se incrementa el sonido del canal izquierdo, y 
desplazándola hacia abajo (indicador G) se incrementa el sonido del canal 
derecho.
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El menú de unidad de tiempo

La ventana de construcción muestra los clips a lo largo del tiempo. A tal efecto 
en su parte superior se encuentra la regla de tiempo. Esta regla muestra, como 
cualquier regla, divisiones temporales. Ahora bien: cuál sea la unidad de dicha 
regla depende del nivel de detalle con el que se pretenda mostrar los clips en 
esta ventana. Ese nivel de detalle se determina, bien mediante la herramienta 
zoom, bien mediante el menú de ampliación.

Pulsando sobre el menú de ampliación se puede elegir la unidad de la regla de 
tiempo, la cual puede oscilar entre 1 fotograma y 8 minutos.

La representación visual de la duración de los clips en la ventana de 
construcción, se ajusta proporcionalmente a la unidad de tiempo seleccionado. 
Así, si, por ejemplo, tenemos un clip que tenga un minuto de duración, ocurrirá 
lo siguiente:

• Si se elige como unidad de tiempo 1 fotograma, el clip ocupará 1500 
unidades de la regla de tiempo (porque en un minuto hay 1500 
fotogramas); es decir: se verá largúisimo. 

• Si se elige como unidad de tiempo 1 segundo, el clip ocupará 60 
unidades de la regla de tiempo. 

• Si se elige como unidad de tiempo 1 minuto, el clip ocupará una unidad 
de la regla de tiempo 

• Etc. 

Normalmente, es recomendable escoger una unidad pequeña cuando se quiere 
realizar una modificación que exija un control muy preciso (por ejemplo: marcar 
los puntos In y Out, fijar puntos de control para el sonido, opacidad, etc), y una 
unidad de tiempo más alta para desplazarse por la ventana de construcción 
con más rapidez.

Botones de la ventana de construcción

En la parte inferior de la ventana de construcción se muestran los siguientes 
botones:

A. Menú de unidad de tiempo. B. Opciones de pistas. 
C. Alineación con los bordes. D. Ver bordes. E. 
Cambiar modo de inserción. F. Modo de 
sincronización.

Del menú de unidad de tiempo ya he 
hablado en el tema anterior de ayuda. Respecto a los restantes botones, su 
utilidad es la siguiente:

• Opciones de pista: Pulsando este botón se abre un cuadro de diálogo 
que permite añadir, suprimir o renombrar las pistas. Consulte Añadir, 
renombrar y borrar pistas. 
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• Alineación con los bordes: Cuando este botón está pulsado es posible 
ajustar el borde de un clip con el de otro clip o con una marca. Consulte 
Desplazamiento de clips en el tiempo y Uso de marcas. 

• Ver bordes: Cuando este botón está pulsado, cuando se ajustan los 
puntos In u Out desde la ventana de construcción arrastrando los bordes 
del clip, en la ventana de monitor se va mostrando el fotograma inicial o 
final del clip conforme se realiza el arrastre. Consulte Marcado y 
búsqueda de puntos In y Out. 

• Este botón afecta al modo en que se insertarán los nuevos clips: Puede 
ser desplazando a la derecha todos los clips en todas las pistas, o 
desplazando a la derecha sólo los clips de la pista donde se inserte un 
nuevo clip. Consulte personalización de la ventana de construcción. 

• Modo de sincronización: Activa o desactiva el modo de sincronización. 
Cuando se está en modo sincronizado, la alteración de los puntos In y 
Out de un clip de vídeo o de audio afectará también al clip de audio o 
vídeo vinculado. Consulte Víncular clips de vídeo y audio en la ventana 
de construcción y Selección de clips. 
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La regla de tiempo

La regla de tiempo se encuentra en la parte superior de la ventana de 
construcción y permite saber con exactitud en qué momento exacto se 
encuentra cada uno de los sucesos del programa de vídeo.

Las unidades de tiempo que se muestren en esta regla, dependen de la unidad 
de tiempo elegida en el menú de unidad de tiempo.

Su aspecto es el siguiente:

A. Subdivisión temporal. B. Punto In del programa de vídeo. C. División temporal. D. Punto Out 
del programa. E. Punto de edición.

Como se verá, en la regla de tiempo se muestran divisiones y subdivisiones 
temporales. Así el punto C corresponde exactamente al segundo cuarto del 
programa.

Si se marcarón puntos In y Out, no para los clips individuales, sino para el 
programa propiamente dicho, estos se señalarán en la regla de tiempo, y la 
zona entre ambos aparecerá sombreada. El punto de edición, por su parte, 
también se muestra en la regla de tiempo.

Las peculiaridades de la regla de tiempo son las siguientes:

• Haciendo click sobre ella, el punto de edición se desplaza al lugar donde 
se hizo click. 

• Arrastrando el ratón sobre ella, se previsualiza en la ventana de monitor 
los clips que se encuentran en el lugar donde se arrastre, pero esta 
previsualización es sin aplicar efectos ni mostrar las transiciones. 

• Arrastrando el ratón sobre ella mientras se pulsa la tecla Alt se realiza lo 
que se llama una previsualización de barrido, en la que se muestran los 
efectos y transiciones aplicados. 

La barra de área de trabajo

Esta zona de la ventana de construcción se utiliza para las previsualizaciones. 
Se trata de una banda, situada en la parte superior de la ventana, en la que se 
muestra una barra amarilla.
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La barra amarilla representa la parte del programa de vídeo que se incluirá si 
se solicita una previsualización. Se puede arrastrar a lo largo de la banda, o 
redimensionar.

La línea roja en la parte inferior indica que existen ficheros temporales de 
previsualización.

Consulte Previsualización del programa de vídeo.

Edición de los puntos In y Out

La mayor parte de los clips se capturan con un material adicional al principio y 
al final que permite editar con más precisión más adelante. Es habitual realizar 
los ajustes de precisión al principio y al final de un clip justo antes de pasarlo al 
programa de vídeo. El principio se define colocando un punto IN (el primer 
fotograma de un clip que aparece en el programa de vídeo), mientras que el 
final se define mediante un punto OUT (el último fotograma que aparece en el 
programa de vídeo).
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Marcado y búsqueda de puntos In y 
Out

Los puntos In y Out se pueden definir

• En la ventana de monitor (tanto en la vista origen con en la del 
programa). En este caso se marcan los puntos directamente en el 
fotograma exacto, por lo que la precisión es absoluta. 

• En la ventana de construcción. Cuando el puntero del ratón se coloca 
sobre el borde de un clip automáticamente se convierte en la 
herramienta de recortar bordes. 

El segundo procedimiento es más visual, pero para tener tanta precisión como 
el primero requiere que en la ventana de construcción la unidad de 
visualización sean los fotogramas.

Cuando un clip contiene vídeo y audio (a los que se denomina clips enlazados), 
puede establecerse para cada parte sus propios puntos In y Out 
independientes, en cuyo caso se habla de puntos separados. Esto puede ser 
útil para crear ediciones en las que el audio de un clip se extiende hasta el 
siguiente. Pueden marcarse puntos separados sólo cuando, en la ventana de 
monitor, la vista origen contiene un clip enlazado. Si un clip enlazado es llevado 
a la vista origen de la ventana monitor desde la ventana de construcción, 
asegurese de que el modo sincronizado se ha seleccionado antes. Para más 
información sobre el modo de sincronización, consulte Enlace de clips de vídeo 
y audio en la ventana de construcción.

Para marcar o borrar puntos In y Out en la ventana de monitor:

1 Realice una de las siguientes acciones:

• Para editar puntos IN y OUT de un clip de origen, abra un clip desde la 
ventana de proyecto o una ventana de contenedor.

• Para editar los puntos IN y OUT de un clip que ya se encuentre en el 
programa, haga doble click en un clip de la ventana de construcción. Si 
se trata de un clip enlazado (que contiene simultáneamente vídeo y 
audio) y se desea marcar puntos separados para el vídeo y para el 
audio, asegúrese de que el modo de sincronización ha sido 
seleccionado antes de hacer doble click sobre el clip. 

2 En la ventana de monitor, haga click en la vista (de origen o de programa) en 
la que desee trabajar con puntos IN y OUT.

3 Realice una de las siguientes acciones:
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• Para marcar un punto IN, vaya al fotograma que desee y, a 
continuación, haga click en el botón Marcar IN ( ).

• Para borrar un punto IN, pulse Alt (Windows) u Opción (Mac OS) 
mientras hace click en el botón Marcar IN.

• Para marcar un punto OUT, vaya al fotograma que desee y, a 
continuación, haga click en el botón Marcar OUT ( ).

• Para borrar un punto OUT, pulse Alt (Windows) u Opción (Mac OS) 
mientras hace click en el botón Marcar OUT.

• Para borrar tanto el punto IN como el OUT, pulse G. 
• Para marcar un punto In u Out separado, haga click con el botón 

derecho del ratón (Windows) o haga Control-Click (Mac OS) en la vista 
fuente o en la vista programa, y después elija Set Clip Marker > Video In, 
Video Out, Audio In, o Audio Out, dependiendo del punto separado que 
se desee. 

• Para editar un punto separado In u Out, mantenga pulsada la tecla Alt 
(Windows) o Opción (Mac OS) y arrastre el punto en el control de 
avance rápido. 

4 Si ha abierto un clip desde la ventana de construcción, haga click en el botón 
Apply para que los cambios tengan efecto. El botón Aplicar no aparece cuando 
se prepara un nuevo clip para la ventana de construcción, ya que los puntos IN 
y OUT se aplican automáticamente al añadir el clip a la ventana de 
construcción

Para editar los puntos In y Out en la ventana de construcción:

1 Para ver cómo cambian los bordes de los fotogramas al arrastrar, seleccione 
Ver fotogramas en el menú de la ventana de construcción, o haga click en el 
botón Ver Bordes ( ) en la parte inferior de la ventana de construcción

2 Con la herramienta de selección ( ) activada, haga click en el clip que desee 
editar en la ventana de construcción, y realice una de las siguientes acciones:

• Para editar el punto In, arrastre el borde izquierdo del clip. 
• Para editar el putno Out, arrastre el borde derecho del clip. 

Izquierda: Un clip mientras se está editando el punto Out. Derecha: El mismo clip tras haber 
editado el punto Out

137



Para encontrar los puntos In y Out de un Clip:

1 Realice una de las siguientes acciones:

• En el caso de los puntos IN o OUT del origen de un clip, abra el clip y 
active la ventana de origen o del clip.

• En el caso de un punto IN o OUT del programa de un clip, abra el clip y 
active la vista de programa. 

2 Elija Clip > Go to Clip Marker > In, o Clip > Go to Clip Marker > Out.

138



Marcado de puntos In y Out para un 
clip duplicado

Si está trabajando con un clip duplicado que ha sido recordado (consulte Uso 
de clips duplicados con nombre y de copias de clips sin nombre), quizás desee 
definir un nuevo punto IN o OUT aparte de los puntos IN y OUT del subclip. 
Puede hacerlo abriendo el clip maestro del subclip. Puede hacerlo abriendo el 
clip maestro.

Para marcar puntos IN y OUT diferentes de los puntos inicial y 
final de un clip duplicado:

1 Haga doble click en el clip maestro del duplicado en la ventana de proyecto, 
para abrirlo en la ventana de monitor.

2 Si desea recortar el clip maestro, para crear un nuevo clip duplicado, consulte 
Uso de clips duplicados con nombre y de copias de clips sin nombre.

3 Establezca los nuevos puntos In y Out.
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Definición de un punto In de origen 
de audio entre divisiones de base de 
tiempo

Puede definir el punto IN de origen de un clip de audio con la precisión de los 
fotogramas individuales o de las muestras de audio de un clip. Por ejemplo, si 
edita la banda sonora de una película, puede desear que se reproduzca el clip 
de audio de un chasquido de dedos en el instante en que se escuche el sonido, 
pero puede que la visualización de tiempo de la banda sonora, de 24 
fotogramas por segundo (definida inicialmente para que coincida con la base 
de tiempo), no está bien ajustada para iniciar la reproducción justo en el 
momento deseado. Puede utilizar la opción de visualización de tiempo 
Fotogramas/Muestras para definir un punto IN de audio de origen de forma más 
precisa que con una unidad de base de tiempo, pero la base de tiempo del 
proyecto aún determina dónde puede aparecer el punto OUT de origen en la 
ventana de construcción. 

Para definir un punto IN de origen entre divisiones de base de tiempo:

1 Abra el clip en la vista de origen o en una ventana independiente.

2 Elija Window > Window Options > Monitor Window Options o Window > 
Window Options > Clip Window Options, según en qué ventana haya abierto el 
clip.

3 En Count, seleccione Frames/Samples, y pulse OK. Ahora los controles de 
reproducción actúan sobre fotogramas o muestras individuales, en lugar de 
utilizar la base de tiempo del proyecto.

4 Marque los puntos In y Out para el clip. Consulte Marcado y búsqueda de 
puntos In y Out.

5 Si desea definir el recuento con el valor anterior, seleccione Window > 
Window Options > Monitor Window Options o Window > Window Options > Clip 
Window Options, seleccione la visualización de tiempo original en el menú 
Count y haga click en OK.
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Uso de clips duplicados con nombre 
y de copias de clips sin nombre

Un mismo clip se puede utilizar varias veces en la ventana de construcción. El 
clip de origen se denomina clip maestro y cada vez que se añade el mismo clip 
maestro a la ventana de construcción se crea una nueva copia de ese clip 
maestro. Premiere controla automáticamente cada copia del clip, pero no los 
lista en la ventana de proyecto. Si desea que una copia de un clip aparezca en 
la lista de la ventana de proyecto, debe crear un clip duplicado, los cuales son 
útiles cuando varias o todas las escenas que desea utilizar se encuentran en 
un clip largo. En lugar de capturar cada escena por separado y gestionar un 
número determinado de archivos capturados, puede simplemente capturar un 
clip largo y crear un clip duplicado con nombre para cada escena. 

Un clip maestro es una referencia a un archivo real del disco. Una copia hace 
referencia al clip maestro del proyecto, de forma que si elimina el clip maestro, 
se borran también todas las copias. Un clip duplicado es una copia 
independiente de su maestro que hace referencia directamente al archivo de 
origen en el disco, de forma que si elimina el clip maestro, los subclips creados 
a partir de él permanecen en el proyecto. Al crear un clip duplicado no se crean 
nuevos archivos en el disco. Aparte de estas diferencias, es lo mismo trabajar 
con copias y clips duplicados que con un clip maestro.

Al hacer doble click en una copia o en un clip duplicado en la ventana de 
construcción, éste aparece en la vista de origen y se añade al menú de la vista 
de origen, con lo que se identifica a cada clip duplicado por nombre y a cada 
copia por el código de tiempo del punto IN de su programa (donde el punto IN 
de origen aparece en el programa).

Para crear un clip duplicado:

1 En la ventana de proyecto, seleccione el clip para el que desee crear un clip 
duplicado con nombre.

2 Si desea crear un clip duplicado sólo para una parte del clip maestro, haga 
doble click en el clip para abrirlo y defina el punto IN y el OUT para indicar los 
fotogramas que desea incluir en el subclip. Consulte Edición de los puntos In y 
Out.

3 Elija Edit > Duplicate Clip.

4 Asigne un nombre al subclip y seleccione una ubicación. Si tiene abiertas 
ventanas de contenedor, aparecerán en el menú Ubicación junto con la 
ventana de proyecto.
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5 Pulse OK. Premiere almacena la nueva referencia al clip maestro en la 
ventana que especifique.

También puede crear un clip duplicado copiando un clip de una ventana 
de proyectoo de contenedor y pegándolo en cualquiera de estas ventanas; o 
bien, arrastrándolo desde la vista de origen hasta la ventana de proyecto o de 
contenedor. Si copia a o desde la ventana de construcción, creará una copia 
del clip.
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Uso de marcas

Las marcas proporcionan una manera de indicar puntos importantes en el 
tiempo. Ayudan a colocar y disponer los clips.

La ventana de construcción y cada clip pueden contener su propio conjunto de 
hasta diez marcas, numeradas del 0 al 9. Además, la ventana de construcción 
y cada uno de los clips pueden contener hasta 999 marcas sin numerar.

El trabajo con las marcas es parecido al de los puntos IN y OUT, pero a 
diferencia de ellos, las marcas son sólo referencias y no modifican el programa 
de vídeo (excepto en el caso de las marcas establecidas como enlaces Web). 
En general, se añaden marcas a un clip en puntos importantes dentro de un 
clip concreto y se añade una marca a la ventana de construcción para puntos 
de tiempos significativos que afectan a varios clips, como en el caso de la 
sincronización de vídeo y audio en diferentes clips

Al añadir una marca a un clip en una vista de origen, o en la ventana de clip, la 
marca y cualquier otra que haya en el clip maestro se incluyen junto al clip al 
añadirlo a la ventana de construcción o al crear un clip duplicado. No obstante, 
si abre un clip desde la ventana de proyecto y le añade una marca, ésta no se 
añade a ningún subclip o copias del clip que ya se encuentren en la ventana de 
construcción.

Al añadir una marca a la ventana de construcción o a la vista de programa, 
aparece tanto en la ventana de construcción como en la vista de programa, 
pero no se añade a ningún clip maestro. Si añade una marca a un clip en la 
ventana de construcción aparece junto al clip y la propia marca añadida a la 
ventana de construcción aparece en la regla de tiempo.

Las marcas en la ventana de construcción pueden también incluir un 
comentario, un enlace a una página Web o a un capítulo. Los comentarios se 
muestran sólo en la vista de programa; los enlaces Web generan un salto a una 
página web en su navegador, y los enlaces a capítulos generan un salto a un 
capítulo en una película QuickTime o en un DVD.

Premiere incluye comandos para marcar clips que pueden usarse tanto para 
establecer los puntos In y Out del clip como para ir a dichos puntos. Igualmente 
es posible establecer e ir a los puntos In y Out de vídeo o de audio, lo cual es 
útil cuando se está trabajando en un clip que incluye puntos In y Out separados 
para su vídeo y audio. Estos comandos están disponibles solamente para el 
clip seleccionado y no se aplican a la ventana de construcción.

Para añadir una marca:

1 Realice una de las siguientes acciones:
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• Para añadir una marca a un clip, abralo en la ventana de monitor o en 
una ventana independiente, o seleccionelo en la ventana de 
construcción. 

• Para añadir una parca a un clip en la ventana de construcción, 
seleccionelo o haga doble click en él para abrirlo. 

• Para añadir una marca a la ventana de construcción, active la vista de 
programa o la ventana de construcción. 

2 Vaya a la posición temporal exacta en donde que se quiere establecer la 
marca.

3 Elija Clip > Set Clip Marker o Timeline > Set Timeline Marker (dependiende 
de dónde quiere añadir la marca, si en el clip o en la ventana de construcción), 
y elija la marca que desea añadir.

Nota: Si se está trabajando en la ventana de monitor es posible usar el botón 
Marker ( ) en la parte inferior de la ventana, en lugar de usar el comando del 
menú.

Las marcas numeradas que se hayan colocado en el proyecto se indican en el 
menú mediante un punto a la izquierda del número de la marca.

Para insertar marcas durante la reproducción de un clip o de la ventana de 
construcción, pulse la tecla * (asterisco) en el teclado numérico en el instante 
en el que desea insertar el marcador. También se puede insertar una marca 
numerada presionando su combinación de teclas rápidas mientras se 
reproduce un clip o la ventana de construcción.

Para ir a una marca:

1 Active la ventana en la que quiere ir a una marca.

2 Realice alguna de las siguientes acciones:

• Para ir a una marca numerada, elija Clip > Go to Clip Marker > marker x 
o Timeline > Go to Timeline Marker > marker x. 

• Para ir a la próxima marca, elija Clip > Go to Clip Marker > Next o 
Timeline > Go to Timeline Marker > Next. 

• Para ir a la próxima marca, elija Clip > Go to Clip Marker > Previous o 
Timeline > Go to Timeline Marker > Previous. 

• Para ir a la primera marca en la ventana de construcción, presione 
Ctrl+Shift+Flecha arriba (Windows) o Comando+Shift+Flecha arriba 
(Mac OS). 

• Para ir a la última marca en la ventana de construcción, presione 
Ctrl+Shift+Flecha abajo (Windows) o Comando+Shift+Flecha abajo (Mac 
OS). 
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Para usar marcas que ayuden a colocar clips, use el comando Snap to Edges, 
en el menú de la ventana de construcción o el botón Toggle Snap to Edges 
(Conmutador de alineación con los bordes) ( ) en la parte inferior de la 
ventana de construcción (consulte Movimiento de clips en el tiempo).

Para ocultar las marcas o moverlas cuando se mueven varias pistas, use las 
opciones Show Markers y Block Move Markers, respectivamente, en el cuadro 
de diálogo de opciones de la ventana de construcción (Consulte 
Personalización de la ventana de construcción).

Para borrar una marca:

1 Realice una de las siguientes acciones:

• Para borrar una marca de un clip, ábralo en la ventana de monitor o en 
una ventana independiente, o seleccionelo en la ventana de 
construcción. 

• Para borrar una marca de un clip en la ventana de construcción, 
seleccionelo o haga doble click sobre él para abrirlo. 

• Para borrar una marca de la ventana de construcción, actívela, o active 
la vista de programa en la ventana de monitor. 

2 Vaya a la marca que desea borrar (tal y como se explica en el procedimiento 
anterior).

3 Elija Clip > Clear Clip Marker > Current Marker o 
Timeline > Clear Timeline Marker > Current Marker, según desee borrar la 
marca de un clip o de la ventana de construcción.

También es posible borrar una marca de la ventana de construcción desde el 
cuadro de diálogo de marcas.

Para borrar todas las marcas:

1 Realice una de las siguientes acciones:

• Para borrar las marcas de un clip, ábralo en la ventana monitor o en una 
ventana independiente 

• Para borrar las marcas de la ventana de construcción, pero no de los 
clips colocados en ella, active la vista de programa (en la ventana de 
monitor) o la ventana de construcción. 

2 Elija Clip > Clear Clip Marker > Clear All Markers o 
Timeline > Clear Timeline Marker > Clear All Markers.
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Uso de marcas, en la ventana de 
construcción, para comentarios

Es posible añadir comentarios a una marca en la ventana de construcción, y si 
se está editando en vídeo del tipo QuickTime, los comentarios se mostrarán en 
la ventana de monitor como texto superpuesto. La duración por defecto del 
comentario es de un fotograma (precisamente aquel que aparecerá marcado 
en la ventana de construcción), y el comentario se muestra cuando se muestre 
dicho fotograma. Para mostrar el comentario por más tiempo, inremente su 
duración.

Para crear una marca para comentarios:

1 Active la vista de programa en la ventana de monitor, o la ventana de 
construcción.

2 Coloquese en la posición temporal en donde quiere establecer la marca.

3 Haga click en el botón Marker ( ), en la parte inferior de la vista de programa, 
elija Mark y seleccione un número para la marca.

4 Cuando la marca aparezca en la ventana de construcción debe abrir el 
cuadro de diálogo de marcas.

5 Escriba un comentario en el campo Comment.

6 Introduzca la duración para la marca en el campo Duration; esta representa la 
cantidad de tiempo durante el que se mostrará la marca.
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Creación de enlaces Web

Escribiendo una dirección URL en el campo Web Links que está en el cuadro 
de diálogo de marcas, se creará un enlace automático a dicha dirección.

En tal caso Premiere incrustará dicha información en la película, de tal forma 
que si la misma se incluye en una página Web creada por programas como 
Adobe Golive, el enlace incrustado es reconocido y ejecutado, iniciando un 
salto a la dirección URL especificada. También es posible definir el enlace 
escribiendo un número de fotograma que se activará en el sitio web.

Las marcas con enlace a sitios web sólo funcionan con marcas de la ventana 
de construcción, no con marcas de clips, y con formatos de salida soportados, 
como QuickTime.

Para crear un enlace Web:

1 Cree primero una marca para la ventana de construcción, y a continuación 
debe abrir el cuadro de diálogo de marcas y localizar en él la marca recién 
hecha.

2 Escriba la dirección Web en el campo URL.

3 Para activar un fotograma específico en el sitio web, escriba el nombre de 
fichero del fotograma en el campo Frame Target y pulse OK.

Para ver o modificar la dirección de un enlace Web:

1 Haga doble click en la marca de la ventana de construcción.

2 En el cuadro de diálogo de marcas, compruebe la información y realice los 
cambios que desee.

3 Para ver o cambiar la informacion de cualquier otro marcador, pulse Prev o 
Next hasta localizarlo.
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Creación de enlaces a capítulos

También es posible crear una marca en la ventana de construcción que 
funcione como punto de referencia a un capítulo, similar a los capítulos usados 
en CD-ROM y en discos DVD.

Al igual que los capítulos de un libro, un enlace de capítulo divide la película en 
segmentos.

Estos enlaces están soportados en películas QuickTime y en DVD.

Para crear un enlace a capítulo:

1 Cree una marca en la ventana de construcción, y a continuación debe abrir el 
cuadro de diálogo de marcas y localizar en él la marca recién hecha.

2 En el campo chapter, escribe el nombre y número del capítulo, y después 
pulse OK.
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El cuadro de diálogo de marcas
Las marcas, que no sean de clips, es decir: las que afectan a todo el programa 
de vídeo por encontrarse en la ventana de construcción, pueden gestionarse 
mediante el cuadro de diálogo de marcas. 

Para abrir el cuadro de diálogo de marcas

Realice una de las siguientes acciones:

• Localice en la ventana de construcción la marca que pretende editar y 
haga doble click sobre ella. 

• Elija Timeline > Edit timeline marker 

Tras ello se abrirá el cuadro de diálogo que tiene el siguiente aspecto:

En la barra del título se ofrece información sobre el número de marca que se 
está editando y su ubicación en la línea temporal.

Mediante los botones Prev y Next es posible navegar entre las distintas 
marcas. Pulsando el botón Prev se editará la marca anterior a la actual, y 
pulsando Next se editará la posterior a la actual.

El botón Delete borra la marca actualmente editada.

Los diferentes campos del cuadro ofrecen la siguiente utilidad:

• Comment: Permite incluir un comentario para la marca. 
• Duration: Indica la duración de la marca. Ello es de interés sólo si la 

marca tiene un comentario. 
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• Chapter: Para establecer una marca de enlace a capítulo. 
• URL y Frame Target: Para establecer una marca de enlace a página 

Web. 

Edición de clips

Las opciones y procedimientos descritos en esta sección, afectan a clips 
completos e individuales, no siendo posible aplicarlas simultáneamente a más 
de un clip, salvo que expresamente se diga lo contrario.
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Edición de un clip en su aplicación 
original

El comando Edit > Edit Original, abre los clips en su aplicación original (en 
realidad abre el clip en la aplicación a la que se haya asociado su extensión, es 
decir: aquella con la que se abriría haciendo doble click sobre él desde el 
explorador de Windows o Mi Pc).

Abriendo un clip en su aplicación original es posible editarlo de tal manera que 
los cambios introducidos automáticamente se incorporen al proyecto actual sin 
salir de Premiere y sin reemplazar el fichero.

Las películas generadas por Premiere para la exportación, pueden también 
contener información interna que permita abrirlas usando el comando Edit 
> Edit Original, indicando otra aplicación distinta para abrirlas, como Adobe 
After Effects.

Para abrir un clip con su aplicación original:

1 Selecciónelo, bien sea en la ventana de proyecto, en una ventana de 
contenedor, o en la ventana de monitor.

2 Elija Edit > Edit Original.

Para grabar un proyecto de Premiere con la información necesaria para 
usar el comando Edit Original:

Al exportar un clip, o el contenido de la ventana de construcción, elija Project 
Link del menú Embedding Options en el cuadro de diálogo Export Settings. 
Para más información sobre cómo exportar una película, consulte Exportación 
de un vídeo
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Ajuste de la escala de un clip

Si el clip se encuentra en la ventana de construcción, puede ajustar su escala y 
su posición. Para ello deben usarse las opciones de ajuste de escala 
proporcionadas por la función de movimiento; este procedimiento describe 
cómo ajustar la escala de un clip y mantenerlo en su posición. Para más 
información acerca de la función de movimiento, consulte Animación de un clip 
de movimiento.

Para cambiar el tamaño de un clip conservando su posición:

1 Seleccione un clip de la ventana de construcción.

2 Elija Clip > Video Options > Motion.

Aparecerá la siguiente ventana

3 En la opción Zoom, arrastre el potenciómetro o escriba un porcentaje para la 
escala. Observe la imagen de muestra de la esquina superior derecha del 
cuadro de diálogo; ignore por ahora la previsualización del movimiento en la 
esquina superior izquierda.

4 En la imagen de muestra con la trayectoria del movimiento, arrastre el primer 
punto de movimiento (rojo) para colocar el clip ya escalado en el fotograma.
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5 Anote las coordenadas (que aparecen en el campo Info) y el porcentaje de la 
opción de Zoom.

6 Haga click en el segundo punto de movimiento (blanco) de la imagen de 
muestra e introduzca las coordenadas de Información y el porcentaje de Zoom 
anotados en el paso anterior. Esto establece que la posición y el zoom 
empiecen y acaben en el mismo punto, evitando que el clip se mueva o cambie 
de escala con el tiempo.

7 Compruebe la previsualización del movimiento en la esquina superior 
izquierda del cuadro de diálogo. Si la imagen tiene la posición y el tamaño 
correctos, haga click en OK. En caso contrario, repita los pasos 4 a 8 para 
recolocar la imagen.
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Cambio de la duración y velocidad 
del clip

La duración de un vídeo o de un clip de audio es el tiempo que tarda en 
reproducirse (la diferencia de tiempo entre el punto IN y el punto OUT). La 
duración inicial de un clip es la misma que cuando se capturó o importó. Si 
modifica el inicio y el final de un clip editando los puntos IN y OUT de origen, su 
duración cambiará. También puede definir la duración del clip especificando un 
intervalo de tiempo desde el punto IN de origen actual. Una imagen fija también 
puede tener una duración determinada si desea que se muestre durante un 
determinado periodo de tiempo. Puede definir la duración predeterminada de 
las imágenes fijas importadas. Consulte Importación de imágenes fijas.

La velocidad de un clip es la velocidad de reproducción de la acción o del audio 
en comparación a la velocidad con que fue grabada. Inicialmente, la velocidad 
es la misma que tenía en el momento de importar o capturar el clip. El cambio 
de la velocidad del clip modifica la velocidad de origen y puede hacer que se 
ignoren o repitan algunos fotogramas (consulte Fotogramas por segundo en 
relación a la base de tiempo). Además, la modificación de la velocidad de un 
clip requiere ejecutar el mismo número de fotogramas en un intervalo de tiempo 
diferente, lo que también cambia la duración (desplaza el punto OUT) del clip.

Si la velocidad se establece como un valor negativo (como, por ejemplo, -100) 
el clip se reproducirá en sentido inverso. De otro lado, cuando se cambia la 
velocidad de un clip que contiene campos entrelazados, puede ser necesario 
ajustar el cómo Premiere trata los campos, especialmente cuando el campo se 
reduce por debajo de un 100% de la velocidad original. Consulte Proceso de 
vídeo con campos entrelazados.

Nota: Cuando se reproduce un clip .AVI en sentido inverso (con velocidad 
negativa), no es posible utilizar la reproducción en bucle (Loop) o reproducir del 
punto In al punto Out en la ventana de Monitor.

Para cambiar la duración de un clip o imagen fija:

1 En la ventana de construcción o de proyecto seleccione un clip.

2 Realice una de las siguientes acciones:

• Para modificar la duración numéricamente, seleccione Clip > Duratión, 
escriba una nueva duración y, a continuación, haga click en OK. 

• Para modificar visualmente la duración en la ventana de construcción, 
sitúe la herramienta de selección sobre el borde del clip y arrastre hacia 
uno de los extremos. Si desea que el clip sea más largo, el clip de origen 
debe contener los suficientes fotogramas adicionales fuera de los puntos 
IN y OUT para realizar el ajuste. 
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Cuando se mueve la herramienta de selección sobre el punto de edición entre 
dos clips, el icono cambia, dependiendo de sobre qué clip se encuentre y de si 
dicho clip dispone de fotogramas adicionales.

El icono cambia para motrar que afecta al clip situado a la izquierda (A) o a la derecha (B). Las 
flechas demuestran de qué modo se puede ajustar un clip: hacia la izquierda (C), derecha (D), 
o en ambas direcciones (E).

Para cambiar la duración de un clip sólo en la ventana de construcción:

1 Seleccione un clip y realice una de las siguientes acciones:

• Para modificar numéricamente la velocidad, seleccione Clip > Speed. 
Escriba un porcentaje o una nueva duración (o bien, escriba un valor 
negativo para reproducir el clip en sentido inverso) y haga click en OK. 

• Para modificar visualmente la velocidad, seleccione la herramienta para 
modificar la velocidad ( ) (rate stretch tool) y arrastre uno de los 
extremos del clip. 

Para cambiar la velocidad de un clip que no está en la ventana de 
construcción:

1 Seleccione un clip en la ventana de proyecto o en una ventana de 
contenedor.

2 Realice una de las siguientes acciones:

• Para especificar la nueva velocidad en términos de porcentaje o de 
duración, seleccione Clip > Speed. Escriba un porcentaje o una nueva 
duración (o bien, escriba un valor negativo para reproducir el clip en 
sentido inverso) y haga click en OK. a aplicación de este comando a un 
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clip en las ventanas de proyectoo de contenedor no afecta a los clips 
que ya se encuentren en la ventana de construcción. 

• Para especificar una nueva velocidad modificando la velocidad del clip 
de origen, seleccione Clip > Advanced Options > Interpret Footage. 
Haga click en Assume This Frame Rate, escriba un valor para los 
fotogramas por segundo y haga click en OK. Premiere edistribuye todos 
los fotogramas del clip para crear la nueva velocidad. Si hay copias de la 
ventana de construcción y subclips que se basan en el clip, sus 
velocidades y duraciones cambian en consecuencia. 

Si define en la ventana de construcción la duración deseada para un clip 
pero no le gusta donde empieza y acaba el clip en relación con los clips que 
hay antes y después, puede utilizar la herramienta de desplazamiento para 
ajustar el clip sin cambiar los puntos IN o OUT del programa de clip o su 
duración. Consulte Edición de un clip que está, en la ventana de construcción, 
entre otros clips.
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Modificación de los fotogramas por 
segundo de un clip

Es posible modificar el número de fotogramas que se muestran cada segundo 
en un clip especificando la velocidad de fotogramas por segundo. Esta 
modificación no cambia la velocidad de la acción, a no ser que utilice el 
comando Interpretar material, que cambia tanto los fotogramas por segundo 
como la velocidad de la acción. Si especifica una velocidad de fotogramas por 
segundo inferior a la que se rodó el clip, o inferior a la de fotogramas por 
segundo del proyecto, no habrá suficientes fotogramas en el clip para 
adecuarse al número de fotogramas por segundo del proyecto y el movimiento 
se producirá a saltos. En esta situación, Premiere emula los fotogramas 
perdidos repitiendo el último fotograma de origen que estaba disponible, hasta 
que encuentra uno nuevo. No obstante, puede aplicar el entrelazado de 
fotogramas, que interpola entre los fotogramas disponibles para crear 
fotogramas intermedios que crean la impresión de un movimiento más suave. 
El entrelazado de fotogramas también resulta de utilidad después de cambiar la 
velocidad del clip, lo que cambia también los fotogramas por segundo.

Los fotogramas por segundo reales de un clip al reproducirlo o exportarlo 
dependen de una compleja relación entre los fotogramas por segundo del clip 
de origen, la base de tiempo del proyecto, los fotogramas por segundo 
especificados para la reproducción y para la exportación y cualquier otra 
modificación que se haya realizado siguiendo los procedimientos de esta 
sección. La modificación del número de fotogramas por segundo puede hacer 
que se ignoren, creen o repitan algunos fotogramas. Consulte Fotogramas por 
segundo en relación a la base de tiempo. Si desea cambiar los fotogramas por 
segundo para toda la ventana de construcción, no siga los procedimientos de 
esta sección; consulte en su lugar Configuración de vídeo y Acerca de la 
exportación de vídeo desde Premiere.

Para cambiar el número de fotogramas por segundo de un clip de origen y 
así modificar la velocidad de la acción:

1 Seleccione un clip in en la ventana de proyecto, en la de construcción, o en 
una ventana de contenedor.

2 Elija Clip > Advanced Options > Interpret Footage (Interpretar metraje).

3 Seleccione Assume This Frame Rate, escriba un valor para los fotogramas 
por segundo y haga click en OK. Premiere redistribuye todos los fotogramas del 
clip de origen para obtener una nueva velocidad. Si hay copias y clips 
duplicados basados en el clip en la ventana de construcción, su número de 
fotogramas por segundo y sus duraciones también cambian.
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Para cambiar el número de fotogramas por segundo de un clip en la 
ventana de construcción sin cambiar la velocidad de la acción:

1 Seleccione un clip en la ventana de construcción, y elija Clip > Video Options 
> Frame Hold (Congelar fotograma).

2 En la sección Clip Frame Rate (Velocidad de clip), seleccione Alternate Rate 
(velocidad alternativa) y escriba una nueva velocidad.

3 Seleccione Frame Blending (entrelazar fotogramas) si lo desea, y pulse OK.
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Proceso de campos de vídeo 
entrelazados

En algunos sistemas de vídeo, como NTSC, PAL o SECAM, cada fotograma de 
vídeo se compone de dos campos entrelazados (consulte Comparación entre 
vídeo entrelazado y no entrelazado). Un campo contiene las líneas impares y el 
otro las líneas pares. Los dos campos se muestran uno tras otro para crear un 
fotograma, pero la dominancia de campos, o el campo que se muestra primero, 
puede variar según sea el formato de vídeo y el equipo utilizado para capturarlo 
y reproducirlo. Si se invierte la secuencia de los campos, el movimiento puede 
ir a saltos o parecer que parpadea. Los campos pueden invertirse en las 
siguiente situaciones

• La dominancia de campo de la cinta de vídeo original era la contraria a 
la de la tarjeta de captura de vídeo utilizada para capturar el clip 

• La dominancia de campo de la cinta de vídeo original era la contraria a 
la del software de edición o animación de vídeo que se utilizó la última 
vez para renderizar el clip 

• Ha definido un clip entrelazado para que se reproduzca hacia atrás en 
Premiere. 

Premiere puede procesar campos de un clip entrelazado en la ventana de 
construcción con el fin de mantener la calidad de la imagen y del movimiento al 
cambiar la velocidad del clip, exportar un filmstrip, reproducir un clip hacia atrás 
o congelar un fotograma de vídeo. Las siguientes configuraciones funcionan en 
clips individuales; los resultados finales se ven afectados por las 
configuraciones del proyecto en las Opciones de keyframe y render (consulte la 
descripción de la opción Configuraciones de los campos en Opciones de 
Keyframe y render y Exportación de vídeo).

Para determinar las opciones de proceso de campos de un clip:

1 Seleccione un clip en la ventana de construcción.

2 Elija Clip > Video Options > Field Options.

3 Seleccione Reverse Field Dominance (invertir dominancia de campos) si la 
dominancia de campos del clip seleccionado es la opuesta a la utilizada por la 
tarjeta de captura de vídeo. Esta opción también resulta útil si los clips del 
proyecto incluyen clips capturados con tarjetas de captura de vídeo diferentes o 
cuando reproduce un vídeo hacia atrás.

4 Haga click en una de las siguientes Opciones de procesado:

• Seleccione None si no desea procesar los campos del clip de origen. 
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• Seleccione Interlace Consecutive Frames (entrelazar fotogramas 
consecutivos) para convertir los pares de fotogramas de exploración 
progresiva (no entrelazados) a campos entrelazados. Esta opción resulta 
de utilidad al convertir animaciones de exploración progresiva a 60 fps a 
vídeo entrelazado a 30 fps, ya que muchas aplicaciones de animación 
no crean fotogramas entrelazados. 

• Seleccione Always Deinterlace (desentrelazar siempre) si desea 
convertir los campos entrelazados en fotogramas de exploración 
progresiva. Premiere desentrelaza descartando un campo e interpolando 
un nuevo campo que se basa en las líneas del campo restante. 
Mantiene el campo especificado en la opción Configuraciones de los 
campos (consulte Opciones de keyframe y render y Exportación de 
archivos de vídeo). Si especifica Sin campos, Premiere mantiene la 
dominancia del campo 1, a menos que seleccione Invertir dominancia de 
campos, en cuyo caso mantiene la dominancia del campo 2. Esta opción 
resulta de utilidad para congelar un fotograma del clip 

• Seleccione Flicker Removal para evitar que vibre un objeto pequeño de 
la película (como una línea horizontal de un píxel, por ejemplo). A esta 
opción también se la conoce como desplazamiento de píxeles vertical y 
puede ser de gran utilidad con imágenes fijas. Si un objeto es tan 
delgado como una línea de escaneado, puede que sólo aparezca en uno 
de los dos campos del vídeo. Esto provoca vibraciones, ya que el objeto 
sólo se dibuja cada vez que aparece el otro campo. Al seleccionar 
Flicker Removal, Premiere difumina ligeramente los dos campos juntos, 
de forma que un objeto delgado aparece, al menos parcialmente, en los 
dos campos. Se mantiene toda la resolución del fotograma. 

5 Seleccione Deinterlace When Speed is Below 100% (Desentrelazar si la 
velocidad es inferior al 100%) para identificar y retener automáticamente los 
campos que proporcionan una cámara lenta más suave. El campo que se 
mantiene puede variar de fotograma a fotograma, según donde aparezca el 
fotograma en ese momento. Cuando termine, haga click en OK.
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Conservación de la proporción 
original de un clip

Un proyecto puede contener clips con diferentes ratios (proporción 
altura/anchura). El ratio de aspecto de un proyecto se determina por el tamaño 
de los fotogramas especificados en los cuadros de diálogo Configuraciones de 
proyecto o en las configuraciones de exportación. Si un clip de la ventana de 
construcción utiliza un ratio de aspecto diferente al del proyecto, Premiere lo 
ajusta para que coincida con el del proyecto. No obstante, esto distorsiona la 
imagen, por lo que Premiere también permite mantener el ratio de aspecto 
original del clip. Si conserva el ratio de aspecto de un clip que tiene uno 
diferente al del fotograma, dos lados tocan el borde del fotograma y aparece un 
espacio vacío en los otros dos, de forma parecida a los vídeos de formato 
panorámico en televisión. Premiere permite especificar el color de las áreas 
vacías.

Para mantener la proporción original de un clip:

Seleccione un clip en la ventana de construcción y elija Clip > Video Options > 
Maintain Aspect Ratio.

Para definir el color de las áreas exteriores del fotograma que mantenga 
su proporción:

1 Seleccione un clip en la ventana de construcción.

2 Elija Clip > Video Options > Aspect Fill Color, especifique un color (consulte 
Uso del selector de color), y pulse OK
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Activación y desactivación de los 
clips

Es posible desactivar un clip en la ventana de construcción. Esto resulta útil si 
desea suprimir un clip mientras prueba otras ideas de edición, para reducir el 
proceso cuando trabaja con proyectos complejos o para excluir un clip de una 
EDL a exportar. Un clip desactivado no aparece en la vista de programa de 
monitor ni tampoco aparecerá en las previsualizaciones ni en el archivo de 
vídeo exportado. Si no bloquea un clip desactivado, todavía puede realizar 
cambios en él. Si desea desactivar todos los clips de una misma pista, puede 
optar por excluir toda la pista. Consulte Personalización del aspecto de las 
pistas.

Para activar o desactivar un clip:

Seleccione un clip en la ventana de construcción y elija Clip > Enable Clip on 
Timeline. Una marca de verificación junto al comando indica que el clip 
seleccionado está activado. Un clip desactivado se identifica mediante una 
trama de barras invertidas.
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Bloqueo y desbloqueo de clips

Se puede bloquear un clip en la ventana de construcción para evitar que se 
realicen cambios en él, en particular cambios accidentales. Un clip bloqueado 
sigue apareciendo en la vista de programa de monitor y aparecerá en los 
archivos de vídeo que exporte. Un clip bloqueado sigue apareciendo en la 
ventana de construcción con una trama de barras invertidas. Si desea bloquear 
todos los clips de una misma pista, puede optar por bloquear toda la pista. 
Consulte Bloqueo y desbloqueo de pistas.

Para bloquear o desbloquear un clip:

Seleccione uno o más clips en la ventana de construcción y elija Clip > Lock 
Clip on Timeline. Una marca de verificación en el menú indica que el clip 
seleccionado está bloqueado.

Búsqueda del origen de un clip del 
programa

Es posible buscar de forma rápida el origen de cualquier clip de la ventana de 
construcción y resaltarlo en la ventana de proyecto o de contenedor en la que 
esté almacenado. También puede ver el origen de un clip en la ventana de 
monitor, ya listo para ser editado.

Para ver el origen de un clip del programa:

Seleccione el clip en la ventana de construcción y realice una de las siguientes 
acciones:

• Elija Edit > Locate Clip para resaltar el origen en la ventana en la que 
está guardado. 

• Elija Clip > Open Clip para ver el origen en la ventana de monitor. 
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Congelado de un fotograma

Puede congelar un fotograma de un clip, de forma que sólo aparezca ese 
fotograma durante todo el clip, como si hubiera importado el fotograma como 
una imagen fija. Se puede congelar en el punto IN del clip, en el punto OUT o 
en una marca 0 (cero), si la hay.

Para congelar un fotograma de vídeo:

1 Seleccione el clip en la ventana de construcción.

2 Si desea congelar un fotograma diferente al punto IN o OUT, desplace el 
punto de edición al fotograma que desee y seleccione Clip > Set Clip Marker > 
0.

3 Elija Clip > Video Options > Frame Hold.

4 Elija Hold On (congelar en), y elija en el menú el fotograma que desee 
congelar.

5 Especifique las siguientes opciones según lo necesite y haga click en OK:

• Si se aplican uno o más filtros con keyframes al clip y desea evitar que la 
configuración del clip cambie en el transcurso de éste, seleccione Hold 
Filters (congelar filtros). 

• Si el clip era originalmente un vídeo entrelazado, seleccione Deinterlace 
(desentrelazar) para evitar que las imágenes vibren. 

Nota: Si el fotograma no se congela, asegúrese de que ha definido la marca en 
un clip y no en la regla de la ventana de construcción

Edición de un programa de vídeo

Puede editar un programa en la ventana de monitor mediante los controles de 
origen y de programa para introducir el código de tiempo o editarlo visualmente 
en la ventana de construcción. Algunas ediciones basadas en el tiempo son 
mas sencillas de realizar en la ventana de construcción, donde puede ajustar 
los puntos IN y OUT y la duración haciendo click y arrastrando. Si amplía el 
zoom en la ventana de construcción podrá editar fotogramas individuales con el 
ratón. Alejando el zoom, puede hacer cambios grandes de forma rápida 
(consulte Uso de la ventana de construcción).
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Edición mediante el teclado

Es posible que para algunos editores de vídeo experimentados sea más 
sencillo utilizar el teclado. Premiere proporciona atajos de teclado para la 
mayoría de comandos y botones, de forma que es posible editar un vídeo con 
un mínimo uso del ratón. En esta Guía del usuario y en la Guía de referencia 
rápida hay documentación completa sobre todos los atajos de teclado.

Para encontrar el atajo de teclado de comandos, herramientas o botones:

Realice una de las siguientes acciones:

• Si se trata de una herramienta o de un botón, coloque el puntero sobre 
ellos hasta que aparezca la sugerencia correspondiente. Si está 
disponible, el atajo de teclado aparecerá en la sugerencia, tras una 
descripción de la herramienta. (Si no aparecen las sugerencias, 
seleccione Edit > Preferences > General and Still Image y compruebe 
que la opción Show Tool tips está seleccionada). Si se trata de una 
herramienta de la ventana de construcción, pulse repetidamente el atajo 
de teclado para navegar entre todas las herramientas disponibles para 
un grupo. 

• En el caso de un comando del menú, el atajo de teclado, si existe, 
aparece en el propio menú, a la derecha del comando. 

• En el caso de atajos de teclado que no aparezcan ni en los menús ni en 
las sugerencias, consulte la Guía de referencia rápida. 
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Adición de un clip a la ventana de 
construcción

Los clips del proyecto no forman en realidad parte del programa de vídeo final 
hasta que se añaden a la ventana de construcción.

Al añadir un clip, éste aparece en la vista de programa y en la ventana de 
construcción, siendo el primer fotograma del clip el punto IN definido en la vista 
de origen. Puede añadir o quitar clips arrastrándolos de una ventana a otra o 
mediante los controles de la ventana de monitor. El método de arrastrar es más 
visual y depende en gran medida del uso del ratón. El uso de la ventana de 
monitor utiliza más el teclado y permite realizar muchas ediciones completas 
dentro de la ventana de monitor. Puede utilizar los dos métodos en cualquier 
momento.

Al arrastrar un clip a la ventana de construcción para añadirlo, el clip se agrega 
a la pista en la posición temporal donde se suelta. No obstante, si añade clips a 
la ventana de construcción mediante los controles de la ventana de monitor o el 
teclado, Premiere no puede saber exactamente cómo y dónde desea añadir el 
clip. En estos casos, debe especificar previamente la forma en la que se 
añadirán las pistas de vídeo u audio a la ventana de construcción y los puntos 
IN y OUT del programa.

Nota: Según la relación entre el clip de origen y las configuraciones del 
proyecto, es posible que se omitan o repitan algunos fotogramas de origen una 
vez añadido el clip a la ventana de construcción. Consulte Medición del tiempo.

Para añadir un clip arrastrándolo:

1 Marque los puntos IN y OUT del clip de origen. (consulte Marcado y 
búsqueda de los puntos In y Out.)

2 Marque los puntos IN y OUT del clip de origen. (consulte Especificación de 
las pistas de origen y de destino), Premiere añadirá automáticamente ambos y 
los iniciará al mismo tiempo.

Si no necesita recortar un clip o no desea hacerlo todavía, puede 
arrastrarlo directamente desde la ventana de proyecto o de contenedor, hasta 
la ventana de construcción.

Nota: Si va a crear un esbozo y la pista Vídeo 1 está expandida, empiece 
arrastrando los clips a la pista Vídeo 1A. Utilice la pista Vídeo 1B como pista 
alternativa o cinta-B y utilice las pistas Vídeo 2 y superiores como pistas de 
superposición (consulte Personalización del aspecto de las pistas). Evite usar 
la pista de vídeo 1A para insertar recortes o metrajes alternativos a los de la 

167

file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c03ev10.htm
file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c03ev14.htm
file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c03ev14.htm
file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c03ev17.htm
file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c03ev17.htm
file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\Meditemp00.htm


vista 1B. Para ello coloque este material en la pista sobrepuesta apropiada 
(una pista sobrepuesta es cualquier pista de vídeo que no sea la 1)

Para añadir una pista al tiempo que se añade el clip:

Desde la ventana de proyecto o desde la vista origen en la ventana de monitor 
arrastre el clip hasta la regla de tiempo o el espacio en blanco existente en la 
parte inferior de la ventana de construcción. En el primer caso se añadirá una 
pista de vídeo, en el segundo una de audio, y si el clip contenía vídeo y audio, 
se añadirán las dos pistas.

Para añadir un clip de origen usando los controles de la ventana de 
monitor:

1 Configure los iconos Usar vídeo y Usar audio y las pistas de destino del 
programa (consulte Especificación de las pistas de origen y de destino).

2 Marque los puntos IN y OUT del clip de origen (consulte Marcado y búsqueda 
de los puntos In y Out).

3 En el control del programa, especifique el fotograma donde desea que se 
inicie el punto IN del clip de origen. Consulte Uso de los controles de la ventana 
de monitor.

4 Realice una de las siguientes acciones:

• Haga click en el botón Insertar ( ), o elija Clip > Insert at Edit Line. 
Todos los vídeos y clips que siguen al punto de edición se desplazan 
hacia adelante en el tiempo por la duración del clip de origen insertado. 
Si el punto de edición divide un clip existente, Premiere lo divide y 
desplaza la segunda mitad y cualquier otro clip que haya a continuación, 
para hacer sitio para el nuevo clip. Tenga en cuenta que las pistas 
exactas que se desplacen dependen de las configuraciones de la opción 
On Insert del cuadro de diálogo Opciones de la ventana de construcción. 
Consulte Personalización de la ventana de construcción. 

• Haga click en el botón Superponer ( ), o seleccione Clip > Overlay at 
Edit Line. Todos los fotogramas de vídeo o audio existentes que ocupen 
la duración del clip insertado se sustituyen por éste último. 

Para más información acerca de cómo editar clips en el programa, consulte 
Edición de un clip que se encuentra entre otros clips de la ventana de 
construcción.

Nota: De forma predeterminada, los botones Insertar y Superponer añaden el 
clip a la ventana de construcción en el punto de edición. Puede evitar esto y 
especificar la ubicación deseada del clip definiendo el punto IN o OUT del 
programa o ambos. Consulte Sustitución de fotogramas del programa mediante 
la edición de tres o cuatro puntos.

168

file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c03ev41.htm
file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c03ev41.htm
file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c03ev44.htm
file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c03ev44.htm
file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c03ev9.htm
file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c03ev5.htm
file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c03ev5.htm
file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c03ev17.htm
file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c03ev17.htm
file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c03ev14.htm
file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\Timeline06.htm


Adición de múltiples clips mediante 
un proceso automatizado

Para ensamblar con rapidez el esbozo de un proyecto, o añadir una secuencia 
a un proyecto existente, puede añadir a la ventana de construcción múltiples 
clips desde la ventana de proyecto o de contenedor usando el comando 
Automate to Timeline del menú de la ventana de proyecto o de contenedor (o 
del menú general Edit). Cuando así se hace, Premiere hará lo siguiente:

• Si se está en el modo de edición A/B, alternará los clips de vídeo entre 
las pistas de Vídeo 1A y 1B, y los clips de audio entre las pistas 1 y 2 de 
audio. 

• Si se está en el modo de edición de una sóla pista (single-track), 
Premiere coloca todos los clips de vídeo en la pista de vídeo 1, y alterna 
los clips de auido entre las pistas 1 y 2 

Asímismo Premiere puede añadir automáticamente transiciones.

El comando Automate to Timeline sólo añade los clips que se encuentren en la 
ventana desde donde se ejecuta. Y así, si se ejecuta desde una ventana de 
contenedor, sólo se añadirán los clips de dicho contenedor. Si en la ventana 
hay contenedores, los clips existentes en éstos tampoco se añadirán.

Este comando también se puede ejecutar desde la ventana de Storyboard, en 
la que se pueden organizar los clips simplemente arrastrándolos. Consulte 
Creación de un storyboard.

Cuando se ejecuta este comando, aparece un cuadro de diálogo que permite 
especificar las siguientes opciones:

Contents Especifica que parte del contenedor se añadirá a la ventana de 
construcción. Puede elegirse entre

• Whole Bin (el contenedor entero): todos los clips se añadirán, con 
independencia de los que estuvieran seleccionados. 

• Selected Clips, sólo se añadirán los clips que estuvieran seleccionados. 

Ordering Especifica el método usado para determinar el orden en el que los 
clips se añadirán a la ventana de construcción. Puede ser:

• Sort Order: Premiere usará el criterio de ordenación especificado en la 
vista en modo de lista de la ventana de proyecto, con independencia de 
qué tipo de vista esté activa en ese momento. Si se está trabajando en 
la ventana StoryBoard, Sort Order utiliza el orden en el que aparecen los 
clips en ella, de izquierda a derecha y de arriba a abajo. 
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• Selection Order: Los clips se añadirán según el orden en el que fueron 
seleccionados. 

Nota: Cuando la ventana de proyecto se muestra en la vista de iconos, se 
pueden seleccionar clips arrastrando una marca de selección alrededor de ellos 
(dibujando un cuadrado en la ventana con el cursor del ratón, y seleccionando 
así todos los iconos que se encuentren en la zona marcada). Si se usa este 
método para seleccionar los clips, y se establece el orden como Selection 
Order, Premiere añadirá los clips usando el orden en el que los clips aparecen 
en la ventana de proyecto.

Placement Especifica cómo se colocarán los clips en la ventana de 
construcción. Si se elige Sequentially, los clips se colocarán en secuencia; en 
el modo de edición A/B se alternará entre las pistas de vídeo 1A y 1B, y en el 
modo de edición de una sóla pista, uno junto al otro, con las porciones de audio 
alternando entre las pistas Audio 1 y Audio 2. Si se elige At Unnumberd 
Markers, los clips se colocarán en las marcas no numeradas de la ventana de 
construcción.

La elección que se haga de esta opción determina cuál de las próximas 
opciones se mostrarán en el cuadro de diálogo.

• Si se elige como Placement Sequentially, aparecen las siguientes 
opciones 

o Insert At Especifica en qué lugar de la ventana de construcción 
se insertará el primer clip. Se puede elegir entre añadir al principio 
de la ventana de construccion, en la posición actual del punto de 
edición o al final de la ventana de construcción (es decir: los clips 
se añadirán después del último clip existente). 

o Clip Overlap Especifica la superposición entre clips adyacentes 
en la ventana de construcción. En esa zona de superposición es 
donde se colocan las transiciones, por lo que lo que aquí se elija 
afecta también a la duración de las transiciones que se añadan. 
El valor indicado se puede introducir por fotogramas o por 
segundos. Por defecto el valor es de 15 fotogramas: puede 
introducir otro valor, teniendo en cuenta que si se introduce un 
número negativo, se creará un hueco entre los clips. 

o Use Default Transition Cuando se marca esta opción , se coloca 
la transición por defecto entre dos clips. Dicha transición está 
definida en la paleta de transiciones. Esta opción no está 
disponible si Clip Overlap se establece con valor 0 (o negativo). 

o Perform Audio Cross Fade Cuando se marca esta opción se 
crea un cross fade de audio entre todos los clips de audio que se 
solapen. La opción no está disponible si como Clip Overlap se fijo 
un valor igual o inferior a 0 

• Si se eligió como Placement At unnumered markers, aparecen las 
siguientes opciones: 

o Inser at: Similar a la que aparece cuando se eligió Sequentially, 
pero no está disponible la última posibilidad: Añadir al final. 
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o Insufficient Material Especifica cómo debe gestionar Premiere el 
espacio entre clips, cuando los clips se deben añadir en las 
marcas y la duración de un clip no se ajusta al espacio entre la 
marca donde hay que insertarlo y la marca donde se debe 
insertar el próximo clip. Puede escoger Fit to Fill para adaptar la 
duración del clip al espacio disponible o Leave Gap para dejar 
espacio en blanco entre marcas. 

Ignore Audio Cuando se selecciona, se ignora el audio en los clips 
seleccionados para ser añadidos automáticamente a la ventana de 
construcción.
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Creación de un StoryBoard

Para especificar y organizar las tomas para una filmación o vídeo, los editores 
crean un storyboard, que es una colección de escenas, descripciones o ambas, 
dispuestas en orden.

De modo similar es posible organizar un grupo de clips en una ventana, y 
después moverlos a la ventana de construcción para crear un esbozo.

En la ventana de storyboard los clips están representados por iconos, similares 
a los que se muestran en la ventana de proyecto cuando se selecciona la vista 
de iconos. Cada icono muestra el mismo fotograma mostrada en la ventana de 
proyecto, el cual puede ser cambiado tal y como se explica en Personalización 
del aspecto de las ventanas de proyecto o contenedor.

Se puede elegir entre cuatro tamaños para los iconos. A cada icono se le 
asigna un número indicando su orden en la secuencia. Asímismo se muestran 
flechas desde un icono hasta el próximo, reprsentando así la secuencia. En el 
último icono hay un indicador de fin de secuencia.

A. Fotograma de muestra de un clip B. Nº de clip en la secuencia C. Nombre de fichero D. 
Duración E. Comentarios F. Flechas marcando la dirección del flujo G. Indicador de fin de 
secuencia

Desde la ventana de storyboard es posible mover automáticamente los clips a 
la ventana de construcción (Véase Adición de múltiples clips mediante un 
proceso automatizado), e igualmente es posible imprimir una secuencia en 
vídeo o exportarla a cinta (consulte Acerca de la exportación de vídeo con 
Premiere).

De los cuatro tamaños de iconos posibles, debe tenerse en cuenta que

• El número de clip en la secuencia sólo se muestra en los dos más 
grandes 

• La duración del clip sólo se muestra en los tres más grandes 
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• Los comentarios introducidos en la ventana de proyecto sólo se 
muestran en los dos más grandes. 

Para crear un storyboard:

1 Elija File > New > Storyboard.

2 Importe clips en la ventana de Storyboard usando uno de los siguientes 
métodos:

• Si está abierta una ventana de proyecto o de contenedor, y contiene 
clips, arrastre los clips deseados a la ventana de storuboard. 

• Elija File > Import y pulse un comando del menú de importación. 
Localice y seleccione los ficheros que se desean importar y pulse OK 

3 En la ventana de Storyboard arrastre los clips para reordenarlos según 
desee. Si se quiere colocar un clip antes de su lugar actual, arrástrelo hasta el 
clip que lo deba preceder. Si se quiere colocar un clip después de su ubicación 
actual, arrástrelo hasta el clip que lo deba seguir.

4 Si solo se quiere incluir ciertos clips, pulse Ctrl-click (Windows) o Shift-click 
(Mac OS) en los clips para seleccionarlos.

5 Elija File > Save As, especifique la localizacion y nombre de fichero para el 
storyboard, y pulse OK.

6 Haga click en el botón Automate to Timeline ( ) en la parte inferior de la 
ventana de Storyboard.

Para cambiar el tamaño de icono:

1 En el menú de la ventana Storyboard elija Storyboard Window Options.

2 Seleccione el tamaño de icono que se desea y pulse OK.
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Sustitución de fotogramas del 
programa mediante la edición de 
tres o cuatro puntos

Puede utilizar la ventana de monitor para sustituir una serie de fotogramas del 
clip de origen. Premiere permite la edición de tres y cuatro puntos, técnicas 
estándar en la edición de vídeo tradicional.
En la edición de tres puntos, para el origen y el programa juntos, debe marcar 
dos puntos IN y un punto OUT o dos puntos OUT y un punto IN. Este tipo de 
edición resulta útil cuando uno de los extremos del origen o del programa es 
crítico pero el otro no. Con la edición de tres puntos también puede ahorrar 
tiempo, ya que no tiene que especificar el cuarto punto y porque el proceso 
concluye con el punto de edición al final del clip, una posición cómoda para 
añadir otro clip después. Al añadir los fotogramas de origen a la ventana de 
construcción, Premiere determina el cuarto punto utilizando la duración desde 
los puntos IN y OUT especificados hasta el tercer punto. Por ejemplo, si marca 
un punto IN de origen de 00:03:15, un punto OUT de origen de 00:04:15 y un 
punto OUT del programa de 13:22:05, Premiere aplicará la duración de un 
segundo que hay entre los puntos IN y OUT de origen y el punto OUT del 
programa, definiendo automáticamente el punto IN del programa en 13:21:05. 
Puede dejar cualquier punto IN o OUT sin marcar, pero debe especificar un 
total de tres puntos IN y OUT.

En la edición de cuatro puntos, se marcan los puntos IN y OUT de origen y los 
puntos IN y OUT del programa. El cuarto punto de edición es útil en los casos 
en que tanto el fotograma inicial y final del origen y del programa son críticos. 
Si las duraciones marcadas del origen y del programa son diferentes, Premiere 
le notificará esta discrepancia y le propondrá alternativas para resolverla.
Puede previsualizar ediciones de tres o cuatro puntos sincronizando los 
controles de origen y de programa. Para obtener más información, consulte 
Previsualización de una edición mediante los controles de sincronización.

Para realizar una edición de tres puntos:

1 Configure los iconos Usar vídeo y Usar audio y las pistas de destino del 
programa (consulte Especificación de las pistas de origen y de destino).

2 En las vistas de origen y de programa, marque cualquier combinación de tres 
puntos IN y OUT (consulte Marcado y búsqueda de puntos IN y OUT).

3 Haga click en el botón Insertar ( ) o en el botón Superponer ( ).

Para realizar una edición de cuatro puntos:
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1 Configure los iconos Usar vídeo y utilizar audio y las pistas de destino del 
programa (consulte Especificación de las pistas de origen y de destino).

2 Mediante el control de origen, marque un punto IN y un punto OUT para el 
clip de origen. A continuación, utilice el control del programa para marcar un 
punto IN y OUT para el programa. (Consulte Marcado y búsqueda de puntos IN 
y OUT.).

3 Haga click en el botón Insertar ( ) o en el botón Superponer ( ). Si las 
duraciones del origen marcado del programa son diferentes, seleccione una de 
estas opciones cuando se le solicite:

• Change Speed, distribuye el intervalo de fotogramas de origen dentro de 
los puntos IN y OUT del programa especificados, aunque las duraciones 
sean diferentes. Esto modifica la velocidad del clip. 

• Trim Source, desplaza el punto OUT de origen especificado hasta que 
los fotogramas de origen encajen en el programa dentro de los puntos IN 
y OUT especificados. Esto no modifica la velocidad del clip. 

• Cancelar edición, deja todo sin modificar. 
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Selección de clips

Si desea realizar acciones que van a afectar al clip en su totalidad, como 
aplicar filtros, eliminar un clip o desplazar el clip en el tiempo, primero debe 
seleccionar el clip en la ventana de construcción. La caja de herramientas 
contiene herramientas de selección que pueden realizar diferentes tareas.

Para seleccionar uno o más clips:

Realice alguna de las siguientes acciones:

• Para seleccionar un solo clip, elija la herramienta de selección ( ) y 
haga click en un clip en la ventana de construcción. 

• Para seleccionar varios clips arrastrándolos, elija la herramienta para 
seleccionar rangos ( ) y trace un rectángulo arrastrando el cursor para 
incluir los clips que desee.

• Para seleccionar varios clips haciendo clic, elija la herramienta para 
seleccionar rangos ( ) y mantenga pulsada la tecla Mayúsculas 
mientras hace click en cada uno de los clips que desee seleccionar. La 
herramienta de selección de rango selecciona clips en grupos, y la 
herramienta de selección selecciona clips contiguos o todos los clips 
entre una selección previa y la selección actual. Para usar la 
herramienta de selección para seleccionar o deseleccionar clips 
individuales en varios lugares de la ventana de construcción, mantenga 
pulsada la tecla Control (Windows) o Comando (Mac OS), mientras hace 
click en los clips que desea seleccionar u omitir. 

• Para seleccionar todos los clips que existan en una pista a partir de 
cierto momento, utilice la herramienta de selección de pista ( ) y haga 
click en el clip que haya al principio del intervalo de tiempo que desee 
seleccionar. Pulse Mayúsculas mientras hace click para seleccionar clips 
en otras pistas. 
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• Para seleccionar clips completos o parciales que existen en un tiempo 
determinado o después de un tiempo determinado, utilice la herramienta 
de selección multipista ( ) haga click en el clip que hay al principio del 
intervalo de tiempo que desee seleccionar. 

• Para seleccionar un clip de vídeo vinculado con otro de audio (o al 
revés) y editarlo con independencia del clip que tiene vinculado, pulse el 
conmutador de sincronización ( ) en la parte inferior de la ventana de 
construcción, para desactivar el modo de sincronización, y después edite 
el clip. Cuando haya terminado pulse de nuevo el conmutador de 
sincronización para retornar al modo sincronizado. 

Nota: El modo sincronizado está desactivado cuando en el icono del botón no 
se ve ningún enlace.
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Desplazamiento de clips en el 
tiempo

En general, mover un clip es tan sencillo como arrastrarlo a un área vacía de 
una pista en la ventana de construcción. El clip se puede ajustar con el borde 
de otro clip, con una marca, con el principio o el final de la ventana de 
construcción y con el punto de edición.

Para desplazar un clip hacia adelante o hacia atrás en el programa:

Arrastre el clip hacia la izquierda o hacia la derecha y colóquelo manteniendo a 
la vista las líneas indicativas de los puntos IN y OUT (si trabaja en la misma 
pista) o el rectángulo negro que representa la duración del clip (si lo arrastra a 
otra pista diferente) y suelte el botón del ratón.

Nota: Si arrastra un clip que contiene vídeo y audio, y tiene activado el modo 
de sincronización (consulte Vinculación de clips de vídeo y audio en la ventana 
de construcción), Premiere intentará mantener ambos en la misma pista. Por 
ejemplo, si arrastra un clip a la pista Vídeo 3, Premiere arrastrará también el 
audio del clip a Audio 3, pero si intenta arrastrar la parte de vídeo del clip a un 
momento donde la pista Vídeo 3 esté vacía y Audio 3 esté ocupada Premiere 
moverá el clip de audio a la próxima pista de audio que esté libre en punto. Si 
no hubiera ninguna libre, Premiere no permitirá que el clip se mueva a dicho 
lugar.

Para ajustar el borde de un clip con el borde de otro clip o con una marca:

1 Asegúrese de que la opción Snap to Edges esté seleccionada en el menú de 
la ventana de construcción. De no ser así, puede escogerla en el menú de la 
ventana de construción, o pulsar el botón de alineación con los bordes bordes (

), en la parte inferior de la ventana de construcción.

2 Arrastre el borde de un clip hacia el borde del otro clip o de la marca.

Para ajustar una marca mientras arrastra el clip que la contiene:

1 Asegúrese de que la opción Snap to Edges esté seleccionada en el menú de 
la ventana de construcción. De no ser así, puede escogerla en el menú de la 
ventana de construción, o pulsar el botón de alineación con los bordes bordes (

), en la parte inferior de la ventana de construcción.

2 Con la herramienta de selección ( ), coloque el puntero sobre la marca que 
hay en el clip que desea mover. El puntero adoptará la forma de una flecha 
azul.

178

file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c03ev49.htm
file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c03ev49.htm


3 Cuando aparezca el puntero de la flecha azul, arrastre el marcador hacia el 
borde del otro clip, hacia una marca o hacia el punto de edición. Mientras 
arrastra, la flecha azul adopta la forma de una mano que agarra y la marca que 
está arrastrando se ajusta a los bordes del otro clip, marca o punto de edición.
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Edición de un clip que se encuentra 
entre otros clips de la ventana de 
construcción

Antes de editar un clip en la ventana de construcción, debe decidir cómo desea 
que la edición afecte a los clips adyacentes y a la duración del programa. Por 
ejemplo, si reduce un clip moviendo su punto OUT a una posición anterior en el 
tiempo, ¿prefiere que todos los clips que le siguen permanezcan en su sitio o 
que rellenen el hueco dejado por el clip ajustado? Puede realizar ediciones que 
permitan especificar exactamente lo que ocurrirá con los clips adyacentes al 
clip que está ajustando. Esto facilita una correcta edición la primera vez y 
mantiene la integridad del resto del programa de vídeo.

Premiere admite las siguientes formas de edición para un clip y sus clips 
adyacentes:

Edición de enrollado

La edición de enrollado mantiene constante la duración del programa y además 
mantiene la duración combinada de los dos clips que se están editando. Se 
ajusta el punto de edición, y los fotogramas que se añadan o eliminen de un 
clip se añaden o eliminan del clip del otro lado del punto de edición. Para hacer 
un corte L, desactive el modo de sincronización antes de realizar una edición 
de enrollado.

En esta edición de enrollado, el punto de edición se ha arrastrado a un momento anterior en el 
tiempo, reduciendo el clip anterior, alargando el siguiente y manteniendo la duración del 
programa.
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Para realizar esta edición:

1 Seleccione la herramienta de edición de enrollado (rolling edit tool) ( ).

2 Coloquela en el borde del clip que desee modificar y arrastre hacia la 
izquierda o hacia la derecha. Si el modo de sincronización está desactivado, la 
cabecera de la flecha de la herramienta de edición de enrollado se verá 
atenuada y desconectada de su eje, indicando que se está editando sólo el 
vídeo o el audio de un clip que contiene vídeo y audio. El mismo número de 
fotogramas añadidos al clip son los que se recortan del clip adyacente.

La ventana de construcción durante (izquierda) y después (derecha) de una edición de 
enrollado

Edición de rizo

La edición de rizo mantiene la duración de todos los demás clips modificando la 
duración total del programa. Se arrastra el punto de edición y la duración total 
del programa se alarga o reduce según el número de fotogramas añadidos o 
eliminados del clip que se está editando. Si hay un espacio vacío en uno de los 
lados del punto de edición, se tratará como si fuera un clip y será ajustado por 
la herramienta de edición de rizo como si fuera un clip. La edición de rizo puede 
controlar el material cambiado en todas las pistas, o sólo en las definidas como 
Destio en el cuadro de diálogo de opciones de la ventana de construcción.
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En esta edición de rizo, el punto de edición se ha arrastrado a un momento anterior en el 
tiempo, reduciendo el clip anterior y la duración del programa.

Para realizar una edición de rizo:

1 Seleccione la herramienta de edición de rizo (ripple edit tool) ( ).

2 Colóquela en el punto In o en el punto Out del clip a editar, y arrastre a 
izquierda o derecha. La duración del programa se alarga o reduce para 
compensar la edición, mientras que la duración de los clips adyacentes 
permanece inalterada

Cuando un clip no tiene fotogramas adicionales disponibles, la cabeza del 
puntero de la herramienta desaparecerá. Si el modo de sincronización está 
desactivado, la cabeza del puntero será blanca, indicando que se está editando 
sólo la porción de vídeo o audio de un clip que contiene vídeo y audio.

La Ventana de construcción durante (izquierda) y después (derecha) de una edición de 
rizo 
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Edición de desplazamiento

La edición de desplazamiento permite desplazar en cualquier dirección los 
fotogramas inicial y final de un clip, sin que ello afecte a otros elementos de la 
ventana de construcción. Se arrastra el clip hacia la derecha o hacia la 
izquierda y sus puntos IN y OUT de origen se desplazan en consecuencia. La 
duración del programa y los puntos IN y OUT de origen y del programa de los 
demás clips permanecen inalterados. Esta herramienta no requiere que haya 
un clip en el otro lado del clip cuya duración se está ajustando.

En esta edición de desplazamiento, se arrastra un clip hacia la izquierda, desplazando sus 
puntos IN y OUT de origen hacia adelante en el tiempo.

Para realizar una edición de desplazamiento:

1 Seleccione la herramienta de edición de desplazamiento ( ).

2 Coloque el puntero en el clip de vídeo que desee ajustar y realice una de las 
siguientes acciones:

• Arrastre hacia la izquierda para desplazar los puntos IN y OUT de origen 
a una posición anterior del clip. 

• Arrastre hacia la derecha para desplazar los puntos IN y OUT de origen 
a una posición posterior del clip. 
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Premiere actualiza los puntos IN y OUT del clip y muestra el resultado en la 
ventana de monitor, manteniendo la duración del clip y del programa.

Edición de deslizamiento

La edición de deslizamiento mantiene la duración de un clip y del programa 
cambiando los puntos IN y OUT de los clips precedentes y posteriores. Al 
arrastrar un clip hacia la izquierda o hacia la derecha, el punto OUT del clip 
precedente, el punto IN del clip siguiente y los puntos IN y OUT del programa 
del clip se desplazan un número de fotogramas equivalente al del clip 
desplazado. Los puntos IN y OUT de origen del clip y la duración del programa 
permanecen inalterados. Esta herramienta requiere que haya un clip en el otro 
lado del clip que se está ajustando.

En esta edición de deslizamiento, se arrastra un clip hacia a izquierda de forma que empieza 
antes en el programa, reduciendo el clip precedente y alargando el clip siguiente.

Nota: Si realiza alguna acción que amplíe la duración de un clip, deben existir 
fotogramas adicionales disponibles en el clip maestro de origen más allá de los 
puntos IN o OUT actuales. Por ejemplo, si no recortó el principio o el final de un 
clip de origen antes de añadirlo a la ventana de construcción, el clip ya está 
utilizando todos los fotogramas disponibles de su origen, por lo que no se 
puede aumentar la duración.

Para realizar una edición de deslizamiento:

1 Seleccione la herramienta de deslizamiento ( ).
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2 Coloque el puntero en el clip de vídeo que desee ajustar y realice una de las 
siguientes acciones:

• Arrastre hacia la izquierda para desplazar el punto OUT del clip 
precedente y el punto IN del clip siguiente a una posición anterior en el 
tiempo. 

• Arrastre hacia la derecha para desplazar el punto OUT del clip 
precedente y el punto IN del clip siguiente a una posición posterior en el 
tiempo. 

Al soltar el botón del ratón, Premiere actualiza los puntos IN y OUT de los clips 
adyacentes y muestra el resultado en la ventana de monitor, manteniendo la 
duración del clip y del programa. El único cambio realizado al clip que se ha 
desplazado es su posición en la ventana de construcción.

Nota: Las herramientas de desplazamiento y deslizamiento no se pueden 
utilizar directamente en clips de audio, pero si las utiliza en clips de vídeo, 
todos los clips de audio vinculados se ajustan para que coincidan.
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División de un clip

Puede dividir un clip en la ventana de construcción mediante la herramienta 
para cortar ( ). 

Al cortar un clip, en realidad se hace lo siguiente: 

• En el clip original se establece como punto Out el del lugar del corte. 
• Se crea una nueva copia del clip y se establece como punto In el del 

lugar del corte, y como punto Out el punto Out original del Clip. 

Esto resulta de utilidad cuando desee utilizar efectos diferentes que no pueden 
aplicarse a la vez a un mismo clip, como una cantidad de fotogramas por 
segundo diferente, por ejemplo. Al dividir un clip, Premiere crea una copia 
nueva del clip y de los clips a los que esté vinculado.

Si el modo de sincronización está desactivado, Premiere cortará sólo la porción 
de audio o vídeo del clip.

Nota: Si desea cambiar las configuraciones de filtros a lo largo del tiempo, no 
necesita dividir el clip. En vez de esto, puede aplicar keyframes a un solo clip. 
Consulte Comprender los KeyFrame.

Para dividir un clip:

Realice una de las siguientes acciones:

• Coloque el punto de edición donde desee dividir el clip y seleccione 
Timeline > Razor at Edit Line. 

• Seleccione la herramienta para cortar ( ) y exactamente en el lugar 
donde desea dividir un clip de la ventana de construcción, haga click 
sobre él con dicha herramienta. 

Para dividir varias pistas en el mismo punto de la ventana de 
construcción:

Seleccione la herramienta para multicortar clips ( ) y haga click en un clip de 
la ventana de construcción, donde desee dividirlo. Premiere divide todos los 
clips no bloqueados de todas las pistas no bloqueadas de dicho punto de 
tiempo en dos copias separadas en el programa.
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Cortar y pegar clips y 
configuraciones de los clips

Es posible reorganizar los clips existentes en la ventana de construcción 
mediante el proceso de cortar y pegar. Si se limita a pegar un clip, Premiere lo 
inserta en la ventana de construcción, y si el clip a pegar tuviera una duración 
superior al tamaño hueco de la ventana de construcción donde se inserta, se 
recortará la duración (modificando el punto Out).

Es posible obtener otros resultados. Premiere dispone de opciones que 
permiten controlar con exactitud lo que le ocurre a los clips del punto de edición 
cuando se pegan. Este tipo de control es útil sobre todo al pegar un clip de una 
duración determinada en un espacio seleccionado con otra duración diferente.

También es posible aplicar la opción de "copiar", no al clip en sí, sino a sus 
configuraciones de tal manera que se puedan después utilizar en otro clip. Por 
ejemplo, si desea aplicar una corrección de color idéntica a una serie de clips 
capturados en la misma sesión.

Para encajar un clip en el espacio seleccionado al pegarlo:

1 Seleccione un clip y elija Edit > Copy o Edit > Cut.

2 Seleccione un segmento vacío en la ventana de construcción.

3 Elija Edit > Paste to Fit.

4 Elija entre alguna de las siguientes opciones que se mostrarán a 
continuación:

• Change Speed: altera la velocidad de reproducción del clip 
(acelerándola o frenándola) para ajustar su duración al espacio 
disponible en la ventana de construcción. 

• Trim Source: ajusta la duración conservando el punto In del clip original, 
pero estableciendo un nuevo punto Out. 

Para controlar la forma en que un clip se pega en el espacio 
seleccionado:

1 Seleccione un clip y elija Edit > Copy o Edit > Cut.

2 Seleccione un segmento vacío en la ventana de construcción.

3 Elija Edit > Paste Attributes, y asegúrese de haber seleccionado Content.
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4 Seleccione una opción en el menú. Aparecerá una representación animada 
de la opción en la sección Content que le ayudará a determinar si la opción 
seleccionada es la adecuada.

5 Pulse Paste.

Para transferir las configuraciones de un clip a otro clip:

1 Seleccione un clip al que haya aplicado filtros, control de nivel, transparencia 
o movimiento y, a continuación, elija Edit > Copy o Edit > Cut.

2 Seleccione un clip en la ventana de construcción.

3 Elija Edit > Paste Attributes.

4 Haga click en Configuraciones y seleccione los que desee pegar.

5 Haga click en Paste.

Supresión de espacios entre clips

Los espacios vacíos que hay entre los clips de una pista se pueden eliminar 
rápidamente mediante el comando Ripple Delete. 

Para eliminar espacios vacíos entre los clips:

Seleccione el espacio vacío y elija Timeline > Ripple Delete.
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Supresión de un clip o de un grupo 
de fotogramas del programa

Es posible eliminar un clip entero o un rango de fotogramas de la ventana de 
construcción. Premiere proporciona dos maneras de eliminar grupos de 
fotogramas:

• El levantado (Lifting) elimina los fotogramas del programa y deja un 
espacio de la misma duración que los fotogramas eliminados. 

• La extracción (Extracting) elimina los fotogramas del programa y cierra el 
espacio resultante mediante la eliminación de espacios vacíos. 

Estos métodos resultan especialmente útiles cuando se desean eliminar 
fotogramas situados en la parte central de un clip o de varios clips de la misma 
pista. Si sólo desea eliminar los fotogramas de un extremo del clip, sólo tiene 
que recortar este extremo (consulte Edición de un clip que se encuentra entre 
otros clips en la ventana de construcción).

Para eliminar fotogramas sin que los otros clips se vean afectados 
(levantado):

Realice una de las siguientes acciones:

• Para eliminar un clip completo, seleccione el clip en la ventana de 
construcción y pulse la tecla Suprimir. 

• Para eliminar un rango de fotogramas, utilice el control del programa 
para especificar los puntos IN y OUT a eliminar y haga click en el botón 
Lift ( ) de la ventana de monitor. 

Para eliminar fotogramas y cerrar el espacio resultante (extracción):

Realice una de las siguientes acciones:

• Para eliminar un clip completo, seleccione el clip en la ventana de 
construcción y elija Timeline > Ripple Delete. 

• Para eliminar un rango de fotogramas, utilice el control del programa 
para especificar los puntos IN y OUT a eliminar y haga click en el botón 
Extract ( ) de la ventana de monitor. 

Para eliminar todos los clips de una pista:
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1 Seleccione la herramienta para seleccionar pistas ( ).

2 haga click en el primer clip de la pista y pulse Suprimir.

Nota: También se pueden eliminar las pistas. Consulte Añadir, renombrar y 
borrar pistas.
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Víncular clips de vídeo y audio en la 
ventana de construcción

Cuando se añade al programa un clip que contiene vídeo y audio y se ha 
especificado que se van a añadir estas partes, (consulte Especificación de las 
pistas de origen y de destino), la parte del vídeo aparece en una pista de vídeo 
y la de audio en una pista de audio. Estas partes de vídeo y audio del clip están 
vinculadas, de forma que cuando arrastra la parte de vídeo a la ventana de 
construcción se incluye el audio vinculado con ella. Si divide el clip, vídeo y 
audio siguen vinculados en los dos clips resultantes.

Sólo puede vincular el vídeo con el audio (y no un clip de vídeo con otro clip de 
vídeo).

En muchas situaciones resulta de utilidad vincular o desvincular los clips 
manualmente. Por ejemplo, puede que quiera mover juntos clips de audio o 
vídeo que se hayan desvinculado previamente o editar el punto IN o OUT de la 
parte de vídeo o de audio de forma independiente. No es necesario desvincular 
los clips si lo único que desea es eliminar uno u otro clip.

Cuando se quiere trabajar con clips vinculados individualmente, temporalmente 
puede desactivar la sincronización usando el Comnutador de Modo 
sincronizado. Cuando el modo sincronizado está activado, ambos clips 
vinculados se consideran como una sola unidad. Es decir: todas las 
herramientas de la ventana de construcción actúan en ambos clips, y ambos 
clips se ven afectados cuando se seleccionan, recortan, dividen, borran, 
mueven o se cambia la duración o velocidad. Cuando el modo de 
sincronización está desactivado, los clips vinculados pueden ser editados 
independientemente, como si no estuvieran vinculados entre sí. Premiere, no 
obstante, continua manteniendo la información necesaria para la 
sincronización, incluso cuando este modo se desactiva. Así cuando los clips se 
mueven a un lugar donde no se pueden sincronizar, ambos clips muestran un 
triándolo rojo en el punto In, para indicar tal circunstancia.

Nota: Las opciones On Insert en el cuadro de diálogo de opciones de la 
ventana de construcción, controlan cómo se insertan los clips, con 
independencia de la configuración de modo de sincronización. Así, si se 
selecciona la opción Shift Material in All Tracks, todas las pistas se verán 
afectadas como respuesta a una edición. Si se selecciona Shift Material Only in 
Target Tracks, solo se moverán los clips en la pista destino.

En otras palabras: el modo de sincronización especifica qué porción de un clip 
es editada, y las opciones On Insert especifican qué clips serán desplazados o 
modificadas como respuesta a una edición.

192

file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c03ev14.htm
file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c03ev14.htm


Las porciones de vídeo y de audio de los clips vinculados se muestran en color 
verde claro, así se puede saber sólo mirando la ventana de construcción, qué 
clips están vinculados.

Para vincular el vídeo y el audio:

Seleccione la herramienta link/unlink ( ), haga click en el primer clip que 
desee vincular y, a continuación, en el segundo clip que desee vincular.

Para desvincular el vídeo y el audio:

Realice alguna de las siguientes acciones:

• Seleccione un clip vinculado y elija Clip > Unlink Audio and Video. Una 
marca blanca se añade a cada clip desvinculado. Si se quieren realinear 
estos clips después de haber sido movidos con independencia, arrastre 
la marca hasta la marca correspondiente del otro clip. 

• Seleccione la herramienta link/unlink ( ), haga click sobre el primer clip 
a desvincular, y después sobre el segundo. 

Para revincular clips que se han movido a un lugar donde no se pueden 
sincronizar:

1 Haga click y sostenga el tríangulo rojo que aparece juto al punto In del clip 
fuera de sincronización. Aparecerá un cuadro mostrando la cantidad de tiempo 
en el que el clip está dessincronizado.

2 Arrastre por el interior del cuadro, y suelte el botón del ratón.

Para editar individualmente clips vinculados:

Pulse el conmutador de modo de sincronización (Toggle Sync Mode) ( ) para 
desactivar el modo de sincronización, y edite uno de los clips (el de vídeo o 
audio) usando las herramientas de la ventana de construcción. Cuando haya 
terminado, vuelva a pulsar el conmutador para reactivar el modo de 
sincronización.
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Uso de la vista de recorte (en la 
ventana de monitor)

La vista de recorte de la ventana de monitor está pensada para mostrar el 
fotograma final y el fotograma inicial de dos clips que están adyacentes. De 
esta manera resulta sencillo indicar exactamente por donde cortar uno de ellos.

La vista de recorte de la ventana de monitor constituye un método de precisión 
para recortar los clips interactivamente. Se pueden realizar ediciones de 
enrollado o de rizo en cualquier parte de la ventana de construcción. A medida 
que realice los ajustes, verá los fotogramas a ambos lados de la edición.

También es posible establecer un rango de fotogramas para ver a ambos lados 
del punto de edición, de tal modo que se pueda apreciar con más facilidad el 
contexto. La ventana de construcción se va modificando conforme se ejecuta la 
edición.

Para pasar a la vista de recorte:

Haga Click en el botón Trim Mode ( ) en la parte superior de la ventana de 
Monitor. También es posible elegir Trim Mode del menú de la ventana de 
monitor.

Para buscar la edición que desea recortar:

1 Seleccione la pista de destino en el menú que hay en la parte inferior de la 
ventana.

2 Pulse los botones Previous Edit ( ) o Next Edit ( ) . La ventana se irá 
desplazando (hacia atrás o hacia delante) por los distintos clips existentes en la 
pista, mostrando, en cada caso, el último fotograma del clip de la izquierda y el 
primero del clip de la derecha.

194



Para realizar una edición de rizo en la vista de recorte:

1 Haga click en la vista izquierda o derecha para activar el clip que desea 
recortar. El clip activo se reconoce por los números verdes del código de 
tiempo y por los botones Set Focus Left o Set Focus Right (según el foco esté a 
la izquierda o derecha, el botón correspondiente aparecerá hundido o 
presionado).

2 Siga estos procedimientos en cualquier combinación:

• Para eliminar un fotograma del clip izquierdo cuando está activo o para 
añadir un fotograma al clip de la derecha cuando está activo, pulse el 
botón Trim Left ( ). 

• Para editar varios fotogramas, pulse el botón Trim Left n Frames button (
). 

• Para añadir un fotograma al clip en el lado izquierdo cuando está activo, 
o borrar un fotograma del clip en el lado derecho cuando está activo, 
pulse el botón Trim Right ( ). 

• Para editar varios fotogramas pulse el botónTrim Right n Frames ( ).

Nota: Puede definir el número de fotogramas que se editan con los botones 
Cortar n fotogramas a la izquierda o Cortar n fotogramas a la derecha (consulte 
el procedimiento Para establecer las opciones de la vista de recorte, más 
adelante en este mismo tema de ayuda)

  Para ejecutar una edición de rizo numéricamente, escriba un numero 
negativo (para mover a la izquierda) o un número positivo (para movera a la 
derecha) en el espacio entre los botones, y pulse Enter (Windows) o Return 
(Mac OS). 
  Para realizar una edición de rizo interactiva, coloque el cursor del ratón 
sobre la línea existente en la parte inferior de cada vista hasta que se convierta 
en la herramienta correspondiente de edición de rizo ( ) o ( ), tras lo cual 
bastará con arrastrar en la dirección adecuada. 

Para realizar una edición de enrollado en la vista de recorte

1 Pulse el botón Set Focus Both ( ) o Haga click entre las dos vistas para 
activar los clips a la izquierda y a la derecha del punto de edición.

2 Realice una de las siguientes acciones:

• Para eliminar un fotograma del clip izquierdo y añadir un fotograma al 
derecho, haga click en el botón Trim Left ( ). 

• Para editar varios fotogramas, haga click en el botón Cortar 5 
fotogramas a la izquierda ( ). 

• Para añadir un fotograma al clip y eliminar un fotograma del clip de la 
derecha, haga click en el botón Trim Right ( ). 

195



• Para editar varios fotogramas, haga click en el botón Cortar 5 
fotogramas a la derecha ( ).

Nota: Puede definir el número de fotogramas que se editan con los botones 
Cortar n fotogramas a la izquierda o Cortar n fotogramas a la derecha. Para ello 
consulte el procedimiento "Para establecer las opciones de la vista de recorte", 
más adelante en este tema de ayuda

  Para ejecutar una edición de enrollado numéricamente, escriba un número 
negativo (para mover a la izquierda) o un número positivo, (para mover a la 
derecha) en el espacio entre los botones, y pulse Enter (Windows) o Return 
(Mac OS). 
  Para realizar una edición de enrollado interactiva, arrastre a izquierda o 
derecha en el espacio vacío entre las dos vistas. 

Para cancelar una edición:

Pulse el botón Cancel Edit ( ).

Para previsualizar la edición:

Pulse el botón Play Edit ( ).

Para volver a la vista dual:

Pulse el botón Dual View ( ) en la parte superior de la ventana de monitor.

Para establecer las opciones de la vista de recorte:

1 En el menú de la ventana de monitor elija Monitor window Options.

2 En la sección Trim Mode Options, seleccione una de las siguientes opciones:

• Haga click en la primera opción para mostrar el fotograma que hay a la 
izquierda de la cola (el clip a la izquierda del punto de edición) y el 
fotograma que hay a la derecha de la cabeza (el clip a la derecha del 
punto de edición) 

• Haga click en la segunda opción para mostrar la cola del clip izquierdo 
con representaciones pequeñas de los fotogramas que hay antes y 
después de la cola, y para mostrar la cabeza del clip derecho con 
representaciones pequeñas de los fotogramas que hay antes y después 
de la cabeza. 

• Haga click en la tercera opción para mostrar (de arriba a abajo) 
representaciones pequeñas del quinto y primer fotograma antes de la 
cola del clip izquierdo o la cabeza del clip derecho, una representación 
grande de la cola y de la cabeza y representaciones pequeñas del 
primer y quinto fotograma después de la cola y de la cabeza. 
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3 En Large Frame Offset (desplazamiento de fotograma grande), especifique el 
número de fotogramas que se recortarán cuando utilice los botones de recorte 
de varios fotogramas ([ ] o [ ]) que cortan 5 fotogramas de manera 
predeterminada.

4 Seleccione Play Previews at Maximum Size cuando el tamaño del fotograma 
del programa sea menor que el espacio disponible en la ventana de monitor y 
desee que los previos de los recortes se muestren con el mayor tamaño posible 
que encaje en la ventana de monitor. A continuación, haga click en OK.
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Anidado de ediciones mediante clips 
virtuales

Un clip virtual es un clip que no existe, pero que existiría si se exportara a un 
fichero el contenido de la ventana de construcción o de una parte de la misma. 
Premiere permite en un momento dado definir el contenido de la ventana de 
construcción como clip virtual y, a partir de ahí, utilizarlo en la edición como un 
clip más.

Al igual que éste, un clip virtual puede contener varios clips, transiciones y 
efectos y ocupar varias pistas. Una vez definido, puede utilizar el clip virtual en 
el programa principal el número de veces que desee. Premiere trata y muestra 
el clip virtual como un solo clip, al que puede editar y aplicar configuraciones de 
la misma forma en la que lo haría con un clip de vídeo de origen. El uso de 
clips virtuales para organizar y agrupar secuencias permite ahorrar tiempo en 
ediciones de programas de vídeo complicados. Mediante los clips virtuales se 
puede hacer lo siguiente:

• Reutilizar trabajos anteriores. Por ejemplo, si crea una secuencia corta 
que incluya cuatro pistas de vídeo superpuestas y tres pistas de audio 
mezcladas y desea utilizarla diez veces en el proyecto, sólo necesita 
crearla una vez, obtener un clip virtual a partir de ella y añadir diez 
copias del clip virtual a la ventana de construcción. 

• Aplicar diferentes configuraciones a las copias de una secuencia. Por 
ejemplo, si quisiera que una secuencia se reprodujese repetidamente 
con un filtro distinto cada vez, podría crear un clip virtual y copiarlo para 
cada copia en la que desee que aparezca un efecto diferente. 

• Actualizar de una sola vez secuencias dispersas que sean idénticas. Por 
ejemplo, si crea el clip virtual descrito antes y lo utiliza diez veces, puede 
actualizar simultáneamente las diez copias del clip virtual simplemente 
editando los clips en el área de la ventana de construcción del clip 
virtual. Si se aplican efectos diferentes a cada copia de un clip virtual, 
éstos se mantienen para cada uno de ellos. Si copió y pegó la secuencia 
en lugar de crear un clip virtual, tendría que actualizar una secuencia y 
pegar a continuación la actualización nueve veces; o bien, editar cada 
copia individualmente. 

• Aplicar configuraciones más de una vez al mismo clip. Por ejemplo, hay 
ciertos efectos que sólo se pueden obtener combinando transiciones. No 
obstante, no se puede aplicar más de una transición en un mismo punto 
en el tiempo (a no ser que utilice un clip virtual). Por ejemplo, puede 
aplicar una transición entre dos clips de la ventana de construcción fuera 
del programa principal, crear dos clips virtuales utilizando los clips del 
otro lado de esa transición y mover los nuevos clips virtuales a la 
ventana de construcción. La primera transición aplicada se encuentra 
ahora dentro de cada clip virtual, de forma que ya puede aplicar una 
segunda transición entre los dos clips virtuales. 
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Al copiar y pegar varias veces una secuencia en la ventana de construcción se crean muchos 
objetos en esta ventana.

Con los clips virtuales se obtiene el mismo resultado, pero de una forma mucho más sencilla.

Al crear clips virtuales, tenga en cuenta lo siguiente:

• Un clip virtual siempre representa el estado actual del área original de la 
ventana de construcción en la que se basa, de forma que si edita esta 
área, el clip virtual se verá afectado de la misma manera. 

• Debido a que los clips de un clip virtual deben estar en la ventana de 
construcción, pero fuera del programa principal de vídeo, es aconsejable 
crear clips virtuales en un área definida fuera y antes del inicio del 
programa principal en la ventana de construcción. Esto reduce la 
posibilidad de que las ediciones realizadas al programa principal (como 
las ediciones de rizo) modifiquen accidentalmente áreas de la ventana 
de construcción que contengan clip virtuales. También puede proteger 
los clips originales creando los clips virtuales en pistas diferentes a las 
que contienen el programa principal o las superposiciones y bloqueando 
los clips en sus pistas (consulte Bloqueo y desbloqueo de pistas o 
Bloqueo y desbloqueo de clips). 

• Un clip virtual puede contener uno o más clips virtuales. Esta técnica se 
denomina anidado y puede ser de utilidad cuando tenga que organizar 
un jerarquía compleja de efectos. En Premiere se pueden anidar hasta 
64 niveles de clips virtuales. 

• Debido a que los clips virtuales pueden contener referencias a muchos 
clips, se puede necesitar más tiempo de proceso para que Premiere 
aplique las acciones a todos los clips componentes. 

• Como cualquier cambio hecho a los clips originales de un clip virtual, 
alterarán el clip virtual resultante, no puede colocarse un clip virtual por 
encima, por debajo o antes de sus clips originales en la ventana de 
construcción. Si lo hace Premiere no podrá crear un fichero de 
previsualización y la vista del programa se mostrará como una pantalla 
negra o líneas amarillas y negras. 
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Para crear un clip virtual:

1 Arrastre las marcas del área de trabajo para marcar el principio y el final del 
programa principal (consulte Previsualización de un programa de vídeo). Como 
está a punto de crear un segundo programa dentro de la ventana de 
construcción, definir el área de trabajo para el programa principal sólo permite 
asegurarse de que al terminar el programa, exportará sólo el principal y no el 
resto de las áreas de la ventana de construcción.

2 En un área de la ventana de construcción que esté fuera del área de trabajo 
del programa principal (preferiblemente antes), añada y edite los clips que 
desee en su clip virtual. Aplique efectos y transiciones si lo desea

3 Utilice la herramienta para seleccionar bloques ( ).

4 race un rectángulo arrastrando el cursor para definir los límites de tiempo de 
los clips que desea incluir en el clip virtual. Puede incluir partes de clips. 
Premiere sólo utilizará las partes de clips que haya dentro del rectángulo que 
acaba de trazar.

5 Coloque la herramienta de selección de bloques dentro del rectángulo. El 
puntero adopta la forma de la herramienta de clips virtuales ( ).

6 Arrastre el bloque seleccionado a cualquier posición disponible de la ventana 
de construcción. También puede usar sólo las porciones de audio o de video de 
los clips originales manteniendo pulsada la tecla Shift mientras se arrastra la 
porción deseada. Mientras se realiza el arrastre, el clip virtual se representará 
mediante un rectángulo negro idéntico al que aparecía cuando arrastró un clip 
de origen
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Izquierda: Arrastrando para seleccionar el area que se incluirá en el clip virtual. 
Derecga; arrastrando la selección para crear un clip virtual

Para localizar los fotogramas originales que comprenden un clip virtual:

Realice una de las siguientes acciones:

• En la ventana de construcción, haga doble click en el clip virtual. 
• En la ventana de construcción, seleccione el clip virtual y elija Edit > 

Locate Clip. 

La ventana de construcción muestra el rectángulo de selección alrededor de los 
fotogramas de origen del clip virtual.

Puede cambiar el área de la ventana de construcción que es origen de un 
clip virtual simplemente arrastrando el borde del clip virtual. Puede observar la 
diferencia si hace doble click en el clip virtual antes y después de recortarlo
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Creación de una cuenta atrás

En los primeros tiempos del cine sonoro, la imagen y el sonido no se 
encontraban en la misma cinta sino en cintas independientes. Por ello el 
operador tenía que activar el proyector y el reproductor de sonido exactamente 
en el mismo momento. Para ayudarle las películas empezaban con una cuenta 
atrás: al llegar al cero era el momento de activar el sonido.

Todavía hoy se utilizan las cuentas atrás, aunque, más que nada, para producir 
el efecto de "antiguo".

Premiere permite crear y personalizar una cuenta atrás universal, de 11 
segundos de duración, que se puede añadir al principio de un Proyecto.

Para crear una cuenta atrás:

Haga click en el botón Create Item, en la parte inferior de la ventana de 
proyecto (o pulse File > New > Universal Counting Leader), y elija Universal 
Counting Leader del menú que aparecerá. A continuación especifique las 
siguientes opciones:

Wipe Color (Color de la cortin) Permite especificar un color para el área 
circular de un segundo de barrido.

Background Color (Color del fondo) Permite especificar un color para el área 
posterior a la cortina.

Line Color (Color de línea) Permite especificar un color para las líneas 
horizontales y verticales.

Target Color (Color del objetivo) Permite especificar un color para el doble 
círculo alrededor del número.

Numeral Color (Color del número) Permite especificar un color para el número 
del contador.

Cue Blip on Out (Señal al final) Selecciónelo para mostrar una pequeña marca 
circular en el último fotograma del contador.

Cue Blip on 2 (Señal en el 2) Selecciónelo para que se oiga un pitido en la 
marca de dos segundos.

Cue Blip at All Second Starts (Señal cada segundo) Selecciónelo para que se 
oiga un pitido al principio de cada segundo, durante la ejecución del contador.
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Se puede personalizar la cuenta atrás haciendo doble click en él y 
modificando las opciones.
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Creación de barras de color y de un 
tono de 1 KhZ

En muchas ocasiones se colocan barras de color al principio de un programa 
para ayudar a calibrar el monitor de vídeo que mostrará el programa. 
Igualmente mientras se muestran las barras, es corriente que suene un tono de 
1 Khz para ayudar a calibrar el audio.

Premiere permite incluir un clip que contenga barras de color y el tono de 
audio. La duración de este clip es de 10 segundos.

Para crear barras de color y un tono de un 1Khz:

Pulse el botón Create Item, en la parte inferior de la ventana de proyecto, y elija 
Bars and Tone del menú que se mostrará (o Seleccione File > New > Bars and 
tone)
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Creación de vídeo negro

Se puede crear un clip de vídeo negro para insertarlo en cualquier sección del 
programa. El clip de vídeo negro consiste en una imagen fija con una 
resolución de 640 x 480 y una duración de cuatro segundos. La duración 
puede, no obstante, ajustarse arrastrando cualquiera de los bordes del clip. 
Para insertar un clip de un color diferente, use una máscara de color. Consulte 
Adición de una máscara de fondo.

Para crear un vídeo negro:

Pulse el botón Create Item, en la parte inferior de la ventana de proyecto, y elija 
Black Video del menú que se mostrará (o elija File > New > Black Video).
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Previsualización del programa de 
vídeo

Premiere permite previsualizar una parte o todo el programa, sin tener que 
exportarlo. Las previsualizaciones pueden reproducirse en la vista del 
programa del monitor, en el centro de un monitor sobre un fondo negro o en 
cualquier monitor compatible NTSC o PAL conectado al ordenador. La 
previsualización es relativamente rápida en el caso de un programa que sólo 
consista en cortes entre los clips. La aplicación de transiciones, filtros, efectos o 
configuraciones de superposición, aumentan el tiempo que se tarda en 
procesar la previsualización.

Premiere ofrece varios métodos para previsualizar el programa. La elección de 
uno u otro dependerá de si se quiere una previsualización rápida, una 
previsualización a la velocidad adecuada, o una previsualización intermedia 
entre las dos anteriores. La apariencia de la previsualización se controla por la 
configuración de vídeo en el cuadro de diálogo de configuración de proyecto 
(consulte Especificar la configuración del proyecto).

El área que será previsualizada es denominada área de trabajo y queda 
definida, por una barra amarilla que se extiende por la parte superior de la 
ventana de construcción, en la zona llamada Banda del área de trabajo. La 
barra de área de trabajo automáticamente se expande para comprender todo el 
programa cuando se añaden clips a la ventana de construcción; pero también 
se puede ajustar manualmente.

Usando ciertas tarjetas de vídeo es posible ver en tiempo real programas de 
vídeo que incluyan transiciones, configuraciones de movimiento y efectos, sin 
necesidad de renderizar la previsualización. Para ello es preciso que la tarjeta 
de vídeo tenga capacidad para trabajar en tiempo real. Para obtener 
información sobre si su tarjeta tiene o no tal capacidad, consulte la 
documentación de la misma.

Para establecer el área de previsualización (el área de trabajo):

Realice una de las siguientes acciones:

• Arrastre la barra del área de trabajo sobre la zona que desee 
previsualizar. 
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A la izquierda, cogiendo la barra de área de trabajo, para arrastrarla (derecha) sobre la sección 
a previsualizar

• Arrastre las marcas del área de trabajo para indicar el principio y el final 
del área de trabajo. 

Arrastre de la marca del área de trabajo para señalar el principio (izquierda) y el final (derecha) 
del área de trabajo.

• Pulse Alt (Windows) o Opción (Mac OS) mientras hace click en la banda 
del área de trabajo que hay sobre la serie de clips a previsualizar para 
definir el área de trabajo y previsualizar una serie continua de clips. El 
área de trabajo se detiene en el primer espacio vacío detectado entre los 
clips a la izquierda y derecha de donde haga clic 

• Haga doble click en la banda del área de trabajo para previsualizar sólo 
la sección visible en la ventana de construcción. 
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Para crear un fichero de previsualización para el área de trabajo, pero no 
reproducirlo, elija Timeline > Render Work Area. Este comando ahorra tiempo 
al procesado final.
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Previsualización con la velocidad de 
reproducción final

Es posible previsualizar el área de trabajo a la velocidad final de reproducción. 
Para ello hay es preciso generar un fichero de previsualización en el disco duro 
(renderización). Este método procesa todos los efectos y los almacena en 
ficheros de previsualización en el disco (consulte Trabajo con ficheros de 
previsualización). 

La primera vez que se previsualiza puede haber un retraso mientras los efectos 
se procesan. No obstante, una vez que han sido procesados, las próximas 
previsualización se reproducirán instantáneamente, a no ser que se hayan 
añadido o modificado los efectos del área de trabajo desde la última 
previsualización.

Premiere no genera ficheros de previsualización de audio, a no ser que las 
pistas de audio de la ventana de construcción reunan ciertos parámetros 
respecto al número de pistas de audio y número de filtros aplicados a las 
msmas. Estos parámetros pueden ser establecidos manualmente. Para 
información acerca de la configuración de tales parámetros, consulte 
Configuración de audio.

Para activar la previsualización con la velocidad de reproducción final:

1 Elija Project > Project Settings > Keyframe and Rendering.

2 En Preview (bajo Rendering Options), seleccione From Disk.

3 Pulse OK.

Para previsualizar el área de trabajo a la velocidad de reproducción final:

Elija Timeline > Preview o pulse Enter (Windows) o Return (Mac OS).
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Previsualizar barriendo a través de la 
regla de tiempo

Para comprobar inmediatamente las ediciones o efectos, se puede arrastrar el 
punto de edición en la ventana de construcción. Esta acción es conocida como 
"barrido". En tal caso la velocidad de la reproducción depende de la velocidad 
del arrastre.

Para previsualizar barriendo la regla de tiempo:

Realice una de las siguientes acciones:

• Arrastre el punto de edición en la regla de tiempo. Premiere muestra 
fotogramas del programa sin aplicar efectos. 

• Para ver también los efectos (haciendo lo que se llama una 
renderización de barrido), mantenga pulsada la tecla Alt (Windows) o 
Option (Mac OS) mientras se arrastra el punto de edición por la regla de 
tiempo. 

• Para mostrar sólo la máscara del canal alfa mientras se hace el barrido, 
pulse Mayúsculas+Alt (Windows) o Mayúsculas+Opción (Mac OS) 
mientras arrastra el punto de edición en la regla de tiempo. 

También puede utilizar los controles de las vistas origen y programa de la 
ventana de monitor para ver los fotogramas sin los efectos o filtros aplicados 
(consulte Visualización de un clip).
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Enviar la previsualización a la 
pantalla

Cuando se quieren previsualizar las ediciones, transiciones y efectos, pero no 
importa si la previsualización es o no a la velocidad final de reproducción, 
puede usarse la opciónPreview to Screen. 

Con ella, Premiere renderiza a la mayor velocidad posible. La velocidad de 
reproducción depende del tamaño y resolución de la imagen, el número y 
complejidad de los efectos y transiciones, y la velocidad de procesado de su 
sistema.

Previsualizar con esta opción puede ser significativamente lento si se están 
viendo áreas que incluyan muchos efectos. Pero, a diferencia de la 
previsualización desde RAM, esta opción no está limitada por la cantidad de 
memoria RAM instalada en el sistema.

Para activar la previsualización a la pantalla:

1 Elija Project > Project Settings > Keyframe and Rendering.

2 En Preview (bajo Rendering Options), elija To Screen.

3 Pulse OK.

Para previsualizar usando la opción de previsualización a la pantalla:

Pulse Enter (Windows) o Return (Mac OS). Para detener la previsualización 
pulse Esc.
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Previsualización desde RAM

La renderización de la previsualización puede hacerse más rápidamente si se 
usa la utilidad de Premisualización desde RAM. Cuando así se hace Premiere 
almacena y procesa los fotogramas seleccionados en la RAM, en lugar de 
escribiendo en el disco y leyendo después de él. 

Esta utilidad procesa vídeo, audio y efectos. Pero si la RAM resulta insuficiente, 
Premiere muestra el mensaje "Previewing from disk" y reproduce o renderiza 
un fichero normal de previsualización. Por el contrario, si hay suficiente RAM, 
se muestra el mensaje "Retrieving Source Frames" y la previsualización se 
renderiza en la RAM.

Si las exigencias de procesado son demasiadas para su sistema, algunos 
fotogramas se perderán durante la previsualización. Esto se puede solucionar 
reduciendo los fotogramas por segundo o el tamaño del fotograma en el cuadro 
de diálogo Configuración de vídeo. Un tamaño de fotograma reducido, puede 
también minimizar la reducción de la velocidad del vídeo que a veces se 
produce mientras se previsualiza desde la RAM.

Para ver ficheros de previsualización existentes mientras se previsualiza desde 
la RAM, utilice la reproducción standard desde la ventana de construcción o la 
vista origen de la ventana de monitor.

Para activar la previsualización desde RAM:

1 Elija Project > Project Settings > Keyframe and Rendering.

2 En Preview (bajo Rendering Options), elija From RAM.

3 Pulse OK.

Para previsualizar desde RAM:

Pulse Enter (Windows) o Return (Mac OS). Para detener la previsualización 
pulse Esc.
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Previsualización de una edición 
mediante los controles de 
sincronización

En ocasiones, podría desear mover juntas las vistas de origen y de programa. 
Esto se denomina agrupar los monitores y permite previsualizar cómo se ajusta 
un clip al programa de vídeo sin tener que añadir el clip al programa. Por 
ejemplo, si desea comparar la acción en un clip de origen con el espacio 
disponible para él en el programa, empiece reproduciendo el programa en el 
punto IN propuesto para el clip y se reproducirá en la vista de origen 
simultáneamente con la vista de programa. A continuación, puede utilizar los 
controles para previsualizar el lugar donde deberían ir los puntos OUT 
propuestos en el clip de origen y en el programa existente.

Para sincronizar los controles de la vista de origen y de programa:

1 En las vistas de origen y de programa, utilice los controles para ir al 
fotograma de cada vista desde el que desea empezar la reproducción 
sincronizada.

2 En el menú de la ventana de Monitor, elija Gang Source and Program.

3 Utilice el control de avance paso a paso, el control de avance rápido y los 
botones Fotograma anterior ( ), y Fotograma siguiente ( ) para comparar los 
fotogramas (si utiliza otros controles se desactivará la agrupación). Al utilizar un 
control verá como el otro se desplaza la misma cantidad de tiempo y en la 
misma dirección. Puede haber un pequeño retardo mientras se sincronizan los 
controles.
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Previsualización en otro monitor

Se puede mostrar la previsualización en cualquier monitor conectado al 
ordenador. Para evaluar correctamente el aspecto que tendrá el programa de 
vídeo, debe conectar un monitor que pueda mostrar el programa con el 
estándar de vídeo que utilice la audiencia de destino. Por ejemplo, para un 
programa destinado a verse en la televisión de EE.UU. debería conectar un 
monitor NTSC y, si está destinado a Europa un monitor PAL. Para realizar la 
previsualización en otro monitor se necesita el hardware de vídeo que 
proporcione un puerto de vídeo adecuado para el monitor de previsualización. 
Algunas tarjetas de edición de vídeo y diferentes tipos de software de sistemas 
operativos admiten un monitor de previsualización independiente del escritorio, 
mientras que otros utilizan un monitor de previsualización anexo al escritorio, 
que puede utilizarse como espacio adicional para ventanas y paletas. Consulte 
la documentación incluida con la tarjeta de edición de vídeo y con el sistema 
operativo
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Trabajo con ficheros de 
previsualización

Al previsualizar un programa, Premiere crea archivos temporales en el disco 
duro. Estos ficheros de previsualización contienen el resultado de los efectos 
que Premiere ha procesado durante la previsualización. Si previsualiza la 
misma área de trabajo más de una vez sin realizar cambios, Premiere 
reproduce al instante los ficheros existentes, en lugar de procesar la ventana 
de construcción de nuevo. De forma parecida, estos ficheros pueden ahorrarle 
tiempo al exportar el programa de vídeo final utilizando los efectos procesados 
ya almacenados en ellos. Premiere almacena estos ficheros en una carpeta 
especificada por el usuario.

Para favorecer el ahorro de tiempo, Premiere mantiene los ficheros de 
previsualización existentes mientras sea posible. Estos ficheros se modifican al 
mismo tiempo que el segmento de la ventana de construcción al que están 
asociados. Cuando una parte de la ventana de construcción es cambiada, 
Premiere automáticamente recorta los ficheros de previsualización 
correspondientes salvando los restantes, referidos a zonas no modificadas.

El status de previsualización para cada clip se indica en la ventana de 
construcción mediante una barra coloreada situada encima de la regla de 
tiempo. Cuando no hay fichero de previsualización disponible, la barra se 
muestra de color rojo. Por el contrario, cuando sí hay disponible un fichero de 
previsualización para la zona mostrada un indicador adicional bajo la barra 
aparece con color verde claro. Si todos los efectos en una zona pueden ser 
reproducidos en tiempo real, no hay barra coloreada.

Nota: Para encontrar las propiedades para los ficheros de previsualización de 
audio, elija Project > Project Settings > Audio. Al respecto consulte 
Configuración de audio.

Para especificar la ubicación en el disco de los ficheros de 
previsualización:

1 Elija Edit > Preferences > Scratch Disks/Device Control.

2 En los menús de previsualización de vídeo y de audio, escriba una ubicación 
para los ficheros temporales. El disco elegido debe ser suficientemente grande 
y rápido para soportar la reproducción de vídeo; por ello no se debe elegir un 
disco de red, sino un disco físico del sistema. De otro lado, como Premiere está 
preparado para buscar los ficheros de previsualización cuando se abre un 
proyecto, no deben especificarse discos removibles.

3 Pulse OK.
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Para eliminar los ficheros de previsualización:

Realice una de las siguientes acciones:

• Para borrar todos los ficheros de previsualización, mueva el cursor a la 
barra coloreada indicadora de la presencia de ficheros de 
previsualización mientras mantiene pulsados Ctrl+Alt+Shift (Windows) o 
Command+Option+Shift (Mac OS). Cuando el cursor se convierta en un 
cubo de basura, haga click. 

• Para borrar sólo los ficheros de previsualización de vídeo, mueva el 
cursor a la barra coloreada indicadora de la presencia de ficheros de 
previsualización mientras mantiene pulsados Ctrl+Alt (Windows) o 
Command+Option (Mac OS). Cuando el cursor se convierta en un cubo 
de basura etiquetado con la letra V, haga click. 

• Para borrar sólo los ficheros de audio, mueva el cursor a la barra 
coloreada indicadora de la presencia de ficheros de previsualización 
mientras mantiene pulsados Ctrl+Shift (Windows) o Command+Shift 
(Mac OS). Cuando el cursor se convierta en un cubo de basura 
etiquetado con la letra A, haga click. 
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Reproducción de vídeo a pantalla 
completa

El comando Imprimir en vídeo reproduce un clip o la ventana de construcción 
centrada en el monitor del ordenador o de la televisión. Si el clip o la ventana 
de construcción son más pequeños que la pantalla, el vídeo se reproduce solo 
sobre un fondo negro. Esto es de utilidad para previsualizar el programa en la 
ventana de construcción, para ver clips de vídeo de origen o archivos de vídeo 
individuales y para reproducir en la televisión con objeto de grabar en una cinta 
de vídeo. Imprimir en vídeo puede doblar el tamaño del fotograma durante la 
reproducción, de forma que es posible reproducir a pantalla completa un vídeo 
que ocupa un cuarto de pantalla.

Nota: Algunas tarjetas de captura de vídeo no admiten esta función o lo hacen 
de forma diferente. Si ve opciones diferentes a las que se indican en esta 
sección, consulte la documentación de la tarjeta de captura de vídeo.

Para reproducir un vídeo a pantalla completa:

1 Realice alguna de las siguientes acciones:

• Para reproducir la vista de origen en la ventana de monitor, active la 
vista de origen. 

• Para reproducir el programa en la ventana de construcción, active la 
vista del programa en la ventana de monitor y asegúrese de que el área 
de trabajo que desea previsualizar está especificada en la ventana de 
construcción. 

• Para reproducir un clip o una secuencia en su propia ventana, active una 
ventana de clip o de storyboard (consulte Añadir múltiples clips mediante 
un proceso automatizado). 

2 Elija File > Export Clip > Print to Video o File > Export Timeline > Print to 
Video.

3 Especifique las opciones siguientes, según sea necesario y, a continuación, 
haga click en OK:

• En Color Bars For escriba el número de segundos que desea que se 
muestren las barras antes de reproducir el vídeo. 

• En Play Black For, scriba el número de segundos que debe permanecer 
la pantalla en negro después de las barras normalizadas (si se 
especificó) y antes de reproducir el vídeo. Para grabar en cinta de vídeo, 
15 segundos de pantalla negra son suficientes para la mayoría de los 
casos. 
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• Seleccione Full Screen (Windows) o Zoom Screen (Mac OS) para 
modificar el tamaño del fotograma para que llene la pantalla sólo para 
Imprimir en vídeo.

  (Solo Mac OS) Seleccione Hardware en el menú Zoom Screen si dispone de 
una tarjeta de vídeo que admita el zoom mediante hardware. En caso contrario, 
elija Software. 
  Si el tamaño del fotograma especificado en Configuraciones de vídeo es 
inferior a la mitad de la pantalla, la imagen resultante puede ser de poca 
calidad o estar pixelada. No obstante, este efecto puede no ser tan evidente 
después de grabar en una cinta de vídeo. 
  (Sólo Windows) Seleccione Zoom by 2 para duplicar la altura y la anchura 
del fotograma sólo para Imprimir en vídeo. Esto es de utilidad si el tamaño de 
fotograma del proyecto es de 320 x 240 o más pequeño. 
  En Screen Mode, Elija Current para reproducir en la pantalla del ordenador, 
o bien elija NTSC si dispone de un monitor NTSC conectado al sistema. El 
plug-in de software que incluyen algunas tarjetas de captura de vídeo permite 
cambiar de un modo a otro. Para más información, consulte la documentación 
incluida con la tarjeta de captura de vídeo. 
  Seleccione Loop Playback para reproducir el vídeo de forma continua. 
Para más información sobre cómo grabar la ventana de construcción en una 
cinta de vídeo, consulte Exportación a una cinta de vídeo.

Para detener la reproducción de Imprimir en vídeo:

Pulse Esc.
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Trabajo con transiciones

Acerca de las transiciones
Uso de la paleta de transiciones
Colocar una transición entre dos clips
Sustituir una transición
Cambio de la configuración de las transiciones
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Acerca de las transiciones

El cambio visual de un clip a otro es denominado transición. La más sencilla de 
todas es el corte, en el que el último fotograma de un clip conduce 
directamente al primer fotograma del siguiente. El término proviene de la 
edición cinematográfica, en la que un corte es la unión de dos tomas. Con 
frecuencia, el corte es la forma más efectiva de desplazarse de una escena a la 
siguiente; sin embargo, otras transiciones resultan muy útiles para crear una 
atmósfera o añadir un elemento creativo al proyecto.

Las transiciones que incluye Premiere relacionan normalmente el final de un 
clip con el comienzo del siguiente; por ejemplo, la transición Encadenado 
puede fundir el último segundo de un clip con el primer segundo del siguiente. 
Algunas transiciones, tal como Insertar, pueden fundir ambos clips por 
completo, según el efecto deseado. Consulte Cambio de la configuración de 
transiciones.
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Uso de la paleta de transiciones

Premiere incluye más de 75 transiciones que pueden elegirse desde la paleta 
de transiciones. Dentro de ella las transiciones están organizadas por tipos, en 
carpetas. Cada transición se representa por un icono descriptivo de su modo 
de trabajar, en el que A es el primer clip y B el segundo. Para facilitar la 
elección se pueden animar dichos iconos y ver una breve descripción.

Asímismo es posible ver una previsualización del efecto de una transición, con 
fotogramas reales de los dos clips que participan en ella; consulte Cambio de la 
configuración de transiciones. 

La paleta de transiciones puede personalizarse para agrupar ciertas 
transiciones, u ocultar otras que no se usen con frecuencia. Los cambios 
hechos en la paleta afectan a todos los proyectos y no solo al actual.

Para mostrar la paleta de transiciones:

Elija Window > Show Transitions.

Para ver la descripción de una transición:

1 Muestre la paleta Info; si es necesario elija Window > Show Info.

2 Seleccione una transición en la paleta de transiciones. Su descripción 
aparece en la paleta Info.

Funcionamiento de la paleta de transiciones:

La paleta organiza las transiciones en carpetas. Estas carpetas se abren o 
cierran mediante el triángulo que aparece a la izquierda del nombre de la 
carpeta.

Arrastrando una transición hacia arriba o abajo, cambiará su posición, siendo 
posible incluso cambiarla de carpeta. También las carpetas pueden cambiarse 
de lugar simplemente arranstrando

El menú de la paleta de transiciones:

El menú de la paleta ofrece las siguientes opciones de personalización:

• Find: Permite buscar una transición por su nombre. Se buscará la 
primera transición en cuyo nombre aparezca la palabra introducida. Tras 
ello puede pulsarse Find Next para ir a la próxima transición en la que 
aparezca la palabra. Tiene el mismo efecto que pulsar el botón ( ), en 
la parte inferior de la paleta. 
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• New folder: Crea una nueva carpeta. Tiene el mismo efecto que pulsar el 
botón New Folder ( ) que se encuentra en la parte inferior de la paleta. 
Tras crear una nueva carpeta podrá arrastrar a ella las transiciones que 
desee. 

• Rename folder: Permite cambiar el nombre de una carpeta 
• Delete folder: Borra la carpeta seleccionadada. Tiene el mismo efecto 

que pulsar el botón Delete Folder ( ) existente en la parte inferior de la 
paleta. Cuando se borra una carpeta, las transiciones dentro de ella 
quedan ocultas, y si se trataba de una carpeta personalizada (creada 
mediante New Folder) a la que se habían arrastrado transiciones, todas 
las transiciones dentro de ella vuelven, además, a su lugar original. 

• Expand all folders: Expande todas las carpetas 
• Collapse all folders: Colapsa todas las carpetas 
• Show Hiden: Cuando esta opción se activa, las transiciones que se han 

ocultado (mediante Hide Selected) se muestran, aunque atenuadas. Se 
puede usar por lo tanto esta opción para deshacer el efecto de la opción 
Hide Selected: Podemos mostrar todas las transiciones, seleccionar las 
transiciones ocultas que queramos restaurar, y elegir Show Selected. 

• Hide / Show Selected: Esta opción tiene un nombre u otro dependiendo 
de qué transiciones estén seleccionadas: Si se han seleccionado 
transiciones que se muestran en la paleta, la opción se denomina Hide 
Selected y permite ocultarlas. Por el contrario, si sólo hay seleccionadas 
transiciones ocultas, esta opción se denomina Show Selected, y 
deshace el efecto de la anterior. Una transición oculta sigue existiendo, 
pero no se muestra en la paleta a no ser que la opción Show Hiden esté 
marcada. 

• Set selected as default: Convierte la transición seleccionada en la 
transición por defecto. Consulte Especificación de la transición por 
defecto. 

• Animate: Funciona como un conmutador para animar los iconos de las 
transiciones, de tal modo que se muestra, más o menos, el efecto de la 
misma. Si los iconos ya están animados, pulsando de nuevo esta opción 
se detendrá la animación. 
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Colocar una transición entre dos 
clips

Para añadir una transición hay que colocarla en la ventana de construcción 
entre dos clips.

Sólo es posible colocar transiciones entre dos clips que se encuentren en la 
pista de Vídeo 1. La forma de colocarlas variará según:

• El modo de edición en que se esté trabajando (A/B o edición en una sola 
pista) 

• Si la transición que se coloca es o no la transición por defecto. 

Desde la ventana de monitor sólo se puede colocar la transición por defecto. 
Esta transición es asímismo la que se coloca cuando se ejecuta el comando 
Automate to timeline.

El resto de las transiciones hay que arrastrarlas a la ventana de construcción. 
Pero, dado el distinto modo de funcionamiento de la pista de Vídeo 1, según el 
modo de edición en que se trabaje, no se recomienda cambiar de un modo a 
otro una vez que ha empezado la edición, pues ello puede tener efectos 
impredecibles en la colocación de clips y transiciones.

Es también posible combinar los efectos de dos o más transiciones en forma de 
una secuencia. Se las puede situar una al lado de la otra en el área en la que 
se superponen los clips. De esta forma se puede añadir creatividad a las 
transiciones proporcionadas con Premiere. Para hacer esto se debe usar el 
modo de edición A/B y colocar las transiciones una junto a otra en la zona en la 
que los clips se solapan. Por ejemplo, es posible usar dos instancias de la 
transición Push (en donde un clip parece empujar al próximo), invirtiendo la 
dirección para la segunda transiciónpara crear el efecto de un clip empujando a 
otro clip

Añadir dos instancias de la transición, en el espacio donde los clips se superponen (izquierda) 
e invertir la dirección de la segunda (derecha).
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Transiciones en el modo de edición 
A/B

Cuando se trabaja en el modo de edición A/B, o la ventana de construcción se 
encuentra en el modo A/B, para la pista de vídeo 1 se utilizan tres subpistas: 
Video 1A, Transiciones, y Video 1B. Con este diseño es fácil determinar 
visualmente la posición y duración de una transición entre dos clips que se 
superpone. Para información sobre este modo de edición consulte 
Personalización del aspecto de las pistas.

Para añadir una transición a la pista de vídeo 1:

1 Coloque un clip en la pista de vídeo 1A, y otro clip en la pista 1B. Coloquelos 
de tal manera que parte de ellos se superpongan (se deban reproducir 
simultáneamente). La cantidad superpuesta determina la duración por defecto 
de la transición.

2 Si la paleta de transiciones no está visible, elija Window > Show Transitions.

3 Seleccione y arrastre una transición desde la paleta a la pista de transiciones 
en la ventana de construcción. Lleve la transición a la zona en donde los clips 
se superponen. La duración de la transición automáticamente se ajustará a la 
zona de superposición.

Transición colocada (izquierda) y automáticamente ajustada para llenar la zona de 
superposición entre los dos clips (derecha)

4 Para alargar o reducir la transición, asegurese de que la herramienta puntero 
está seleccionada y pulse Control (Windows) o Command (Mac OS) mientras 
arrastra el borde izquierdo o derecho de la transición. Para volver a situar la 
transición entre los clips, arrástrela de nuevo.
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Nota: Una vez añadida una transición, mover uno de sus bordes puede hacer 
que un borde de los clips afectados se mueva en el mismo sentido y viceversa. 
Para mover el borde de un clip o de una transición independientemente, 
mantenga pulsada la tecla Control (Windows) o Comando (Mac OS) al arrastrar 
el borde.

5 Configure la transición tal y como se describe en Configuración de las 
transiciones.

6 Para previsualizar la transición, consulte Previsualización de transiciones.
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Transiciones en el modo de edición 
de una sola pista

Es posible añadir una transición entre dos clips cuando la ventana de 
construcción se encuentra en el modo de edición de una sóla pista. Este 
método requiere mayor planificación y es recomendado solo para personas con 
experiencia en la edición de vídeo.

Para crear una transición en el modo de edición de una sola pista, Premiere 
usa los fotogramas extras disponibles para los clips. Estos fotogramas se crean 
cuando se recorta un clip. Si no los hay, Premiere repetirá fotogramas del 
principio o del final de los clips.

Este método de creación de transiciones es similar al que se hacía en los 
estudios tradicionales de edición lineal, en donde los fotogramas que se habían 
eliminado del programa (estableciendo nuevos puntos In u Out, o usando las 
herramientas de recorte, edición de rizo o edición de enrollado), son usados 
para crear la transición.

Los fotogramas recortados del principio de un clip se denominan material de 
cabecera; los recortados del final del clip se denominan material de cola. Si el 
material de cabecera o el de cola es insuficiente en el momento de aplicar la 
transición, Premiere muestra un cuadro de diálogo para reparar la transición, 
en el que puede elegirse entre cambiar la duración de la transición, cambiar su 
alineación, o repetir el primer y el último fotograma del clip, de tal modo que 
tales fotogramas repetidos puedan ser utilizados para la transición.

Si se borra o mueve una transición (o uno de los clips ligados a la transición) 
después de que se hayan realizado ajustes utilizando el cuadro de diálogo 
Reparar Transición, Premiere automáticamente restaura los puntos In y Out de 
los clips correspondientes.

Para añadir una transición a la pista de vídeo 1:

1 Si los dos clips continguos en la ventana de construcción carecen de 
fotogramas extras que se puedan usar para la transición, recorte el punto Out 
del primero y el punto In del segundo a la mitad del número de fotogramas que 
se usarán para la transición. Por ejemplo, para una transición de 10 
fotogramas, recorte el punto Out del primer clip en cinco fotogramas, y el punto 
In del segundo clip en otros cinco fotogramas. Tras ello elimine el hueco que 
queda en la pista seleccionándolo y eligiendo Timeline > Ripple Delete.

2 Realice una de las siguientes acciones:

• Arrastre una transición desde la paleta de transiciones hasta el punto en 
el que se tocan los dos clips. La zona de superposición se iluminará 
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mientras el puntero se mueve sobre ella. La transición se aplicará 
utilizando la duración por defecto para transiciones. Si los fotogramas 
disponibles son insuficientes aparecerá el cuadro de diálogo Reparar 
transición. 

• Mantenga pulsada la tecla Alt (Windows) u Option (Mac OS) y arrastre 
una transición dede la paleta al punto en que se unen los dos clips. 
Aparecerá un cuadro de diálogo en el que pueden establecerse el 
efecto, duración y alineación de la transición. 

3 Para ver la zona de superposición en la ventana de construcción, pulse el 
botón Uncollapse ( ), que se encuentra junto al nombre de la pista, en la 
cabecera.

4 Para previsualizar la transición, consulte el próximo tema de ayuda.
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Previsualizar transiciones

Para previsualizar una transición, es posible construir una previsualización, o 
realizar un barrido de la zona de la ventana de construcción que contiene la 
transición. Mediante el barrido es posible ver rápidamente el efecto de la 
transición sin esperar a que Premiere construya un fichero de previsualización.

Para construir una previsualización de la transición:

En la ventana de construcción, mueva la barra amarilla indicadora del área de 
trabajo hasta que cubra la zona de la transición, y pulse Enter (Windows) o 
Return (Mac OS).

Para hacer un barrido de la transición:

Mantenga pulsada la tecla Alt (Windows) u Option (Mac OS) y, cuando el 
cursor se convierta en una flecha hacia abajo ( ), arrástrelo por la regla de 
tiempo de la ventana de construcción.
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Transiciones de QuickTime

Además de las transiciones disponibles en Premiere, pueden añadirse 
transiciones para QuickTime.

Al instalar QuickTime, versión 4 o posterior, pueden instalarse también 
transiciones específicas para este tipo de ficheros de vídeo: Estas transiciones, 
si están disponibles, se mostrarán en la carpeta denominada QuickTime, dentro 
de la paleta de transiciones de Premiere.

Para añadir una transición de QuickTime:

1 En la paleta de transiciones, haga click en el triángulo junto a la carpeta 
denominada QuickTime.

2 Arrastre la transición de QuickTime al lugar de la ventana de construcción 
donde desee insertarla.

3 En el cuadro de diálogo Select Effect, elija la transición que desea añadir.

4 Modifique, si lo desea, la configuración de la transición, y pulse OK.
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Especificar y añadir una transición 
por defecto

En Premiere puede definir una de las transiciones (cualquiera de ellas) como 
Transición por defecto. Esta se podrá añadir rápidamente, sin necesidad de 
abrir la paleta de transiciones ni de arrastrarla a la ventana de construcción.

Recién instalado Premiere, y en tanto no se señale otra, Premiere utiliza como 
transición por defecto la denominada Cross Dissolve, que es una de las 
transiciones más utilizadas.

La manera de añadir la transición por defecto depende del modo de edición 
utilizado: A/B o Una sola pista.

Para especificar cuál es la transición por defecto, y establecer su 
duración y alineación:

1 Si es necesario elija Window > Show Transitions.

2 Seleccione la transición que se quiere convertir en transición por defecto.

3 En el menú de la paleta de transiciones, elija Set Selected as Default.

4 Escriba una duración por defecto para la transición. Esta duración se podrá 
cambiar más tarde, una vez que la transición se ha añadido a la ventana de 
construcción.

5 Escoja la alineación por defecto de la transición. Esta alineación se utilizará 
solo cuando se añada la transición en el modo de edición en una sola pista. 
Cuando se usa el modo de edición A/B, las transiciones siempre ocupan el 
espacio de superposición de los clips, salvo que fisicamente se le cambie la 
duración usando la herramienta de recorte.

6 Pulse OK. Esta configuración afectará a todos los proyectos y no sólo al 
actual. Pero cambiar la transición por defecto sólo afecta a las transiciones por 
defecto que se añadan después del cambio.

Para añadir la transición por defecto a la ventana de construcción:

1 Realice una de las siguientes acciones:

• Si se encuentra en el modo de edición A/B, coloque un clip en la pista 
1A y otro clip en la pista 1B, de tal modo que haya una zona de 
superposición entre ambos. 
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• Si se encuentra en el modo de edición de una sola pista, asegúrese de 
que la pista de vídeo 1A se encuentra colapsada, y después coloque dos 
clips en ella, de tal modo que se encuentren contiguos. 

2 Coloque el punto de edición donde los dos clips se unen o se solapan.

En la ventana de monitor puede desplazarse con facilidad a la 
intersección entre dos clips pulsando los botones Next Edit ( ) o Previous Edit (

).

3 Realice una de las siguientes acciones:

• En el modo de edición de una sola pista, pulse el botón Apply Default 
Transition ( ) en la ventana de Monitor, o presione Ctrl+D (Windows) o 
Command+D (Mac OS), o elija Timeline > Apply default transition. Si no 
hay disponibles fotogramas para construir la transición, aparecerá el 
cuadro de diálogo Reparar transición: seleccione en él las opciones 
necesarias. 

• En el modo de edición A/B, expanda la pista de vídeo 1 en la ventana de 
construcción, y después pulse Ctrl+Alt+Shift (Windows) o 
Command+Option+Shift (Mac OS) y haga click en la pista de 
transiciones en la zona donde los dos clips se superponen. 

232



Sustituir una transición

Se puede sustituir una transición por otra, simplemente colocando la nueva 
transición encima de la vieja.

En estos casos se conservan la alineación y duración. Pero la configuración de 
la vieja transición se pierde y es reemplazada por la configuración por defecto 
de la nueva transición, o por la configuración maestra para transiciones en el 
caso de que la haya establecido en la paleta de transiciones. Consulte Cambio 
de la configuración de transiciones.

Para sustituir una transición:

Arrastre la nueva transición desde la paleta de transiciones sobre la transición 
existente en la ventana de construcción.
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Cambio de la configuración de las 
transiciones

En las transiciones se puede cambiar una serie de valores, entre los que se 
incluye la dirección de la transición, los valores inicial y final, el borde y el 
suavizado. El procedimiento siguiente describe cómo mostrar el cuadro de 
diálogo Configuraciones de la transición y cambiar las configuraciones 
comunes a varias transiciones. Las configuraciones específicas de cada 
transición aparecen al hacer click en el botón Custom del cuadro de diálogo 
Configuraciones de la transición.

A. Deslizador de Inicio/Final  B. Espesor del borde  C. Selector de pista  D. Selector de borde 
E. Selector de suavidad  F. Selector de dirección.

Para cambiar la configuración de una transición:

1 Abra el cuadro de diálogo de configuración de transiciones de una de las 
siguientes maneras:

• Para cambiar la configuración en una transición existente en el programa 
de vídeo, haga doble click sobre la transición en la ventana de 
construcción, o seleccione la transición y elija Timeline > Transition 
Settings. En estos casos es posible marcar la casilla Show Actual 
Sources para mostrar los fotogramas inicial y final de los clips ligados a 
la transición. 

• Para cambiar la configuración por defecto de una transición de tal modo 
que dicha configuración se aplique siempre que la transición se inserte 
en la ventana de construcción, haga doble click sobre la transición en la 
paleta de transiciones. 
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2 Ajuste cualquiera de las siguientes configuraciones y luego pulse OK:

• Para cambiar la apariencia inicial y final de la transición, utilice el 
deslizador de Inicio/Final (Marcado como A en el gráfico). Por ejemplo 
para crear el efecto de una imagen dentro de otra, utilice la transición 
Zoom y establezca el principio y el final aproximadamente en un 30%., 
después añada un borde y mueva el punto de centrado a la esquina 
deseada. 

• Puede mantener pulsada la tecla Shift mientras mueve el deslizador de 
inicio o final, para mover ambos deslizadores conjuntamente. 

• Para ajustar la anchura de un borde opcional para la transición, arrastre 
el deslizador de borde. Por defecto las transiciones no llevan borde (el 
deslizador está totalmente a la izquierda); y algunas transiciones no lo 
admiten. 

• Para seleccionar un color para el borde, pulse el selector de color, 
seleccione un color de la ventana de selección de colores, y pulse OK. 

• Para especificar qué clip inicia la transición, pulse el selector de pista en 
el lado izquierdo de la miniatura de la transición (marcado como C en el 
gráfico). El selector de pista es un botón con una flecha que puede 
apuntar hacia abajo o hacia arriba. Si apunta hacia abajo quiere decir 
que la transición se realiza desde el clip colocado en la pista 1A hasta el 
colocado en la pista 1B. Si el selector apunta hacia arriba significa que la 
transición se realizará desde la pista 1B a la pista 1A. Si la transición es 
lo suficientemente larga, este selector de dirección también se muestra 
en la ventana de construcción. 

• Para cambiar la orientación de la transición, pulse un selector de borde 
en la miniatura de la transición (hay cuatro selectores de borde: 
representados como pequeños triángulos alrededor de la miniatura de la 
transición. Los tres selectores inactivos se muestran en color blanco, y el 
activo en color rojo). Algunas transiciones no se pueden orientar de 
forma vertical, o de forma horizontal, o de ninguna manera. En estos 
casos sólo existirán los selectores de borde que puedan utilizarse. 

• En el lado superior derecho de la miniatura de la transición se encuentra 
el selector de dirección. Puede hacer que el movimiento sea hacia 
delante o hacia atrás. Por ejemplo la transición Clock Wipe puede 
moverse en la dirección de las agujas del reloj o a la inversa. 

• Para ajustar la suavidad del movimiento, pulse el selector de Anti-
aliasing, en el lado inferior derecho de la miniatura de la transición. 
Pulsando este selector irá cambiando entre los valores Bajo, Alto y 
Desconectado. Este selector también es accesible desde la miniatura de 
la transición en la ventana de construcción. 

• Para ajustar el punto de inicio de la transición, arrastre el pequeño 
cuadrado que aparece en las imágenes Start y End. Por ejemplo, la 
transición Iris Round puede ser centrada hacia el lado o hacia las 
esquinas de las imágenes. 

• Algunas transiciones disponen todavía de otros valores de configuración. 
En tal caso aparecerá el botón Custom: púlselo para acceder a dichos 
valores adicionales. 
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Nota: Dependiendo de la transición habrá valores de configuración que no 
estén disponibles; en especial: bordes, orientación de borde, punto de inicio...

Nota2: Para cambiar la duración de una transición en el modo de edición A/B 
mantenga pulsada la tecla Ctrl (Windows) o Command (Mac OS) y arrastre 
desde un borde.
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Uso de la transición Máscara de 
imagen

Es posible utilizar una imagen de mapa de bits en blanco y negro como 
máscara de transición, en la que la imagen A sustituye al negro de la máscara 
y la imagen B al blanco. Si se utiliza una escala de grises para la máscara, los 
píxeles que contengan el 50% o más de gris se convertirán en negro y los 
píxeles que contengan menos del 50% de gris se convertirán en blanco. 
Numerosas colecciones de imágenes realizadas por terceros (empresas 
distintas de Adobe) pueden ser usadas con esta transición.

Para añadir una máscara de imagen como transición:

1 Arrastre la transición Image Mask desde la carpeta Special Effect a la pista 
de transiciones de la ventana de construcción. Aparecerá el cuadro de diálogo 
Configuraciones imagen de máscara.

2 Pulse Select Image, y doble click en el archivo de imagen que desee utilizar 
como máscara de transición. La imagen seleccionada aparecerá en el cuadro 
de diálogo Configuraciones de imagen de máscara.

3 Pulse OK. Para previsualizar la transición, consulte Previsualización de 
transiciones.

La transición de máscara de imagen va mostrando el clip B a través de los pixels blancos del 
fichero de imagen seleccionado, mientras que el clip A se muestra en los pixels negros.
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Uso de la transición Cortina 
degradada

Adobe Premiere puede utilizar como cortina degradada cualquier imagen en 
escala de grises que se pueda importar. En una cortina degradada, la imagen B 
rellena el área negra de la imagen en escala de grises y deja ver cada nivel de 
gris según avanza la transición hasta que la zona blanca se convierte en 
transparente. Al crear una transición Cortina degradada, se puede determinar 
la "suavidad" de los bordes de la transición.

Para crear una transición Cortina degradada:

1 Arrastre la transición Gradient Wipe desde la carpeta Special Effect a la pista 
de transiciones de la ventana de construcción. Aparecerá el cuadro de diálogo 
Configuraciones de cortina degradada.

2 Haga click en Select Image, y, a continuación, haga doble click en el archivo 
que desee utilizar para la cortina. La imagen seleccionada aparecerá en el 
cuadro de diálogo Configuraciones de cortina degradada..

3 Ajuste la suavidad de los bordes de la transición arrastrando el potenciómetro 
Softness. Al arrastrarlo hacia la derecha, la imagen A se verá cada vez más a 
través de la imagen B.

4 Pulse OK. Para previsualizar la transición, consulte Previsualización de 
transiciones.

Resultado de la transición de cortina degradada en el clip.
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Mezcla de audio

Cómo procesa Premiere el audio
Ajuste de ganancia
Ajuste de los niveles de audio en la ventana de construcción
Encadenado de pistas vinculadas a vídeo
Establecimiento del balance de un clip
La ventana del mezclador de audio
Ajuste del nivel de audio en el mezclador con automatización
Cambios de volumen no lineales
Ajuste de balance en el mezclador mediante automatización
Utilización de un solo canal en estéreo (derecho o izquierdo)
Silenciar un canal en un clip stéreo
Intercambio de canales en un clip stéreo
Visualización de un clip de audio
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Cómo procesa Premiere el audio

Existen diferentes maneras de aplicar efectos de audio a un clip: ajustando la 
pista de audio en la ventana de construcción, seleccionando un comando de 
menú para un clip seleccionado o aplicando un filtro de audio. Comprender el 
orden en que Premiere procesa el audio resulta de gran ayuda a la hora de 
planear los ajustes de audio.

Cuando se previsualiza, reproduce o exporta un vídeo, Premiere, en primer 
lugar, convierte su audio (fotograma a fotograma) usando los valores que se 
hayan especificado en el cuadro de diálogo de configuración de audio. Si se 
utiliza audio en stereo, en el menú Clip > Audio options, habrá comandos 
adicionales.

Tras procesar el audio original, se procesarán los efectos añadidos, seguidos 
de los ajustes de ganancia o panoramización del clip en la pista de audio de la 
ventana de construcción. Por último, Premiere procesa todo ajuste de ganancia 
que se aplique mediante el comando Clip > Audio Options > Audio Gain. El 
resultado se incluirá en el vídeo previsualizado, reproducido o exportado.
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Ajuste de ganancia

Nota introductoria de Quinurio: Se denomina "ganancia de audio" al nivel de 
amplificación de la onda de sonido. Para entender esto bien es preciso tener 
conocimientos sobre cómo funcionan los ficheros de sonido de onda y cómo se 
reproducen, en un sistema informático, los ficheros de sonido. Si no se sabe 
nada de eso (o se sabe muy poco, como yo) para entendernos llamaremos 
"ganancia de audio" a lo fuerte que puede sonar (es decir: el volumen al que se 
graba el audio, distinto, por tanto, del volumen al que se reproduce, pero 
teniendo en cuenta que el volumen de reproducción está afectado, 
necesariamente, por el volumen de grabación: si un clip se grabó a un volumen 
muy bajo, nunca se podrá reproducir muy alto. Pero si se grabó a un volumen 
alto, es posible reducirle el nivel de sonido en la reproducción).

El tema de ayuda propiamente dicho: Es posible ajustar la ganancia, o 
volumen, de un sólo clip; y como la configuración de ganancia es procesada 
después del volumen, balance y efectos, ninguno de estos aspectos se verá 
afectado por el ajuste de ganancia.

Este ajuste es de gran utilidad a la hora de equilibrar los niveles de ganancia de 
varios clips o cuando la señal de audio de un clip es demasiado alta o baja. No 
obstante, recuerde que si la ganancia de un clip de audio se ajustó demasiado 
baja cuando se digitalizó, el hecho de aumentar la ganancia puede hacer que 
aumenten los ruidos o aparezca distorsión. Para obtener los mejores 
resultados, es conveniente seguir la práctica estandarizada de asegurarse de 
que el nivel de ganancia sea el correcto en el momento de digitalizar el clip de 
audio.

Pueden ajustarse los niveles de audio ajustando el volumen para secciones 
aisladas de un clip, tanto de modo directo en la ventana de construcción como 
en la ventana de mezcla de audio. Para más información sobre como ajustar el 
volumen de secciones aisladas de un clip, consulte Ajuste de los niveles de 
audio en la ventana de construcción. Para información sobre cómo realizar el 
ajuste en la ventana de mezcla de audio, consulte Ajuste de los niveles de 
audio en la ventana de mezcla, usando automatización.

Para ajustar la ganancia de forma uniforme en un clip:

1 En la ventana de construcción, seleccione un clip de audio usando la 
herrramienta de selección, o seleccione varios clips de audio usando la 
herramienta de selección de rango.

2 Elija Clip > Audio Options > Audio Gain.

3 Realice una de las siguientes acciones:
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• Introduzca un Nivel de ganancia. Un nivel superior al 100% amplifica el 
clip. Un nivel inferior al 100% atenúa el clip, haciéndolo más silencioso 

• Pulse Smart Gain para que Premiere establezca automáticamente un 
nivel máximo de ganancia por encima del 200%. Este valor representa el 
porcentaje de amplificación necesario para amplificar las partes más 
ruidosas del clip al máximo nivel que su sistema pueda reproducir. 

4 Pulse OK.
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Ajuste de los niveles de audio en la 
ventana de construcción

Nota de Quinurio: Este tema prefiero no traducirlo, sino explicarlo tal y como 
yo lo entiendo. Porque, los que ya saben como funciona esto no lo necesitan; y 
a los que no lo saben, la explicación de Adobe les puede parecer muy críptica 
(ininteligible).

En todo clip de audio, el volumen (o nivel de audio) viene marcado por una 
línea roja que atraviesa el clip. Para verla hay que expandir la pista (haciendo 
click sobre el triángulo que se muestra a la izquierda del nombre de la pista).

Dicha línea marca el volumen del audio (el nivel). Es decir: si la desplazamos 
hacia arriba, el sonido será más alto, y si la desplazamos hacia abajo, el sonido 
será más apagado. Ahora bien: la línea no se puede desplazar como tal, sino 
que haciendo click en un punto cualquiera de ella se creará un tirador o punto 
de control de audio (que se indica con un pequeño rectángulo rojo sobre la 
línea). Podemos subir o bajar esos puntos de control para incrementar o reducir 
el sonido. Obsérvese, sin embargo que cuando subimos o bajamos un punto de 
control de audio, la línea roja se redibuja para trazar una línea recta desde el 
punto de control que hemos movido hasta los siguientes puntos de control. Ello 
es así porque Premiere siempre incrementa y decrementa el nivel de audio de 
forma gradual.

En este sentido los puntos de control señalan distintos segmentos de audio. Un 
segmento de audio va desde un punto de control hasta el próximo.

Todos los clips de audio incluyen dos puntos de control que no se pueden 
eliminar, uno al principio del clip y otro al final. También es posible realizar un 
encadenado de dos clips de audio automáticamente, de manera que el sonido 
de uno salga gradualmente mientras el del otro entre de forma igualmente 
gradual.

Para ajustar el volumen en un punto específico:

1 Si es preciso, pulse el triángulo a la izquierda del nombre de la pista, para 
expandirla y mostrar así la línea roja representativa del nivel de audio.
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Izquirda: Al pulsar el triángulo, se expande la pista de audio. Derecha: La pista de audio una 
vez expandida

2 Si la línea roja representativa del volumen no se muestra, tras haber 
expandido la pista, haga click en el icono Display Volume Rubberband ( ) en la 
cabecera de la pista.

3 Con la herramienta de selección, coloque el puntero sobre el punto de la 
línea de volumen en el que se quiere crear un nuevo punto de control. Mientras 
el cursor esté sobre la línea de volumen adoptará la forma de un dedo 
apuntando con los signos más y menos.

4 Haga click para crear un nuevo segmento de audio.

5 Arrastre el punto de control hacia arriba o hacia abajo, para ajustar el 
volumen de los sementos adyacentes. Arrastrando hacia arriba se indica que el 
audio debe ir incrementándose gradualmente hasta llegar a ese punto. 
Arrastrando hacia abajo se indica lo contrario: el audio irá reduciéndose hasta 
llegar a ese punto.

Izquierda: Creación de un nuevo punto de control de volumen. Derecha: El resultado tras haber 
incrementado el volumen
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Si se activa la paleta Info, antes de arrastrar el punto de control, puede 
verse en dicha paleta el nivel de volumen conforme se realiza el arrastre.

Para eliminar un punto de control del volumen:

Arrástrelo hacia arriba o abajo hasta salir de la pista de audio. Entonces libere 
el ratón.

Para ver los incrementos porcentuales mientras se ajusta el nivel de 
audio:

Hay que seguir el procedimiento anterior, pero, en el momento de arrastrar 
hacia arriba o abajo el punto de control, debe mantenerse pulsada la tecla Shift. 
Entonces aparecerá un pequeño rótulo con información numérica sobre el nivel 
de volumen conforme se arrastra. En este caso, además, si por error se 
arrastra el punto de control fuera de la pista de audio, no se borrará

Para ajustar simultáneamente dos puntos de control:

1 Si es preciso, pulse el triángulo a la izquierda del nombre de la pista, para 
expandirla y mostrar así la línea roja representativa del nivel de audio, y, de ser 
necesario, haga click en el icono Display Volume Rubberband ( ).

2 Seleccione la herramienta para mover segmentos fade adjustment ( ).

3 Coloque el cursor del ratón entre los dos puntos de control que desea ajustar, 
y después arrastre todo el segmento hacia arriba o hacia abajo.

Para crear dos puntos de control adyacentes:

Hay ocasiones en las que se desea dejar intacto el volumen del segmento 
anterior y realizar un ajuste de nivel brusco a partir de ese segmento. En este 
caso son necesarios dos puntos de control, uno para mantener el nivel de 
ganancia anterior y otro para ajustar el nivel inicial del segmento siguiente. 
Puede crear dos puntos adyacentes de la siguiente manera.

1 Si es preciso, pulse el triángulo a la izquierda del nombre de la pista, para 
expandirla y mostrar así la línea roja representativa del nivel de audio, y, de ser 
necesario, haga click en el icono Display Volume Rubberband ( ).

2 Seleccione la herramienta para insertar puntos adyacentes: fade scissors ( )
.
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3 Haga click sobre la línea de control del volumen en un punto en el que no 
existan controladores de volumen. Esto creará dos puntos de control 
adyacentes. Al estar tan juntos es posible que se vean como uno sólo si el 
zoom de la ventana de construcción no está establecido a nivel de fotogramas.

4 Seleccione la herramienta de selección y arrastre los nuevos tiradores según 
sea necesario..

Si desea mayor espacio para arrastrar el control de nivel dentro de la pista 
de audio, haga click en el triángulo situado debajo de la barra de menú de la 
ventana de construcción; elija Opciones de la ventana de construcción del 
menú de la ventana de construcción, seleccione un Tamaño del icono mayor y, 
a continuación, haga click en OK. Para obtener una mayor precisión, pulse la 
tecla Mayúsculas mientras arrastra el nivel de control.

Para realizar encadenados entre dos clips de audio:

1 Si es necesario, haga click en el triángulo situado a la izquierda de cada 
nombre de pista para expandir las pistas de audio que desea encadenar.

2 Asegúrese de que los dos clips de audio se solapan en el tiempo. Dos clips 
no pueden solaparse en una misma pista por lo que cada clip de audio debe 
situarse en una pista de audio diferente.

3 Seleccione la herramienta para encadenados cross-fade ( ).

4 Haga click en el clip cuyo sonido desea que vaya cesando de forma gradual.

5 Haga click en el clip cuyo sonido desea que entre de forma gradual. Premiere 
crea y ajusta automáticamente tiradores en ambos clips.

Nota: Cuando se crea un encadenado, el orden en el que se seleccionen los 
clips no es importante.
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Encadenado de pistas vinculadas a 
vídeo

Cuando las pistas de audio están vinculadas a pistas de vídeo que no se 
solapan entre sí, realizar el encadenado de las pistas de audio es una tarea 
más compleja que la de realizar un encadenado de sólo audio. Los clips de 
audio vinculados a clips de vídeo no pueden ser arrastrados para 
superponerse, si los vídeos se encuentran en la misma pista.

Es posible resolver este problema moviendo los clips a pistas diferentes. Para 
ello, en primer lugar, desactive el modo de sincronización, de manera que 
pueda mover o recortar la parte de vídeo o la de audio sin mover o recortar la 
otra parte.

El encadenado de audios vinculados a vídeos es de utilidad cuando se realizan 
las ediciones denominadas de corte en L y de corte en J

• En la división de corte en L, el punto Out del audio es posterior al del 
vídeo; es decir: terminada la reproducción del vídeo (y tal vez habiendo 
empezado ya la del próximo clip de vídeo), continua durante unos 
momentos el audio. 

• En la división de corte en J, el audio empieza a sonar antes de que el 
vídeo se muestre. 

Izquirda: División de corte en L, el punto Out del audio es posterior al del vídeo. 
Derecha: División de corte en J: el punto In del audio es anterior al del vídeo.

Nota: La realización del encadenado de pistas existentes en la ventana de 
construcción generalmente requiere que se amplie la duración de uno o más 
clips de audio. Cuando se amplía la duración de un clip, debe de haber 
fotogramas adicionales disponibles en el clip de origen (maestro) del clip más 
allá de los puntos IN o OUT actuales. Por ejemplo, si no ha recortado el inicio o 
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el final de un clip de origen antes de añadirlo a la ventana de construcción, el 
clip aún sigue utilizando todos los fotogramas disponibles de su clip de origen 
de manera que la duración no se puede ampliar.

Para encadenar clips de audio vinculados a vídeo no superpuesto:

1 Si es necesario pulse el triángulo a la izquierda del nombre de cada una de 
las pista de audio que pretende encadenar, para expandirla.

2 Pulse el conmutador de modo de sincronización ( ) para desactivar la 
sincronización entre vídeo y audio. Consulte Vinculación de clips de vídeo y 
audio en la ventana de construcción.

3 Arrastre uno de los clips de audio a una pista en la que se pueda superponer 
al otro clip. Las pistas no tienen por qué ser contiguas.

4 Arrastre el punto In o el punto Out de uno de los clips de audio para 
extenderlo más allá del inicio (o final) del otro. Asegurese de que se están 
moviendo los puntos In o Aut, y no el clip entero.

5 Seleccione la herramienta para encadenados cross-fade ( ).

6 Haga click en ambos clips. Primero en el que esté más a la izquierda, y 
después en el que esté más a la derecha. Premiere automáticamente creará y 
ajustará puntos de control de audio para encadenar el sonido de ambos clips.

7 Pulse de nuevo el botón de sincronización.
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Establecimiento del balance de un 
clip

En un sistema de audio con dos altavoces (o, dicho más correctamente, 
canales de audio), el balance representa la cantidad de sonido que se envía a 
cada altavoz (que se transmite por cada canal). Un balance equilibrado implica 
que ambos canales suenan con el mismo volumen; pero se puede alterar el 
balance para realzar uno de los canales, incrementando su volumen y 
reduciendo el volumen del otro.

Cuando el sonido es stereo, cada canal de audio recibe información diferente. 
Pero cuando el sonido no es stéreo, ambos canales reciben la misma 
información. El ajuste de balance en este caso se denomina "panoramización", 
y puede ser útil en algunas ocasiones. Por ejemplo, si un clip de audio contiene 
la conversación de una persona, se puede panoramizar el audio de manera 
que coincida con la posición de la persona en el fotograma.

Al igual que los ajustes de volumen, puede ajustarse el balance de un clip, 
tanto en la ventana de construcción como en la de mezcla de audio. En la 
ventana de construcción la línea de balance se corresponde con el control 
pan/balance de la ventana del mezclador de audio, y sirve al mismo propósito. 
Para información sobre como panoramizar y establecer el balance de un clip en 
el mezclador de audio, consulte Establecimiento del balance en la ventana del 
mezclador de audio usando automatización.
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Fijar el balance en la ventana de 
construcción

Es posible cambiar el balance libremente durante la duración del clip, de un 
modo parecido a como se controla el nivel de volumen: Creando puntos de 
control para la línea de balance en el clip de audio.

La línea de balance es una línea azul que atraviesa el clip de audio. Para 
mostrarla hay que expandir la pista de audio, y pulsar el boton Display pan 
Rubberbands que se encuentra en la cabecera de la pista.

La línea roja de volumen y la línea azul de balance funcionan de forma 
parecida. Elevándo la línea de balance se representa un desplazamiento del 
sonido hacia el canal izquierdo; desplazándola hacia abajo se representa un 
desplazamiento del sonido hacia el canal derecho.

Para obtener los mejores resultados los resultados del previo de la 
panoramización, asegúrese de que el ordenador o tarjeta de sonido esté 
correctamente conectada a los altavoces en estéreo. Asegúrese también de 
que los canales izquierdo y derecho no estén invertidos.

Para fijar el balance de un clip de audio:

1 Si es necesario, pulse el triángulo a la izquierda del nombre de la pista de 
audio donde está el clip, para expandirla

2 Si no se muestra la línea azul de balance, pulse el icono azul Display 
Pan/balance ( ) en la cabecera de la pista.

3 Coloque el puntero sobre la línea de balance hasta que se transforme en un 
dedo apuntando con flechas azules debajo. Haga click para crear un punto de 
control y después arrastre el punto hacia arriba, para desplazar el sonido al 
canal izquierdo, o hacia abajo para desplazarlo hacia el canal derecho.

Si se activa la paleta Info, antes de arrastrar el punto de control, puede 
verse en dicha paleta el nivel de balance conforme se realiza el arrastre.

Para eliminar un punto de control del balance:

Arrástrelo hacia arriba o abajo hasta salir de la pista de audio. Entonces libere 
el ratón.

Para ver los incrementos porcentuales mientras se ajusta el balance de 
audio:
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Hay que seguir el procedimiento anterior, pero, en el momento de arrastrar 
hacia arriba o abajo el punto de control, debe mantenerse pulsada la tecla Shift. 
Entonces aparecerá un pequeño rótulo con información numérica sobre el nivel 
de balance conforme se arrastra. En este caso, además, si por error se arrastra 
el punto de control fuera de la pista de audio, no se borrará
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La ventana del mezclador de audio

En la ventana del mezclador de audio puede ajustarse el nivel de volumen y el 
balance de varias pistas de audio. Premiere usa automatización (un 
procedimiento informático) para grabar los ajustes y después aplicarlos cuando 
los clips se reproducen.

El mezclador de audio, al igual que una consola mezcladora de audio, contiene 
un conjunto de controles para cada pista de audio, las cuales se numeran 
según la numeración de las mismas en la ventana de construcción.

La diferencia básica entre el ajuste en la ventana de construcción y el ajuste en 
el mezclador está en que en la ventana de construcción se ajusta el volumen y 
el balance de clips individuales, pero en el mezclador se ajusta el volumen y 
balance de las pistas en su conjunto.

Es posible incluso unir pistas para aplicar niveles de decibelios relativos a 
varias pistas simultáneamente. Por ejemplo, si se quiere que el volumen de 
audio sea de dos decibelios menos en las pistas 1, 3 y 4, agrupe los 
controladores de volumen de dichas pistas y, después baje uno de ellos dos 
decibelios.

Para agrupar los controles de volumen de varias pistas, coloque el ratón sobre 
uno de ellos, púlse el botón derecho del ratón, y asignelo a un grupo. Se 
pueden crear hasta cuatro grupos. Cuando dos o más pistas forman parte del 
mismo grupo, moviendo el volumen en una, se mueve en todas. El color del 
controlador de volumen cambia cuando se ha asignado a un grupo.

Cuando se realizan ajustes en el mezclador, Premiere crea puntos de control 
en los clips de audio de la ventana de construcción para así aplicar los 
cambios.

El aspecto del mezclador es el siguiente:
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A. Nombre de la pista de audio B. Botones de automatización C. Botones de Mute/Solo D. 
control de Pan/Balance E. Indicador de nivel de Pan/Balance F. Indicador de recorte 
G. Deslizador de control del volumen H. medidor de VU I. Indicador de nivel de decibelios J. 
Controles de transporte

Establecimiento del volumen de la pista

El volumen para la pista puede establecerse arrastrando con el ratón el 
deslizador G, o escribiendo directamente en el cuadro I el nivel en decibelios. 
Se admiten los valores en el rango +6 a -95.

El medidor de VU (H) representa gráficamente el nivel de audio. Cuando este 
nivel puede causar distorsiones, el pequeño indicador que se encuentra encima 
del medidor se vuelve de color rojo.

Establecimiento del balance

El control pan/balance representa un botón redondo (D) que se puede arrastrar 
con el ratón a derecha o izquierda. También es posible introducir 
numéricamente un valor entre -100 o +100 para este control en el cuadro que 
hay debajo (E).

Seleccionar las pistas de audio a escuchar

Los botones Mute / Solo (C) permiten silenciar una pista (botón Mute), o 
escuchar exclusivamente una pista silenciando las demás (botón Solo). Si no 
se selecciona ninguno de estos botones en ninguna pista, se escucharán todas 
las pistas de audio.
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Si se pulsa el botón Solo en más de una pista, se escucharán todas las pistas 
en las que se haya pulsado dicho botón.

Uso de la automatización

Los cambios que se introduzcan en la ventana del mezclador pueden grabarse 
mediante la automatización. Para ello hay que usar los controles de transporte, 
en la parte inferior del mezclador (J) así como los tres botones situados en la 
parte superior (B). Estos botones representan el estado de la automatización 
durante el proceso de mezclado:

• Automation Write ( ) Lee el volumen y balance de la pista de audio y 
graba cualquier ajuste que se realice en los mismos usando los 
controles de volumen y balance. Para ello generará en los clips, si es 
preciso puntos de control de los niveles de audio y balance. El 
funcionamiento de este botón se ve afectado por la selección que se 
haya hecho en la opción Automation Write, en el cuadro de diálogo de 
opciones de la ventana de mezclador de audio. Para información sobre 
este cuadro de diálogo consulte Ajuste de los niveles de audio en el 
mezclador usando automatización. 

• Automation Read ( ) Lee el volumen y balance original de los clips. 
• Automation Off ( ) Ignora los datos de volumen y balance de los clips 

durante la reproducción. Este es el modo de automatización por defecto, 
que permite usar el mezclador en tiempo real sin interferencias 
ocasionadas por las especificaciones de volumen y balance hechas en 
los clips. 

El mezclador de audio también incluye controles para la reproducción. Para la 
descripción de estos controles consulte Uso de los controles de la ventana de 
monitor.

También es posible modificar la ventana del mezclador de audio para mostrar 
sólo las pistas de audio, sólo el control maestro o ambos. Por defecto se 
muestran tanto las pistas de audio como el control maestro.

Para modificar la ventana del mezclador:

1 Haga click con el botón derecho del ratón (Windows) o Control-click (Mac OS) 
en la barra de título del mezclador para abrir el cuadro de diálogo de opciones 
de la ventana. Después realice alguna de las siguientes opciones:

• Para mostrar las pistas de audio sin el control maestro, elija Audio 
Tracks Only. 

• Para mostrar el control maestro sin las pistas de audio, elija Master 
Fader Only. 

• Para mostrar tanto las pistas de audio como el control maestro, elija 
Audio Tracks and Master Fader. 
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Ajuste del nivel de audio en el 
mezclador con automatización

La automatización es el procedimiento por el que, desde el mezclador de audio, 
es posible realizar cambios en los clips, ajustando el volumen y el balance. 
Todo ello en tiempo real, mientras se reproducen las distintas pistas de audio.

Conforme se introducen cambios desde la ventana del mezclador, Premiere va 
generando en los clips correspondientes los puntos de control de nivel de audio 
y balance necesarios para que dichos cambios se realicen.

Nota: Las pistas del mezclador de audio no pueden reproducir segmentos de la 
ventana de construcción que contengan ficheros de previsualización. Ello hay 
que hacerlo desde el control maestro del mezclador. Por ello se recomienda 
que se utiliza el mezclador antes de aplicar efectos de audio que deban 
ocasionar la creación de ficheros de previsualización.

Uso de la automatización para ajustar el volumen de una pista o de parte 
de ella:

1 Si es necesario, pulse el triángulo a la izquierda del nombre de la pista, para 
expandir la pista de audio que se pretende ajustar.

2 Arrastre el punto de edición al lugar en el que quiere empezar a grabar 
cambios mediante la automatización.

3 Elija Window > Audio Mixer.

4 En la ventana del mezclador de audio localice la columna correspondiente a 
la pista de audio que pretende ajustar (por ejemplo, Track 1 controla la pista de 
audio 1). El nombre de la pista aparece en la parte superior de cada columna 
del mezclador.

5 Pulse el botón Automation Write ( ) en la parte superior de la columna del 
mezclador. Para realizar cambios en otras pistas, pulse el mismo botón para 
cada una de ellas.

6 Pulse el botón derecho del ratón (Windows) o realice Control-click (Mac OS) 
sobre la barra de título del mezclador, para abrir el cuadro de diálogo de 
opciones del mezclador. En la sección Automation Write Options elija uno de 
los valores siguientes y pulse OK

• Touch: Modificará el nivel de volumen y de balance solo cuando arrastre 
los botones correspondientes del mezclador. Al soltar el ratón, los 
controles volverán a su posición original. 
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• Latch: Modificará el nivel de volumen y de balance cuando arrastre los 
botones correspondientes del mezclador. Pero al soltar el ratón los 
controles permanecerán en el lugar donde los haya dejado. 

• Write: Modificará el volumen y balance en la posición del punto de 
edición. No es preciso arrastrar los controles del mezclador durante la 
reproducción, sino que se pueden ajustar antes de que empiece la esta. 
La modificación sólo se realizará en el trozo reproducido. Por ejemplo: 
se puede subir el volumen un decibelio, reproducir dos segundos y 
detener la reproducción: Se grabará una elevación de un decibelios 
durante dos segundos 

• Write/Touch: usará el modo Write para la próxima reproducción, e 
inmediatamente después cambiará, de forma automática al modo Touch 
para las siguientes reproducciones. 

7 Elija una opción del menú Enable Automation Of: Puede elegir 

• Volume and Pan para modificar simultáneamente el volumen y el 
balance 

• Volume Only para modificar sólo el nivel de volumen 
• Pan Only para modificar sólo el balance. 

8 Pulse el botón Play ( ) en el mezclador para empezar a grabar. Se puede 
también pulsar el botón Loop ( ) para reproducir en un bucle continuo, o pulsar 
el botón Play In to Out ( ) para reproducir desde el punto In hasta el punto Out.

9 Arrastre el control de volumen hacia arriba para incrementarlo o hacia abajo 
para reducirlo. Para evitar distorsiones ajuste el volumen de tal modo que el 
medidor VU, a la derecha del control de volumen, solo muestre líneas 
amarillas, no rojas. Cuando se alcanza un nivel de distorsión, el indicador rojo 
permanecerá de tal color aunque, el sonido actual, ya no quede distorsionado. 
Para restaurarlo, baje el control de volumen y haga click en el indicador de 
distorsión.

10 Para detener la grabación, pulse el botón Stop ( ). Para evitar que 
accidentalmente se reescriba lo que acaba de grabar, haga inmediatamente 
click en el botón Auto Read ( ) para la pista que se acaba de grabar.

11 Para previsualizar los cambios de volumen, arrastre el punto de edición al 
principio de los cambios, y pulse de nuevo el botón Play ( ).

Para ajustar el volumen simultáneamente para más de una pista:

1 Agrupe las pistas con las que se desea trabjar. Para ello haga click con el 
botón derecho del ratón (Windows) o Control-click (Mac OS) en el control de 
volumen de cada una de las pistas, y asígnelas a uno de los cuatro grupos 
posibles, denominados Gang 1, Gang 2, Gang 3 y Gang 4. Repita el proceso 
para el resto de las pistas que se desea agrupar, asignando siempre el mismo 
grupo.
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2 Pulse el botón Automation Write ( ) en cada una de las pistas agrupadas.

3 Siga en todo lo demás el procedimiento anterior, teniendo en cuenta que, 
para realizar cambios bastará con ajustar el control de cualquiera de las pistas 
agrupadas: los controles de las demás pistas del grupo se ajustarán 
automáticamente al mismo valor.

Para desagrupar las pistas de audio:

Realice una de las siguientes acciones:

• Para eliminar una pista de un grupo, haga click con el botón derecho del 
ratón sobre su control de volumen (Windows) o Control-click (Mac OS) y 
elija No Gang 

• Para que una acción concreta no afecte a todo el grupo, mantenga 
pulsada la tecla Shift mientras arrastra el control de volumen. 

NOTA: La agrupación sólo afecta al control de volumen, no al control de 
balance.

Para seleccionar pistas a monitorizar durante la reproducción:

Realice una de las siguientes acciones:

• Para monitorizar una o más pistas, pulse el botón Solo en las pistas 
correspondientes. 

• Para silenciar una o más pistas, pulse el botón Mute en las pistas 
correspondientes. 
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Cambios de volumen no lineales

Un segmento de audio entre dos puntos de control en la ventana de 
construcción, es siempre lineal: cada punto de control está conectado al 
próximo mediante una línea recta.

Los ajustes de volumen que se realizan desde el mezclador pueden, no 
obstante, ser lineales o no lineales, dependiendo de la velocidad a la que se 
arrastre el control de volumen. Esto es así porque aunque los cambios de 
volumen lineales constituyen un procedimiento rápido y simple para cambiar el 
volumen, no siempre suenan naturales para el oido humano. Los sonidos 
derivados de objetos físicos, como una campana, pueden ser bruscos y, en 
consecuencia, no lineales.

En la ventana de construcción es posible representar algo parecido a un 
cambio no lineal formando una especie de curva en la línea de volumen.

Seleccionando la opción Logarithmic Audio Fades en el cuadro de diálogo de 
configuración de audio, los cambios lineales se convierten en cambios 
logarítmicos, aunque esa conversión sólo se produce cuando se reproduce o 
previsualiza el proyecto.

Asímismo, es posible seleccionar la opción Logarithmic Audio Fades en el 
cuadro de diálogo de configuración de exportación (consulte Exportación de 
vídeo) para convertir los cambios lineales en no lineales en una película 
exportada.

Cuando se selecciona esta opción, en el proyecto los cambios de volumen se 
siguen seleccionando como lineales; sólo cambia la salida.
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Ajuste de balance en el mezclador 
mediante automatización

Es posible ajustar el balance de un clip mediante el control Pan/Balance del 
mezclador de audio. Cuando el clip es monofónico a ese proceso se le 
denomina panoramización.

Para ajustar el balance (o panoramizar) un clip de audio en el mezclador:

1 Si es necesario, pulse el triángulo a la izquierda del nombre de la pista que se 
desea ajustar, para expandirla.

2 Coloque el punto de edición en el lugar en donde se desea iniciar la 
grabación de los cambios mediante la automatización.

3 Si el mezclador está cerrado u oculto, pulse Window > Audio Mixer.

4 Pulse el botón Auto Write ( ) en el canal del mezclador cuyo balance se 
desea modificar.

5 Seleccione una opción para la forma de grabar en automatización. Respecto 
de estas opciones consulte Ajuste del nivel de audio en el mezclacor con 
automatización

6 Pulse el botón Play ( ) en la ventana del mezclador para empezar la 
grabación.

7 Pulse el control de balance y arrástrelo hacia fuera, luego arrastre en el 
sentido de las agujas del reloj para desplazar el sonido al canal derecho, o en 
sentido inverso para desplazarlo al canal izquierdo. Arrastrando desde fuera del 
control se obtiene una mayor precisión para el ajuste.

8 Para detener la grabación pulse el botón Stop ( ).

9 Para previsualizar sus cambios, pulse el botón Auto Read ( ), para evitar 
sobreescrituras accidentales de los cambios recién realizados. Coloque de 
nuevo el punto de edición en el principio de sus cambios, y pulse el botón Play.
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Utilización de un solo canal en 
estéreo (derecho o izquierdo)

Los comandos Duplicate Left y Duplicate Right permiten sustituir todo un clip de 
audio con sólo un canal, el izquierdo o el derecho. Por ejemplo, es posible 
crear un clip de audio equilibrado y completo a partir de un clip grabado 
originalmente en sólo un canal en estéreo, el izquierdo o el derecho.

Para utilizar sólo un canal en estéreo en todo un clip de audio:

1 Seleccione un clip de audio en la ventana de construcción.

2 Realice una de las siguientes acciones:

• Elija Clip > Audio Options > Duplicate Left para utilizar el canal izquierdo 
• Elija Clip > Audio Options > Duplicate Right para utilizar el canal 

derecho. 
• Elija Clip > Audio Options > Normal para restaurar los canales stereo 

originales del clip. 

Silenciar un canal en un clip stéreo

Silenciar un canal de un clip stéreo en la ventana de construcción puede ser útil 
si un canal contiene ruidos no deseados, o si los canales fueron grabados de 
forma desfasada.

Para silenciar un canal en un clip stéreo:
1 Seleccione un clip de audio en la ventana de construcción.

2 Realice una de las siguientes acciones:

• Elija Clip > Audio Options > Mute Left para silenciar el canal izquierdo 
• Elija Clip > Audio Options > Mute Right para silenciar el canal derecho 
• Elija Clip > Audio Options > Normal para restaurar los canales originales 

del clip. 
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Intercambio de canales en un clip 
stéreo

En la ventana de construcción es posible intercambiar los canales en un clip de 
audio stéreo. Esto normalmente se hará si los canales fueron grabados de 
forma incorrecta, aunque también puede servir para provocar ciertos efectos 
(cuando se produce un intercambio brusco de canales bien diferenciados).

Para intercambiar los canales stéreo:

1 Seleccione un clip de audio en la ventana de construcción.

2 Realice una de las siguientes acciones:

• Elija Clip > Audio Options > Swap Channels para invertir los canales 
• Elija Clip > Audio Options > Normal para restaurar la orientación normal 

de los canales del clip. 
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Visualización de un clip de audio

De un clip de audio, en la ventana de construcción, estando expandida la pista 
donde el clip se encuentre, se muestra información visual sobre la línea de 
volumen (línea roja), la de balance (línea azul) así como sobre la forma de la 
onda de sonido. Pero también es posible abrir un clip de audio en su propia 
ventana, lo cual es útil en situaciones en las que se desea fijar con precisión los 
puntos In y Out del clip. Consulte Definición de un punto In de origen de audio 
entre divisiones de base de tiempo.

Para ver un clip de audio:

Realice una de las siguientes acciones:

• Para ver la forma de la onda del clip, en la ventana de construcción, 
pulse el triángulo a la izquierda del nombre de la pista, y despues pulse 
el icono Waveform ( ). Asegúrese de que en el cuadro de diálogo de 
opciones de la ventana de construcción ha marcado la opción Draw 
Audio When View n or Closer. Para más información sobre esta opción 
consulte Personalización de la ventana de construcción. 

• Para ver en su propia ventana un clip de audio situado en la ventana de 
construcción, pulse Alt (Windows) u Option (Mac OS) mientras se hace 
doble click sobre el clip. 

• Para ver siempre los clips de audio en su propia ventana, elija 
Preferences > General, y seleccione Open Movies in Clip Window. 

• Para abrir el clip en la forma contraria a la indicada en Preferences 
> General, pulse la tecla Alt (Windows) u Option (Mac OS) mientras se 
hace doble click sobre el clip en la ventana de proyecto. Es 
decir: Pulsando Alt el clip se abrirá en su propia ventana, si en 
Preferences se indicó que no se abriera en su propia ventana, o, si en 
Preferences se indicó que los clips se deben abrir en su propia ventana, 
el clip se abrirá en la vista origen de la ventana de monitor. 
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Creación de títulos
Los títulos son clips especiales, porque aunque funcionan como un clip de 
vídeo, en realidad no contienen imágenes propiamente dichas, sino texto (y a 
veces gráficos). Estos clips se usan para varias finalidades: Mostrar rótulos, 
títulos de crédito, subtítulos de una película....

A diferencia de otros programas de edición de vídeo que almacenan toda la 
información sobre títulos dentro del mismo proyecto (como Ulead Media 
Studio), en Premiere los títulos son ficheros independientes.

Es decir: para utilizar un título primero hay que crear el fichero que lo contiene, 
y después importarlo al proyecto como un clip más.

En este capítulo de la ayuda se explica fundamentalmente cómo crear los 
títulos desde Premiere (se pueden crear con otras aplicaciones compatibles). 
Sobre el uso de estos clips sólo en el último tema de este capítulo se dice algo, 
poco.

Ello es porque una vez creado el título hay que añadirlo a la ventana de 
construcción; y si se quiere que el título se superponga sobre la imagen de otro 
clip (por ejemplo: títulos de crédito de una película superpuestos a las primeras 
o últimas imágenes de la misma), habrá que utilizar el mismo procedimiento 
que se utiliza en general para crear clips superpuestos. La ayuda al respecto 
no se encuentra en este capítulo, sino en el de Superposiciones y 
composiciones.

Temas de ayuda sobre creación de títulos:

Creación de un título desde Premiere
Creación de objetos de texto
Creación de texto con desplazamiento vertical u horizontal
Creación de objetos gráficos
Adición de una sombra
Uso de color, transparencia y degradado
Resumen sobre la aplicación de color
Uso del selector de color
Ordenaciónde los objetos de texto y gráficos
Adición de un título a un proyecto
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Creación de un título desde Premiere

Aunque es posible crear un título mientras se trabaja en un proyecto, un título 
es un archivo independiente separado del proyecto. Como cualquier otro clip, 
no formará parte del programa de vídeo hasta que se añada a la ventana de 
construcción. Es posible trabajar con más de una ventana de título abiertas al 
mismo tiempo o utilizar un mismo título en más de un proyecto.

Nota: También es posible crear un título en otra aplicación gráfica, grabarlo en 
un formato compatible con Premiere e importarlo a Premiere; o usar una 
aplicación generadora de títulos distinta de Premiere, e importar el fichero de 
título resultante a Premiere.

Para crear y grabar un nuevo título:

1 Elija File > New > Title.

2 Elija File > Save As.

3 Especifique una ruta de acceso y nombre de fichero y después pulse Save.

También es posible crear un título, desde la ventana de proyecto, 
pulsando el botón Create Item ( ) y eligiendo, como tipo de objeto Title.

Tras realizar el procedimiento anterior, se abre la ventana de título y en la barra 
de menús de Premiere aparece un nuevo menú denominado Title. Esté menú 
estará accesible sólo cuando la ventana activa sea la de títulos.
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Importación de un fotograma de 
ejemplo

Es posible, en la ventana de títulos, importar de un clip (o imagen fija) un 
fotograma de ejemplo que funcionará sólo como una ayuda visual para colocar 
el texto y los gráficos. Pero el fotograma importado, aunque se ve en la ventana 
de título, no forma realmente parte de él. Aun así es posible seleccionar y usar 
cualquier color del fotograma, usando la herramienta de cuentagotas 
(eyedropper ). 

Por defecto Premiere utiliza como fotograma de ejemplo el primer fotograma de 
un clip, o el fotograma que se haya definido como Poster de un clip (sobre 
cómo definir el poster de un clip, consulte Ver la información de un clip en la 
ventana de proyecto). También puede especificar el fotograma que desea 
utilizar definiendo la opción Marcar del clip a 0 (cero). Consulte Uso de marcas.

Para importar un fotograma de ejemplo a la ventana de títulos:

1 Abra la ventana de títulos.

2 Realice una de las siguientes acciones:

• Si el proyecto está abierto, haga doble click sobre cualquier clip en la 
ventana de proyecto. 

• Si no hay ningún proyecto abierto, elija File > Open, localice el fichero de 
vídeo o de imagen que se quiere usar como referencia, y pulse OK. 

3 En la ventana del clip, o en la vista origen de la ventana de monitor, vaya al 
fotograma que quiere importar.

4 Pulse el botón Marker Menu ( ) y elija Mark > 0 (Poster Frame). Esto 
especifica el fotograma que Premiere utilizará para la ventana de título.

5 Arrastre el fotograma a la ventana de título.
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Arrestre de un fotograma desde la vista de origen de la ventana de monitor (derecha) a la 
ventana de título (izquierda).

Para cambiar el fotograma de ejemplo: 

Repita el procedimiento anterior con un nuevo fotograma. Una vez pulsado el 
botón Marker Menu ( ) y elegido Mark > 0 (Poster Frame), el nuevo fotograma 
se colocará automáticamente en la ventana de título. Es decir: Ya no hace falta 
arrastrar

Para eliminar el fotograma de ejemplo:

Estando activa la ventana de título seleccione Title > Remove Background Clip.
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Configuración de las opciones de la 
ventana de título

Las opciones de la ventana de título permiten especificar el tamaño del área del 
título, un color de fondo y las áreas de seguridad.

Las áreas de seguridad son de utilidad al editar transmisiones y cintas de vídeo 
NTSC, ya que la mayoría de los televisores NTSC cortan parte de los bordes 
exteriores de la imagen. Este proceso, denominado OverScan, permite ampliar 
el centro de la imagen. La cantidad de imagen que se puede perder no es la 
misma en todos los televisores, por lo que es aconsejable mantener los títulos 
dentro del área de seguridad para los títulos así como los temas importantes 
dentro del área de seguridad para las acciones. Las opciones de la ventana de 
título incluyen una opción para visualizar tanto las áreas de seguridad para los 
títulos como las áreas de seguridad para las acciones en NTSC. Para optimizar 
los resultados, reproduzca el vídeo en una pantalla de televisión conectada al 
ordenador (consulte Previsualización en otro monitor).

Nota: Aunque Adobe (yanquis tenían que ser) dice que el OverScan se da en 
los televisores NTSC, lo cierto es que también se da en los sistemas PAL y 
SECAM. Lo que ocurre es que, como el programa está hecho en Estados 
Unidos, que, como todo el mundo sabe, es el centro del Universo, las zonas de 
seguridad que Premiere indica, sólo son realmente seguras en sistemas NTSC. 
Para otros sistemas como PAL o SECAM, sirven sólo como indicadores 
aproximados, pero para asegurarse realmente de que no se recorta nada 
importante habrá que ver los resultados en una pantalla de televisión normal.

Zona de seguridad de títulos (A) y zona de seguridad de acciones (B)

Para establecer las opciones de la ventana de título:

1 on la ventana de título abierta, elija Window > Window Options > Title 
Window Options, o haga click con e botón derecho del ratón (Windows) o 
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Control-click (Mac OS) en la ventana de títulos y elija Title Window Options del 
menú contextual.

2 Especifique las siguientes configuraciones según sus necesidades y, a 
continuación, haga click en OK:

• En Size, escriba las dimensiones en píxeles que tendrá el fotograma del 
título, como, por ejemplo 320 horizontal (h) y 240 vertical (v). 

• En Aspect, seleccione la proporción de aspecto de píxel que se usará en 
el vídeo final. 

• En Background, haga click en el rectángulo y especifique un color de 
fondo (consulte Uso del selector de color). Si desea que el color de 
fondo se visualice en Premiere, seleccione Opaque. 

• Seleccione Show Safe Titlespara visualizar las áreas de seguridad para 
los títulos y para las acciones en NTSC (o en PAL o SECAM) 

• Seleccione NTSC-Safe Colors para cambiar automáticamente al rango 
de seguridad NTSC todos aquellos colores que se encuentran fuera de 
él cuando el título está renderizado. Esta opción puede en cierta manera 
apagar los colores. Si crea títulos para televisores NTSC y no selecciona 
esta opción, los colores que se encuentran fuera del rango de seguridad 
NTSC pueden aparecer apagados o producirse una sangría en las 
líneas de exploración del televisor. 

Si la ventana de título está activa, puede definir el color de fondo como 
blanco o negro directamente desde el teclado pulsando B para el negro y W 
para el blanco.

Para acelerar la visualización mediante la opción Draft:

Seleccione Draft (Boceto) en la ventana de título. La ventana de 
título se visualiza con mayor rapidez aunque pierde calidad. 
Esta opción sólo afecta a la visualización de la ventana de 
título; cuando se utilice en un programa de vídeo, el título se 
visualizará con la máxima calidad.

Para seleccionar herramientas de texto y gráficos:

Realice una de las siguientes acciones:

• Para seleccionar una herramienta para un solo uso, haga 
click en dicha herramienta en la caja de herramientas 
(excepto la herramienta de selección). La herramienta se 
resaltará en color gris y, una vez utilizada, volverá a la 
herramienta de selección. 

• Para seleccionar una herramienta para un uso 
continuado, haga doble click en dicha herramienta en la 
caja de herramientas. La herramienta se resaltará en 
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color negro y permanecerá activa hasta que se seleccione otra. Esto es 
así en todas las herramientas salvo la de escritura (type tool) que 
siempre vuelve a la herramienta de selección después de haber sido 
usada. 

Para tener acceso más rápido a la mayoría de las opciones de formato, 
haga click con el botón derecho del ratón en un objeto (Windows) o haga click y 
pulse Comando (Mac OS) y elija un comando del menú.
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Creación de objetos de texto

Utilice las herramientas y los comandos de la ventana de título para crear 
objetos que contengan texto u objetos de texto. Premiere proporciona varias 
opciones de formato de texto y permite elegir entre un amplio rango de fuentes, 
incluidas las fuentes PostScript o TrueType. Cuando se cambian los atributos 
de texto, el cambio afecta a todos los elementos futuros.

Comparado con papel, el vídeo se muestra a mucha menor resolución y se 
suele ver desde una mayor distancia (normalmente desde el otro lado de la 
habitación). Para mayor legibilidad, siga los siguientes consejos a la hora de 
especificar fuentes para vídeos:

• Utilice fuentes sans-serif grandes. Evite las letras y fuentes serif 
pequeñas. El trazo fino de algunos caracteres pequeños o serif no se 
visualizan bien en los televisores entrelazados, haciendo que vibren. 

• Utilice negrita o semi-negrita que, por lo general, resultan más fáciles de 
leer en televisión que los caracteres con grosor normal o atenuado. 

• Utilice pocas palabras en los títulos. Los párrafos extensos de letra 
pequeña se leen con dificultad en los televisores. 

• Cuando diseñe un título para superponerlo a un clip de imagen o vídeo, 
utilice colores que contrasten con los del vídeo de fondo. Puede importar 
un fotograma de muestra para comprobar cómo queda el título con ese 
fondo (consulte Importación de un fotograma de muestra). Si el fondo es 
complejo, puede añadir una sombra (consulte Adición de una sombra) o 
una forma semitransparente detrás de las letras (consulte Creación de 
objetos gráficos). 

• segúrese de que las fuentes que utilice en el archivo de título estén 
instaladas en todos los ordenadores en los que se abrirá dicho archivo o 
el proyecto que lo incluye. Las fuentes tienen a menudo nombres 
diferentes en Windows y en Mac OS, incluso en los casos en que las 
fuentes son idénticas. Cuando finalice la edición y grabe el clip final en 
una cinta de vídeo o lo exporte a un archivo de vídeo, ya no necesitará 
más las fuentes del título. 

Para crear texto:

1 Seleccione la herramienta de escritura (type tool ).

2 Haga click para posicionar la esquina superior izquierda del objeto de texto 
en la ventana de título y escriba el texto que desee.

3 Cuando haya finalizado, haga click fuera del texto.
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El texto nuevo utiliza los ajustes actuales de color, transparencia y degradado. 
Consulte Uso de color, transpariencias y degradado.

Para editar y modificar texto ya existente:

1 Elija como debe afectar al texto la edición que se hará mediante uno de los 
siguientes procedimientos:

• Para cambiar de manera uniforme los atributos de un objeto de texto, 
seleccione la herramienta de selección ( ) y haga click en el texto. Se 
selecciona el objeto de texto completo y aparecen tiradores en las 
esquinas. 

• Para editar el texto o aplicar diferentes atributos a caracteres 
individuales, seleccione la herramienta de escritura, haga click en un 
objeto de texto y, a continuación, arrastre hasta seleccionar el texto que 
desea cambiar. Por ejemplo, puede aplicar un color y tamaño diferentes 
a una de las palabras del título.

Nota: La herramienta de selección afecta a todos los caracteres del objeto de 
texto, mientras que la de escritura sólo afecta a los seleccionados. Así, por 
ejemplo, si utiliza la herramienta de escritura para aplicar el color azul a una 
palabra y, a continuación, utiliza la herramienta de selección para aplicar el 
color rojo al objeto de texto que contiene la palabra en azul, todos los 
caracteres del objeto de texto se cambian al color rojo.

2 Realice una de las siguientes acciones:

• Para cambiar la fuente, elija Title > Font y seleccione una fuente. En 
Windows, haga click en OK. 

• Para cambiar el estilo de escritura, elija Title > Style y seleccione un 
estilo del menú Estilo. Los estilos Normal (Plain), Negrita (Bold), Cursiva 
(Italic) y Subrayado (Underline) funcionan igual que en un procesador de 
texto. El estilo Relieve (Emboss) crea una copia ligeramente desplazada 
del texto detrás del texto original. 

• Para cambiar el tamaño de la fuente, elija Title > Size y seleccione un 
tamaño de fuente. En Windows también se puede cambiar el tamaño de 
la fuente eligiendo Title > Font y seleccionando un nuevo tamaño del 
menú Size. 

• Para cambiar el color, consulte Uso de color, transparencia y degradado. 
• Para especificar el espaciado interlineal, elija Title > Leading y 

seleccione un ajuste de interlineado (espacio interlineal) del menú. Reset 
Leading restaura el interlineado predeterminado de la fuente. 

• Para definir el espacio entre caracteres, haga click en un punto de 
inserción entre las letras en las que desea ajustar el espacio o 
seleccione un rango de caracteres. A continuación, haga click en el 
botón Decrease Kerning ( ) para reducir el espacio entre caracteres, o 
haga click en el botón Increase Kerning ( ) para aumentar el espacio 
entre caracteres 
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• Para cambiar el ajuste de párrafo, haga click en un punto de inserción en 
el párrafo que desee ajustar, elija Title > Justify, y seleccione un tipo de 
alineación de párrafo. 

Para editar texto ya existente, haga doble click en el texto con la 
herramienta de selección. Premiere cambia la herramienta de selección por la 
herramienta de texto de manera que pueda seleccionar caracteres individuales.

Para estirar el texto:

Con la herramienta de selección, haga click en un objeto de texto. Mantenga 
pulsada la tecla Control (Windows) u Opción (Mac OS) mientras arrastra 
cualquiera de los tiradores del objeto. Mientras lo arrastra, la herramienta de 
selección cambia a una herramienta de estiramiento.
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Cambio de la orientación del texto

Puede cambiar la orientación del texto. De forma predeterminada, una línea de 
texto se muestra de izquierda a derecha, pero puede especificar que tenga una 
orientación vertical de manera que la línea se muestre de arriba a abajo. Esto 
es de gran utilidad en idiomas como el japonés o para conseguir un efecto de 
texto.

Nota: Para hacer rotar libremente el texto, puede aplicar configuraciones de 
movimiento a un título después de añadirlo a la ventana de construcción 
(consulte Rotaciones, ampliaciones o reducciones, paradas y distorsiones), o 
preparar el título en otra aplicación como Adobe After Effects.

Para cambiar la orientación del texto:

Con la herramienta de selección ( ), haga click en un objeto de texto. Elija Title 
> Orientation y seleccione Horizontal o Vertical.
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Creación de texto con 
desplazamiento vertical u horizontal

Puede hacer que el texto se desplace por la pantalla en sentido vertical u 
horizontal. Los desplazamientos verticales pueden ser hacia abajo o hacia 
arriba y los horizontales hacia la izquierda o hacia la derecha.

La velocidad del movimiento no se determina en el momento de la creación del 
título, sino que ésta se ajusta en el momento de añadir el título a un programa 
de vídeo. Entonces la duración que se especifique para el título en la ventana 
de construcción determinará la velocidad con que el texto se desplazará por la 
pantalla. Por ejemplo, si al principio especifica una duración de veinte 
segundos para un título de crédito y con posterioridad lo cambia a diez 
segundos, el título debe desplazarse en sentido vertical el doble de rápido para 
poder moverse el mismo número de líneas a través de la pantalla en la mitad 
de tiempo.

Para crear texto con desplazamiento vertical u horizontal:

1 Seleccione la herramienta de desplazamiento de título (rolling title tool ).

2 Arrástrela para especificar el tamaño del objeto de texto que va a contener el 
título de crédito.

Al arrastrar la herramienta de desplazamiento de título (izquierda) se crea un objeto de texto 
(derecha).

3 Escriba el texto que desea en el título.

Nota: Para hacer que el texto se desplace, debe escribirse suficiente texto para 
llenar toda la caja de texto. Si su texto no es suficiente, utilice en el resto 
espacios en blanco. Para crear espacios en blanco, si el texto se moverá 
verticalmente, pulse Enter (hasta llegar al fondo de la caja de texto), pero si el 
texto se moverá horizontalmente pulse la barra espaciadora.
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4 Con la herramienta de desplazamiento aun seleccionada, elija Title > Rolling 
Title Options.

5 En la sección Direction seleccione la dirección en la que desea se desplace el 
título. Puede ser Up (arriba), Down (abajo), Left (izquierda) o Right (Derecha).

6 Marque Enable Special Timings (Activar sincronización especial) si desea 
mayor control sobre el desplazamiento vertical u horizontal. A continuación, 
especifique los siguientes valores según sus necesidades y haga click en OK:

• En Pre Roll, especifique el número de fotogramas que desea que 
aparezcan sin movimiento (empezando por el punto IN del clip del título 
hasta el fotograma en que el título empieza a desplazarse). 

• En Ramp Up (aceleración), especifique el número de fotogramas que 
debe utilizar el clip para acelerar hasta la velocidad normal. Introduzca 0 
(cero) para empezar a desplazar el título a velocidad normal. Para 
acelerar de forma gradual, especifique más fotogramas 

• En Ramp Down (frenado), especifique el número de fotogramas que 
debe utilizar el clip para desacelerar la velocidad hasta la mitad. Para 
desacelerar de forma más rápida, especifique menos fotogramas. 
Introduzca 0 (cero) para detener el título inmediatamente. Para 
desacelerar de forma gradual, especifique más fotogramas. 

• En Post Roll, especifique el número de fotogramas que desee que 
aparezcan sin movimiento en el título (empezando por el fotograma en el 
que el título se detiene hasta el punto OUT del título). 

Para previsualizar texto con desplazamiento vertical u horizontal:

Arrastre el potenciómetro situado en la esquina inferior izquierda de la ventana 
de título. Premiere proyecta todos los objetos de texto con desplazamiento 
vertical u horizontal en la ventana de título. Si ha importado un fotograma de 
fondo (consulte Importación de un fotograma de ejemplo), Premiere utiliza el 
clip que contiene el fotograma de fondo como duración del texto con 
desplazamiento vertical u horizontal y lo proyecta junto con el texto.

Nota: Este potenciómetro no previsualiza ninguna sincronización especial. La 
sincronización especial depende de la duración del clip en fotogramas, lo que 
se determina en la ventana de construcción. Para previsualizar la 
sincronización especial, añada el título a la ventana de construcción de un 
proyecto (consulte Adición de un título a un proyecto) previsualice la ventana 
de construcción.

Nota de Quinurio: No lo he conseguido hacer funcionar. Si alguien sabe 
hacerlo, por favor que me lo comunique. He probado de dos maneras: Creando 
una caja para el texto a mover (en la que sólo esté el texto) y creando una caja 
en la que se encuentre el texto y su trayectoria: Nones. De todas formas creo 
que la forma más efectiva de hacer un título en movimiento es hacer el título 
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normal, y luego utilizar las opciones de animación de clips de Premiere, por eso 
el no poder hacer funcionar esta utilidad no me parece especialmente grave.
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Creación de objetos gráficos

La caja de herramientas de la ventana de título contiene herramientas para 
crear objetos gráficos como líneas rectas, rectángulos, elipses y polígonos. Los 
polígonos pueden tener ángulos puntiagudos bien definidos o puede hacer que 
Premiere los redondee. Las líneas y formas utilizan inicialmente los atributos 
predeterminados de línea, color, degradado y sombra. Cuando se cambian los 
atributos de los objetos gráficos, el cambio afectará a todos los objetos que se 
creen después.

En la ventana de título, un objeto gráfico puede estar vacío (con contorno y sin 
relleno) u opaco (con relleno y sin contorno). Los objetos vacíos pueden 
convertirse en objetos opacos y viceversa. Si desea que una forma tenga tanto 
relleno como contorno, debe duplicarla y aplicar un relleno a una y un contorno 
a la otra.

Para crear una línea recta:

1 Seleccione la herramienta de líneas en la caja de herramientas (line tool ). 
Cada herramienta se vuelve a convertir en la herramienta de selección ( ) 
después de cada uso a menos que haga doble click en la misma, como se 
explica en Creación de objetos de texto.

2 Arrastre la herramienta para dibujar la línea o mantenga pulsada la tecla 
Mayúsculas mientras arrastra la herramienta para dibujar una línea forzada a 
incrementos de 45 grados.

Para crear un rectángulo, un rectángulo redondeado o una elipse:

1 Haga click en la mitad izquierda de la herramienta que desee utilizar para 
crear una forma vacía o en la mitad derecha para crear una forma opaca.

2 Realice una de las siguientes acciones:

• Arrastre la herramienta para dibujar la forma. 
• Mantenga pulsada la tecla Mayúsculas mientras arrastra la herramienta 

para dibujar una forma forzada como un cuadrado, un cuadrado de 
ángulos redondeados o un círculo. 

Para crear una forma poligonal:

1 Haga click en la mitad izquierda de la herramienta de polígonos ( ) para 
crear un polígono vacío o haga click en la mitad derecha de la misma ( ) 
para crear un polígono opaco.
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2 Sitúe la herramienta de polígonos donde desea comenzar a dibujar y haga 
clic. De esta manera creará un punto y un segmento de línea que partirá de él..

3 Sitúe la herramienta de polígonos donde desea que finalice el segmento y 
haga clic.

4 Repita los pasos 2 y 3 hasta que sólo quede un segmento por dibujar.

5 Realice una de las siguientes acciones:

• Para cerrar el polígono, haga click en el primer punto creado. Aparecerá 
un pequeño círculo junto al cursor cuando éste se encuentre 
exactamente sobre el primer punto. 

• Para dejar un polígono vacío abierto, haga doble click en el lugar en el 
que desee que aparezca el último punto. Un polígono opaco no se 
puede dejar abierto. 

Para convertir un objeto opaco en un objeto vacío o viceversa:

1 Con la herramienta de selección, seleccione el objeto gráfico.

2 Elija Title > Convert to Filled o Title > Convert to Framed.

Para definir el grosor de una línea o de un objeto vacío:

1 Con la herramienta de selección, seleccione la línea u objeto vacío que desea 
cambiar.

2 Arrastre el potenciómetro Grosor de línea para especificar el grosor de línea 
que desea.

No se puede definir el grosor de línea de un objeto opaco ya que no tiene 
contorno. No obstante, sí se puede crear un duplicado vacío del objeto 
(consulte el siguiente procedimiento) y definir el grosor de línea del nuevo 
objeto.

Para crear un duplicado vacío de un objeto opaco:

Seleccione un objeto opaco y elija Title > Create Framed Object. Aparecerá 
una copia vacía en la misma posición que el original.

Para crear un duplicado opaco de un objeto vacío:

Seleccione un objeto vacío y elija Title > Create Filled Object. Aparecerá una 
copia opaca en la misma posición encima del original. Si no puede ver el 
original vacío detrás de la copia opaca, seleccione la copia opaca y elija Title > 
Send to Back.
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Para redondear un polígono:

1 Con la herramienta de selección, seleccione un polígono.

2 Elija Title > Smooth Polygon.

Para editar un polígono:

1 on la herramienta de selección, seleccione el objeto gráfico que desea editar.

2 Arrastre cualquiera de los tiradores del objeto.
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Adición de una sombra

Premiere puede crear una sombra regulable tanto para los objetos de texto 
como para los objetos gráficos. Una ligera sombra puede ser útil para distinguir 
el texto del fondo. No obstante, la sombra tiende a hacer que el texto con letra 
pequeña sea aún más difícil de leer. A una sombra se le puede aplicar color, 
transparencia o degradado. Consulte Uso de color, transparencia y degradado.

Para crear una sombra:

1 Seleccione el objeto al que desea añadir una sombra.

2 Arrastre el control de desplazamiento de sombra (Shadow Offset) de la caja 
de herramientas para especificar la distancia a la que la sombra cae desde el 
objeto. Para forzar el movimiento en incrementos de 45 grados, mantenga 
pulsada la tecla Mayúsculas mientras arrastra dicho control.

Antes (izquierda) y después (derecha) de añadir una sombra

Para especificar el tipo de sombra:

1 Seleccione un objeto con sombra.

2 Elija Title > Shadow y seleccione un tipo de sombra del menú Sombra:

• Single crea una sombra básica. 
• Solid simula una sombra tridimensional. 
• Soft crea una versión de bordes difuminados de la sombra Simple. 

Para eliminar una sombra:

1 Seleccione un objeto con sombra.

2 Arrastre el control de desplazamiento de sombra (Shadow Offset) hacia 
afuera o hacia el centro del área de control. La sombra se ha eliminado 
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correctamente si en el control de desplazamiento de sombra se muestra el 
mensaje "No Shadow".
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Uso de color, transparencia y 
degradado

Es posible aplicar color, transparencia, color del degradado y transparencia del 
degradado a un texto, a objetos gráficos o a sombras. También se puede 
utilizar la herramienta de cuentagotas (eyedropper) para conseguir un color que 
ya existe en la ventana de título, incluso en el caso de que se encuentre en un 
fotograma de fondo importado.

Nota de Quinurio:

En mi opinión Premiere lía mucho la cuestión de cómo aplicar colores, y pienso 
que es más fácil de lo que parece. Por ello, a continuación el tema de 
Premiere, y después he añadido mi síntesis, en el próximo tema: Resumen 
sobre la aplicación de color.

Para aplicar un color sólido:

1 Realice una de las siguientes acciones:

• Utilice la herramienta de selección ( ) para seleccionar un objeto de 
texto o gráfico de manera que afecte a todo el objeto. 

• Utilice la herramienta de escritura ( ) para seleccionar caracteres 
individuales de un objeto de texto de manera que sólo afecte a esos 
caracteres. 

2 Si pretende añadir color a un objeto, haga click en el selector de color de 
objetos, si pretende añadir color a una sombra, haga click en el selector de 
color de sombras.

Selector de color de objetos (A) y selector de color de sombras (B)

3 Especifique un color (consulte Uso del selector de color), y pulse OK.

Para conseguir un color que existe en la ventana de título:
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1 Con la herramienta de selección, seleccione el objeto de texto o gráfico al 
que desea aplicar el color.

2 Seleccione la herramienta de cuentagotas (eyedropper ).

3 Haga click con la herramienta de cuentagotas en el color que desea aplicar.

Para conseguir un color y aplicarlo a determinados caracteres del texto:

1 Haga click en un área que no contenga objetos para asegurarse de no 
seleccionar nada.

2 Seleccione la herramienta de cuentagotas.

3 Haga click con la herramienta de cuentagotas en el color que desea aplicar.

4 Pulse el selector de color de objeto.

5 Anote los valores de Red, Green, y Blue, y pulse Cancel.

6 Seleccione la herramienta de escritura y arrástrela hasta seleccionar uno o 
más caracteres del texto.

7 Haga click en el muestrario Color del objeto o en el muestrario Color de la 
sombra y, para los campos Red, Green, y Blue, escriba los valores que antes 
anotó. Después pulse OK.

Para cambiar los colores del objeto y de la sombra:

Haga click en la flecha curvada de dos puntas ( ), que se encuentra entre el 
selector de color de objeto y el de sombra.

Para aplicar un degradado:

1 Realice una de las siguientes acciones:

• Utilice la herramienta de selección para seleccionar un objeto de texto o 
gráfico si desea que el degradado afecte a todo el objeto. 

• Utilice la herramienta de escritura para seleccionar caracteres 
individuales de un objeto de texto si desea que el degradado afecte sólo 
a esos caracteres. 

2 Si es necesario haga click en el selector de color de objeto o en el selector de 
color de sombra, para colocarlo delante. El efecto se aplicará al selector que se 
encuentre delante.

3 Haga click en el selector de color inicial del degradado y especifique un color 
(consulte Uso del selector de color), y pulse OK.
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Selector de color inicial de degradado (A) y selector de color final de degradado (B)

4 Pulse el selector de color final del degradado, especifique un color y pulse 
OK.

5 Para definir la dirección de un degradado, haga click en un triángulo de la 
opción Dirección del degradado/transparencia.

Pulsando un triángulo se establece la dirección del degradado.

Para definir la opacidad:

1 Realice una de las siguientes acciones:

• Utilice la herramienta de selección para seleccionar el objeto de texto o 
gráfico si desea que afecte a todo el objeto. 

• Utilice la herramienta de escritura para seleccionar caracteres 
individuales de un objeto de texto si desea que afecte sólo a esos 
caracteres. 

2 Si es necesario haga click en el selector de color de objeto o en el selector de 
color de sombra, para colocarlo delante. El efecto de opacidad se aplicará al 
selector que se encuentre delante.

3 Realice una de las siguientes acciones:

• Haga click en el triángulo situado a la izquierda del selector de color 
inicial de degradado o a la derecha del selector de color final de 
degradado y, a continuación, haga click o arrástrelo hasta especificar un 
valor de opacidad. 
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• Haga click en el triángulo que hay entre los dos selectores de color 
inicial y final de degradado y, a continuación, haga click o arrástrelo 
hasta especificar un valor de opacidad del menú Transparencia total. 
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Resumen sobre la aplicación de color

Para aplicar color a los objetos de la ventana de título debe tenerse en cuenta 
lo siguiente:

• Cuando se selecciona un color este se aplica, inmediatamente a lo que 
esté seleccionado en la ventana. 

• En la ventana puede estar seleccionado un objeto (si se hizo click en él 
con la herramienta de selección), o un fragmento de texto (sólo algunas 
letas) si se seleccionaron con la herramienta de escritura. 

• Se pueden seleccionar: 
o Colores para objetos y texto 
o Colores para sombras 
o Colores para degradados 

Para seleccionar los colores se utilizan los selectores de color. Hay un selector 
para color de objetos, otro para color de sombras, otro para color inicial de 
degradados y otro para color final de degradados. Véase la imagen:

A: Selector de color para objetos

B: Idem para sombras

C: Idem para inicio de degradado

D: Idem para final de degradado

Los selectores de objeto y sombra sólo están activos cuando se encuentran en 
primer plano. Para colocar uno de ellos en el primer plano, basta con hacer 
click sobre él.

A la vista de lo anterior, para seleccionar un color hay tres procedimientos:

• 1º. Pulsar el selector de color y elegir visualmente un color dentro del 
rango mostrado 

• 2º. Pulsar el selector de color e introducir los valores de Rojo, Verde y 
Azul para un color. 

• Utilizar la herramienta cuentagotas. Esta herramienta selecciona 
cualquier color existente ya en la ventana sobre el que se haga click. El 
color se aplicará al selector de color para objetos o al selector para 
sombras, según cual de ellos se encuentre en el primer plano. Esta 
herramienta no se puede utilizar cuando está activa la herramienta de 
escritura. 

Ya está todo. Quizás sólo falte añadir que un degradado consiste en la 
aplicación progresiva de un rango de colores: Basta con indicar el color inicial y 
el final, y Premiere selecciona todos los colores intermedios necesarios.
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Sobre opacidad y transparencia de los colores, así como sobre dirección del 
degradado, véase el tema de ayuda anterior.

288



Uso del selector de color

En Premiere, se puede especificar el color de forma visual o bien mediante el 
uso de los valores RGB (rojo, verde y azul). El Selector de color está disponible 
siempre que el color sea una opción en la tarea que se esté realizando.

Para utilizar el Selector de color de Premiere:

1 Realice una de las siguientes acciones:

• Para especificar un color de forma visual, haga click en el color que 
desee en el área de colores. 

• Para especificar un color mediante el uso de los valores RGB, escriba 
los valores que desee en las opciones Rojo (Red), Verde (Green) y Azul 
(Blue). 

En la esquina superior derecha del Selector de color, la mitad inferior de la 
muestra de color cambia para mostrar el color especificado. Para servir de 
referencia, la mitad superior de la muestra de color permanece con el color 
original y no cambia.

2 Cuando una nueva muestra de color aparece con un símbolo de advertencia 
de la gama de colores ( ) junto a la muestra de color más baja, es porque el 
color especificado está fuera de la gama de colores que los vídeos NTSC 
pueden reproducir con exactitud. Si edita para vídeos NTSC, haga click en la 
muestra o en el símbolo de advertencia de la gama de colores para que el color 
cambie automáticamente al color más próximo que exista dentro de la gama de 
colores NTSC cuando el título no está renderizado, es decir que su apariencia 
no cambia inmediatamente. Este símbolo de advertencia no se aplica en vídeos 
PAL y SECAM ya que disponen de una mayor gama de colores.

3 Pulse OK.
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Ordenación de los objetos de texto y 
gráficos

Cada vez que se añade un objeto a la ventana de título, este forma una nueva 
capa. Las capas son importantes para entender cómo se ordenan los objetos, 
porque la capa superior siempre tapará a la capa inferior. Es decir: si se 
arrastra un objeto sobre otro, el que se encuentre en la capa superior ocultará 
al que se encuentre en la capa inferior (a no ser que se trate de un objeto 
transparente).

De forma predeterminada el orden de las capas coincide con el orden en el que 
los objetos se crearon, aunque en la ventana de títulos se incluyen opciones 
para ordenar las capas de otra manera.

Para modificar la capa en la que se encuentra un objeto:

1 Con la herramienta de selección ( ), eleccione un objeto de texto o gráfico.

2 Realice una de las siguientes acciones:

• Elija Title > Bring to Front. El objeto pasará a la capa superior 
• Elija Title > Send to Back. El objeto pasará a la capa inferior. 

3 Repita los puntos 1 y 2 con los demás objetos según sea necesario hasta que 
el texto y los objetos estén dispuestos de la manera que desea.

Para centrar el texto u objetos en el área de dibujo:

1 Con la herramienta de selección ( ), eleccione un objeto de texto o gráfico.

2 Realice una de las siguientes acciones para conseguir el centrado deseado:

• Elija Title > Center Horizontally. El objeto se centrará horizontalmente 
• Elija Title > Center Vertically. El objeto se centrará verticalmente 
• Elija Title > Position in Lower Third. El objeto se colocará a un tercio del 

borde inferior. 
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Adición de un título a un proyecto

Cuando se ha terminado y grabado el título, Premiere automáticamente lo 
añade al proyecto que se encuentre abierto. El título se convierte en un clip 
más. Si se quiere añadir al proyecto un título que no se encuentra actualmente 
abierto en una ventana de título, éste se debe importar de la misma manera 
que cualquier otro clip. Consulte Importación de clips.

Nota: Si para generar el título se importó un fotograma de ejemplo, este no 
formará parte del título una vez que el mismo se haya añadido al proyecto.

Si desea que el título aparezca opaco y editado en el programa de vídeo entre 
otros clips, simplemente añádalo a la pista de vídeo 1A o 1B de la ventana de 
construcción de la misma manera que haría con cualquier otro clip. 

Si, por el contrario, desea que el título se muestre sobre otro clip, debe añadir 
el título a una pista superpuesta. Cuando mueve un título desde la ventana de 
título hasta un proyecto, las áreas vacías o semitransparentes del título se 
convierten automáticamente en un canal alfa que marca las áreas 
transparentes y semitransparentes. Premiere automáticamente aplica la 
transparencia de canal alfa a los títulos. Para más información consulte Uso de 
la transparencia de canal Alfa.

Para añadir un título al proyecto:

1 Si se trata de un título que se acaba de crear, simplemente grávelo: El título 
automáticamente se incorporará al proyecto actualmente abierto.

Nota: Si no hay abierto ningún proyecto cuando se creó el título, grabe el título 
en el disco, abra un proyecto y después arrástrelo directamente desde la 
ventana de título a la ventana de proyecto o de construcción.

2. Si el título ya se había creado antes, elija File > Import > File. Localice y 
seleccione el título y pulse Abrir.

3 Relice una de las siguientes acciones:

• Para superponer el título sobre otro clip, añádalo a una vista de vídeo 
superpuesto (Cualquier pista de vídeo que no sea la pista 1A ó 1B). 

• Para hacer que el título se muestre opaco (como un clip normal), 
añádalo a las pistas de Vídeo 1A o 1B (o seleccione la opción Opaque, 
en el cuadro de diálogo de opciones de la ventana de título, y después 
añádalo a cualquier pista de vídeo). 

•
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Nota: Si primero se añade un título a la pista de vídeo 1A o 1B y después se 
mueve a una pista de vídeo distinta, seguirá siendo opaco. Para hacerlo 
transparente, bórrelo de la ventana de construcción y luego añádalo 
directamente a la pista de vídeo superpuesto.

Para cambiar la duración de un título en la ventana de construcción:

Arrastre su punto IN o OUT o seleccione el clip y elija Clip > Duration

Para ver un título con áreas transparentes:

Realice una de las siguientes acciones:

• Haga un barrido sobre la porción de la ventana de construcción en 
donde se encuentra el título. Para ello presione Alt (Windows) u Option 
(Mac OS) mientras arrastra por la regla de tiempo sobre los fotogramas 
que desea ver. 

• Construya una previsualización del título: En la ventana de construcción 
mueva la barra amarilla representativa del área de trabajo hasta que 
cubra la zona donde se encuentra el título y depués pulse Enter 
(Windows) o Return (Mac OS) (Consulte Previsualización del programa 
de vídeo). 

Nota: Si el fondo del título no se muestra transparente, haga doble click sobre 
él para abrirlo, elija Window > Title Window Options, y asegúrese de que la 
opción Opaque no está seleccionada.
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Superposición y composición

Acerca de las transparencias
Uso de la línea de nivel de opacidad
Uso de transparencias para superposiciones y para crear composiciones
Superposición de dos o más clips
Adición de un fondo de color
Creación de máscaras para ocultar partes no deseadas
Creación de pantallas divididas
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Acerca de las transparencias

Tanto en el vídeo como en las filmaciones, la transparencia permite ver un clip 
a través de otro, y, por tanto, crear composiciones, transiciones o efectos 
especiales. La opacidad de un clip o de parte de él determina su nivel de 
transparencia: con una opacidad del 100%, una imagen no será en absoluto 
transparente; con una opacidad del 0% será totalmente transparente (y por 
tanto prácticamente invisible), permitiendo, por tanto, ver otros clips a través de 
ella. Con otros porcentajes, la imagen es parcialmente transparente, por lo que 
las imágenes que se encuentren debajo serán visibles al mismo tiempo. La 
opacidad del clip también se ve afectada por los valores de luminosidad de un 
clip canal alfa, o por una escala de gris adicional o un canal monocromo en una 
imagen RGB.

Para hacer que algunas partes de los clips sean transparentes se utilizan unas 
herramientas denominadas transparencias. Las transparencias buscan los 
pixeles de una imagen que se corresponden con un color o un brillo 
determinado y los convierten en transparentes o semitransparentes, 
dependiendo del tipo de transparencia aplicado. Este proceso se denomina 
extracción de color. Las transparencias también usan un canal alfa del clip para 
funcionar.

Sólo se puede crear una transparencia en un clip después de situarlo en una 
pista de superposición. Todos los proyectos nuevos incluyen, de forma 
predeterminada, una pista de superposición denominada Vídeo 2; sin embargo, 
se pueden añadir hasta 97 pistas de este tipo. Para más información al 
respecto, consulte Añadir, renombrar y borrar pistas.
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Composición

Los efectos especiales para películas o vídeos se crean a menudo filmando 
una escena contra un fondo de color; de este modo, después de digitalizar el 
material, el fondo de color se hace transparente mediante una transparencia. 
Esta primera escena, o clip, se sitúa sobre un segundo clip, que normalmente 
incluye algún tipo de escena de fondo. El resultado forma una composición, en 
donde el fondo resulta visible a través de las partes del primer clip que sean 
transparentes, creando el efecto de que el primer clip y el segundo son sólo 
uno.

Este tipo de composiciones se ven a menudo en películas en las que un actor 
parece colgar de un helicóptero o flotar en el espacio. En este caso, se filma al 
actor en una posición apropiada contra un fondo de color y después de hacer el 
color transparente, la escena con el actor se compone sobre el fondo deseado. 
Los fondos de color son normalmente azules o verdes ya que estos colores 
están prácticamente ausentes del color de la piel o del pelo.
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Opacidad

Además de aplicar transparencias a partes de un clip, también se puede ajustar 
la opacidad de todo el clip para darle entrada o salida gradualmente. Asimismo, 
se puede utilizar el ajuste del nivel de opacidad para crear efectos de transición 
adicionales o superposiciones simples.

Diferencias entre opacidad y transparencias:

Ajustando el nivel de opacidad de un clip puede hacerse total o parcialmente 
transparente. Pero la transparencia así obtenida afecta por igual a todos los 
pixeles de los fotogramas que sean transparentes.

Por el contrario, cuando se utilizan las opciones de Transparencia propiamente 
dichas, lo que se pretende es que sólo ciertas partes de los fotogramas sean 
transparentes, para así poder crear composiciones.
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Uso de la línea de nivel de opacidad

Cuando se sitúa un clip en una pista de superposición, aparece debajo una 
línea roja que controla el nivel de opacidad (para ver dicha línea, se deberá 
expandir la pista de superposición). La situación de esta línea determina la 
opacidad del clip: Si se encuentra en la parte superior el clip tendrá un 100% de 
opacidad (no será transparente), y si se encuentra en la parte inferior su nivel 
de opacidad será del 0% siendo pues absolutamente transparente. Añadiendo 
a la línea puntos de control se puede ajustar la opacidad de todo el clip, 
haciendo incluso unas partes más opacas que otras.

La línea de nivel de opacidad la ajusta después de aplicar transparencias; es 
decir, al moverla se ajusta la opacidad de las zonas opacas, transparentes y 
semitransparentes de un clip.

Para ajustar el nivel de opacidad:

1 Sitúe un clip en una pista de superposición. Si fuera necesario, haga click en 
el triángulo situado a la izquierda del nombre de la pista para expandirla, o 
pulse Option-click (Mac OS) o Alt-click (Windows) sobre el triángulo para 
expandir en un solo paso todas las pistas superpuestas.

2 Si la línea roja de opacidad no está visible tras expandir la pista, pulse el 
icono rojo Display Opacity Rubberbands ( ) para mostrarla.

3 Con la herramienta de selección activada, sitúe el puntero sobre la parte 
superior de la línea roja. El puntero adopta la forma de un dedo señalando con 
los signos más y menos en rojo.

4 Haga click para crear un punto de control (que se muestra como un pequeño 
cuadrado rojo sobre la línea), y arrástrelo hacia arriba o hacia abajo con el fin 
de ajustar la opacidad. El porcentaje de opacidad aparece en la paleta de 
información y se actualiza según se arrastra el punto de control. Pulse la tecla 
Shift con un punto de control seleccionada para ver el porcentaje de opacidad 
como un pequeño rótulo junto al cursor y para cambiarlo en incrementos de un 
1% (para ajustes más precisos).

Cuando el punto de control se encuentra en la parte superior del área del 
control de nivel, la imagen es totalmente opaca; cuando se encuentra en la 
parte inferior del panel, la imagen es transparente. La línea entre dos puntos de 
control indica la dirección, la longitud y la velocidad del ajuste de opacidad. 
Cuanto más acusado sea el ángulo, más repentino resultará el cambio.

297



Haciendo click en la línea roja de opacidad, se crea un punto de control de opacidad 
(izquierda), y arrastrándolo hacia abajo, se reduce la opacidad y aumenta la transparencia 
(derecha)

5 Repita el paso anterior para crear tantos puntos de control como precise.

6 Para suprimir un punto de control arrástrelo fuera de la pista de 
superposición.

Para crear dos puntos de control de opacidad:

1 Seleccione la herramienta para insertar puntos adyacentes (fade scissors ).

2 Haga click sobre la línea de control de la opacidad donde no existan puntos 
de control. Aparecerán dos puntos adyacentes.

3 Arrastre los nuevos puntos de control arriba o abajo para aumentar o reducir 
drásticamente la opacidad.

Para ajustar el nivel de opacidad de un segmento determinado:

1 Seleccione la herramienta para mover segmentos (fade adjustment ).
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2 Arrastre el segmento de línea hacia arriba o hacia abajo. Para ajustar la 
opacidad del clip completo a un valor constante, ajuste el control de nivel de 
esta manera antes de crear puntos de control.
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Uso de transparencias para 
superposiciones y para crear 
composiciones

Adobe Premiere incluye 15 transparencias que se pueden aplicar a un clip para 
crear transparencias de distintas formas. Se pueden emplear transparencias 
basadas en colores para superponer, transparencias de brillo para añadir 
textura o efectos especiales, transparencias de canal alfa para clips o 
imágenes que ya contengan un canal alfa y transparencias de máscara para 
añadir máscaras movibles o superposiciones creativas.

En algunos casos, se puede hacer que el proceso de transparencia resulte más 
sencillo utilizando temporalmente una máscara de fondo de color vivo, ya que 
un color de este tipo bajo la imagen a la que se está aplicando una 
transparencia permite ver con mayor facilidad las áreas transparentes. Para 
más información, consulte Adición de una máscara de fondo.

Para aplicar una transparencia a un clip:

1 Seleccione el clip en una pista de superposición (Vídeo 2 o superior).

2 Realice una de las siguientes acciones:

• En la paleta de control de efectos pulse Transparency Setup 
• Elija Clip > Video Options > Transparency. 

3 Elija una transparencia del submenú..
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El tipo de transparencia predeterminado es Ninguna. Con este valor, no se 
aplicará transparencia a ninguna parte de la imagen superpuesta; aunque 
puede ajustar la opacidad de la imagen con el control de nivel en la ventana de 
construcción (consulte Uso de la línea de nivel de opacidad). Asimismo, podrá 
utilizar el tipo de transparencia Ninguna para crear pantallas divididas y otros 
efectos en los que una parte de la imagen subyacente sea visible (consulte 
Creación de pantallas divididas).

4 Haga click en uno de los siguientes iconos para ver la transparencia:

Sitúa un fondo negro o blanco detrás de la imagen a la que se le ha aplicado 
la transparencia. Haga click para cambiar entre blanco y negro.

Muestra un diseño de tablero para ayudarle a distinguir la transparencia en 
áreas que pueden resultar difíciles de ver con un fondo sólido o con la imagen 
subyacente actual. Haga click para invertir el tablero.

Muestra la imagen subyacente actual del proyecto. Esta vista puede resultar 
más lenta de ver cuando se arrastra el potenciómetro de previsualización 
situado bajo el cuadro Muestra.

5 Para aumentar la imagen del área Sample seleccione el icono del zoom ( ), 
a continuación, haga click en una zona de la imagen. Haga click de nuevo para 
incrementar el zoom. La imagen puede aumentarse hasta 10 veces su tamaño 
original. Para reducirla, mantenga pulsada la tecla Alt (Windows) u Opción 
(Macintosh) y haga click en la imagen con el icono del zoom seleccionado. 
Para ver otras áreas de la imagen con el mismo nivel de zoom, seleccione el 
icono de la mano ( ) y arrastre la imagen. Sólo en Mac OS, puede hacer click 
en el icono Colapsar ( ) para mover la imagen a la vista de programa de la 
ventana de monitor.

6 Seleccione las opciones siguientes según las necesite, y dependiendo del 
tipo de transparencia elegido en el paso 3:

• Reverse Key para invertir las áreas transparentes y opacas (disponible 
sólo para algunas transparencias). 

• Drop Shadow para añadir una sombra 50% gris y 50% opaca a las áreas 
opacas (disponible sólo para algunas transparencias). La sombra se 
sitúa cuatro pixeles por debajo y a la derecha de cualquier región opaca 
contigua. Esta opción resulta muy eficaz para títulos o gráficos simples. 

• Mask Only para producir un efecto especial que muestra sólo la máscara 
del canal alfa del clip (disponible sólo para algunas transparencias). 

7 Ajuste los potenciómetros de transparencia y seleccione otras opciones tal y 
como se describe en las secciones siguientes correspondientes a cada 
transparencia.
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8 Arrastre el potenciómetro situado bajo Sample para ver las configuraciones 
de la transparencia a lo largo de la duración del clip.

9 Pulse OK para aplicar las configuraciones al clip.

Nota de Quinurio: En los siguientes temas de ayuda se explican las diferentes 
transparencias incorporadas a Premiere. Como estas transparencias hay que 
elegirlas en el menú Key Type del cuadro de diálogo de configuración de 
transparencias, he decidido no traducir el nombre de la transparencia en el 
título de los temas de ayuda, para que sea más fácil seleccionar el tema de 
ayuda que corresponde a cada opción de dicho menú. En el texto de la ayuda 
si se traducen los nombres de las transparencias.
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Uso de la transparencia Chroma

La transparencia Croma (en inglés Chroma) permite seleccionar un color o un 
rango de colores para que aparezcan como transparentes en el clip. Se puede 
aplicar esta transparencia cuando se ha filmado una escena sobre un fondo 
que contenga un rango de colores, como por ejemplo, un fondo con distintos 
tonos de azul. Seleccione un color de transparencia haciendo click en el 
muestrario de color o mediante el cuentagotas para seleccionar un color de la 
miniatura situada bajo el muestrario de color. Utilice las barras del 
potenciómetro del cuadro de diálogo para ajustar el color al que desea aplicar 
transparencia.

Cuanso se selecciona este tipo de transparencia, se pueden ajustar los 
siguientes valores:

Similarity (Semejanza) Amplia o reduce el rango de colores que se volverá 
transparente. Cuanto mayor sea el valor, más amplia será la gama.

Blend (Mezcla) Mezcla el clip al que se está aplicando una transparencia con 
el clip subyacente. Cuanto mayor sea el valor, más partes del clip se 
mezclarán.

Threshold (Umbral) Controla la cantidad de sombras del rango de colores al 
que ha aplicado una transparencia. Cuanto mayor sea el valor, más sombras 
se retienen.

Cutoff (Corte) Oscurece o aclara las sombras. Arrastre hacia la derecha para 
oscurecer sombras, pero no arrastre más allá del potenciómetro Umbral, ya 
que si lo hace, los pixeles grises y los transparentes se invertirán.

Smoothing (Suavizado) Especifica la cantidad de suavizado que Premiere 
aplicará a los límites entre las zonas transparentes y las opacas. El suavizado 
mezcla los pixeles para producir bordes más suaves y lisos. Elija None 
(ninguno) si desea producir bordes marcados, sin suavizar, que resultan útiles 
cuando se desea conservar líneas nítidas, como en el caso de los títulos. Elija 
Low (bajo) o High (alto) para producir distintas intensidades de suavizado.
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Uso de la transparencia RGB 
Difference

La transparencia Diferencia RGB es una versión más simple de la 
transparencia Croma. Se puede seleccionar un rango de colores, pero no se 
puede mezclar la imagen o ajustar la transparencia en grises. Utilice la 
transparencia Diferencia RGB para una escena con una iluminación muy 
intensa y que no contenga sombras, o para esbozos que no requieran ajustes 
exactos. Seleccione un color de transparencia haciendo click en el muestrario 
de color o mediante el cuentagotas, y seleccione un color de la miniatura 
situada bajo el muestrario de color.

Cuando se elige este tipo de transparencia, se pueden ajustar los siguientes 
valores:

Similarity (Semejanza)Amplía o reduce el rango de colores que se volverá 
transparente. Cuanto mayor sea el valor, más amplio será el rango.

Smoothing (Suavizado) Especifica la cantidad de suavizado que Premiere 
aplicará a los límites entre las zonas transparentes y las opacas. El suavizado 
mezcla los pixeles para producir bordes más suaves y lisos. Elija None 
(ninguno) si desea producir bordes marcados, sin suavizar, que resultan útiles 
cuando se desea conservar líneas nítidas, como en el caso de los títulos. Elija 
Low (bajo) o High (alto) para producir distintas intensidades de suavizado.
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Uso de las transparencias Blue 
Screen y Green Screen

Las transparencias Pantalla azul y Pantalla verde (en inglés Blue Screen y 
Green Screen, respectivamente) crean transparencia a partir de azul croma 
verdadero y verde croma verdadero. Utilice estas transparencias para hacer 
transparentes fondos azules o verdes bien iluminados al crear composiciones. 

Cuanso se seleccionan estos tipos de transparencia, se pueden ajustar los 
siguientes valores:

Threshold (Umbral) Arrastre hacia la izquierda hasta que el fondo azul o verde 
sea transparente.

Cutoff (Corte) Arrastre hacia la derecha hasta que el área opaca alcance un 
nivel satisfactorio.

Para ajustar de forma precisa los bordes, arrastre los potenciómetros 
Umbral y Corte poco a poco.
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Uso de la transparencia Non-Red

La transparencia Non-Red (aproximadamente: Sin rojo) crea transparencia a 
partir de fondos verdes o azules. Resulta similar a las transparencias Pantalla 
azul (Blue Screen) y Pantalla verde (Green Screen), pero además permite 
mezclar dos clips. Asimismo, la transparencia Sin Rojo reduce los flecos 
alrededor de los bordes de los objetos que no son transparentes. Se 
recomienda utilizar esta transparencia para hacer transparentes los fondos 
verdes cuando es necesario controlar la mezcla o cuando no se puedan 
producir resultados satisfactorios con las transparencias Pantalla azul o 
Pantalla verde.

Cuando se elige esta transparencia se pueden ajustar los siguientes valores:

Threshold (Umbral) Arrastre hacia la izquierda hasta que el fondo azul o verde 
sea transparente.

Cutoff (Corte) Arrastre hacia la derecha hasta que el área opaca alcance un 
nivel satisfactorio.

Blend (Mezcla) Arrastre para mezclar una imagen con cualquier imagen 
subyacente.
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Uso de la transparencia Luminance

La transparencia Luminancia (Luminance) crea una transparencia a partir de 
los valores más oscuros de la imagen, dejando los colores más vivos como 
opacos. Al igual que las transparencias Multiplicar (Multiply) y Fondo (Screen), 
resulta más eficaz cuando la imagen a la que se está aplicando una 
transparencia contiene áreas oscuras y claras en contraste. Utilice la 
transparencia Luminancia para crear superposiciones sutiles o para hacer 
transparentes áreas oscuras.

Cuando se elige esta transparencia se pueden ajustar los siguientes valores:

Threshold (Umbral) Especifica el rango de valores más oscuros que se 
convertirán en transparentes. Los valores altos aumentan el rango de 
transparencia.

Cutoff (Corte) Ajusta la opacidad de las áreas que se han especificado 
mediante el potenciómetro Umbral. Los valores altos aumentan la 
transparencia.

Uso de las transparencias Multiply y 
Screen

Las transparencias Multiplicar (Multiply) y Fondo (Screen) utilizan una imagen 
subyacente como mapa para determinar qué parte de la imagen a la que se 
aplica transparencia se convertirá en transparente. La transparencia Multiplicar 
crea una transparencia en las áreas de la imagen que corresponden a las 
zonas claras de la imagen subyacente. Por el contrario, la transparencia Dividir 
crea una transparencia en las áreas que corresponden a las zonas oscuras de 
la imagen subyacente. Utilice estas transparencias para crear superposiciones 
sutiles, cuando la imagen subyacente contiene elementos con un contraste 
muy acusado.

Eligiendo estas transparencias es posible ajustar el siguiente valor:

Cutoff (Corte) Arrastre hacia la derecha hasta que el área opaca alcance un 
nivel satisfactorio. Los valores altos producen menos transparencia.
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Uso de la transparencia Alpha 
Channel

Las imágenes representadas en vídeo se componen de tres imágenes en 
escala de grises denominadas canales: una roja, una verde y una azul. Estas 
imágenes se denominan imágenes RGB. Un canal alfa es un cuarto canal en 
una imagen RGB que define qué partes de la imagen son transparentes o 
semitransparentes. Muchos programas, como Adobe Illustrator y Photoshop, 
utilizan canales alfa para permitir al usuario especificar las regiones 
transparentes de una imagen. Un canal alfa puede ser directo o 
premultiplicado, dependiendo del programa que haya creado la imagen. 
Cuando una imagen contiene un canal alfa directo, la información de 
transparencia sólo se encuentra almacenada en el canal alfa. Cuando una 
imagen contiene un canal alfa premultiplicado, el color de fondo que se 
considera transparente está también mezclado con las esquinas de la imagen.

Utilice este tipo de transparencia en clips que contengan un canal alfa directo, 
como por ejemplo, las imágenes creadas con Adobe Photoshop, Adobe 
Illustrator y Adobe After Effects.

Si se usa esta transparencia con un clip al que se le ha aplicado o se planea 
aplicar animación, seleccione la opción Use Clip's Alpha en el cuadro de 
diálogo de configuración de la animación. Si no se hace así aparecerá la caja 
de construcción del clip cuando éste se mueva. Consulte Especificación de 
canal alfa y de opciones de color.

La imagen de Photoshop (izquierda) contiene un canal alfa independiente (centro) que 
Premiere utiliza para componer el primer plano contra otro fondo (derecha).
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Uso de las transparencias Black 
Alpha Matte y White Alpha Matte

Cuando una imagen contiene un canal alfa premultiplicado, la información de 
transparencia se encuentra almacenada en los tres canales de color, además 
del canal alfa. Normalmente, una imagen que contenga un canal alfa 
premultiplicado también contiene un fondo blanco o negro. Si se está 
componiendo la imagen, es posible que se tenga que aplicar una transparencia 
al fondo.

ara aplicar una transparencia a un fondo negro, utilice la transparencia Canal 
alfa sobre negro (Black Alpha Matte); y para aplicar una transparencia a un 
fondo blanco, la transparencia Canal alfa sobre blanco (White Alpha Matte).
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Uso de Image Matte (Imagen como 
máscara)

La transparencia Imagen como máscara utiliza una imagen fija especificada (la 
máscara) para determinar las áreas de transparencia de un clip. Las áreas del 
clip superpuesto que se correspondan con las zonas de blanco de la imagen 
fija permanecerán opacas, mientras que las áreas de negro de la imagen fija se 
volverán totalmente transparentes en el clip. Las partes de la imagen que se 
encuentren entre el blanco y el negro producirán niveles variables de 
transparencia en el clip.

A. Imagen fija elegida para la transparencia Imagen como 
máscara en el cuadro de diálogo Configuraciones de 
transparencia.

B. Clip de vídeo en pista de superposición.

C. Efecto de la transparencia Imagen como máscara en la 
pista de superposición.

D. Resultado final sobre la pista inferior.
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Uso de Difference Matte (Máscara de 
diferencia)

La Máscara de diferencia crea una transparencia comparando la imagen 
especificada con el clip especificado y eliminando las áreas del clip que se 
corresponden con aquéllas de la imagen. Aunque esta transparencia se puede 
utilizar para crear efectos especiales, también se puede emplear para aplicar 
una transparencia a un fondo estático seleccionando la opción Invertir máscara.

De este modo, se puede eliminar un fondo estático situado detrás de un objeto 
en movimiento, como por ejemplo una persona paseando por un escenario, y 
situarla sobre otro fondo distinto. Con frecuencia la imagen especificada es 
simplemente un fotograma de material de fondo (antes de que el objeto en 
movimiento haya entrado en la escena). Por esta razón, se recomienda el uso 
de la Máscara de diferencia cuando las escenas se hayan filmado con una 
cámara fija. 

Para sustituir un fondo fijo situado detrás de un objeto en movimiento:

1 Busque un fotograma del clip que sólo sea un fondo estático.

2 Guarde este fotograma de fondo como archivo de imagen. Para más 
información sobre cómo guardar un fotograma, consulte Exportación de 
imágenes fijas.

3 Sitúe el clip de vídeo en una pista de superposición, selecciónelo y, a 
continuación, elija Clip > Video Options > -Transparency.

4 En Key Type, Elija Difference Matte.

5 En la sección Matte del cuadro de diálogo, pulse el botón Choose y 
seleccione la imagen grabada en el paso 2.

6 eleccione la opción Reverse Key para aplicar una transparencia al fondo 
estático.

7 Sitúe el nuevo fondo en una pista inferior para crear la composición.

311

file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c10fv14.htm
file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c10fv14.htm


Uso de Track Matte (Máscara en 
pista aparte)

La transparencia Máscara en pista aparte permite crear una máscara que 
puede desplazarse (a menudo denominada máscara movible), superponiendo 
un clip sobre otro utilizando la máscara para integrar ambos clips. Se puede 
utilizar cualquier clip, imagen fija o imagen animada para la máscara.

Ya que la Máscara en pista aparte puede aplicarse a un clip de vídeo, la máscara se puede 
cambiar a lo largo del tiempo.

Las zonas de blanco de la máscara crean áreas opacas en el clip superpuesto, 
evitando que los clips subyacentes se vean. Las zonas negras de la máscara 
crearán áreas transparentes y las zonas grises áreas semitransparentes. Para 
mantener los colores originales en el clip superpuesto, se debe utilizar una 
imagen en escala de grises como máscara, ya que cualquier color de ésta 
elimina el mismo nivel de color del clip superpuesto. 

Es posible crear máscaras de las siguientes maneras:

• Utilice la ventana de título para crear texto o formas (sólo en escala de 
grises), guarde el título y, a continuación, importe el archivo como 
máscara. 

• Cree una máscara a partir de un clip mediante una de las siguientes 
transparencias: Croma, Diferencia RGB, Máscara de diferencia, Fondo 
azul, Fondo verde o Máscara sin rojo. A continuación, seleccione la 
opción Mask Only. 

• Utilice Adobe Illustrator o Photoshop para crear una imagen en escala 
de grises, impórtela a Premiere y (opcionalmente) aplique las 
configuraciones de movimiento a la imagen. 

• Añada movimiento a cualquier imagen fija con las configuraciones de 
movimiento de Premiere. Consulte Animación de un clip. 

Para aplicar la Máscara en pista aparte:

1 En la pista Vídeo 1, sitúe el clip que se reproducirá en el fondo.
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2 En la primera pista de superposición, Vídeo 2, sitúe el clip que se 
superpondrá al clip de la pista Vídeo 1.

3 Si la ventana de construcción ya contiene una segunda pista de 
superposición, continúe con el paso 4; en caso contrario, elija Add Video Track 
en el menú de la ventana de construcción.

4 En la segunda pista de superposición, Vídeo 3, sitúe el clip o la imagen que 
desea utilizar como máscara.

5 Seleccione el clip de la pista Vídeo 2 y elija Clip > Video Options > 
Transparency. En Key Type, elija Track Matte. A continuación pulse OK.
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Superposición de dos o más clips

Es posible superponer varios clips, uno encima de otro hasta ocupar las 97 
pistas de vídeo superpuesto de que dispone Premiere. Cada clip debe estar en 
una pista de vídeo distinta. También es posible renombrar las pistas para que 
tengan nombres descriptivos. Consulte Añadir, renombrar y borrar pistas.

Al superponer clips para crear composiciones y transparencias téngase en 
cuenta que los clips se colocan en capas. Es decir: la capa superior tapa a la 
capa inferior a no ser que sea total o parcialmente transparente.

Eso quiere decir que si colocamos un clip en la pista de vídeo 3, otro en la pista 
de vídeo 2 y otro en la pista de vídeo 1, sólo se verá el clip de la pista 3. Si este 
tiene una zona transparente, a través de ella podrá verse algo del clip colocado 
en la pista 2, y si en la zona visible de este clip hay otra transparente, por ahí 
se verá algo del clip colocado en la pista 1.

El clip que se encuentra debajo de todos los demás no necesita ninguna zona 
transparente (de hecho la pista de vídeo uno carece de control de opacidad y, 
para los clips situados en ella no está disponible la opción Transparency).

Tenga lo anterior en cuenta para, al colocar un clip en las pistas de 
superposición, no olvidar nunca ajustar su nivel de opacidad o establecer una 
transparencia, pues en caso contrario los clips situados debajo no serán 
visibles.

Solamente los títulos generados con Premiere y colocados directamente en 
una pista de vídeo superpuesto, son automáticamente transparentes. Consulte 
Adición de un título al proyecto.
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Adición de un fondo de color

Adobe Premiere permite crear un fotograma completo con un color sólido que 
se puede utilizar igual que un clip. En la terminología de Premiere esto se 
denomina Máscara de fondo.

Las máscaras de fondo se pueden utilizar, por ejemplo, como fondos sólidos 
para títulos. Asimismo, las máscaras de colores vivos pueden servir como 
fondos temporales mientras se utiliza una transparencia para ver con mayor 
claridad las áreas transparentes.

Para crear un fondo de color:

1 Active la ventana de proyecto.

2 Elija File > New > Color Matte, o pulse el botón Create Item de la ventana de 
proyecto y seleccione la opción Color Matte.

3 Seleccione un color de la ventana de selección de color y haga click en OK.

4 ntroduzca el nombre que desea que el clip tenga en la ventana de proyecto, y 
a continuación pulse OK.

Se puede crear un fondo con un fotograma existente exportándolo como 
imagen fija. Para más información, consulte Exportación de imágenes fijas.

Para usar un fondo de color temporal durante la creación de 
transparencias:

1 Cree un fondo de color tal y como se describe en el procedimiento anterior. 
Normalmente, los mejores colores son el verde o el amarillo vivo.

2 Sitúe la clip de fondo de color en una pista por debajo del clip al que desea 
aplicar una transparencia, en una pista de superposición o en la pista Vídeo 1.

3 Defina para la el clip de fondo de color la misma longitud que tiene el clip al 
que desea aplicar una transparencia, de forma que pueda ver la 
previsualización de la transparencia de todo el clip.

4 Cree una transparencia en el clip, tal y como se describe en Uso de 
transparencias para superposiciones y creación de composiciones. La máscara 
de color vivo se verá a través de las áreas transparentes.

5 Cuando esté satisfecho con la transparencia, elimine la máscara de color de 
la ventana de construcción.
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Creación de máscaras para ocultar 
partes no deseadas

En algunos casos se puede aplicar una transparencia adecuada al contenido 
de una escena excepto para algunos objetos no deseados. Las máscaras para 
ocultar partes no deseadas permiten ocultar dichos objetos, de modo que se 
pueda situar el contenido de ésta en otra escena para crear efectos simples.

El micrófono (izquierda) se oculta recortando la imagen en el cuadro de diálogo 
Configuraciones de transparencia (centro), creando una máscara para ocultar partes no 
deseadas a la que, a continuación, se aplica transparencia y se compone sobre un fondo 
(derecha).

Para crear una máscara que oculte las partes no deseadas:

1 Seleccione un clip en una pista de superposición y elija Clip > Video Options 
> Transparency. Para más información, consulte Uso de transparencias para 
superposiciones y creación de composiciones.

2 En la zona Sampledel cuadro de diálogo de configuración de transparencias, 
arrastre los puntos situados en las esquinas de la imagen de ejemplo, para 
recortarla, dejando sólo la parte que se desea conservar.

3 Elija una transparencia para ocultar el fondo de la parte seleccionada y, a 
continuación, haga click en OK.
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Creación de pantallas divididas

Se puede utilizar el cuadro de diálogo Configuraciones de transparencia para 
crear una pantalla dividida u otros efectos de pantalla que muestren dos clips, 
uno junto al otro.

Para crear una pantalla dividida:

1 Sitúe dos clips en pistas distintas que sean contiguas. Por lo menos una de 
las pistas deberá ser una pista de superposición.

2 Seleccione el clip de la pista superior y elija Clip > Video Options > 
Transparency.

3 En Key Type, elija None.

4 Arrastre los puntos situados en las esquinas de la imagen de ejemplo, para 
dividir o separar la pantalla en dos secciones, una que contenga el clip de la 
pista superior y la otra el clip de la pista inferior. 

5 Para ver el efecto, pulse el icono page peel ( ). A continuación pulse OK.

Nota complementaria de Quinurio: Esta utilidad sólo sirve para crear una 
pantalla dividida cuando se produce la casualidad de que la imagen que 
interesa de un clip está en su parte izquierda y la que interesa del otro en la 
derecha (o arriba y abajo). Pero si se quiere crear el efecto de mostrar dos o 
más clips simultáneamente en la pantalla, y no se puede hacer por este 
procedimiento, previamente habrá que escalar los clips para que ocupen 
menos espacio, y luego desplazarlos en la pantalla.
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Animación de un clip

Desplazamiento de un clip en la pantalla
Rotaciones, ampliaciones o reducciones, paradas y distorsiones
Determinación del momento exacto para el movimiento
Otras opciones del cuadro de diálogo de configuración del movimiento
Guardar, cargar y eliminar las configuraciones de movimiento
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Desplazamiento de un clip en la 
pantalla

Se puede animar un clip de tal modo que se desplace por la pantalla. Para ello 
hay que crear una trayectoria de movimiento, la cual puede encontrarse 
enteramente en la zona visible, o extenderse más allá de ésta, de forma que el 
clip salga y entre en los límites de la pantalla. 

Se debe tener en cuenta que sólo se puede añadir movimiento al clip como tal 
y no a los elementos que se encuentran dentro del mismo. Asimismo, Premiere 
permite especificar rotaciones, ampliaciones o reducciones, retardos y 
distorsiones con el fin de crear un movimiento más complejo. Consulte 
Rotaciones, ampliaciones o reducciones, paradas o distorsiones.

Nota: También es posible animar un clip utilizando el efecto de transformación. 

A. Zona de previsualización  B. Trayectoria de movimiento  C. Línea de tiempo de movimiento.

Para definir una trayectoria de movimiento para un clip:

1 Seleccione un clip en la ventana de construcción.

2 Realice una de las siguientes acciones para abrir el cuadro de diálogo de 
configuración de movimiento:
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• Pulse el cuadrado a la izquierda de la palabra Motion en la paleta de 
control de efectos. 

• Elija Clip > Video Options > Motion. 

En la esquina izquierda del cuadro de diálogo, una muestra del clip 
seleccionado se mueve a lo largo de la trayectoria de movimiento por defecto. 
Esta trayectoria por defecto coloca los puntos Inicio y fin del movimiento fuera 
del área visible del programa de vídeo, de modo que el clip entra en la zona 
visible desde la izquierda, atraviesa la pantalla y sale por la derecha.

3 Determine y ajuste puntos en la trayectoria de movimiento utilizando uno de 
los métodos siguientes:

• Para movimientos simples en sentido horizontal, vertical o diagonal, 
arrastre los puntos Start (inicio) y End (fin) a cualquier posición dentro o 
fuera del área visible. 

• Situé el puntero en cualquier punto de la trayectoria de movimiento. El 
puntero se convertirá en un dedo señalando. Haga click para añadir un 
punto a la trayectoria y arrástrelo con el fin de ajustar su posición, 
creando un nuevo segmento de la trayectoria. 

Haga click para crear un punto de la trayectoria de movimiento (izquierda), y después arrástrelo 
a una nueva situación (derecha).

• Haga click sobre la línea de tiempo de movimiento (marcada con C en el 
primer gráfico de este tema). Cuando mueve el ratón sobre esta línea, 
su puntero se convierte en un triángulo invertido ( ). Después arrastre 
el nuevo punto de control de trayectoria para ajustar su posición. 

4 Para previsualizar la animación utilice los botones Play ( ) y Pause ( ). 
Respecto de otras opciones de previsualización, consulte Previsualización del 
movimiento.
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Para ajustar con exactitud la posición de un punto en la trayectoria de 
movimiento:

1 Seleccione el punto a ajustar mediante uno de los siguientes procedimientos:

• Pulse el punto a ajustar en la trayectoria de movimiento o en la línea de 
tiempo de movimiento. El puntero del ratón se convierte en un dedo 
apuntador de color gris cuando está situado directamente sobre un 
punto de control de trayectoria. 

• Pulse la tecla Tab para seleccionar los puntos de control sucesivos 
desde el punto inicial al final a lo largo de la trayectoria. 

• Mantenga pulsada la tecla Shift mientras pulsa Tab para moverse en 
dirección inversa entre los puntos de control. 

Nota: Si en el cuadro de diálogo Configuraciones de movimiento hay un cuadro 
de texto activo, al pulsar la tecla de tabulación se resaltarán sucesivamente los 
cuadros de texto, en lugar de seleccionarse los puntos de movimiento.

2 Para ajustar la posición de los puntos, realice una de las siguientes acciones:

• Pulse una tecla de flecha para desplazar el punto seleccionado 1 píxel 
por vez en la dirección de la flecha. 

• Mantenga pulsada la tecla Mayúsculas y pulse una tecla de flecha para 
desplazar el punto en incrementos de 5 píxeles. 

• Introduzca las coordenadas de la posición del punto en los cuadros de 
información situados debajo de la línea de tiempo de movimiento. 

Nota: En el cuadro de diálogo Configuraciones de movimiento, las 
coordenadas que aparecen en los cuadros de texto de información se 
determinan con la resolución de la imagen de muestra (80 x 60 píxeles), pero 
en el momento de la salida se escalan al tamaño de salida del proyecto; es 
decir, un desplazamiento de 1 píxel en el tamaño de la muestra se ampliará a 
un desplazamiento de 4 píxeles si el tamaño de salida del proyecto es 320 x 
240, o a un desplazamiento de 8 píxeles si el tamaño de salida es 640 x 480. 
Se pueden introducir valores con decimales para situar los puntos con una 
precisión superior a incrementos de 4 u 8 puntos. Por ejemplo, si se introduce 
1,75 en el primer cuadro de texto se producirá un desplazamiento horizontal de 
14 píxeles a una resolución de 640 x 480. Para calcular el valor correcto para 
introducir la dirección en la que desea desplazarse, divida en primer lugar el 
tamaño de salida adecuado (por ejemplo, 640) entre el tamaño de la imagen de 
muestra correspondiente (80) y, a continuación, divida la distancia que desea 
desplazarse (por ejemplo, 14 píxeles) entre el resultado.

Para poner en el centro de la zona visible un punto de la trayectoria de 
movimiento:
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1 Seleccione el punto de trayectoria que desea centrar.

2 En los cuadros de información situados debajo de la línea de tiempo de 
movimiento, introduzca las coordenadas (0, 0) de la situación del punto o haga 
click en el botón Center con el fin de que Adobe Premiere introduzca estas 
coordenadas

Para eliminar un punto de la trayectoria de movimiento:

Seleccione el punto y pulse Suprimir (en el teclado), o arrastre el punto fuera de 
la zona donde se muestra la línea de trayectoria de movimiento.

Para editar la configuración de movimiento para un clip:

1 En la ventana de construcción seleccione el clip cuya trayectoria de 
movimiento desea editar.

2 Realice una de las siguientes acciones:

• En la paleta de control de efectos, pulse el texto Setup que parece a la 
derecha de la palabra Motion. 

• Elija Clip > Video Options > Motion. 

3 Edite la configuración y después pulse OK.
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Cambio de la velocidad del 
movimiento

Nota de Quinurio: Este tema lo redacto completamente yo, porque no me 
gusta la ayuda de Adobe (no distingue, por ejemplo, entre velocidad absoluta 
del movimiento y velocidad relativa). 

Para cambiar la velocidad del movimiento debe tenerse en cuenta que la 
velocidad de movimiento es siempre relativa con respecto a la duración del clip. 
Es decir: Si el clip dura 10 segundos, todo el movimiento aplicado al clip tendrá 
que ejecutarse en 10 segundos, pero si, exactamente con el mismo 
movimiento, dejamos la duración del clip en 5 segundos, la velocidad será el 
doble.

Otra cosa distinta es que, el movimiento no tiene por qué ejecutarse de manera 
uniforme. Es decir: podemos, por ejemplo, indicar que para realizar la primera 
mitad del movimiento se ocupen dos tercios del tiempo total, y para la segunda 
mitad el tercio restante. El efecto será que, con independencia de lo que dure el 
clip, se verá un movimiento lento que luego se acelera.

Para hacer estos cambios de velocidad es preciso que haya más de dos puntos 
de trayectoria, porque si solo están los puntos inicial y final, es lógico que el 
tiempo que se tardará en ir de uno a otro será el tiempo total de duración del 
clip.

Ahora bien: en cuanto introducimos un tercer punto de trayectoria, ya es 
posible distribuir el tiempo total (determinado por la duración del clip) entre los 
distintos segmentos. Como esta distribución se hace por porcentajes del tiempo 
total, si después se cambia la duración del clip, la distribución de tiempos se 
mantendrá, y Premiere automáticamente determinará la velocidad necesaria en 
cada segmento.

Velocidades relativas y línea de tiempo de movimiento:
Para ajustar las velocidades relativas se utiliza la línea de tiempo de 
movimiento: En la próxima imagen se muestra dicha línea en un ejemplo en el 
que se han marcado dos puntos intermedios en la trayectoria de movimiento:

Obsérvese que en la línea aparecen cuatro pequeñas líneas 
perpendiculares: Cada una de ellas representa un punto de control de 
trayectoria. Sobre uno de los segmentos perpendiculares hay colocado un 
triángulo negro apuntando hacia abajo: Ese triángulo indica que ese punto de 
control de trayectoria está ahora mismo seleccionado. Para seleccionar otro 

323



distinto basta con hacer click sobre el pequeño segmento que lo representa en 
la línea.

En la parte superior derecha de la línea aparece escrito un 20%, con ello se 
indica que, al llegar al punto de control seleccionado, se habrá invertido un 20% 
del total del tiempo.

Pues bien: teniendo en cuenta lo anterior, cambiar las velocidades relativas 
entre segmentos es tan sencillo como arrastrar el triángulo negro a derecha o 
izquierda, teniendo en cuenta lo siguiente:

• Arrastrando a la izquierda se reduce el tanto por tiempo necesario para 
alcanzar el punto de que se trate, lo que quiere decir que se incrementa 
la velocidad para llegar a él, pero, al mismo tiempo, se reduce la 
velocidad que se utilizará para ir de dicho punto de control al próximo. 

• Arrastrando a la derecha se produce el efecto contrario. 
• No se puede arrastrar más que hasta el próximo punto de control a 

derecha o izquierda. 

Dicho con otras palabras: Cuanto más cerca se encuentren en la línea dos 
puntos de control, mayor será la velocidad entre ellos. Pero, al acercar un 
punto de control a otro (por ejemplo, al que tiene a su derecha), 
necesariamente lo estaremos alejando del que tenía al otro lado.

Para suavizar cambios bruscos en la dirección, rotación o distorsión:

Seleccione la opción Smooth Motion y elija del menú una opción de suavizado 
que van desde Smooth Motion (el más imperceptible de todos) a Averaging 
High (el mayor posible).
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Previsualización del movimiento

Las configuraciones de movimiento se aplican al ejemplo situado en la esquina 
superior izquierda del cuadro de diálogo Configuraciones de movimiento, desde 
donde se puede ver inmediatamente como afectará cualquier cambio realizado.

Para previsualizar el movimiento en el cuadro de diálogo Configuraciones 
de movimiento:

Realice una de las siguientes acciones:

• Pulse el botón Play ( ) ituado junto a la miniatura del movimiento. 
• Pulse el botón Pause ( ) para detener la previsualización. 
• Arrstre la pequeña flecha que aparece bajo la línea de tiempo de 

movimiento. 
• Sólo en Mac OS, haga click en el icono Collapse ( ) para mover la 

previsualización actual a la vista de programa de la ventana de monitor. 
Utillice esta opción para ver en qué lugar aparece la imagen dentro de la 
zona visible. Pulse el botón ( ) para devolver la previsualización al 
cuadro de diálogo de opciones de movimiento. 

• Seleccione Show All para mostrar la imagen en la trayectoria de 
movimiento como aparecería en el programa de vídeo final, incluidas las 
configuraciones de las transiciones, los filtros y las transparencias. 
Tenga en cuenta que es posible que la miniatura del movimiento no se 
reproduzca fluidamente si está seleccionada esta opción. 

• Seleccione Show Outlines para mostrar un esquema del clip (incluidas 
las rotaciones, ampliaciones o reducciones y distorsiones) en cada punto 
de movimiento de la trayectoria. 

• Seleccione Show Path ara mostrar la trayectoria de movimiento como 
una serie de puntos entre los puntos de movimiento; cuando los puntos 
están cerca, indican un velocidad lenta y cuando están más separados, 
una velocidad rápida. 

Para previsualizar el movimiento en la ventana de monitor:

1 Pulse OK para guardar y cerrar la configuración de movimiento.

2 Realice una de las siguientes acciones:

• Construya un fichero de previsualización: mueva la barra amarilla 
indicadora del área de trabajo de tal modo que cubra el clip con la 
configuración de movimiento y pulse Enter. 

• Hata un barrido sobre el área que quiere previsualizar. Para ello 
sostenga pulsada la tecla Alt (Windows) u Option (Mac OS); cuando el 
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cursor se convierta en en una flecha hacia abajo ( ), arrástrelo por la 
regla de tiempo de la ventana de construcción. 
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Rotaciones, ampliaciones o 
reducciones, paradas y distorsiones

Para cada punto de movimiento de la trayectoria, se puede determinar un valor 
para las rotaciones, ampliaciones o reducciones y paradas, así como definir 
una forma para distorsionar el clip. Si se especifican diferentes valores para 
puntos diferentes de la trayectoria, se producirá una ampliación o reducción 
progresiva del click, o paradas y distorsiones.

Para rotar, ampliar o reducir (zoom), o parar el clip:

1 Abra el cuadro de diálogo de configuración de movimiento.

2 En la trayectoria de movimiento o en la línea temporal de movimiento, 
seleccione el punto de movimiento en el que desea añadir rotaciones, 
ampliaciones o reducciones y distorsiones.

3 Arrastre el potenciómetro o introduzca un valor para los controles siguientes 
según sea necesario:

• En Rotation, se puede establecer el ángulo de rotación de un clip en el 
punto especificado. El ángulo puede variar entre –1440 y 1440 grados, 
produciendo hasta ocho rotaciones completas del clip entre puntos. Una 
rotación completa equivale a 360 grados. 

• En Zoom, es posible aumentar o reducir el tamaño de un clip en un 
punto determinado de la trayectoria de movimiento. El porcentaje de 
zoom puede oscilar entre 0 y 500. En 0, el clip no se puede ver; en 100, 
el clip se visualiza a su tamaño original. 

• En Delay, se puede detener el movimiento de un clip durante el tiempo 
que se especifique. El valor de parada es un porcentaje de la duración 
del clip y no puede sobrepasar la distancia en tiempo hasta el siguiente 
punto de movimiento. Al añadir una parada aparecerá una barra azul en 
la línea de tiempo de movimiento, que muestra la longitud de la parada. 

4 Seleccione una opción del menú Motion para definir cómo se producirá el 
movimiento entre el punto seleccionado y el punto siguiente. Se puede lograr 
un movimiento suave al ampliar o reducir (zoom) mediante la aceleración o 
desaceleración del movimiento donde sea necesario. Cuando se realiza una 
ampliación del clip se recomienda elegir Accelerate. Por el contrario, cuando el 
clip se va progresivamente reduciendo suele ser preferible escoger Decelerate.

5 Repita los pasos 2 a 4 ara cada punto de movimiento que desee cambiar.
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Nota: Se pueden utilizar los atajos de teclado normales para copiar y pegar con 
el fin de copiar las configuraciones de movimiento de un punto a otro punto del 
mismo o de otro clip.

Para distorsionar un clip:

1 En la trayectoria de movimiento o en la línea de tiempo de movimiento, 
seleccione el punto en el que desea añadir una distorsión.

2 En el área de distorsión, 
realice una de las 

siguientes acciones:

• Para crear una distorsión, arrastre uno o varios de los cuatro puntos de 
las esquinas a otras posiciones. 

• Para girar una imagen distorsionada alrededor de un punto central, 
mantenga pulsada la tecla Alt (Windows) u Opción (Mac OS) y sitúe el 
puntero en uno de los puntos de las esquinas; a continuación, arrastre 
para girar la imagen alrededor del punto central. 

• Si desea mover los cuatro puntos de esquina a la vez, sitúe el puntero 
en el centro de la imagen y arrastre. 

3 Repita los pasos 1 y 2 para cada punto de movimiento que desee 
distorsionar.
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Determinación del momento exacto 
para el movimiento

Para sincronizar el movimiento con otros eventos del programa de vídeo o 
determinar un momento exacto para el movimiento, se puede utilizar el 
indicador de tiempo situado junto a la línea de tiempo de movimiento. El 
indicador de tiempo muestra el momento en el tiempo del punto de movimiento 
seleccionado, medido desde el comienzo del clip o desde el comienzo del 
programa de vídeo.

Para especificar un momento exacto para el movimiento:

1 Haga click en las dos flechas rojas situadas junto al indicador de tiempo para 
determinar como se medirá el tiempo:

• Si las dos flechas se tocan, , el tiempo se mide a partir del comienzo 
del clip. Así, si el clip mide 20 segundos y se establece un punto de 
control de trayectoria en 00:10:00, el punto aparecerá exactamente en el 
centro de la duración del clip. Utilice esta opción para especificar una 
localización exacta en el clip para el punto de control. 

• Si las dos flechas están separadas, , el tiempo se mide a partir del 
comienzo del programa de vídeo en la ventana de construcción. De esta 
manera si, por ejemplo, el clip está colocado en 00:10:00 en la ventana 
de construcción, y tiene una duración de 20 segundos, se puede 
especificar, para cualquier punto de control de trayectoria, una 
localización entre 00:10:00 y 00:30:00. 

2 ree un punto de movimiento, o seleccione uno que ya exista, haciendo click 
en la línea de tiempo de movimiento. A continuación, arrástrelo al momento en 
el tiempo apropiado observando el indicador de tiempo
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Otras opciones del cuadro de 
diálogo de configuración del 
movimiento

En el cuadro de diálogo de opciones de movimiento, es posible especificar 
tanto un color de relleno como la manera en que Premiere tratará el canal alfa 
del clip.

Las siguientes opciones del cuadro de diálogo provocan los siguientes efectos:

Reset Elimina las configuraciones de distorsión, parar, rotación y ampliación o 
reducción (zoom) para un punto seleccionado.

Fill Color Determina el color de fondo que rellena el fotograma detrás del clip 
en movimiento: Si en algún momento el clip deja de ocupar toda la zona de la 
pantalla, será ese color el que se verá. Hay dos formas para seleccionar un 
color de fondo:

• Hacer click en el cuadro que hay bajo Fill color, y escoger un color en el 
selector de colores de Premiere. 

• Pasar el ratón sobre la miniatura del clip que se encuentra bajo el cuadro 
Fill Color. Cuando el ratón pasa por encima de la miniatura el puntero se 
convierte en la herramienta cuentagotas de tal forma que, haciendo click 
sobre cualquier color de la miniatura, este color será seleccionado como 
color de fondo. 

El color elegido para fondo del clip sólo se mostrará en las previsualizaciones y 
el vídeo renderizado si el clip está situado en la pista de vídeo 1.

Alpha: Use Clip's Superpone un clip utilizando el canal alfa existente. Es la 
configuración normal para títulos o gráficos creados en otras aplicaciones que 
admiten canales alfa, como Adobe Photoshop. Esta opción afectará 
únicamente a los clips a los que se haya asignado un tipo de transparencia de 
canal alfa en el cuadro de diálogo Configuraciones de transparencia. Para más 
información sobre los canales alfa, consulte Uso de la transparencia de canal 
alfa.

Alpha: Create New Crea un relleno opaco para los clips que no cuentan con 
un canal alfa. Si esta opción está seleccionada, se creará un canal alfa con la 
forma del clip mientras se mueve. Esta opción afectará sólo a los clips a los 
que se haya asignado un tipo de transparencia de canal alfa en el cuadro de 
diálogo Configuraciones de transparencia. Consulte Uso de la transparencia de 
canal alfa.
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Nota: Si se selecciona la opción Crear nuevo para una imagen que contenga 
un canal alfa, se sustituirá el canal alfa original al superponer la imagen

Guardar, cargar y eliminar las 
configuraciones de movimiento

Se pueden utilizar los botones Save (guardar) y Load (cargar) del cuadro de 
diálogo Configuraciones de movimiento para guardar las configuraciones de 
movimiento creadas para un clip y utilizarlas posteriormente con otros clips. Las 
configuraciones de movimiento se aplican a todo el clip y no pueden aplicarse a 
un número limitado de fotogramas de un clip.

Para eliminar todas las configuraciones de movimiento aplicados a un clip, 
haga click en Remove (eliminar) del cuadro de diálogo Configuraciones de 
movimiento.
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Aplicación de efectos

En Premiere 6.0 se denomina efectos de vídeo, o efectos de audio a lo que en 
otros programas de edición, e incluso en versiones previas de Premiere, se 
denominaba Filtros de vídeo o filtros de audio.

Uso de efectos en Premiere
Qué son los keyframes
Trabajo con keyframes
Trabajo con efectos
Uso de efectos de Affter Effects
Galería de ejemplos de los efectos de Premiere
Efectos de vídeo incluidos con Premiere
Efectos de audio incluidos con Premiere
Efectos obsoletos

332

file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c09af110.htm
file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c09af91.htm
file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c09af16.htm
file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c09af15.htm
file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c09af13.htm
file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c09af9.htm
file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c09af4.htm
file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c09af3.htm
file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c09af2.htm


Uso de efectos en Premiere

Es posible aplicar un gran número de efectos a un clip en cualquier momento. 
Si el resultado no le convence, puede eliminarlo. Incluso es posible aplicar el 
mismo efecto más de una vez al mismo clip, utilizando en cada caso 
configuraciones diferentes. Esto a veces es util para obtener ciertos efectos, 
como por ejemplo si se añade varias veces el efecto de audio Equalize para 
utilizar en cadena varios módulos de hardware de equalización, en un estudio 
de audio convencional.

En principio cuando se aplica un efecto a un clip el efecto tiene la misma 
duración que el clip. No obstante es posible indicar puntos distintos de inicio y 
terminación para el efecto, o hacerlo más o menos intenso a lo largo del 
tiempo, utilizando para ello keyframes.
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Qué son los keyframes

Todos los filtros de vídeo proporcionan uno o varios controles que permiten 
determinar diversas propiedades del efecto. Estas propiedades se pueden 
cambiar a lo largo del tiempo, y para ello Premiere utiliza keyframes. Un 
keyframe contiene los valores de todos los controles del efecto en un momento 
determinado.

Cuando se aplica un efecto a un clip, Premiere crea un keyframe inicial y otro 
final con los mismos valores; pero si posteriormente (en el cuadro de 
configuración del efecto) se decide aplicar valores distintos a los keyframes, el 
efecto irá cambiando a lo larto del tiempo: Premiere irá automáticamente 
interpolando los valores necesarios para las propiedades del efecto utilizando 
una progresión lineal. Esto significa que no es preciso crear un keyframe para 
cada fotograma del clip, sino que basta con indicar los valores inicial y final.

Por ejemplo, si desea utilizar el filtro Cristalizar para añadir un efecto que 
aumente y a continuación disminuya a lo largo del tiempo, deberá definir tres 
keyframes: el primero con una cristalización ligera, el segundo con una 
cristalización más acusada y el tercero con una cristalización ligera de nuevo. 
Al interpolar Premiere automáticamente la distorsión entre cada keyframe, la 
cristalización aumentará gradualmente (de forma lineal) entre el primer y el 
segundo keyframe y, a continuación, disminuirá paulatinamente entre el 
segundo y el tercero. 

Nota: Algunos efectos incorporados a Premiere no soportan la creación de 
keyframes y no pueden, en consecuencia, ser animados.
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Trabajo con keyframes

Para modificar los valores de un determinado efecto mediante keyframes, es 
preciso, en primer lugar, crearlos en la línea de keyframes de la ventana de 
construcción. Tras ello se podrán modificar los valores para cada keyframe en 
la paleta de control de efectos.

\xfa
A. Botón de Keyframe B. Navegador de keyframes C. Menú desplegable de efectos D. línea de 
keyframes.

A. Botón de activación de efecto, con el icono de cronómetro visible B. Botón de activación de 
keyframes C. Nombre del efecto D. Controles del efecto.
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Cómo mostrar la línea de keyframes

Tras haber añadido un efecto a un clip, el efecto se muestra bajo el clip en la 
línea de keyframes de la ventana de construcción. Si se añade más de un 
efecto a un clip, en el lado izquierdo del clip aparecerá el menú de efectos: en 
él se puede elegir entre uno de los efectos aplicados para que sea ese el que 
se muestre en la línea de keyframes.

Si el efecto aplicable tiene controles ajustables, es posible establecer 
keyframes para él en la línea de keyframes.

Para mostrar la línea de keyframes hay que expandir la pista de vídeo. Tras 
ello, si se trata de la pista 1, la línea se muestra directamente, pero si se trata 
de la pista de vídeo 2 o superior, la línea de keyframas se muestra en el mismo 
espacio que la línea de control de opacidad. Pulsando el botón ( ) se muestra 
la línea de keyframes, y pulsando ( ) se muestra la de control de opacidad.

En los clips de audio la línea de keyframes ocupa el mismo lugar que la de 
volumen y la de balance. Para activar la línea de keyframes es preciso pulsar el 
botón correspondiente ( ).

Nota: Cuando la pista de vídeo 1 está colapsada, de modo las pistas 1A y 1B 
se ven juntas en una sóla línea, Premiere muestra la línea de keyframes para la 
pista de vídeo 1A o para el clip seleccionado.
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Uso del navegador de keyframes

Cuando se activa la línea de keyframes para que sea mostrada (véase tema 
anterior), también se muestra, en la cabecera de la pista, el navegador de 
keyframes que tiene el siguiente aspecto: .

El navegador se utiliza para moverse entre keyframes y para crear o borrar 
keyframes. Pulsando las flechas derecha izquierda, el punto de edición saltará, 
respectivamente, al próximo o al anterior keyframe. Pulsando en el cuadrado 
central, si el punto de edición se encuentra en un lugar del clip donde no hay 
ningún keyframe, este será creado. Por el contrario, si el punto de edición se 
encuentra sobre un keyframe, éste se borrará.

Cuando el punto de edición está exactamente sobre un keyframe, el cuadrado 
de creación-borrado de keyframes muestra una marca de verificación.

Nota: También se añadirá un keyframe si, estando activado el modo de 
keyframes (véase próximo tema) y encontrándose el punto de edición entre dos 
keyframes, se modifica el valor de configuración del efecto. En tal caso se 
generará automáticamente un keyframe en el lugar donde se encuentre el 
punto de edición.

Nota 2: Se pueden borrar todos los keyframes que se desee, siempre que 
queden al menos dos keyframes, porque son necesarios un punto inicial y otro 
final. Si se borra el keyframe que representaba al punto inicial, el siguiente 
keyframe a su derecha pasará a ser el nuevo punto inicial. Y si se borra el 
keyframe que era el punto final, el siguiente keyframe a su izquierda pasará a 
ser el nuevo punto final.
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Modo de keyframes

Nota de Quinurio: En este tema de ayuda sintetizo 
dos temas originales de Premiere: Iconos de 
keyframe y Botón de efecto activado. La verdad es 
que no eran nada claros esos temas. La redacción 

que sigue, por lo tanto, es enteramente mía.

Cuando en la paleta de control de efectos se introduce un valor determinado 
para una opción cualquiera del efecto, Premiere interpreta dicho valor de modo 
distinto según se esté o no en el modo de keyframes.

• Cuando se está en el modo de keyframes, Premiere atribuye el valor 
introducido al keyframe activo en ese momento. 

• Cuando no se está en el modo de keyframes, Premiere atribuye el valor 
introducido a todo el clip. 

Un ejemplo con el filtro de vídeo "Cristalización" creo que aclarará las cosas. 
En ese filtro es configurable el tamaño de la celda. Para aumentarlo o reducirlo 
hay que arrastrar el deslizador bajo el nombre Cell Size.

Pues bien: si, aplicamos este filtro con un valor para tamaño de celda de 10, y 
luego, tal y como se ve en la imagen a la izquierda, aumentamos el valor a 47, 
hay mucha diferencia según hayamos aumentado ese valor estando en modo 
de keyframes o no estando en ese modo.

Si no estábamos en modo de keyframes, Premiere aplicará al clip un filtro de 
cristalización en el que el tamaño de la celda será (en toda la duración del filtro) 
de 47. Pero si, por el contrario, estábamos en el modo de keyframes, el valor 
47 será sólo para el keyframe activo; si este era, por ejemplo, el keyframe final, 
el resultado será que al clip se le aplicará una cristalización que empezará con 
una celda de tamaño 10 e irá aumentando hasta una celda de tamaño 47.

Cómo activar o desactivar el modo de keyframes:

El modo de keyframes se activa de las siguientes maneras:

• Añadiendo un keyframe adicional a los keyframes inicial y final. Siempre 
que para un efecto hay más de dos keyframes, necesariamente el modo 
de keyframes queda activado. 

• Pulsando el cuadrado que en la paleta de control de efectos se 
encuentra inmediatamente a la izquierda del nombre del efecto. Este 
cuadrado alterna entre activar y desactivar el modo de keyframes. 
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Nota: Cuando se desactiva el modo de keyframes, todos los keyframes 
existentes entre el primero y el último se borrarán, pues sólo en el modo 
de keyframes puede haber más de dos keyframes.

Representación gráfica de los keyframes y de si está o no 
activado el modo de keyframes.

El modo en que los 
keyframes se 
representan en la línea de keyframes depende de si está o no activado el modo 
de keyframes.

Cuando este modo está desactivado, significa que no puede haber más que 
dos keyframes (el inicial y el final), los cuales se representan mediante 
rectángulos blancos ( ) en la línea de keyframes.

Estando el modo de keyframes activado, los keyframes se representan 
mediante un rombo o diamante. Si se trata del keyframe inicial, este rombo 
tiene sombreada en gris la parte izquierda ( ). Si se trata del keyframe final, el 
rombo tendrá sombreada en gris la parte derecha ( ), y tratándose de cualquier 
otro keyframe el rombo será enteramente blanco ( ).

Es decir: podemos saber si nos encontramos o no en el modo de keyframes, 
simplemente comprobando los iconos por los que estos se representan. Pero 
hay otro procedimiento más sencillo, y es que, en la paleta de control de 
efectos, cuando el modo de keyframes está activado, en el cuadrado que lo 
activa aparece un pequeño icono con un cronómetro ( )
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Funcionamiento de los keyframes 
inicial y final

Nueva nota de Quinurio: Este tema no lo recoge la ayuda de Adobe Premiere, 
sino que está enteramente redactado por mí.

Cuando se establece un efecto, inicialmente el keyframe inicial y el keyframe 
final se fijan, respectivamente, en el inicio y el final del clip. Es posible no 
obstante mover estos puntos para conseguir que el efecto empiece en un 
fotograma distinto del inicial y termine en un fotograma distinto del final.

Para mover los keyframes inicial y final basta con arrastrarlos por la línea de 
keyframes.

Si se añaden keyframes adicionales, el keyframe inicial será siempre el que se 
encuentre más a la izquierda, y el keyframe final el que se encuentre más a la 
derecha. Esto significa que si se borra el que era keyframe inicial (cosa que es 
posible cuando hay keyframes adicionales), pasará a ser keyframe inicial el que 
se encontrara más cerca de él, que será el nuevo keyframe situado más a la 
izquierda. Igual ocurrirá en el caso de que se borre el que era keyframe final.

Arriba: Hay tres keyframes: Inicial, central y final.

Abajo: Si se borra el keyframe inicial, el que antes era central pasa a ser el inicial.
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Trabajo con efectos

Cuando se aplica un efecto a un clip, el efecto aparece listado en la paleta de 
control de efectos y bajo el clip, en la línea de keyframes. Si a un clip se le han 
aplicado varios efectos, en el lado izquierdo de la línea de keyframes aparecerá 
un botón que, al ser pulsado, mostrará un menú con todos los efectos del clip 
en el orden en el que fueron aplicados: El efecto que esté seleccionado en 
dicho menú será el que se mostrará en la línea de keyframes. También se 
puede activar en la línea de keyframes uno de los efectos, haciendo click sobre 
él en la paleta de control de efectos.

Es importante tener en cuenta que los efectos se renderizan en el mismo orden 
en que se aplican, es decir: en el orden que aparecen en el menú de efectos 
mostrado en el clip; a no ser que se reordenen los efectos. Consulte al respecto 
Aplicación y control de efectos. En todo caso el menú siempre reflejará el orden 
de renderización.
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Uso de las paletas de efectos de 
audio y vídeo

Todos los efectos disponibles en Premiere se encuentran almacenados en las 
paletas de efectos de audio o de efectos de vídeo, que se pueden personalizar 
para acomodarlas al estilo de trabajo preferido.

En las paletas los efectos se agrupan por tipos; por ejemplo: todos los efectos 
de vídeo que de alguna manera producen un desenfoque, se encuentran en 
una carpeta denominada "Blurs" (desenfoques). Se pueden ocultar efectos que 
no se usen, o crear nuevas carpetas que contengan grupos especiales de 
efectos usados con frecuencia, o con efectos poco usados.

Para abrir la paleta de efectos:

Realice una de las siguientes acciones:

• Elija Window > Show Video Effects. 
• Elija Window > Show Audio Effects. 

Para crear una nueva carpeta:

1 Abra la paleta de efectos de vídeo o de efectos de audio y realice una de las 
siguientes acciones:

• Elija New Folder del menú de la paleta. 
• Pulse el botón New Folder ( ) en la parte inferior de la paleta. 

2 Escriba un nombre para la nueva carpeta y pulse OK.

Para borrar una carpeta:
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Selecciónela y realice una de las siguientes acciones:

• Elija Delete Folder del menú de la paleta. 
• Pulse el botón Delete ( ) en la parte inferior de la paleta. 

Note: Sólo se pueden borrar, en el sentido estricto de la palabra, las carpetas 
añadidas por el usuario. Si se intenta borrar una carpeta que no sea de las 
añadidas por el usuario, sino de las que Premiere incorpora por defecto, el 
resultado será que la carpeta y todo su contenido se ocultará y se trasladará al 
final de la paleta, pero en realidad no se borrará.

Si se borra una carpeta creada por el usuario, los efectos que ésta contenía se 
devuelven a sus carpetas originales y allí quedan ocultos.

Para ocultar carpetas o efectos:

1 Seleccione la carpeta o los efectos que se quieren ocultar.

2 Elija Hide Selected del menú de la paleta.

El efecto que entonces se produce varía: Si en el menú de la paleta está 
seleccionada la opción Show Hidden, los efectos y carpetas seleccionados se 
atenuarán (para indicar que están ocultos); pero si la opción Show Hidden no 
estaba seleccionada, las carpetas y efectos en cuestión se ocultarán, 
quedando invisibles.

Para ver carpetas o efectos ocultos:

1 Elija Show Hidden del menú de la paleta. Todas las carpetas y efectos 
ocultos se mostrarán, aunque atenuados..

2 Seleccione los efectos que quiere desocultar y elija Show Selected del menú 
de la paleta.

Para mover efectos de una carpeta a otra:

1 Arrastre el nombre del efecto a la localización deseada.

2 Suelte el ratón cuando la localización deseada se ilumine.

Otras opciones del menú de la paleta
Además de las opciones ya expuestas, en el menú de la paleta se encuentran 
las siguientes opciones:

• Find: Permite buscar un efecto por su nombre. Se buscará el primer 
efecto en cuyo nombre aparezca la palabra introducida. Tras ello puede 
pulsarse Find Next para ir al próximo efecto donde aparezca la palabra. 
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Tiene el mismo efecto que pulsar el botón ( ), en la parte inferior de la 
paleta. 

• Expand all folders: Expande todas las carpetas 
• Collapse all folders: Colapsa todas las carpetas 
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Aplicación y control de efectos

Se puede aplicar un efecto de vídeo o de audio a cualquier clip que se 
encuentre en la ventana de construcción. En esta ventana, los clips a los que 
se ha aplicado algún efecto, se muestran con un borde azul en su parte 
superior

Nota de Quinurio: Debo ser daltónico, porque yo el borde lo veo verde.

Los efectos se pueden aplicar y eliminar en cualquier momento. Incluso es 
posible desactivar temporalmente un efecto aplicado, sin eliminarlo. Los efectos 
desactivados no se ven en la vista de programa de la ventana de monitor, y no 
se incluyen en el momento de la previsualización o de la renderización. Sin 
embargo el efecto no es eliminado, y su configuración y keyframes se 
mantienen.

Para aplicar un efecto a un clip:

1 Elija Window > Show Video Effects o Window > Show Audio Effects.

2 En la paleta de efectos, seleccione un efecto y arrástrelo hasta la ventana de 
construcción, colocándolo sobre el clip al que se quiere aplicar; o, si dicho clip 
se encuentra seleccionado en la ventana de construcción, puede también 
arrastrar el efecto a la paleta de control de efectos.

3 Si el efecto tiene opciones configurables, aparecerá el cuadro de diálogo de 
configuración. Los valores que se introduzcan en él serán aplicados a todo el 
clip (a los keyframes inicial y final).

Nota: Si se trata de un efecto creado con Affter Effects no aparecerá ningún 
cuadro de diálogo. No obstante se podrá realizar la configuración necesaria 
desde la paleta de control de efectos.

Usando este procedimiento se puede aplicar a un mismo clip el mismo 
efecto varias veces.

Para abrir la paleta de control de efectos:

Elija Window > Show Effect Controls.

Para ver los efectos de un clip en la paleta de control de efectos:

Seleccione el clip en la ventana de construcción

Para abrir el cuadro de diálogo de configuración de un efecto:
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En la paleta de control de efectos pulse Setup a la derecha del nombre del 
efecto.

Para copiar un efecto y sus keyframes de un clip y pegarlo a otro clip:

1 En la paleta de control de efectos seleccione el efecto y elija Edit > Copy.

2 En la ventana de construcción, seleccione uno o más clips y elija Edit > Paste 
Attributes.

3 En el cuadro de diálogo "Pegar atributos", seleccione Settings; a continuación 
desactive todas las opciones excepto Filters.

Para temporalmente desactivar un efecto:

En la paleta de control de efectos, seleccione el efecto que desea desactivar y 
a continuación pulse el botón de desactivación de efectos, a la izquierda del 
nombre del efecto (en realidad a la izquierda del botón de activación del modo 
de keyframes). El botón de activación-desactivación de efectos tiene el icono (
) cuando el efecto está activado.

Para borrar un efecto de un clip:

1 Seleccione el clip en la ventana de construcción.

2 En la paleta de control de efectos seleccione el efecto que desea eliminar y, 
después, realice una de las siguientes acciones:

• Pulse el botón Delete ( ). 
• Elija Remove Selected Effect del menú de la paleta. 

Para reordenar los efectos:

1 En la paleta de control de efectos, haga click en el triángulo que se encuentra 
a la izquierda del nombre de cada efecto, para mostrar la información del efecto 
en una sola línea (ocultando la configuración del efecto).

2 Haga click sobre el nombre de un efecto y arrástrelo a un nuevo lugar en la 
lista. Una línea negra aparece mientras se realiza el arrastre indicando el lugar 
de la lista donde el efecto se colocaría en el caso de que en ese instante se 
soltara el ratón.
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Uso de keyframes con los efectos

Todo efecto tiene un keyframe al principio y otro al final del clip, representados 
por un rectángulo blanco en la línea de keyframes, o por un diamante o 
semidiamente (cuando se está en el modo de keyframes).

Si el efecto es configurable, es posible cambiar el momento inicial o final del 
efecto, o añadir keyframes adicionales para crear efectos animados. Si no se 
realiza ninguno de estos cambios, la configuración del efecto se aplicará a todo 
el clip.

Nota: El puntero se transforma en un dedo oscurecido cuando se encuentra 
sobre un keyframe en la línea de keyframes.

Para mostrar la línea de keyframes, consulte Cómo mostrar la línea de 
keyframes. Si el clip tiene más de un efecto, para activar el efecto que desea 
examinar, selecciónelo en la ventana de control de efectos, o del menú que se 
abre al pulsar el botón que aparece en la esquina izquierda del clip.

Para añadir y borrar keyframes, consulte Uso del navegador de keyframes.
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Uso de efectos de Affter Effects

Premiere 6.0 incluye varios efectos de Adobe After Effects. Se distinguen de los 
restantes por el icono de Affter Effects ( ) que aparece junto al nombre del 
efecto.

Algunos de estos efectos de After Effects reemplazan efectos que existían en 
Premiere 5.0; pero otros son nuevos en Premiere. Los efectos reemplazados 
pueden ser localizados en la carpeta Obsolete de la paleta de efectos de vídeo. 
Para más información sobre el trabajo con proyectos previos que incluyan 
efectos obsoletos, consulte Efectos obsoletos.

Nota: Premiere sólo soporta directamente los efectos de Affter Effects que se 
instalan con el programa.

Uso de efectos producidos con otros 
productos

Además de las docenas de efectos incluidos con Premiere, están disponibles 
otros efectos en forma de plug-ins que se pueden comprar separadamente o 
adquirir desde otras aplicaciones compatibles. Por ejemplo: varios plug-ins de 
Adobe Photoshop se pueden copiar al directorio Plug-ins de Premiere para ser 
usados en edición de vídeo.

Un efecto está disponible para Premiere cuando el fichero con software plug-in 
ha sido copiado a la carpeta de Plug-ins de Premiere 6.0. Si se adquieren estos 
efectos adicionales, o si se adquiere Premiere como parte de un paquete de 
hardware, o si se borran ficheros del directorio Plug-ins, es posible que en su 
sistema exista un conjunto de efectos diferente de los que a continuación se 
describen en esta ayuda.
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Galería de ejemplos de los efectos de 
Premiere

Los ejemplos abajo ilustrados son algunos de los efectos de vídeo incluidos 
con Premiere. Para previsualizar un efectos que no esté en esta lista, aplíquelo 
a un clip y previsualícelo en la ventana de monitor.

Nota de Quinurio: Se pone el nombre del efecto tal y como aparece en la 
paleta de efectos de vídeo, y entre paréntesis su traducción o significado en 
español.

Brightness & Contrast (Brillo y contraste)

Camera Blur (Desenfoque de cámara)

Clip (Recortar)
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Color Balance (Equilibrio de color)

Crop (Encuadrar)

Emboss (Relieve)

Extract (Extraer)
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Find Edges (Encontrar bordes)

Gaussian Blur (Desenfoque gaussiano)

Horizontal Flip (Giro horizontal)

Invert (Invertir)
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Lens Flare (Destello de lente)

Mosaic (Mosáico)

Pinch (Comprimir)

Pointillize (Puntillizar)
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Posterize (Posterizar)

Radial Blur (Desenfoque radial)

Replicate (Replicar)

Sharpen (Enfocar)
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Shear (Distorsionar)

Solarize (Solarizar)

Spherize (Esferizar)

Tiles (Azulejos)
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Zig Zag

Efectos de vídeo incluidos con 
Premiere

Adobe Premiere incluye una gran variedad de efectos de vídeo diseñados para 
alterar o realzar la apariencia de las imágenes de vídeo. Para información 
sobre cómo usar estos efectos consulte Aplicación y control de efectos.
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Realización del vídeo final

Acerca de la exportación de vídeo desde Premiere
Tipos de ficheros disponibles para la exportación
Exportación a vídeo-cinta
Creación de un archivo de vídeo para Internet
Creación de un archivo de vídeo para su reproducción en CD-ROM
Creación de archivos de vídeo para su uso en otro software
Exportación de un vídeo
Exportación de imágenes fijas
Exportación de una secuencia de imágenes fijas
Exportación de un archivo filmstrip para su edición en Photoshop
Exportación de un proyecto para usarlo en Adobe After Effects
Exportación de varios proyectos mediante proceso por lotes
Acerca de las configuraciones de exportación
Elección de configuraciones para exportar
Acerca de la creación de películas
Exportación de una lista de decisiones de edición
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Acerca de la exportación de vídeo 
desde Premiere

El programa editado en la ventana de construcción no está disponible como un 
fichero independiente hasta que haya sido exportado. Tras la exportación es 
posible reproducirlo independientemente en otros sistemas de edición o 
reproducción, y transportarlo a otros discos o plataformas.

Antes de la exportación hay que asegurarse de que la ventana de construcción 
está preparada para producir la calidad requerida. Reemplace, por ejemplo, los 
archivos de referencia por archivos de alta resolución adecuados para la 
exportación final

Es posible exportar desde la ventana de construcción, así como desde las 
vistas de origen o de programa en la ventana de monitor, o desde las ventanas 
de storyboard o desde una ventana independiente de clip, y se puede 
especificar un rango de fotogramas para su exportación.
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Tipos de ficheros disponibles para la 
exportación

Un programa de vídeo se puede exportar directamente a una vídeo-cinta, o a 
una gran variedad de formatos de fichero de vídeo, audio o imagen.

Junto a las opciones incorporadas a Premiere para la exportanción de películas 
(accesibles en los menús File > Export Timeline > Movie, o File > Export Clip > 
Movie), también se pueden usar alguna de las siguientes opciones disponibles 
mediante plug-ins:

• Grabación para Web 
• (Sólo en Windows) Ficheros de Windows Media avanzados 
• Exportación avanzada a RealMedia 

Para obtener información detallada sobre estos plug-ins, consulte la ayuda en 
línea de los mismos, o visite la página web del fabricante del plug-in.

Los siguientes formatos de fichero están disponibles para la exportación. Otros 
formatos adicionales pueden ser utilizados en Premiere si se han 
proporcionado con una tarjeta de captura de vídeo, o si se han añadido 
separadamente mediante plug-ins.

Formatos de vídeo o de vídeo y audio 

• Formato AVI: El formato de audio y vídeo entrelazado o AVI (Audio 
Video Interleaved) se utiliza para los vídeos que se reproducirán en 
Windows, que cuenta con soporte incorporado para AVI. En algunas 
ocasiones se utiliza para los vídeos que se pueden descargar de la Web. 

• GIF animado: Se utiliza como una forma sencilla de visualizar gráficos 
en movimiento y vídeo en una página Web. Los archivos GIF animado 
no pueden incluir audio. 

• QuickTime: Se utiliza para archivos de vídeo destinados a reproducirse 
tanto en Windows como en Mac OS. Premiere exporta siempre un 
archivo compatibilizado que contiene toda la información necesaria para 
la reproducción en cada plataforma. Se puede utilizar para descargar y 
transferir vídeos en la red, dependiendo de las configuraciones y la 
versión de QuickTime que utilice la audiencia. 

• Otros formatos: MPEG, RealMedia, Windows Media. 

Formatos de sólo audio

• AIFF: Se utiliza cuando se desee exportar únicamente la pista de audio. 
• Audio Waveform de Windows: (sólo en Windows) Se utiliza cuando se 

desea exportar únicamente la pista de audio. Se conoce también como 
un archivo .WAV. Sólo se puede reproducir en ordenadores con el 
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sistema operativo Windows; en ocasiones se utiliza para audio destinado 
a descargarse de la Web. 

• MP3: Formato de audio comprimido, muy popular en Internet. 

Formatos de imagen y de secuencia

• Filmstrip: Se usa cuando se desea realizar una rotoscopia, o dibujar 
directamente en los fotogramas de vídeo con Adobe Photoshop. 

• Flc/Fli: (sólo en Windows) Se utiliza para editar una animación o 
secuencia de imágenes fijas en un software que admita estos formatos. 

• Secuencia GIF: Se usa para la edición de secuencias individuales de 
imágenes fijas en un software que admita este formato. Es diferente al 
GIF animado, que almacena todos los fotogramas en un único archivo. 

• PICT y Secuencia PICT: (sólo en Mac OS) Se utiliza para la edición de 
secuencias de imágenes fijas en un software de Mac OS que admita 
este formato. 

• Targa y Secuencia Targa: Se utiliza para la edición de secuencias de 
imágenes fijas en un software que admita este formato. 

• TIFF y secuencia TIFF: Se utiliza para la edición de secuencias de 
imágenes fijas en un software que admita este formato. 

• Mapa de bits de Windows (BMP): (sólo en Windows) Se utiliza para la 
edición de secuencias de imágenes fijas en un software de Windows que 
admita este formato. 

Nota: Cuando en este tema de ayuda se dice "Sólo en Windows" o "Sólo en 
Mac OS" se hace referencia sólo a funciones específicas de las versiones de 
Premiere para Windows o para Mac OS, pero no se quiere decir nada respecto 
a si un formato de archivo determinado se puede abrir o reproducir en una 
plataforma o sistema determinado.
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Exportación a vídeo-cinta

El programa editado se puede grabar directamente desde el ordenador a una 
cinta de vídeo. Esta operación puede resultar tan sencilla como reproducir el 
vídeo a pantalla completa y grabarlo en una cámara de vídeo o magnetoscopio 
conectados. Asimismo, se puede utilizar Premiere para controlar a distancia un 
dispositivo conectado que admita dicho tipo de control (dispositivo controlable). 
Utilice los comandos Print to Video (imprimir en vídeo) o Export to Tape 
(exportar a cinta) con el fin de reproducir el vídeo en un fondo negro para su 
grabación en cinta; con el comando Imprimir en vídeo también se pueden 
ampliar los fotogramas, de forma que los vídeos que aparezcan en una cuarta 
parte de la pantalla se reproduzcan a pantalla completa.

Cuando se graba directamente desde la ventana de construcción, Premiere 
utiliza las configuraciónes del cuadro de diálogo de configuración del proyecto. 
Muchas tarjetas de vídeo captura incluyen plug-ins de software compatibles 
con Premiere que proporciona un comando en el menú para grabar a cinta. En 
consecuencia, si las opciones que se muestran en su menú son diferentes de 
las que aquí se describen, consulte la documentación de su tarjeta de captura o 
del plug-in para aprender el modo más eficiente de exportar a cinta.

Si se piensa reproducir el programa de vídeo desde la ventana de construcción, 
para grabarlo directamente a una vídeo-cinta, asegúrese de que el proyecto 
está usando opciones de compresión que preserven la más alta calidad de 
imagen, sin pérdida de fotogramas. Para ello ajuste la configuración para el 
ordenador en el que se reproducirá el programa de vídeo durante la grabación.

Para volcar vídeo DV a la cinta DV, todo lo que se necesita es una conexión 
IEEE 1394 (y activar en la vídeo-cámara el DV-IN, si se está en Europa). No 
obstante, si lo que se quiere es grabar vídeo o audio DV en un formato 
analógico, será preciso un dispositivo capaz de convertir el formato DV a 
formato analógico. La mayor parte de las cámaras DV y todos los 
reproductores DV son capaces de esta conversión, aunque algunas vídeo-
cámaras exigen que primero se grabe el DV en una cinta y después se emita 
reproduzca la cinta utilizando las salidas analógicas.

Para proporcionar a su dispositivo de grabación unos pocos segundos de 
tiempo adicional antes de que empiece a grabar o después de que termine la 
grabación, añada, en la ventana de construcción, un fondo de color (o un fondo 
negro) antes y después del programa. Asímismo puede ser recomendable 
añadir un mínimo de 30 segundos de barras de color al principio del programa, 
para ayudar a la calibración de vídeo y audio. Consulte Creación de barras de 
color y de un tono de 1Khz.

Para preparar un programa DV para su grabación a cinta:

360

file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c03ev53.htm
file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c03ev53.htm


1 Conecte el dispositivo DV al ordenador mediante una conexión IEEE 1394. El 
extremo del cable que tiene cuatro pins se conecta al dispositivo DV, y el 
extremo con 6 pins se une al ordenador. El conector en el dispositivo DV 
normalmente estará marcado como DV IN/OUT, I.Link o IEEE 1394.

2 Conecte el dispositivo DV y póngalo en modo de reproducción.

3 Inicie Premiere y abra el proyecto.

4 Elija Project > Project Settings > General. Pulse el botón Playback Settings.

Nota: Cuando se selecciona una preconfiguración DV, el modo de edición es 
establecido automáticamente como DV Playback (Windows) o QuickTime (Mac 
OS), en ambos casos se proporcionan configuraciones adicionales para la 
reproducción DV.

5 Si la opción Editing Mode está establecida como DV Playback, el cuadro de 
diálogo que se abre tiene las siguientes opciones:

• La opción Playback on 
DV Camcorder/VCR 
reproduce todos los clips 
comprimidos en formato 
DV en el dispositivo 
externo conectado. 

• La opción Playback on 
Desktop reproduce en el 
monitor del ordenador. Si 

esta opción se selecciona conjuntamente con la anterior, la CPU debe 
generar una doble salida (al ordenador y al dispositivo externo), con lo 
que puede producirse una disminución del rendimiento: en uno de los 
dos dispsotiviso (normalmente en el ordenador) la reproducción puede 
verse a saltos. Para evitarlo, elija sólo una de las dos opciones. 

• La opción Render Scrub Output to DV Camcorder/VCR proboca que 
también se vean en el dispositivo de salida los resultados del barrido 
rápido de la ventana de construcción. 

• La opción Play Audio on Desktop while Scrubbing determina que el 
audio se escuche simultáneamente en el ordenador y en el dispositivo 
de salida. 

6 Si Editing Mode está establecido como QuickTime, el cuadro de diálogo que 
se muestra tiene las siguientes opciones:
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• En Output Device, seleccione FireWire para reproducir todos los clips en 
formato DV en el monitor NTSC o PAL externo. 

• En Output Mode, seleccione el modo apropiado, NTSC o PAL. El 
tamaño de fotograma y la velocidad (fps) requeridos para el modo 
seleccionado aparecerán automáticamente debajo. 

• Seleccione Play Audio on the Output Device Only para que el audio sólo 
se reproduzca por el dispositivo de salida. Cuando se ha seleccionado 
FireWire el audio se transmite por el puerto hasta el dispositivo de 
salida, pero si se ha seleccionado Desktop el audio suena en el 
ordenador. Si no se selecciona esta opción, el audio siempre suena en 
el ordenador.

Nota: Audio y vídeo podrían no verse sincronizados si se reproduce 
simultáneamente en diferentes dispositivos.

  En Sample Rate, seleccione la frecuencia de muestreo usada por su cámara 
DV. Si se eligió la preconfiguración correcta al empezar el proyecto, esta 
opción estará ya seleccionada con el valor adecuado. La mayoría de las 
cámaras DV utilizan una frecuencia de muestreo de 32 kHz o 48 kHz; en 
algunas cámaras también la frecuencia de 44.1 kHz es una opción válida, 
asegúrese de que su cámara es de éstas antes de seleccionar este valor. 
Consulte la documentación de su cámara respecto de las configuraciones de 
audio soportadas.
Nota: Capture y edite siempre utilizando la misma frecuencia de audio. No 
mezcle en la misma cintaio en el mismo proyecto frecuencias distintas.

  Si se desea reproducir simultáneamente los clips DV en el ordenador y en el 
dispositivo externo conectado, seleccione Play Also on Desktop When Playing 
to the Output Device. En este caso la CPU tiene trabajo adicional, por lo que el 
rendimiento puede resentirse.
Nota: Si esta opción no se ha seleccionado las previsualizaciones con barrido 
rápido siempre se muestran tanto en el ordenador como en el dispositivo 
externo.

  Si es precisa una reproducción de alta calidad, seleccione High-Quality 
Playback y High-Quality Scrubbing. En caso contrario no seleccione estas 
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opciones y así las reproducciones y barridos se producirán con más velocidad, 
pues la CPU tendrá menos trabajo. 
  Seleccione Deinterlace Desktop Playback para desentrelazar el vídeo antes 
de mostrarlo en la ventana de monitor o en la de clip. El vídeo desentrelazado 
es menos borroso en las esquinas de los objetos en movimiento. Esta opción 
no tiene efectos en salidas o previsualizaciones a dispositivos externos. 
  Seleccione Show Marker Comments se se han añadido marcas de 
comentario al proyecdto y desea que los comentarios se muestren en el 
dispositivo de salida. Consulte Uso de marcas, en la ventana de construcción, 
para comentarios. 

7 Pulse OK para cerrar el cuadro de diálogo de configuración del proyecto.

8 Elija Edit > Preferences > Scratch Disks and Device Control.

9 Especifique el disco de trabajo en el que se capturarán las películas. 
Consulte Establecimiento de los discos de trabajo de Premiere.

Nota: La longitud de un clip capturado puede estar limitado por el tamaño 
máximo de fichero admitido por su sistema operativo. Consulte Tamaño 
máximo de fichero.

10 Seleccione DV Device Control 2.0 (or later) en Device y haga click en 
Options. Si es necesario seleccione la marca y modelo de su cámara.

11 Seleccione el formato adecuado de código de tiempo para su dispositivo y 
pulse OK.

12 Pulse OK para cerrar el cuadro de diálogo de preferencias.

Para grabar la ventana de construcción en una vídeo-cinta utilizando el 
control de dispositivo DV:

1 Adegúrese de que su dispositivo de grabación de vídeo está conectado y que 
en él se encuentra la cinta adecuada. Localice y anote el código de tiempo del 
punto en el que desea empezar la grabación.

2 Elija File > Export Timeline > Export to Tape.

Nota: El comando exportación a cinta sólo está disponible si se dispone de un 
dispositivo DV soportado y se utiliza el plug-in de control de dispositivo.

3 Seleccione Activate Recording Deck para dejar que Premiere controle su 
dispositivo.

4 Seleccione Assemble at Timecode y escriba el punto In de la cinta en el que 
desea empezar la grabación. Si no se selecciona esta opción, la grabación 
empezará en el punto actual en el que se encuentre la cinta.
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5 En Movie Start Delay, escriba el número de cuartos de fotograma de retraso 
de la película. Este valor se utiliza porque en algunos dispositivos DV 
transcurre cierto tiempo desde que se recibe la orden de reproducción y el 
inicio de esta. Mediante la opción Movie Start Delay puede hacer que Premiere 
espere el tiempo exacto entre la transmisión de la orden de grabación y el inicio 
de la emisión de fotogramas, de tal forma que se graben realmente todos los 
fotogramas. En otro caso puede ocurrir que los primeros fotogramas no lleguen 
a grabarse.

6 En Preroll, introduzca el número de fotogramas que Premiere debe rebobinar 
en el dispositivo de grabación antes del código de tiempo especificado. 
Introduzca un número de fotogramas suficientes para que el dispositivo alcance 
una velocidad constante. En muchos dispositivos un valor de 5 segundos o de 
150 fotogramas es suficiente.

7 Pulse OK.

Para grabar la ventana de construcción en una vídeo cinta utilizando 
control de dispositivo analógico:

1 Asegúrese de que su dispositivo de grabación de vídeo está conectado y con 
la cinta adecuada dentro.

2 Elija Edit > Preferences > Scratch Disks/Device Control y seleccione el plug-
in de control de dispositivo correcto. Si está disponible, pulse Options y 
establezca las opciones necesarias; después pulse OK.

3 Elija File > Export Timeline > Export to Tape y especifique las opciones 
necesarias.

Nota: Las opciones de control de dispositivo varían dependiendo del plug-in de 
control que se utilice. Consulte la documentación que venía con el mismo.

Para grabar la ventana de construcción en una vídeo cinta sin control de 
dispositivo:

1 En la ventana de construcción, arrastre la barra indicadora del área de trabajo 
para que cubra la parte del programa de vídeo que desea grabar, y pulse Enter 
(Windows) o Return (Mac OS) para construir un fichero de previsualización.

2 Asegúrese de que la previsualización se reproduce en su dispositivo o 
cámara. De no ser así, revise los pasos para pareparar un programa DV para la 
grabación, o consulte la documentación de su dispositivo analógico.

3 Asegúrese de que su dispositivo de grabación está conectado y de que la 
cinta dentro de él se encuentra en el punto en el que desea iniciar la grabación.

4 Coloque el punto de edición al principio de la ventana de construcción, o del 
área de trabajo.
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5 Pulse el botón de grabación de su dispositivo.

6 Pulse el botón Play en la vista de programa de la ventana de monitor.

Para grabar la ventana de construcción usando el comando Print to 
Video:

1 En la ventana de construcción, arrastre la barra indicadora del área de trabajo 
para que cubra la parte del programa de vídeo que desea grabar, y pulse Enter 
(Windows) o Return (Mac OS) para construir un fichero de previsualización.

2 Asegúrese de que la previsualización se reproduce en su dispositivo o 
cámara. De no ser así, revise los pasos para pareparar un programa DV para la 
grabación, o consulte la documentación de su dispositivo analógico.

3 Asegúrese de que su dispositivo de grabación está conectado y de que la 
cinta dentro de él se encuentra en el punto en el que desea iniciar la grabación.

4 Elija File > Export Timeline > Print to Video. Especifique las opciones 
necesarias (consulte Reproducción de vídeo a pantalla completa). En la opción 
Play Black for _ Seconds, asegúrese de que introduce un tiempo suficiente 
para que el dispositivo de grabación se estabilice antes de que el vídeo se 
inicie.

5 Pulse OK, e inicie la grabación en su dispositivo.
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Creación de un archivo de vídeo 
para Internet

Generalmente, el vídeo destinado a reproducirse en Internet se ve limitado por 
la velocidad del flujo de datos, que es incluso inferior que la de la reproducción 
en CD-ROM. Si está utilizando las opciones de exportación de Premiere para 
exportar un programa de vídeo para internet, utilice los consejos 
proporcionados para la exportación en CD-ROM (consulte Creación de un 
archivo de vídeo para su reproducción en un CD-ROM), pero ajuste los valores 
a los flujos de datos de las redes en las que se vaya a emitir el vídeo. Si se 
está usando una de las opciones optimizadas para el Web, como la de Guardar 
para exportar a Web, elija la opción de transmisión que mejor represente las 
capacidades de visualización de su audiencia, como, por ejemplo modem de 
28K, modem de 56K, ISDN, o Broadband/LAN.

Existen muchas opciones para emitir un vídeo en Internet; cada método tiene 
sus propias posibilidades y requisitos de flujo de trabajo, por lo que se deben 
considerar las opciones detenidamente.

Transferencia de vídeo

La transferencia de vídeo se parece a la televisión convencional en la que el 
vídeo se envía al usuario fotograma a fotograma, sin necesidad de descargar 
un archivo de grandes proporciones al disco duro. 

La transferencia de vídeo por internet está restringida por el límite del ancho de 
banda de la mayoría de los modems utilizados por consumidores (56 Kbps o 
menos). No obstante la transferencia de vídeo puede ser muy rápida en 
intranets donde exista un ancho de banda de alta velocidad.

Los siguientes formatos para la transferencia de vídeo están disponibles para la 
exportación desde Premiere: Transferencia QuickTime, Windows Media, 
RealVideo, y RealG2.

Para preparar la transferencia de vídeo se puede utilizar una de las opciones 
de exportación a Web incluídas en Premiere: Save for Web, Advanced 
RealMedia Export, o Advanced Windows Media Export (Sólo en Windows).
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Vídeo de descarga progresiva

Una película de descarga progresiva puede empezar a reproducirse antes de 
que se haya descargado completamente. El programa reproductor (QuickTime, 
MediaPlayer, o RealPlayer) empieza la reproducción cuando ha calculado que 
la película puede estár totalmente descargada en el tiempo que dure la 
reproducción de la parte ya descargada.

Los siguientes formatos de vídeo de descarga progresiva están disponibles 
para la exportación desde Premiere: QuickTime Progressive Download, 
Windows Media, RealVideo, y RealG2 Web Download. 

Se puede crear vídeo de descarga progresiva utilizando uno de los plug-ins 
para la exportación a Internet: Save for Web, Advanced RealMedia Export, o 
Advanced Windows Media Export (Sólo en Windows).

Vídeo MPEG

MPEG (Motion Picture Experts Group) es un formato de archivo que comprime 
los archivos de vídeo de forma eficaz, pero no está tan extendido como 
QuickTime o AVI. De hecho, existen varias versiones de MPEG; la versión que 
se usa normalmente para Internet y CD-ROM es MPEG 1, que proporciona una 
calidad de imagen casi comparable a VHS. MPEG 2 puede proporcionar 
calidad de imagen SVHS. Sin embargo, precisamente la compresión basada en 
keyframes que hace de MPEG un sistema popular para la distribución de 
vídeos finales, resulta, por otro lado, poco apropiada para la edición de alta 
calidad

Es posible crear vídeo MPEG utilizando la opción de exportación Save for Web.
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Audio MP3

MP3 es un formato de fichero que comprime ficheros de audio en una 
proporción que oscila entre1:24 y 1:5. Esta alta compresión hace que los 
ficheros MP3 sean mucho más pequeños, pero con mejor calidad, que la 
mayoría del resto de los formatos.

MP3 es la extensión de los ficheros generados con MPEG 1 Layer 3 (que es el 
verdadero nombre del formato).

Se pueden crear ficheros de audio del tipo MP3 utilizando la opción de 
exportación Save for Web.
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GIF animado

GIF animado resulta idóneo para gráficos de movimiento de tintas planas con 
un tamaño de fotograma pequeño, como un logotipo animado de una empresa; 
su ventaja radica en que se puede visualizar en la mayoría de los navegadores 
Web sin precisar un plug-in. Por otro lado, no se puede incorporar audio en 
este tipo de archivos. GIF animado funciona mejor en gráficos sintéticos que en 
vídeos de imágenes reales.

El tipo de archivo GIF animado se exporta como cualquier otro archivo, 
asegurándose de que se ha seleccionado GIF animado como tipo de archivo. 
Consulte Exportación de vídeo. Con el fin de obtener los mejores resultados, 
efectúe una prueba con los archivos GIF animado una vez finalizados en un 
navegador Web antes de su distribución.
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Creación de un archivo de vídeo 
para su reproducción en CD-ROM

Cuando se crea un archivo de vídeo para su reproducción desde un CD-ROM, 
es posible que se deban definir configuraciones de exportación que tengan en 
cuenta la amplia gama de ordenadores que los destinatarios del vídeo pueden 
tener, incluidas las unidades de CD-ROM antiguas, de velocidad simple o 
doble.

Si los destinatarios del vídeo utilizan unidades de CD-ROM antiguas, es 
importante sintonizar el archivo de vídeo exportado para un flujo de datos 
reducido. El flujo de datos se puede limitar con facilidad especificándolo en 
Premiere, aunque si el archivo de vídeo continúa sin reproducirse 
correctamente en los ordenadores de sus destintarios, posiblemente también 
se deban realizar los ajustes siguientes:

• Reducir el flujo de datos y la calidad tanto como sea posible sin perder 
demasiada calidad de imagen, si ha especificado un codec que permite 
realizar estos ajustes. Consulte Acerca del flujo de datos y Exportación 
de un vídeo. 

• Reducir los fotogramas por segundo tanto como se pueda, sin que el 
movimiento llegue a parecer demasiado entrecortado; comience con 15 
fotogramas por segundo. Consulte Exportación de un vídeo. 

• Reducir la profundidad del color a 256 colores. Además de disminuir el 
flujo de datos, esta operación puede mejorar la calidad de imagen del 
vídeo en un sistema o en un software de presentación que pueda 
visualizar solamente 256 colores (color de 8 bits). Consulte Exportación 
de un vídeo. 

• Recortar la imagen a un tamaño pequeño para obtener una visualización 
óptima, reducir el ruido de vídeo con el fin de mejorar la compresión, o 
ajustar el valor gamma para el monitor de destino mediante el panel 
Procesado especial del cuadro de diálogo Configuraciones para 
exportar. Consulte Exportación de un vídeo. 

• Seleccionar el tipo de archivo y el codec más adecuados para los 
destinatarios de su vídeo; por ejemplo, para un CD-ROM que se vaya a 
utilizar en diferentes plataformas, puede especificar un codec 
QuickTime. Seleccione un codec diseñado para flujos de datos bajos, 
tales como Indeo, Cinepak o Sorenson Video. 

• Elija File > Export Timeline > Save for Web, y seleccione la configuración 
para AVI CD-ROM o QuickTime CD-ROM: Cualquiera de ellas 
automáticamente comprime y guarda el fichero con la xonfiguración más 
adecuada para la óptima reproducción en un CD. 
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Creación de archivos de vídeo para 
su uso en otro software

Premiere exporta a muchos formatos que se pueden leer en otras aplicaciones. 
Por ejemplo, es posible exportar una película QuickTime para su uso en Adobe 
After Effects. Cuando se vaya a exportar a un archivo de vídeo que se va a 
utilizar en otros software de edición de vídeo o de efectos especiales, conteste 
a las siguientes preguntas:

• ¿Qué formatos de archivo y métodos de compresión importa el otro 
software? Esto le facilitará la determinación del formato que utilizará 
para la exportación. 

• ¿Se va a transferir a diferentes plataformas? Esto podría restringir aún 
más la elección de formatos de archivo y los métodos de compresión. 
Considere la utilización de codecs de alta calidad capaces de funcionar 
en diferentes plataformas (transcodificadores), tales como QuickTime 
Motion JPEG A o B, o Animation. 

• ¿Va a superponer los clips de Premiere a otros clips? En este caso, 
conserve la transparencia del canal alfa al exportar desde Premiere. 

• ¿Cuál es el método de compresión de mayor calidad que puede importar 
el otro software? El uso de compresión de alta calidad limita el grado de 
compresión que puede aplicarse a un archivo de vídeo, pero conserva la 
calidad. Conviene conservar el nivel más alto posible de calidad de 
imagen hasta que finalice el proceso de edición; para obtener la máxima 
calidad, seleccione el compresor Ninguno (sin compresión) si cuenta con 
suficiente espacio en disco para almacenar el archivo tan voluminoso 
que resultará. 

• ¿Desea dibujar en los fotogramas? En este caso, puede exportarlo a 
formato Filmstrip y editarlo en Photoshop (consulte Exportación de un 
archivo filmstrip para su edición en photoshop). o, de forma alternativa, 
puede exportar los fotogramas como una secuencia numerada de 
archivos de imágenes fijas individuales y editar cada archivo en 
Photoshop. 

• ¿Desea utilizar un único fotograma como una imagen fija? En este caso, 
consulte Exportación de imágenes fijas. 
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Exportación de un vídeo

Es posible preparar variaciones de un programa o de un clip para varios usos. 
Por ejemplo: se pueden preparar versiones con alta y con baja resolución, o 
crear versiones separadas para obtener calidad de televisión, distribución de 
CD y distribución por internet. También se puede automatizar las variaciones 
en la exportación de un proyecto utilizando el proceso por lotes. Consulte 
Proceso de un grupo de proyectos.

Para exportar un vídeo utilizando un plug-in optimizado para internet o 
CD-ROM:

1 Active la ventana de construcción, vista de origen, vista de programa o una 
ventana independiente de clip. Si se está exportando la ventana de 
construcción y ésta incluye clips virtuales, asegúrese de que el área de trabajo 
en la ventana de construcción incluye sólo el programa de vídeo general. 
Consulte Anidado de ediciones mediante clips virtuales.

2 Elija File > Export Timeline (o Export Clip) > Save for Web, Advanced 
RealMedia Export, o Advanced Windows Media (Sólo en Windows).

3 Establezca un valor para las opciones de configuración y pulse OK o Start. 
Consulte la ayuda en línea de los plug-ins o la documentación PDF para más 
detalles.

Nota: Las opciones Save for Web, RealMedia Export o Advanced Windows 
Media, requieren que se haya instalado Premiere con todos sus módulos.

Para exportar un vídeo utilizando las opciones de exportación de 
Premiere:

1 Active la ventana de construcción, vista de origen, vista de programa o una 
ventana independiente de clip. Si se está exportando la ventana de 
construcción y ésta incluye clips virtuales, asegúrese de que el área de trabajo 
en la ventana de construcción incluye sólo el programa de vídeo general. 
Consulte Anidado de ediciones mediante clips virtuales.

2 Elija File > Export Timeline (o Export Clip) > Movie.

3 Pulse el botón Settings y elija la configuración adecuada. Consulte Opciones 
de configuración para exportar.

4 Pulse OK para cerrar el cuadro de diálogo.

5 Especifique una ruta de acceso y nombre de fichero, y después pulse OK. Si 
sesea cancelar la exportación, pulse Esc; la cancelación puede tardar varios 
segundos.
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Utilice los botones Save y Load en el cuadro de diálogo de configuración 
de la exportación para guardar y más tarde cargar con rapidez configuraciones 
de exportación que se usen con frecuencia. La carga de configuraciones 
guardades es particularmente útil cuando se crean varios tipos de ficheros de 
vídeo (por ejemplo, NTSC, PAL y vídeo para Web) desde el mismo proyecto.

373



Exportación de imágenes fijas

Se puede exportar cualquier fotograma o clip de imagen a un fichero de 
imagen. Cuando se exportan fotogramas, se exportará el correspondiente al 
punto de edición en la ventana de construcción, ventana de programa, vista de 
origen o vista de programa.

Para exportar una imagen fija:

1 Elija File > Export Timeline > Frame (o File > Export Clip > Frame).

2 Pulse el botón Settings.

3 Elija un tipo de fichero. Pulse Advanced Settings si está disponible para 
especificar opciones avanzadas para el tipo de fichero elegido, y después pulse 
OK. Respecto a la configuración avanzada para los ficheros GIG, consulete 
GIF animado.

4 Pulse Next. En el panel de configuración de vídeo, especifique el tamaño de 
fotograma y profundidad de color (consulte Exportación de un vídeo).

5 Pulse Next. En el panel de opciones de Keyframe y de Renderización, 
especifique los valores adecuados.

6 Pulse Next. En el panel de procesado especial, pulse Modify, y especifique 
los valores deseados.

7 Pulse OK para cerrar el cuadro de diálogo de exportación de fotogramas.

8 Especifique una ruta de acceso y nombre de fichero y después pulse OK.
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Exportación de una secuencia de 
imágenes fijas

Es posible exportar un clip o un programa como una secuencia de imágenes 
fijas, con cada fotograma en un archivo de imágenes fijas independiente, lo que 
puede ser útil para mover un clip a aplicaciones de animación y de 3-D que no 
importen formatos de archivos de vídeo, o para su uso en programas de 
animación que requieran una secuencia de imágenes fijas. Al exportar una 
secuencia de este tipo, Premiere numera los archivos de forma automática.

Para exportar una serie de imágenes fijas:

1 Elija File > Export Timeline > Movie.

2 Pulse el botón Settings.

3 En File Type, elija un formato de archivo para las imágenes, normalmente 
cualquier tipo de archivo que termine con la palabra "sequence" así como el 
tipo de archivo FLC/FLI (sólo en Windows).

4 Elija los fotogramas que se van a exportar en el menú Range.

5 Asegúrese de que la opción Exportar vídeo está seleccionada.

6 Pulse Next y confirme las configuraciones de vídeo (consulte Exportación de 
un vídeo).

7 Pulse Next. En el panel de Keyframe y opciones de renderización, 
especifique las opciones necesarias y después pulse OK.

8 Especifique la ubicación para todos los archivos de imágenes fijas que se van 
a exportar. Lo más conveniente es especificar una carpeta vacía aparte, de 
forma que los archivos de la secuencia no se mezclen con otros archivos.

9 Si lo desea, introduzca un nombre de archivo numerado. Para especificar el 
número de dígitos del nombre del archivo, determine cuántos dígitos serán 
necesarios para numerar los fotogramas y añada después los ceros adicionales 
que desee. Por ejemplo, si desea exportar 20 fotogramas y que el nombre del 
archivo tenga cinco dígitos, introduzca Car000 para el primer nombre de 
fichero: los restantes ficheros automáticamente se denominarán Car00001, 
Car00002, ..., Car00020.

10 Pulse OK para exportar la secuencia de imágenes fijas.
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Exportación de un archivo filmstrip 
para su edición en Photoshop

Para editar un clip en Photoshop se puede utilizar el formato Filmstrip, que está 
específicamente creado para este fin. El formato Filmstrip resulta útil si se 
desea dibujar directamente en los fotogramas de vídeo, proceso denominado 
rotoscopia. Es posible exportar un clip de vídeo o una sección de la ventana de 
construcción como un archivo filmstrip.

Un filmstrip es un archivo individual que contiene todos los fotogramas del clip. 
Si el ordenador no cuenta con suficiente memoria para que Photoshop cargue 
el archivo filmstrip, se deberá exportar el clip como imágenes fijas numeradas 
en su lugar, de forma que cada fotograma pueda editarse como un archivo 
individual (consulte Exportación de una secuencia de imágenes fijas). 

En Photoshop, un archivo filmstrip se abrirá como una serie de fotogramas en 
una columna, con los fotogramas etiquetados con un número, un nombre de 
cinta y un código de tiempo. Si la columna creada por los fotogramas del 
filmstrip es mayor de 30.000 píxeles, los fotogramas continuarán en una 
segunda columna. Este límite de tamaño es la dimensión de imagen máxima 
que Photoshop puede manejar. El número de fotogramas que se muestran 
dependerá de la duración del clip y de la velocidad seleccionada al exportar el 
filmstrip desde Premiere.

Para obtener los mejores resultados al editar un filmstrip en Photoshop, siga las 
siguientes directrices:

• Puede dibujar en las líneas grises que dividen los fotogramas del 
filmstrip, ya que no perjudicará al archivo, aunque Premiere sólo 
mostrará la parte de cada fotograma situada dentro de los bordes. 

• Puede editar los canales rojo, verde, azul y alfa del archivo filmstrip. Sin 
embargo, utilice sólo el canal #4 como canal alfa; no se reconocerán el 
resto de los canales alfa. 

• No reajuste el tamaño del filmstrip, ni lo recorte. 

Si simplemente desea exportar un único fotograma, no es necesario 
utilizar el formato Filmstrip, sino que basta con exportar una sola imagen fija. 
Consulte Exportación de imágenes fijas.

Para exportar un clip como un filmstrip:

1 Elija File > Export Timeline (o Export Clip) > Movie.
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2 Pulse Settings.

3 En File Type, Elija Filmstrip como tipo de archivo y seleccione los fotogramas 
que desea exportar en el menú Range.

4 Asegúrese de que está seleccionada la opción Exportar vídeo.

5 Pulse Next, confirme las configuraciones de vídeo (consulte Exportación de 
un vídeo). Asegúrese de que la velocidad coincida con la del proyecto; después 
pulse OK.

Nota: Si el vídeo contiene campos entrelazados, seleccione Opciones de 
keyframe y render en el menú situado en la parte superior del cuadro de 
diálogo. Para Configuraciones de los campos seleccione Dominancia Campo 1 
si el campo dominante del vídeo de origen original es el 1 o Dominancia Campo 
2 si es el 2. Si desconoce la dominancia de campos del vídeo original, póngase 
en contacto con su creador o consulte la documentación del hardware o 
software utilizados para crearlo.

6 Especifique la ubicación y un nombre de archivo y, a continuación, haga click 
en Save.

Tras editar el filmstrip y guardarlo con formato Filmstrip de Photoshop, se 
puede utilizar como clip en un proyecto de Premiere importándolo como 
cualquier otro archivo compatible. Consulte Importación de clips.
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Exportación de un proyecto para 
usarlo en Adobe After Effects

Se puede importar un proyecto de Premiere en Adobe After Effects y aplicarle 
los últimos retoques, como las utilidades avanzadas de transparencia, efectos y 
animaciones. After Effects preserva el orden de los clips en la ventana de 
construcción, duración del material y localización de marcas y transiciones. 
Asimismo convierte las transiciones y títulos del proyecto en capas sólidas 
manteniendo su posición y duración original. Pero todos los efectos de 
transparencia y movimientos establecidos con Premiere serán descartados por 
Affter Effects.

After Effects proporciona muchas de las opciones de exportación que existen 
en Premiere, de tal manera que cuando se haya terminado el trabajo, se puede 
renderizar el proyecto en After Effects utilizando uno de los formatos de fichero 
soportados. Para más información, consulte la documentación de After Effects.

Para abrir un proyecto de Premiere en After Effects:

1 Guarde y cierre el proyecto de Premiere.

2 Abra After Effects y elija File > Import > Premiere as Comp.

3 Localice y seleccione el fichero de proyecto de Premiere y pulse Open.
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Exportación de varios proyectos 
mediante proceso por lotes

Es posible exportar de forma automática varios programas de vídeo o clips. El 
comando Batch Processing utiliza las configuraciones de exportación y las 
opciones de compresión que se hayan especificado para cada archivo de vídeo 
creado. Se pueden crear y guardar varias listas de procesado para exportar de 
forma sencilla y en repetidas ocasiones grupos de proyectos. Las listas de 
procesos contribuyen al ahorro de tiempo y simplifican en gran medida las 
operaciones siguientes:

• Exportación de varios archivos de vídeo durante la noche. 
• Prueba de varios archivos de configuraciones de exportación para 

comprobar cuál funciona mejor. 
• Creación de versiones para diferentes soportes de medios, como cinta 

de vídeo, CD-ROM y distribución a través de la Web. 
• Creación de versiones para diferentes tareas de edición, como la edición 

fuera de línea o la rotoscopia. 

Para exportar mediante el proceso por lotes:

1 Elija Project > Utilities > Batch Processing.

2 Pulse Add. Seleccione un proyecto o fichero de vídeo que desee añadir a la 
lista, y pulse Open. Repita la operación para cada proyecto o fichero de vídeo 
que desee incluir en la lista.

3 Para cada archivo de la lista, realice las siguientes acciones:

• Seleccione el proyecto o el clip y haga click en Target. Especifique la 
ubicación y el nombre del archivo que se producirá a partir de este 
proyecto o clip y haga click en Save. 

• Pulse Settings si desea verificar las configuraciones del proyecto de un 
clip o proyecto seleccionado. 

4 Realice una de las siguientes acciones:

• A fin de asegurarse de que los archivos de origen del proyecto están 
listos para el procesado, seleccione cualquier número de proyectos de la 
lista y haga click en Check. Esto es especialmente importante si nadie 
va a supervisar el ordenador, porque si falta algún archivo el proceso se 
detendrá. Premiere abre cada proyecto seleccionado y verifica que los 
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archivos de clips correspondientes a las copias del clip utilizadas en 
cada proyecto seleccionado se encuentran en el disco. Si falta algún 
archivo de clip, Premiere se lo comunicará de la misma forma que al 
abrir un proyecto. Consulte Abrir un proyecto y localizar los ficheros que 
lo componen. 

• Para procesar toda la lista de procesos, haga click en Make, Seleccione 
Make All Sources in List, y pulse OK. 

• Para procesar un rango continuo de proyectos de la lista, haga click para 
seleccionar el primer proceso que desee procesar, mantenga pulsada la 
tecla Mayúsculas mientras hace click en el último proceso que desee 
procesar; haga click en Make, seleccione Make Selected Sources Only, 
y pulse OK. 

• Para procesar un rango discontinuo de proyectos de la lista, haga click 
para seleccionar el primer proyecto que desee procesar, mantenga 
pulsada la tecla Control (Windows) o Comando (Mac OS) mientras hace 
click en los procesos adicionales que desee procesar; haga click en 
Make, seleccione Make Selected Projects Only, y pulse OK. 

Atención: Si hace click en Cancelar, perderá todos los cambios realizados 
desde que abrió el cuadro de diálogo Lista de procesos. Si decide no realizar la 
película pero desea conservar las configuraciones de la lista de procesos que 
haya determinado, guarde las configuraciones tal y como se describe a 
continuación. Posteriormente, podrá abrir el cuadro de diálogo Lista de 
procesos y cargar estas configuraciones.

Para guardar, cargar o eliminar un elemento de la lista de procesos:

Con la ventana de lista de procesos abierta, realice una de las siguientes 
acciones:

• Para eliminar un proyecto o clip de la lista de procesos, seleccione un 
proyecto o clip de la lista y haga click en Delete. 

• Para guardar la lista de procesos en disco, haga click en Guardar, 
especifique la ubicación y el nombre de archivo y haga click en  Save. 

• Para cargar una lista de procesos de un disco, haga click en Load, 
localice y seleccione un archivo de la lista de procesos y haga click en 
Open. 
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Acerca de las configuraciones de 
exportación

Al exportar desde Premiere, la manera en que se ajusten las configuraciones 
para la exportación depende del tipo de salida que se desee:

• Cuando se graba directamente desde la ventana de construcción (File > 
Export Timeline > Print to Video o Export to Tape), Premiere utiliza la 
configuración establecida para el proyecto en cuadro de diálogo de 
configuración de proyecto. 

• Cuando se exporta a un fichero de vídeo (File > Export Timeline > 
Movie), Premiere utiliza las configuraciones que se establezcan en el 
cuadro de diálogo que aparece tras pulsar el botón Settings. 

• Cuando se exporta para Internet mediante un plug-in (File > Export 
Timeline > Save for Web, Advanced Windows Media, o Advanced 
RealMedia Export), el plug-in utiliza las configuraciones establecidas en 
el proyecto y en su propio cuadro de diálogo de configuración. Consulte 
la documentación del plug-in para más detalles. 

Nota: La tarjeta de captura puede incluir software que proporcione cuadros de 
diálogo y opciones para la exportación. Si las opciones que usted ve no son las 
mismas que aquí se describen, consulte la documentación de la tarjeta de 
captura.

Para ver una lista de las configuraciones actuales de captura, clip, proyecto y 
exportación, abra el visor de configuraciones mediante Project > Settings 
Viewer. Para más información consulte Comparación de configuraciones 
usando el visor de configuraciones.
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Acerca de la compresión

Cuando se exporta un programa de vídeo, hay que elegir un 
compresor/decompresor o codec, para comprimir la información para su 
almacenamiento y transferencia y para decomprimir la información de tal modo 
que pueda ser vista de nuevo.

Al comprimir el programa de vídeo, hace que este se reproduzca con más 
suavidad en el ordenador.

Existe un amplio rango de codecs disponibles, sin que se pueda decir que uno 
de ellos es el mejor para cualquier situación, sino que todo depende del 
resultado que se desea obtener. Por ejemplo, el mejor codec para comprimir 
dibujos animados normalmente no será eficiente para comprimir vídeo con 
imágenes reales.

El codec que se utilice debe estar disponible para cualquiera que pretenda 
reproducir el fichero. Así, por ejemplo, si se utiliza un codec disponible sólo con 
una tarjeta de captura específica, el fichero sólo se podrá reproducir en 
ordenadores donde la misma tarjeta esté instalada.

Algunos formatos, como el DV, usan codecs especiales. Es decir: se reconoce 
que un clip tiene dicho formato por estar comprimido con dicho codec.
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Acerca del flujo de datos

Con algunos codecs de vídeo es posible especificar el flujo de datos o bit-rate 
con el que se controla la cantidad de vídeo y de información que debe ser 
procesado cada segundo durante la reproducción.

Cuando en Premiere se especifica un flujo de datos determinado, lo que se 
está estableciendo en realidad es el flujo de datos máximo, porque para cada 
fotograma su flujo de datos puede variar dependiendo de su contenido.

En la siguiente lista se contienen algunas orientaciones para la elección del 
flujo de datos adecuado:

Producción de vídeocintas El flujo de datos debe encontrarse dentro de la 
capacidad del ordenador y del disco duro que reproducirá la ventana de 
construcción o clip durante la grabación de la cinta.

Reproducción desde el disco duro Si el vídeo final será reproducido desde el 
disco duro, tenga en cuenta la velocidad del disco duro que se utilizará y fije el 
flujo de datos de acuerdo con ella. Si se está exportando vídeo para utilizarlo 
en otro sistema de edición, o para importarlo a una aplicación como Adobe 
After Effects, se debe procurar la máxima calidad, para lo que hay que utilizar 
un codec sin pérdidas, o el codec soportado por su tarjeta de captura, y 
especificar el máximo flujo de datos que el sistema de edición soporte para la 
captura y edición de vídeo.

Reproducción desde CD-ROM El flujo de datos correcto para la reproducción 
desde CD-ROM depende de la velocidad que tenga la unidad reproductora de 
CD-ROM. Por ejemplo si se trata de una unidad de doble velocidad (300K por 
segundo), debe especificarse un flujo de datos entre 150 y 200K por segundo, 
para aprovechar al máximo dicha velocidad, pero dejando cierto margen para 
que el sistema pueda transportar los datos.

Reproducción en una Intranet El flujo de datos puede llegar a 100K por 
segundo o más, dependiendo de la velocidad de la Intranet. Una intranet es 
una red privada que utiliza el protocolo de red de Internet. Como las intranets 
están limitadas en su alcance, normalmente usan líneas de comunicación de 
más alta calidad que las telefónicas, por lo que pueden alcanzar velocidades 
mucho más altas que las de Internet.

Transferencia de vídeo por Internet El flujo de datos debe ajustarse a la 
velocidad del destino. Por ejemplo el flujo de datos para transferencia de vídeo 
pensado para una conexión a 28.800 bps, será normalmente de 20.000 bps.

Descarga de vídeo por Internet En este caso el flujo de datos es menos 
importante que el tamaño final del fichero, porque de lo que se trata es de que 
la transferencia del fichero no ocupe demasiado tiempo. Pero como el flujo de 
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datos afecta al tamaño del fichero, puede ser recomendable reducirlo para 
acelerar la descarga.

Utilice el comando Get Properties For para analizar el flujo de datos de los 
ficheros que se exportan. Consulte Análisis de las propiedades y flujo de datos 
de un clip.
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Acerca de los keyframes de 
compresión

Los keyframes de compresión son distintos de los keyframes que se colocan en 
la ventana de construcción de Premiere.

Los keyframes de compresión se establecen automáticamente y en intervalos 
regulares en la película. Se trata de fotogramas que se almacenan 
completamente, a diferencia de los fotogramas que se encuentran situados 
entre dos keyframes, llamados fotogramas intermedidos, en los que sólo se 
almacenan los cambios respecto del fotograma anterior o posterior. Este 
proceso permite una gran reducción del tamaño del fichero, dependiendo, claro 
está, del espacio entre los keyframes: Pocos keyframes (muy espaciados) 
producen ficheros con tamaños más pequeños, pero también con peor calidad 
de imagen y de reproducción. Más kegrames (y por lo tanto menos espaciados) 
producen ficheros significativamente más grandes, pero con una mayor calidad 
de imagen y de reproducción.

La elección de las configuraciones de compresión debe decidirse pues 
teniendo en cuenta el tipo de material de origen, el formato exigido por el medio 
donde se distribuirá el vídeo y las capacidades standard del sistema que 
tengan probablemente los destinatarios del vídeo. Muy a menudo la 
configuración óptima no se determina hasta después de varias pruebas.
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Elección de configuraciones para 
exportar

Una parte del proceso de exportación consiste en comprobar las opciones 
establecidas en el cuadro de diálogo de configuración de la exportación.

La configuración inicial para exportación es la misma que se especificó en el 
cuadro de diálogo de configuración del proyecto en el momento en que el 
proyecto fue creado. Pero las modificaciones posteriores en la configuración 
del proyecto, ya no afectan directamente a la configuración de exportación. Por 
eso es buena idea, antes de exportar, asegurarse de que la configuración sea 
la adecuada.

Aunque el cuadro de diálogo de configuración para exportación es similar al de 
configuración del proyecto, existen importantes diferencias. Por ejemplo en el 
primero se incluye un panel de Proceso Especial en el que se pueden aplicar 
ciertos cambios a todos los clips existentes en la ventana de construcción en el 
momento de la exportación, como redimesionamiento, recorte o reducción de 
ruido.

Nota: Cierto software de tarjetas de captura y algunos plug-ins proporcionan 
cuadros de diálogo adicionales con opciones específicas. Si las opciones que 
usted ve son distintas de las que se describen en esta ayuda, consulte la 
documentación de su tarjeta de captura o plug-in.
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Configuraciones generales de 
exportación

Las siguientes opciones están disponibles en el panel de configuraciones 
generales del cuadro de diálogo de configuraciones para exportación:

File Type Seleccione el tipo de fichero que desea generar.

Advanced Settings Este botón estará activo sólo si se ha elegido un tipo de 
fichero que disponga de configuraciones avanzadas, las cuales además 
variarán dependiendo del tipo de fichero de que se trate. A continuación se 
exponen las opciones existentes para GIF animado o secuencias GIF, que son 
los únicos formatos incluidos de manera standard por Premier que admiten 
configuraciones avanzadas:

• Dithering: Seleccione esta opción para simular colores que no están 
disponibles en la paleta de colores utilizada por los navegadores web. 
Para ello se utilizan patrones que entremezclan pixels entre los colores 
disponibles. Estos colores simulados pueden verse a veces toscos o 
granulados, pero, a cambio, generalmente se mejora el rango aparente 
de colores y la apariencia de los difuminados. Si la opción se desactiva, 
los colores no disponibles se transformarán en el color más semejante 
disponible en la paleta, lo cual puede causar en ocasiones transiciones 
muy abruptas de color. 

• Transparency: Seleccione None (ninguna) del menú para crear la 
película en un rectángulo opaco. Seleccione Hard (fuerte) para convertir 
un color en una zona transparente; pulse Color para especificar qué 
color se convertirá en transparente. Seleccione Soft (suave) para 
convertir un color en transparente y suavizar los bordes; seleccione color 
para especificar qué color será transparente. 

• Looping: Seleccione esta opción si desea que el Gif animado se 
reproduzca continuamente sin detenerse. Desactívela si desea que el gif 
animado se reproduzca una sola vez y después se detenga. Esta opción 
no está disponible para las secuencias gif. 

Range Seleccione el rango de tiempo para exportar. Si está activa la ventana 
de construcción o la vista del programa, puede seleccionarse Work Area para 
exportar sólo los fotogramas incluidos en el área de trabajo (consulte 
Previsualización de un programa de vídeo). Si se está exportando desde la 
vista de origen o desde una ventana independiente de clip, y se han marcado 
los puntos In y Out, puede seleccionarse In to Out para exportar sólo los 
fotogramas incluidos entre ambos puntos.
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Export Video Marque esta opción para exportar las pistas de vídeo, o 
desactívela para evitar que se exporten dichas pistas.

Export Audio Marque esta opción para exportar las pistas de audio, o 
desactívela para evitar que se exporten dichas pistas.

Open When Finished Marque esta opción si desea que el fichero exportado 
sea abierto desde Premiere una vez haya terminado la exportación.

Beep When Finished Marque esta opción si desea que Premiere emita un 
sonido para advertir de que se ha terminado la exportación.

Embedding Options Seleccione de este menú Project Link si desea que el 
fichero exportado incluya la infroamción necesaria para usar el comando Edit 
Original. Cuando así ocurre es posible abrir y editar el proyecto original dentro 
de otro proyecto de Premiere o desde otra aplicación que reconozca esta 
información. Consulte Edición de un clip en su aplicación original. Seleccione 
None en este menú para evitar que se incluya dicha información.
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Configuraciones para exportación de 
vídeo

Las siguientes opciones están disponibles en el panel de configuraciones de 
vídeo del cuadro de diálogo de configuraciones de exportación:

Compressor Especifica el codec (compresor/descompresor) que se aplicará al 
fichero exportado. Los codecs disponibles dependen del tipo de fichero elegido 
en el panel de Configuraciones generales de exportación

Nota: Si no consigue encontrar opciones que su codec proporciona, consulte la 
documentación incluida con su tarjeta de captura. Téngase en cuenta además 
que muchas tarjetas de captura requieren que se elija un codec proporcionado 
por ellas

El botón Configure se habilitará cuando se seleccione un codec de compresión 
que admita diferentes valores para su configuración. Para conocer las opciones 
que en tal caso se mostrarán al pulsar el botón, debe consultarse la 
documentación facilitada por el fabricante del codec en cuestión.

Depth (Profundidad): Indica la profundidad de bits en color, es decir, el número 
de colores a incluir en los vídeos exportados. Este botón puede no estar 
disponible si el compresor seleccionado proporciona una sola opción de 
profundidad de bits.

Cuando se elige como Profundidad 256 colores (cosa que sólo se puede hacer 
si el codec lo permite), se activa el botón Palette (Paleta). Mediante el que se 
puede especificar una paleta de 8 bits (256 colores), lo cual puede ser útil, por 
ejemplo, para la Web, o para software de presentaciones.

Pulsando el botón paleta puede crear una paleta a partir de una película, o 
cargar una paleta previamente almacenada.

Cuando se elige "crear paleta de la película" (Make palette from Movie) 
Premiere generará una paleta de colores a partir de los fotogramas utilizados 
en los clips que se encuentran en la línea temporal.

Cuando se elige "Cargar Paleta" se puede importar una paleta de colores 
preparada y guardada con anterioridad. Puede cargar paletas de colores 
almacenadas en los formatos .ACO (muestrario de color de Photoshop), .ACT 
(paleta de colores de Photoshop) o PAL (Paleta de Windows, sólo Windows).

Note: With the QuickTime file type, you can attach a 256-color palette to a 
movie of any bit depth. You can specify a palette for 24-bit movies to use when 
displaying on 8-bit monitors, and you can prevent palette "flashing" by attaching 
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the same palette to many movies. Video for Windows supports attaching a 
palette only to an 8-bit movie.

Frame Size Especifica las dimensiones en pixeles de los fotogramas del 
fichero a generar. Si marca la casilla Aspect el tamaño de fotograma se 
ajustará a la proporción utilizada por los televisores convencionales. Algunos 
codecs sólo soportan tamaños de fotograma específicos. Incrementando el 
tamaño de fotograma se muestran más detalles, pero se utiliza también más 
espacio en disco y aumentan los requerimientos del sistema para la 
reproducción.

Frame Rate Especifica el número de fotogramas por segundo que tendrá el 
vídeo exportado. Algunos codecs sólo soportan ciertas velocidades. Al 
incrementar la velocidad se produce normalmente un movimiento más suave 
(dependiendo de la velocidad original de los clips); pero se utiliza también más 
espacio en disco.

Quality (Calidad): Afecta a la calidad de imagen y al espacio del disco utilizado. 
Si se está utilizando el mismo codec que se utilizó para la captura, y si se han 
generado ficheros de previsualización, se puede ahorrar tiempo en la 
renderización ajustando la calidad de la exportación con la calidad original. Por 
ejemplo, si se capturaron los clips con la calidad fijada al 50%, y para la 
exportación se coloca el mismo valor, Premiere copiará, en la medida que sea 
posible, los ficheros ya generados, en lugar de recomprimir los datos fotograma 
a fotograma.

Incrementar la calidad por encima de la del original, no mejora realmente el 
resultado, pero sí aumenta el tiempo de renderización.

Limit Data Rate to _ K/Sec Seleccione esta opción (si está disponible para el 
codec elegido) y escriba el flujo de datos que constituirá el límite superior de la 
cantidad de datos de vídeo producidos por el fichero exportado en el momento 
de su reproducción. Consulte Flujo de datos.

Nota: En algunos codecs la calidad y el flujo de datos están interrelacionados, 
de tal manera que, ajustando una opción, automáticamente se modifica la otra.

Recompress Por defecto Premiere sólo recomprime los fotogramas que tienen 
diferente configuración que la que se haya seleccionado en este cuadro de 
diálogo. Puede seleccionar Recomprimir siempre (Always), en el menú de 
recompresión, para asegurarse de que Premiere recomprime todos los 
fotogramas, incluso los que se encuentran dentro del flujo de datos 
especificado. O también puede seleccionar Mantener flujo de datos (Maintain 
Data Rate) para preservar la calidad comprimiendo sólo los fotogramas que se 
encuentran por encima del flujo de datos especificado.

Al recomprimir fotogramas previamente comprimidos, puede reducirse la 
calidad de la imagen.
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Configuraciones para exportación de 
audio

En el panel de configuraciones de audio del cuadro de diálogo de 
configuraciones de exportación se encuentran las siguientes opciones:

• Rate 
• Format 
• Compressor 
• Interleave 
• Enhanced Rate Conversion 
• Logarithmic Audio Fades 
• Create audio preview files if there are 

Respecto de estas opciones no hay diferencias entre la configuración para 
exportación y la configuración del proyecto. En consecuencia consulte 
Configuración de audio.
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Configuraciones de keyframe y 
render para exportación

Cuando se escoge el panel de configuraciones de Keyframe y renderización del 
cuadro de diálogo de configuraciones de exportación, aparecen las siguientes 
opciones:

• Ignore audio effects 
• Ignore video effects 
• Ignore audio rubber bands 
• Optimize stills 
• Frames Only at markers 
• Fields 
• Keyframe every _ frames 
• Add keyframes at markers 
• Add keyframes at edits 

No hay especialidades para estas opciones respecto de las opciones generales 
del proyecto. Por ello consulte Opciones de Keyframe y renderización en la 
ayuda sobre la configuración general del proyecto.
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Configuraciones especiales de 
exportación

Al elegir Special Processing del menú que se encuentra en la parte superior del 
cuadro de diálogo de configuraciones de exportación, y pulsar el botón Modify, 
es posible especificar las siguientes opciones:

Left, Right, Top, and Bottom (Izquierda, derecha, arriba y abajo): Escriba las 
dimensiones en pixeles de los márgenes, o arrastre los puntos de control del 
rectángulo de recorte para recortar el vídeo exportado. La información de 
tamaño que se ofrece, se refiere al tamaño del fotograma después del recorte. 

Si se ha especificado como codec el de Cinepak, asegúrese de que las 
dimensiones finales son divisible por 4, porque Cinepak trabaja con más 
eficiencia con celdas de 4x4. Otros codecs o sistemas requieren que las 
dimensiones sean múltipos de 8 o 16, como MPEG2.

Scale to (frame size) Seleccione esta opción si se ha recortado el vídeo y se 
desea alargar los fotogramas recortados hasta que coincidan con el tamaño 
señalado en el panel de configuraciones de vídeo. Desactívela si desea que el 
vídeo exportado tenga el tamaño del fotograma recortado.

Deslizador bajo el rectángulo de previsualización Arrastre para previsualizar 
cómo las opciones actuales de procesado especial afectan a otros fotogramas.

Noise Reduction (Reducción de ruido) Seleccione esta opción para 
incrementar la eficiencia de la compresión reduciendo variaciones en el valor 
de los pixeles. En el menú de reducción de ruido seleccione Blur para un 
desenfoque casi imperceptible, Gaussian para un desenfoque más fuerte, o 
Median para un desenfoque que intente conservar el contorno de las esquinas. 
Esta opción no afecta al audio.

Better Resize Selecciónela si ha especificado un recorte o escalado en este 
cuadro de diálogo y desea que Premiere utilice su propio método de alta 
calidad al redimensionar imágenes. Desactívela para dejar que el codec 
seleccionado se ocupe del redimensionamiento; algunos codecs realizan esta 
tarea con mayor rapiedez, pero a expensas de la calidad de la imagen.

Deinterlace (Desentrelazar) Seleccione esta opción para eliminar el campo 
secundario del vídeo entrelazado, interpolando sus líneas en el campo 
dominante. Desactívela para desentrelazar utilizando los métodos incluidos en 
el standard Vídeo para Windows o QuickTime, los cuales no son tan efectivos 
como el método utilizado por Premiere.

Gamma Seleccione esta opción para especificar un valor arrastrando el 
deslizador. La opción Gamma ajusta semitonos preservando las partes de la 
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imagen más iluminadas y más oscuras. Esta opción ayuda a compensar las 
diferencias entre las características del vídeo de las diferentes plataformas. El 
valor de 1.0 no cambia nada: para la reproducción en varias plataformas se 
recomiendan valores de 0.7 ó 0.8.

Reset (Restaurar) Pulse este botón si desea volver a la configuración existente 
antes de abrir este cuadro de diálogo.
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Acerca de la creación de películas

Si se está editando un proyecto para visualizarlo en película, en primer lugar se 
deberá exportar el programa de vídeo de Premiere a un archivo de vídeo 
utilizando definiciones de alta calidad. Después de crear el archivo se deberá 
utilizar un grabador de películas, un dispositivo de hardware que imprime 
fotogramas individuales en fotogramas de películas. Los estudios de post-
producción suelen contar con este servicio. En las películas se pueden mostrar 
más detalles que en la mayoría de los formatos de vídeo, por lo que el proyecto 
puede requerir un tamaño de fotograma mayor que para cinta de vídeo. La 
resolución exacta que se deberá utilizar dependerá de la película en la que se 
vaya a imprimir. Para obtener un óptimo resultado, póngase en contacto con 
los estudios de post-producción antes de comenzar.

Un fotograma de vídeo (NTSC o PAL) se muestra utilizando dos campos 
alternos de líneas de exploración, mientras que un fotograma de película 
aparece todo de una vez. Al crear películas de clips digitalizados originalmente 
desde vídeo entrelazado, asegúrese de definir correctamente las opciones de 
campo para cada clip de la ventana de construcción; con ello se asegura de 
que el movimiento se reproducirá correctamente. Consulte Exportación de 
vídeo.
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Exportación de una lista de 
decisiones de edición

Cuando se utilice Premiere para la edición sin conexión a la red y se desee 
finalizar la edición de la cinta de vídeo o película de origen en un estudio de 
producción, es necesaria una lista de decisiones de edición, denominada EDL 
por las iniciales de su nombre en inglés: Edit Decision List. Una EDL contiene 
los nombres de los clips originales, los puntos IN y OUT de estos clips cuando 
se utilizan en un programa de vídeo, así como el resto de la información 
relativa a la edición, tal como las divisiones, dependiendo del formato EDL. 
Consulte Edición en línea y fuera de línea.

Premiere puede exportar una EDL en formatos compatibles con diferentes 
controladores de edición, incluidos CMX, Grass Valley y Sony BVE. Asimismo, 
se facilita un formato EDL genérico. En la subcarpeta Plug-ins de la carpeta 
Premiere se pueden encontrar los formatos EDL admitidos almacenados como 
plug-ins, por lo que si en un futuro aparecen nuevos formatos EDL en forma de 
plug-in compatibles podrá añadirlos. La mayoría de las EDL se transportan a y 
desde los estudios de producción en discos de 3,5 pulgadas formateados para 
MS-DOS®. En Mac OS, los discos MS-DOS se pueden leer automáticamente, 
formateados y guardados con el software PC Exchange que incluye Mac OS. 
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Exportación de una EDL

Al crear una EDL en Premiere, las decisiones relativas a la edición que se 
tomen en la ventana de construcción se graban en ella en formato de texto. Es 
posible exportar las decisiones sobre la edición a cualquiera de los formatos 
EDL, así como visualizar e imprimir las EDL abriéndolas en Premiere o en 
cualquier procesador de texto. Asimismo, se puede exportar la EDL en un 
formato que un sistema de edición pueda leer directamente. Si los clips de la 
ventana de construcción no tienen un código de tiempo (asignado en el 
momento de la captura o introducido mediante el comando Código de tiempo 
del menú Clip), Premiere asume un tiempo de inicio de 00:00:00:00.

Con el fin de obtener el mejor resultado posible, se deberá colaborar 
estrechamente con los estudios de post-producción. Premiere proporciona 
muchos efectos especiales que no incluyen la mayoría de los sistemas de 
edición tradicionales (consulte Transiciones, efectos especiales y clips 
superpuestos en la EDL). El editor de post-producción puede sugerir alternar 
efectos que se utilizarán antes de montar el archivo de vídeo final.

Nota: Con objeto de evitar confusión al trabajar con EDL NTSC, utilice una 
base de tiempo de 29,97 fps. Si define una base de tiempo de 30 fps, Premiere 
cuenta los fotogramas de vídeo en 1/30 de segundo reales. Debido a que todos 
los vídeos NTSC funcionan a 29,97 fps, el código de tiempo que aparece en la 
vista de origen o en la ventana de clip no coincidirán exactamente con el código 
de tiempo real de la cinta de origen. Esto no sucede con los sistemas de vídeo 
PAL o SECAM, que se cuentan en fotogramas completos a 1/25 de segundo.

Para exportar una EDL genérica:

1 Elija File > Export Timeline > EDL > Generic EDL.

2 Especifique una ubicación y un nombre de archivo, y haga click en Guardar.

Para exportar un proyecto a un formato EDL determinado:

1 Elija File > Export Timeline > EDL, y seleccione un formato EDL.
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2 Especifique las opciones siguientes (que pueden varias según el tipo de EDL 
seleccionada):

• Title for this EDL (título para esta EDL) para visualizar en el encabezado 
de la EDL. 

• Start Timecode (Hora de inicio) para la hora a la que desea que empiece 
la grabación en la cinta. 

• Frame Rate (velocidad de fotogramas) que debe coincidir con el método 
de recuento de tiempo que utiliza la EDL. El valor predeterminado es el 
código de tiempo NTSC Non-Drop-frame; si lo desea, seleccione la 
opción NTSC Drop Frame. Esta opción no altera los fotogramas por 
segundo. 

• Audio Processing (procesado de audio) para las opciones de sonido 
(consulte El audio en la EDL). 

• Level Notes (notas sobre los niveles) para anotar la información sobre la 
edición con más detalle. El valor Ninguno (none) no incluye ninguna nota 
adicional. Sólo audio (Audio Only) incluye notas relativas a los niveles de 
audio, Sólo transparencias (Keys Only) incluye las notas sobre las 
transparencias de superposición y Audio y transparencias (Audio and 
keys) incluye ambas. 

• Create B-Roll (crear cinta B) para realizar una lista independiente de los 
clips de origen utilizados en las transiciones o transparencias cuando 
requieren clips de la misma cinta origen. Esta lista, denominada lista de 
conformación de cinta B, la utilizan los estudios de post-producción para 
crear una cinta origen adicional de los clips utilizados en las transiciones 
o transparencias. 

• B-Roll in Separate File (cinta B en archivo separado) para realizar una 
lista las ediciones de la cinta B en una EDL independiente, si se ha 
seleccionado Crear cinta B. 

3 Haga click en Wipe Codes (códigos de cortinillas) e introduzca los códigos de 
patrones de cortinilla que utilizan los estudios de post-producción.

4 Especifique las opciones siguientes según sus necesidades y, a continuación, 
haga click en OK:

• Load (Cargar) para sustituir los códigos de cortinillas existentes por los 
de un archivo en disco. 

• Defaults (Valores predeterminados) para restaurar la configuración de 
los códigos de cortinillas instalados con Premiere. 
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Consulte Transiciones, efectos especiales y clips superpuestos en una EDL.

5 Haga click en Audio Mapping y asigne las pistas de audio de Premiere a las 
pistas de la EDL utilizando las opciones siguientes:

• Stereo Grouping (Agrupamiento en estéreo) si se piensa utilizar parejas 
de pistas de audio EDL para el sonido estéreo. 

• Track and Destination list (Lista de pista y destino) para asignar las 
pistas de audio de Premiere a cualquiera de las pistas de audio EDL. 
Haga click en Off para mantener una pista de audio de Premiere fuera 
de la EDL. Si ha seleccionado la opción Agrupamiento en estéreo, las 
pistas EDL figurarán en la lista en parejas y no individualmente. 

A. Pares de agrupamiento en stéreo B. Pares de destino
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6 Pulse OK, specifique la ubicación y el nombre de la EDL y haga click en 
Guardar. Si es necesario, Premiere le solicitará la ubicación y el nombre de una 
cinta B. La EDL exportada aparecerá en una ventana de texto.

Nota: Si se exporta la EDL a formatos CMX o Grass Valley, el archivo deberá 
transferirse finalmente a un disco formateado para esos sistemas. Existen 
varias empresas que comercializan la utilidad de software que formatea los 
discos para los sistemas CMX y Grass Valley.
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Transiciones, efectos especiales y 
clips superpuestos en la EDL

Premiere incluye muchos efectos, transiciones y opciones de superposición con 
los que no cuentan muchos sistemas de edición en línea. Las EDL estándar 
reconocen sólo las transiciones de corte, encadenado o algunas de cortina. Los 
módulos EDL disponibles en Premiere tratan de traducir las ediciones del 
proyecto al formato EDL estándar en un único evento. Por ejemplo, la EDL 
estándar interpreta la transición Encadenado de Premiere como una transición 
de encadenado. Aunque muchas de las transiciones de Premiere no pueden 
describirse adecuadamente en la EDL, el nombre de la transición de Premiere 
aparece en una línea de comentarios de la misma.

Las EDL estándar ignoran totalmente los filtros y las configuraciones de 
movimiento de Premiere. Los clips superpuestos se describen como 
transparencias. La única transición permitida bajo una transparencia es un 
corte; cualquier otra transición bajo las transparencias se eliminan de la EDL.

Muchas transiciones de Premiere corresponden con exactitud a los patrones de 
cortina que puede producir un conmutador de vídeo, un dispositivo que maneja 
las transiciones en un espacio de edición convencional. Las transiciones que 
no corresponden a los patrones de cortina se interpretan como encadenadas. 
En la lista siguiente se describen las transiciones de Premiere tal y como son 
interpretadas por las transiciones EDL estándar (como de costumbre, el 
nombre de las transiciones se pone en inglés, que es como aparecen en la 
paleta de transiciones):

Cortina rectangular de EDL Iris Cross, Iris Diamond, Iris Point, Iris Shapes, 
Iris Square, Iris Star, Multi-spin, Spiral Boxes, Swirl, Tumble Away, Zoom, Zoom 
Boxes, and Zoom Trails

Cortina circular de EDL Clock Wipe, Iris Round, and Peel Back

Encadenado de EDL Additive Dissolve, Channel Map, Cross Dissolve, Cross 
Stretch, Cross Zoom, Curtain, Displace, Dither Dissolve, Fold Up, Funnel, 
Image Mask, Luminance Map, Non-Additive Dissolve, Paint Splatter, Random 
Blocks, Random Invert, Slash Slide, Texturize, and Three-D

Cortina cruzada de EDL Center Merge, Center Peel, and Center Split

Cortina diagonal de EDL Page Peel, Page Turn, and Radial Wipe

Cortina horizontal de EDL Checkerboard, Random Wipe, Wedge Wipe, and 
Zig-Zag Blocks

Cortina de corte horizontal de EDL Stretch Over and Venetian Blind
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Inserción de EDL Inset transition

Cortina vertical de EDL Cube Spin, Pinwheel, Push, Roll Away, Slide, Sliding 
Boxes, Stretch, Swing In, Swing Out, and Wipe

Cortina de corte vertical de EDL Band Slide, Band Wipe, Barn Doors, Doors, 
Sliding Bands, Spin, Spin Away, and Split

Los conmutadores de vídeo interpretan los patrones de cortina como códigos. 
Los patrones de cortina de la EDL se pueden asociar con los códigos de los 
patrones de cortina que utilicen los estudios de post-producción haciendo click 
en Códigos de cortinillas del cuadro de diálogo Salida EDL (Consulte 
Exportación de una EDL). Póngase en contacto, asimismo, con los estudios de 
post-producción para determinar qué códigos de cortinillas utilizan los 
conmutadores.

Si desea crear una EDL desde una versión simplificada del proyecto, para 
que la postproducción pueda utilizar la EDL con más facilidad, puede simplificar 
el proyecto, borrando los clips de las pistas de vídeo superpuesto (2 o superior) 
y usando sólo transiciones y efectos soportados por la EDL.
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Componentes de una EDL

Si bien existen ligeras diferencias entre las distintas EDL, la mayoría contienen 
ocho columnas primarias y dos secundarias con la siguiente información:

A. Encabezado B. Número de evento C. Id de la cinta de origen D. Modo de edición E. Tipo de 
transición F. Puntos In y Out de origen G. Puntos In y Out de programa

A. Encabezado: Refleja el nombre de la lista y el tipo de código de tiempo en 
el que se ha creado la grabación.

B. Número de evento: Identifica un único evento, o edición; el número de 
evento puede ser importante al definir el programa en el sistema en línea, 
porque puede utilizarse para localizar una edición determinada. Determinados 
eventos pueden usar más de una línea de la EDL. Las líneas sin numerar que 
acompañan a los eventos se denominan notas o comentarios.

C. ID de la cinta de origen: Identifica el nombre o el número de la cinta de 
vídeo que contiene el clip.

D. Modo de edición: Indica si las ediciones tienen lugar sólo en la pista de 
vídeo (V), sólo en la pista de audio (A) o en una combinación de ambas pistas 
(B).

E. Tipo de transición: Indica el tipo de edición: C es un corte, W es una 
cortina, K es una transparencia (superpuesta) y D un encadenado.

403



F. IN y OUT de origen: Lista los códigos de tiempo del primer y del último 
fotograma del clip como aparecen en la cinta de origen.

G. IN y OUT de programa: Lista los códigos de tiempo con los que se debe 
grabar el clip de origen en la cinta maestra.
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El audio en la EDL

Dado que Premiere trabaja con archivos de ordenador y no con cintas, controla 
el sonido de forma muy diferente a los sistemas de edición tradicionales que, 
basados en cintas, están diseñados para grabar de (y a) una o más pistas de 
audio de la cinta, o en un grabador de cintas de audio independiente. Premiere 
proporciona hasta 99 pistas de audio en la ventana de construcción para ubicar 
los clips de audio; sin embargo, al reproducir o exportar un vídeo, Premiere 
genera una única pista que puede contener más de un canal (como izquierdo y 
derecho). En Premiere, el control de nivel y panoramización que acompaña a 
cada pista de audio controla la mezcla de las pistas de audio. La EDL estándar 
no puede mezclar sonidos, exceptuando la mezcla que se produce cuando un 
origen de audio se encadena con otro.

Con el fin de aprovechar las múltiples pistas de audio de las cintas de vídeo, se 
puede determinar qué pistas de audio de Premiere se asignarán a las pistas 
disponibles del sistema de edición. Al seleccionar una opción EDL de la parte 
inferior del menú File > Export Timeline (Excepto en las EDL genéricas) y 
pulsar el botón Audio Mapping (consulte Exportación de una EDL), aparecerán 
las siguientes opciones

Audio Follows Video (Audio después de vídeo): Con esta opción, el vídeo y el 
audio aparecen juntos en la lista, de acuerdo con las ediciones realizadas en la 
pista de vídeo: donde se corta el vídeo, se corta el clip de audio vinculado; 
donde se encadena el vídeo, se encadena el audio vinculado, etc. Premiere 
procesa las ediciones de vídeo y, a continuación, procesa el audio de forma 
que coincida y lista el resultado de la EDL. Los controles de nivel y 
panoramización del audio se ignoran.

Audio Separately (Audio por separado): Esta opción entrelaza las pistas de 
audio y de vídeo como ediciones independientes dentro de la EDL. Para estas 
opciones, Premiere traduce las ediciones de sonido a un formato que pueda 
interpretar la EDL siguiendo las pautas siguientes:

• Si un clip en la pista Vídeo 1A se superpone totalmente a un clip de la 
pista Vídeo 1B (es decir, tiene el mismo punto IN, o uno anterior, y el 
mismo punto OUT o uno posterior), sólo se tiene en cuenta el clip de la 
pista Vídeo 1A.

Nota: Un punto de encadenamiento de 0 en cualquier clip divide eficazmente el 
clip en ese punto, de forma que la EDL tratará este clip como si fueran dos.

  Si un clip de la pista Vídeo 1A se superpone a un clip de la pista Vídeo 1B, 
en el área superpuesta se creará una transición, de forma que el clip inicial se 
encadena al clip final. 
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  os clips de pistas de superposición se tendrán en cuenta solamente cuando 
ninguna de las pistas Vídeo 1A y Vídeo 1B contengan clips; en caso contrario, 
se ignorarán. 
Una vez creada esta "pista" única, la EDL interpreta los puntos de 
encadenamiento de la forma siguiente:

• Un punto de encadenamiento de 0 en cualquier área que no sea de 
transición crea un encadenamiento entre 0 en ese punto y 100 en el 
punto más cercano especificado en el clip, independientemente del valor 
real especificado para el punto que no sea cero. Se ignorarán el resto de 
los puntos de encadenamiento que no sean cero. 

Audio at End (Audio al final): Esta opción lista todas las ediciones de sonido 
juntas al final de la EDL, utilizando las mismas reglas de traducción de audio 
que la opción Audio por separado. 

406



Apéndices
Como apéndices de esta ayuda Premiere incorpora la guía de teclas rápidas 
para Premiere y Mac Os. Yo (Quinurio) he añadido otros dos apéndices, con 
información procedente de la ayuda de Premiere 5.1 pero que creo que es 
enteramente utilizable en Premiere 6 y que ayuda a entender varios conceptos 
relacionados con la edición de vídeo. Esos apéndices son, por lo tanto, para los 
que, siendo novatos, desean dejar de serlo. Asímismo he añadido un glosario 
con algunos términos utilizados en la ayuda, y que tienen un significado 
preciso, así como un último apéndice, que sirve para encontrar en qué lugar de 
la ayuda se informa sobre cada una de las opciones del menú principal de 
Premiere. 

Teclas rápidas para Mac OS
Teclas rápidas para Windows
Medición del tiempo
Compresión de vídeo y de audio
Opciones del Menú principal
Glosario
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Teclas rápidas para Macintosh 

Significado de los iconos representativos de herramientas que se usan en las 
próximas páginas de ayuda

Icono Nombre de la tecla
Comando
Shift (Mayúsculas)
Opción
Flecha derecha
Flecha izquierda
Flecha arriba
Flecha abajo

Captura de vídeo
Captura de vídeo de cámara de truca
Apertura y edición de clips
Cambio de opciones de visualización
Movimiento del punto de edición
Previsualización
Establecimiento de los puntos In y Out
Edición en la ventana de construcción o en la de monitor
Edición en la ventana de monitor
Edición en la ventana de construcción
Trabajo con Marcas
Herramientas de la ventana de construcción 

Modo de recorte
Ventana de títulos
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Captura de vídeo

Utilice las siguientes teclas rápidas en la ventana de captura de vídeo y de 
cámara de truca.

RESULTADO ACCIÓN

Reproducir Barra espaciadora o L

Reproducir despacio + L

Reproducir despacio en sentido inverso + J

Establecer el punto In del clip I

Establecer el punto Out del clip O

Grabar* G

Grabar del punto In al punto Out + Botón de grabación

Ir al punto In de captura Q

Ir al punto Out de captura W

Detener* S

Pausa Barra espaciadora o K

Avance rápido F o L

Avanzar un fotograma o 2

Rebobinar R o J

Retroceder un fotograma o 1

Moverse entre cuadros editables Tab

Eliminar el foco de cualquier campo Esc

Anotar Return

Expulsar + E

*Disponible cuando se captura sin control de dispositivo. El resto de las opciones requiere 
control de dispositivo
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Captura de vídeo de cámara de truca

Utilice las siguientes teclas rápidas en las ventanas de captura de vídeo y de 
captura de vídeo de cámara de truca

RESULTADO ACCIÓN

Grabar Barra espaciadora o G

Capturar de uno a diez fotogramas Escriba un número del 1 al 9

Capturar 10 fotogramas 0 (cero)

Borrar el fotograma más reciente Suprimir

Hecho Esc
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Apertura y edición de clips

Utilice las siguientes teclas rápidas en las ventanas de Proyecto, contenedor, o 
construcción.

RESULTADO ACCIÓN

Abrir un clip en modo de recorte (Disponible sólo en la 
ventana de construcción)

+ doble-click sobre el 
clip

Abrir el clip maestro (Disponible sólo en la ventana de 
construcción)

+ + doble-click 
sobre el clip

Editar en su aplicación original Seleccione el clip y + 
E
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Cambio de opciones de 
visualización

Use las siguientes teclas rápidas sólo en la ventana de construcción.

RESULTADO ACCIÓN

Definir área de visualización Arrastre la herramienta de Zoom

Mostrar todo el programa \

Cambiar el tamaño de los iconos + [ o ]

Cambiar el formato de las pistas + + [ o ]
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Movimiento del punto de edición

Use estas teclas rápidas en las ventanas de monitor, construcción, captura de 
vídeo, captura de cámara de truca o de clip.

RESULTADO ACCIÓN

Avanzar un fotograma 2 o 

Retroceder un fotograma 1 o 

Avanzar cinco fotogramas 4 o + 

Retroceder cinco fotogramas 3 o + 

Ir al primer fotograma A o o Inicio

Ir al último fotograma S o o Fin

Ir al próximo punto de edición (no aplicable en ventanas 
de clip) + + o Av Pág

Ir al punto de edición anterior (no aplicable en ventanas 
de clip) + + o Re Pág
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Previsualización

Use estas teclas rápidas en las ventanas de Monitor, construcción o clip.

RESULTADO ACCIÓN

Previsualizar Return

Reproducir L o espaciador o ~ (tilde)

Reproducir desde el punto de edición al 
punto Out* + ~ (tilde)

Reproducir del punto In al Out + + ~ (tilde)

Reproducción rápida ~ (tilde) o L varias veces (cada vez 
irá más rápido)

Reproducir desde el pre-roll hasta el post-
roll (cantidad definida en General 
preferences)

+ ~ (tilde) o + hacer click en el 
botón Play

Detenerse Barra espaciadora o K

Bucle desde el punto In al Out + + ~ (tilde)

Reproducir en sentido inverso J o + + ~ (tilde)

Barrido sin renderizar
Arrastrar el punto de edición por la 
regla de tiempo de la ventana de 
construcción

Barrido con transiciones, efectos y 
superposiciones visible

+ arrastre en la regla de tiempo de 
la ventana de construcción

Barrido sólo con el canal alfa visible + + arrastre en la regla de 
tiempo de la ventana de construcción

*No disponible si se usa el método de edición IME (Input Method Editor) para escribir 
caracteres de doble byte.
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Establecimiento de los puntos In y 
Out

Use las siguientes teclas rápidas en las ventanas de Monitor, construcción o 
clip.

RESULTADO ACCIÓN

Establecer el punto In en el lugar donde se encuentra el 
punto de edición

I, E, o + + 

Establecer el punto Out en el lugar donde se encuentra el 
punto de edición

O, R, o + + 

Borrar el punto In D

Borrar el punto Out F

Borrar los puntos In y Out G

Ir al punto In del clip + 

Ir al punto Out del clip + 

Ir al punto In en la ventana de construcción Q

Ir al punto Out en la ventana de construcción W
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Edición en la ventana de 
construcción o en la de monitor

RESULTADO ACCIÓN

Seleccionar la pista de vídeo por encima de la actual + + (plus)

Seleccionar la pista de vídeo por debajo de la actual + - (minus)

Seleccionar la pista de audio por encima de la actual + + + 
(plus)

Seleccionar la pista de audio por debajo de la actual + + - 
(minus)

Ir al próximo punto de edición + + o 
Av Pág

Ir al punto de edición previo + + o 
Re Pág

Rizar edición de un fotograma a la izquierda del punto de 
edición + 

Rizar edición de un fotograma a la derecha del punto de edición + 

Rizar edición de cinco fotogramas a la izquierda del punto de 
edición + + 

Rizar edición de cinco fotogramas a la derecha del punto de 
edición + + 

Enrollar edición de un fotograma a la izquierda del punto de 
edición* + 

Enrollar edición de un fotograma a la derecha del punto de 
edición* + 

Enrollar edición de cinco fotogramas a la izquierda del punto de 
edición* + + 

Enrollar edición de cinco fotogramas a la derecha del punto de 
edición* + + 

Mover el punto de edición de la ventana de construcción al 
fotograma visible en la vista de origen o en la ventana de clip T

*Uso de la edición de enrollado requiere que haya material extra más allá de los puntos In y 
Out.
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Edición en la ventana de monitor

RESULTADO ACCIÓN

Cambiar entre las vistas de origen y de programa Esc

Insertar el clip de origen en el punto de edición , (coma)

Superponer el clip de origen en el punto de edición . (punto)

Elevar el número de fotogramas marcados por los 
puntos In y Out fuera del proyecto /

Eliminar clip de la vista fuente Vista del clip; después 
presionar + Supr

Cambiar entre las ventanas de monitor y de 
construcción Control + Tab
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Edición en la ventana de 
construcción

RESULTADO ACCIÓN

Cambiar entre código de tiempo y formato + click sobre la regla de 
tiempo

Hacer que el área de trabajo cubra toda la parte 
visible de la ventana

Doble-click sobre la barra del 
área de trabajo

Hacer que el área de trabajo cubra toda la 
edición (siempre que no haya huecos entre los 
clips)

+ click barra del área de 
trabajo

Fijar el inicio del área de trabajo + + click barra del área de 
trabajo

Fijar el inicio del área de trabajo en el punto de 
edición actual + [

Fijar el final del área de trabajo + + click barra del área de 
trabajo

Fijar el final del área de trabajo en el punto de 
edición actual + ]

Editar la configuración de la transición Doble-click sobre la transición

Editar la configuración personalizada de la 
transición (si es posible en la transición 
seleccionada)

+ Doble-click sobre la 
transición

Empujar el clip seleccionado un fotograma hacia 
la izquierda + , (coma)

Empujar el clip seleccionado un fotograma hacia 
la derecha + . (punto)

Empujar el clip seleccionado cinco fotogramas 
hacia la izquierda + + , (coma)

Empujar el clip seleccionado cinco fotogramas 
hacia la derecha + + . (punto)

Desplazar el clip seleccionado un fotograma 
hacia la izquierda* + + 

Desplazar el clip seleccionado un fotograma 
hacia la derecha* + + 

Desplazar el clip seleccionado cinco fotogramas 
hacia la izquierda* + + + 
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Desplazar el clip seleccionado cinco fotogramas 
hacia la derecha* + + + 

Deslizar el clip seleccionado un fotograma hacia 
la izquierda* + 

Deslizar el clip seleccionado un fotograma hacia 
la derecha* + 

Deslizar el clip seleccionado cinco fotogramas 
hacia la izquierda* + + 

Deslizar el clip seleccionado cinco fotogramas 
hacia la derecha* + + 

Borrar el clip seleccionado Delete

Borrar el clip seleccionado utilizando la 
eliminación de espacios vacíos + Delete

Borrar el fichero de previsualización del clip 
seleccionado + Delete

Borrar todos los ficheros de previsualización de 
la ventana de construcción

+ + y click en el 
indicador de previsualización

*El uso del desplazamiento y del deslizamiento requiere que, más allá de los puntos In y out 
exista material adicional, así como que los clips sean adyacentes en el tiempo.
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Trabajo con Marcas

Use las siguientes combinaciones de teclado en las ventanas de monitor, 
construcción o clip windows.

RESULTADO ACCIÓN

Establecer marca numerada en el punto de 
edición* + + (0 - 9)

Definir marca sin numerar en el punto de 
edición* + + =

Ir a la primera marca del clip* + + 

Ir a la última marca del clip* + + 

Ir a la marca previa del clip* + 

Ir a la próxima marca del clip* + 

Ir a una marca numerada del clip* + (0 - 9)

Borrar una marca del clip* Ir a la marca; después pulsar + 
+ C

Borrar todas las marcas del clip* + + + C

Establecer una marca numerada en la 
ventana de construcción + + (0 - 9)

Establecer una marca no numerada en el 
punto de edición

* (asterisco en el teclado 
numérico) o + + =

Ir a la primera marca de la ventana de 
construcción + + 

Ir a la última marca de la ventana de 
construcción + + 

Ir a la marca previa de la ventana de 
construcción + Q

Ir a la próxima marca de la ventana de 
construcción + W

Ir a una marca numerada de la ventana de 
construcción + (0 - 9)

Borrar una marca de la ventana de 
construcción

Ir a la marca; después pulsar + 
+ G

Borrar todas las marcas de la ventana de 
construcción + + + G
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*Al trabajar con marcas de clips, seleccione primero el clip y luego use las teclas rápidas.
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Herramientas de la ventana de 
construcción

Nota: Como en la ayuda no he traducido el nombre de las herramientas (para 
que los tool-tips ayuden), tampoco lo haré aquí, por lo que esta página de 
ayuda me va a ser muy fácil de traducir.

Mientras se usa cierta herramienta, pulse las siguientes teclas para 
temporalmente activar la herramienta que se indica.

Herramienta que se desea 
activar

Cuando la 
herramienta en 
uso es

PULSE

Selección Cualquier otra 
herramienta

Link/Unlink Herramienta de 
selección

+ (con un clip 
seleccionado)

Block move Block Select + 

Block copy Block Select

Multitrack Select Track Select

Multirazor Razor

Slide Slip

Fade Adjustment tool Selección
+ + cuando se 

está sobre la línea de 
control

Ajuste preciso del balance o del 
volumen Selección + arrastre de la línea 

de control

Añadir la transición por defecto 
en el punto del cursor Sólo en el 
modo de edición A/B)

Selección + + + click en el 
área de la transición
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Modo de recorte

RESULTADO ACCIÓN

Cambiar entre la vista de monitor y la vista de recorte + T

Ir al próximo punto de edición + + o Av Pág

Ir al punto de edición anterior + + o Re Pág

Recortar un fotograma a la izquierda del punto de edición

Recortar un fotograma a la derecha del punto de edición

Recortar cinco fotogramas a la izquierda del punto de 
edición + 

Recortar cinco fotogramas a la derecha del punto de 
edición + 
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Ventana de títulos

RESULTADO ACCIÓN

Incrementar el tamaño del texto un punto Seleccione texto + + + 

Reducir el tamaño del texto un punto Seleccione texto + + + 

Incrementar el tamaño del texto cinco puntos Seleccione texto + + + 
+ 

Reducir el tamaño del texto cinco puntos Seleccione texto + + + 
+ 

Incrementar una unidad el espaciado + 

Reducir una unidad el espaciado + 

Incrementar una unidad el interlineado + 

Reducir una unidad el interlineado + 

Incrementar cinco unidades el interlineado + + 

Reducir cinco unidades el interlineado + + 

Mover el objeto seleccionado un pixel en la 
dirección indicada , , , o 

Mover el objeto seleccionado cinco pixeles en la 
dirección indicada + , , , o 

Poner el fondo negro B

Poner el fondo blanco W

Restarurar colores y sombras a sus valores por 
defecto Z

Activar o desactivar el modo draft* ~ (tilde)

Seleccionar objeto inferior (de la capa subyacente) , (coma) o <

Seleccionar el objeto de la capa superior . (punto) o >

*No disponible si se usa el método de edición IME (Input Method Editor) para escribir 
caracteres de doble byte.
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Teclas rápidas para Windows 

Nota: En los siguientes temas de ayuda se utilizan las siguientes imágenes 
para representar teclas:

Icono Nombre de la tecla
^ Control

Shift (Mayúsculas)
Flecha derecha
Flecha izquierda
Flecha arriba
Flecha abajo

Captura de vídeo
Captura de vídeo de cámara de truca
Apertura y edición de clips
Cambio de opciones de visualización
Movimiento del punto de edición
Previsualización
Establecimiento de los puntos In y Out
Edición en las ventanas de monitor y de construcción
Edición en la ventana de monitor
Edición en la ventana de construcción
Trabajo con marcas
Herramientas de la ventana de construcción
Modo de recorte
Ventana de títulos
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Captura de vídeo

Utilice las siguientes teclas rápidas en la ventana de captura de vídeo y de 
cámara de truca.

RESULTADO ACCIÓN

Reproducir Barra espaciadora o L

Reproducir despacio + L

Reproducir despacio en sentido inverso + J

Establecer el punto In del clip I

Establecer el punto Out del clip O

Grabar* G

Grabar del punto In al punto Out Alt + Botón de grabación

Ir al punto In de captura Q

Ir al punto Out de captura W

Detener* S

Pausa Barra espaciadora o K

Avance rápido F o L

Avanzar un fotograma o 2

Rebobinar R o J

Retroceder un fotograma o 1

Moverse entre cuadros editables Tab

Eliminar el foco de cualquier campo Esc

Anotar Return

Expulsar + E

*Disponible cuando se captura sin control de dispositivo. El resto de las opciones requiere 
control de dispositivo
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Captura de vídeo de cámara de truca

. 

Utilice las siguientes teclas rápidas en las ventanas de captura de vídeo y de 
captura de vídeo de cámara de truca

RESULTADO ACCIÓN

Grabar Barra espaciadora o G

Capturar de uno a diez fotogramas Escriba un número del 1 al 9

Capturar 10 fotogramas 0 (cero)

Borrar el fotograma más reciente Suprimir

Hecho Esc
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Apertura y edición de clips

Utilice las siguientes teclas rápidas en las ventanas de Proyecto, contenedor, o 
construcción.

RESULTADO ACCIÓN

Abrir un clip en modo de recorte (Disponible sólo en la 
ventana de construcción)

+ doble-click sobre el 
clip

Abrir el clip maestro (Disponible sólo en la ventana de 
construcción)

^ + + doble-click 
sobre el clip

Editar en su aplicación original Seleccione el clip y ^ + 
E
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Cambio de opciones de 
visualización

Use las siguientes teclas rápidas sólo en la ventana de construcción.

RESULTADO ACCIÓN

Definir área de visualización Arrastre la herramienta de Zoom

Mostrar todo el programa \

Cambiar el tamaño de los iconos ^ + [ o ]

Cambiar el formato de las pistas ^ + + [ o ]
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Movimiento del punto de edición

Use estas teclas rápidas en las ventanas de monitor, construcción, captura de 
vídeo, captura de cámara de truca o de clip.

RESULTADO ACCIÓN

Avanzar un fotograma 2 o 

Retroceder un fotograma 1 o 

Avanzar cinco fotogramas 4 o + 

Retroceder cinco fotogramas 3 o + 

Ir al primer fotograma A o o Inicio

Ir al último fotograma S o o Fin

Ir al próximo punto de edición (no aplicable en ventanas 
de clip) ^ + + o Av Pág

Ir al punto de edición anterior (no aplicable en ventanas de 
clip) ^ + + o Re Pág
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Previsualización

Use estas teclas rápidas en las ventanas de Monitor, construcción o clip.

RESULTADO ACCIÓN

Previsualizar Return

Reproducir L o espaciador o ~ (tilde)

Reproducir desde el punto de edición al 
punto Out* Alt + ~ (tilde)

Reproducir del punto In al Out Alt + + ~ (tilde)

Reproducción rápida ~ (tilde) o L varias veces (cada vez 
irá más rápido)

Reproducir desde el pre-roll hasta el post-
roll (cantidad definida en General 
preferences)

^ + ~ (tilde) o Alt + hacer click en el 
botón Play

Detenerse Barra espaciadora o K

Bucle desde el punto In al Out ^ + + ~ (tilde)

Reproducir en sentido inverso J o ^ + Alt + ~ (tilde)

Barrido sin renderizar
Arrastrar el punto de edición por la 
regla de tiempo de la ventana de 
construcción

Barrido con transiciones, efectos y 
superposiciones visible

Alt + arrastre en la regla de tiempo de 
la ventana de construcción

Barrido sólo con el canal alfa visible Alt + + arrastre en la regla de 
tiempo de la ventana de construcción

*No disponible si se usa el método de edición IME (Input Method Editor) para escribir 
caracteres de doble byte.
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Establecimiento de los puntos In y 
Out

Use las siguientes teclas rápidas en las ventanas de Monitor, construcción o 
clip.

RESULTADO ACCIÓN

Establecer el punto In en el lugar donde se encuentra el 
punto de edición

I, E, o ^ + Alt + 

Establecer el punto Out en el lugar donde se encuentra el 
punto de edición

O, R, o ^ + Alt + 

Borrar el punto In D

Borrar el punto Out F

Borrar los puntos In y Out G

Ir al punto In del clip ^ + 

Ir al punto Out del clip ^ + 

Ir al punto In en la ventana de construcción Q

Ir al punto Out en la ventana de construcción W
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Edición en la ventana de 
construcción o en la de monitor

RESULTADO ACCIÓN

Seleccionar la pista de vídeo por encima de la actual ^ + + (plus)

Seleccionar la pista de vídeo por debajo de la actual ^ + - (minus)

Seleccionar la pista de audio por encima de la actual ^ + + + 
(plus)

Seleccionar la pista de audio por debajo de la actual ^ + + - 
(minus)

Ir al próximo punto de edición ^ + + o Av 
Pág

Ir al punto de edición previo ^ + + o 
Re Pág

Rizar edición de un fotograma a la izquierda del punto de edición Alt + 

Rizar edición de un fotograma a la derecha del punto de edición Alt + 

Rizar edición de cinco fotogramas a la izquierda del punto de 
edición Alt + + 

Rizar edición de cinco fotogramas a la derecha del punto de 
edición Alt + + 

Enrollar edición de un fotograma a la izquierda del punto de 
edición* Alt + 

Enrollar edición de un fotograma a la derecha del punto de 
edición* Alt + 

Enrollar edición de cinco fotogramas a la izquierda del punto de 
edición* Alt + + 

Enrollar edición de cinco fotogramas a la derecha del punto de 
edición* Alt + + 

Mover el punto de edición de la ventana de construcción al 
fotograma visible en la vista de origen o en la ventana de clip T

*Uso de la edición de enrollado requiere que haya material extra más allá de los puntos In y 
Out.
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Edición en la ventana de monitor

RESULTADO ACCIÓN

Cambiar entre las vistas de origen y de programa Esc

Insertar el clip de origen en el punto de edición , (coma)

Superponer el clip de origen en el punto de edición . (punto)

Elevar el número de fotogramas marcados por los 
puntos In y Out fuera del proyecto /

Eliminar clip de la vista fuente Vista del clip; después 
presionar ^ + Supr

Cambiar entre las ventanas de monitor y de 
construcción Control + Tab
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Edición en la ventana de 
construcción

RESULTADO ACCIÓN

Cambiar entre código de tiempo y formato ^ + click sobre la regla de 
tiempo

Hacer que el área de trabajo cubra toda la parte 
visible de la ventana

Doble-click sobre la barra del 
área de trabajo

Hacer que el área de trabajo cubra toda la 
edición (siempre que no haya huecos entre los 
clips)

Alt + click barra del área de 
trabajo

Fijar el inicio del área de trabajo ^ + + click barra del área de 
trabajo

Fijar el inicio del área de trabajo en el punto de 
edición actual Alt + [

Fijar el final del área de trabajo ^ + Alt + click barra del área de 
trabajo

Fijar el final del área de trabajo en el punto de 
edición actual Alt + ]

Editar la configuración de la transición Doble-click sobre la transición

Editar la configuración personalizada de la 
transición (si es posible en la transición 
seleccionada)

Alt + Doble-click sobre la 
transición

Empujar el clip seleccionado un fotograma hacia 
la izquierda Alt + , (coma)

Empujar el clip seleccionado un fotograma hacia 
la derecha Alt + . (punto)

Empujar el clip seleccionado cinco fotogramas 
hacia la izquierda Alt + + , (coma)

Empujar el clip seleccionado cinco fotogramas 
hacia la derecha Alt + + . (punto)

Desplazar el clip seleccionado un fotograma 
hacia la izquierda* ^ + Alt + 

Desplazar el clip seleccionado un fotograma 
hacia la derecha* ^ + Alt + 

Desplazar el clip seleccionado cinco fotogramas 
hacia la izquierda* ^ + Alt + + 
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Desplazar el clip seleccionado cinco fotogramas 
hacia la derecha* ^ + Alt + + 

Deslizar el clip seleccionado un fotograma hacia 
la izquierda* Alt + 

Deslizar el clip seleccionado un fotograma hacia 
la derecha* Alt + 

Deslizar el clip seleccionado cinco fotogramas 
hacia la izquierda* Alt + + 

Deslizar el clip seleccionado cinco fotogramas 
hacia la derecha* Alt + + 

Borrar el clip seleccionado Delete

Borrar el clip seleccionado utilizando la 
eliminación de espacios vacíos Alt + Delete

Borrar el fichero de previsualización del clip 
seleccionado ^ + Delete

Borrar todos los ficheros de previsualización de 
la ventana de construcción

^ + + Alt y click en el 
indicador de previsualización

*El uso del desplazamiento y del deslizamiento requiere que, más allá de los puntos In y out 
exista material adicional, así como que los clips sean adyacentes en el tiempo.
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Trabajo con Marcas

Use las siguientes combinaciones de teclado en las ventanas de monitor, 
construcción o clip windows.

RESULTADO ACCIÓN

Establecer marca numerada en el punto de 
edición* ^ + Alt + (0 - 9)

Definir marca sin numerar en el punto de 
edición* ^ + Alt + =

Ir a la primera marca del clip* ^ + + 

Ir a la última marca del clip* ^ + + 

Ir a la marca previa del clip* ^ + 

Ir a la próxima marca del clip* ^ + 

Ir a una marca numerada del clip* ^ + (0 - 9)

Borrar una marca del clip* Ir a la marca; después pulsar ^ + 
+ C

Borrar todas las marcas del clip* ^ + Alt + + C

Establecer una marca numerada en la 
ventana de construcción Alt + + (0 - 9)

Establecer una marca no numerada en el 
punto de edición

* (asterisco en el teclado 
numérico) o Alt + + =

Ir a la primera marca de la ventana de 
construcción ^ + + 

Ir a la última marca de la ventana de 
construcción ^ + + 

Ir a la marca previa de la ventana de 
construcción + Q

Ir a la próxima marca de la ventana de 
construcción + W

Ir a una marca numerada de la ventana de 
construcción + (0 - 9)

Borrar una marca de la ventana de 
construcción

Ir a la marca; después pulsar ^ + 
+ G

Borrar todas las marcas de la ventana de 
construcción ^ + Alt + + G
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*Al trabajar con marcas de clips, seleccione primero el clip y luego use las teclas rápidas.
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Herramientas de la ventana de 
construcción

Nota: Como en la ayuda no he traducido el nombre de las herramientas (para 
que los tool-tips ayuden), tampoco lo haré aquí, por lo que esta página de 
ayuda me va a ser muy fácil de traducir.

Mientras se usa cierta herramienta, pulse las siguientes teclas para 
temporalmente activar la herramienta que se indica.

Herramienta que se desea 
activar

Cuando la 
herramienta en 
uso es

PULSE

Selección Cualquier otra 
herramienta ^

Link/Unlink Herramienta de 
selección

+ Alt (con un clip 
seleccionado)

Block move Block Select ^ + Alt

Block copy Block Select Alt

Multitrack Select Track Select Alt

Multirazor Razor Alt

Slide Slip Alt

Fade Adjustment tool Selección
^ + Alt + cuando se 
está sobre la línea de 
control

Ajuste preciso del balance o del 
volumen Selección + arrastre de la línea 

de control

Añadir la transición por defecto 
en el punto del cursor Sólo en el 
modo de edición A/B)

Selección ^ + Alt + + click en el 
área de la transición
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Modo de recorte

RESULTADO ACCIÓN

Cambiar entre la vista de monitor y la vista de recorte ^ + T

Ir al próximo punto de edición ^ + + o Av Pág

Ir al punto de edición anterior ^ + + o Re Pág

Recortar un fotograma a la izquierda del punto de edición

Recortar un fotograma a la derecha del punto de edición

Recortar cinco fotogramas a la izquierda del punto de 
edición + 

Recortar cinco fotogramas a la derecha del punto de 
edición + 
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Ventana de títulos

RESULTADO ACCIÓN

Incrementar el tamaño del texto un punto Seleccione texto + ^ + Alt + 

Reducir el tamaño del texto un punto Seleccione texto + ^ + Alt + 

Incrementar el tamaño del texto cinco puntos Seleccione texto + ^ + Alt + 
+ 

Reducir el tamaño del texto cinco puntos Seleccione texto + ^ + Alt + 
+ 

Incrementar una unidad el espaciado Alt + 

Reducir una unidad el espaciado Alt + 

Incrementar una unidad el interlineado Alt + 

Reducir una unidad el interlineado Alt + 

Incrementar cinco unidades el interlineado Alt + + 

Reducir cinco unidades el interlineado Alt + + 

Mover el objeto seleccionado un pixel en la 
dirección indicada , , , o 

Mover el objeto seleccionado cinco pixeles en la 
dirección indicada + , , , o 

Poner el fondo negro B

Poner el fondo blanco W

Restarurar colores y sombras a sus valores por 
defecto Z

Activar o desactivar el modo draft* ~ (tilde)

Seleccionar objeto inferior (de la capa subyacente) , (coma) o <

Seleccionar el objeto de la capa superior . (punto) o >

*No disponible si se usa el método de edición IME (Input Method Editor) para escribir 
caracteres de doble byte.
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Medición del tiempo

Los programas de vídeo se pueden definir como una serie de cambios visuales 
y auditivos en el tiempo. A menudo, la edición requiere más precisión de la que 
se puede medir por horas, minutos y segundos, por lo que para los intervalos 
de tiempo menores se utilizan como medida los fotogramas.

Un proyecto puede contener clips de muchos orígenes que pueden contar el 
tiempo de formas distintas. Las opciones de tiempo de Premiere permiten 
definir la forma de medir el tiempo, de modo que todos los clips se puedan 
editar juntos y la reproducción sea precisa y coherente.
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Base de tiempo

La base de tiempo del proyecto especifica el número de divisiones temporales 
por segundo a partir de las cuales calcula Premiere la precisión de la edición. 
La base de tiempo no equivale a fotogramas por segundo, aunque pueden 
utilizar el mismo valor. La base de tiempo se utiliza para calcular el tiempo, 
mientras que con fotogramas por segundo se indica la velocidad a la que se 
reproducen los fotogramas del programa de vídeo final.

Por lo general, se recomienda elegir 24 fps para la edición de película 
cinematográfica, 25 para la edición de vídeo PAL y SECAM, 29,97 para la 
edición de vídeo NTSC y 30 para otros tipos de vídeo. Premiere cuenta 
también con la opción Fotogramas/Muestras, para contar fotogramas o 
muestras de audio sin referencia temporal. Para más información sobre la 
configuración de la base de tiempo, consulte Configuraciones generales.

La base de tiempo influye sobre la forma en que se representan los clips en las 
ventanas de proyecto y de construcción. Por ejemplo, las marcas de la regla de 
la ventana de construcción representan la base de tiempo. En la vista de 
origen, los clips utilizan la base de tiempo a la que se han guardado; Premiere 
repite o ignora fotogramas para ajustar el clip de origen a la base de tiempo del 
proyecto. Por este motivo, los clips de origen funcionan mejor si su base de 
tiempo coincide con la del proyecto en el momento de la importación. Para las 
situaciones en que los fotogramas por segundo difieren de la base de tiempo, 
consulte Fotogramas por segundo en relación a la base de tiempo.

Dado que todos los valores del proyecto se calculan mediante la base de 
tiempo, es importante definirla correctamente antes de comenzar la edición. No 
es recomendable cambiar la base de tiempo a mitad de un proyecto, ya que se 
cambia la precisión de los cálculos temporales, lo que puede hacer que se 
desplacen los puntos de edición o los marcadores o que se modifique 
ligeramente la duración de los clips.
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Fotogramas por segundo en relación a la base de 
tiempo

El término fotogramas por segundo (FPS) puede tener significados distintos, 
según se hable de clips de origen o de vídeo final:

• Para los clips de origen, fotogramas por segundo es el número de 
muestras visuales creadas por segundo durante la toma (mediante una 
cámara) o el render (mediante software de animación) del clip. 

• Para el vídeo final, fotogramas por segundo es el número de fotogramas 
que se muestran por segundo en un clip exportado o en la ventana de 
construcción. 

Para medios tradicionales, defina los FPS para que coincidan con la base de 
tiempo del medio final de reproducción; especifique 24 fps para la edición de 
película cinematográfica, 25 fps para vídeo PAL y SECAM y 29,97 fps para 
vídeo NTSC. La reproducción del movimiento en pantalla no puede tener más 
precisión que la de los FPS de los clips de origen. Aumentar los fotogramas por 
segundo del vídeo final no sirve para hacer que el movimiento sea más fluido.

Cuando coinciden los fotogramas por segundo de los clips de origen, la base 
de tiempo y los fotogramas por segundo especificados para la reproducción o 
exportación, no suele ser necesario preocuparse por los fotogramas por 
segundo. Cuando no coinciden, la relación entre estos tres factores es 
importante por los siguientes motivos:

• Cuando los fotogramas por segundo de un clip de origen no coinciden 
con la base de tiempo, Premiere compara los fotogramas por segundo 
del clip con la base de tiempo para decidir cómo se pueden representar 
los fotogramas originales en la ventana de construcción. Por ejemplo, si 
un clip rodado a 24 fps se utiliza en un proyecto en el que la base de 
tiempo está fijada en 30, Premiere debe repetir uno de cada cuatro 
fotogramas del clip para obtener la cantidad de fotogramas necesaria 
para coincidir con la línea de construcción. Si se utiliza un clip rodado a 
30 fps en un proyecto cuya base de tiempo está fijada en 24, el proceso 
es el inverso: se omite uno de cada cuatro fotogramas. 

• Cuando la base de tiempo no coincide con los fotogramas por segundo 
de las configuraciones de vídeo (reproducción en la ventana de 
construcción) o con los fotogramas por segundo de las configuraciones 
de exportación, Premiere utiliza los fotogramas por segundo de las 
configuraciones de vídeo o de exportación para determinar qué 
fotogramas se pueden incluir en las ventanas de construcción para 
reproducir y exportar, respectivamente. Por ejemplo, si la base de 
tiempo de los clips de origen es de 30 fps y el valor de fotogramas por 
segundo (FPS) especificado en las configuraciones de vídeo es de 15 , 
al efectuar la previsualización en la ventana de construcción se omite 
uno de cada dos fotogramas. 
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Premiere permite modificar la relación entre los fotogramas por segundo del 
clip de origen, la base de tiempo y los fotogramas por segundo de reproducción 
y exportación mediante las siguientes opciones:

• El comando Clip > Vídeo options > Frame Hold modifica los fotogramas 
por segundo del clip de origen sin cambiar su duración. Los fotogramas 
por segundo especificados se crean a partir de los fotogramas que 
quedan después de que Premiere compare los fotogramas originales 
con la ventana de construcción. Por ejemplo, si en la ventana de 
construcción se muestran treinta fotogramas del clip por segundo y se 
utiliza Congelar fotograma para aplicar una velocidad de 15 fotogramas 
por segundo, Premiere omite uno de cada dos fotogramas del clip en la 
reproducción y en la exportación. 

• El comando Clip > Speed aumenta o reduce los fotogramas por segundo 
del clip en la ventana de construcción, pero a diferencia de Interpretar 
material, el cambio se registra como intervalo temporal o como 
porcentaje de la duración original. Si la velocidad resultante es mayor 
que la especificada en las configuraciones de vídeo o de exportación, 
Premiere omite los fotogramas que quedan entre los fotogramas de la 
ventana de construcción, según determinen la base de tiempo y la 
velocidad de reproducción o exportación. Si el número de fotogramas 
por segundo resultante es menor, Premiere repite fotogramas para 
ajustarse a los fotogramas por segundo de reproducción o exportación. 

• Cuando el movimiento de un clip en la ventana de construcción no es 
fluido, es posible que el aumento de los fotogramas por segundo en las 
configuraciones de vídeo o de exportación no mejore automáticamente 
el movimiento del clip de origen, porque todos los fotogramas 
disponibles en la ventana de construcción están ya incluidos (a no ser 
que se haya reducido la velocidad del clip por medio de Congelar 
fotograma). No obstante, en ocasiones se puede simular un movimiento 
más fluido aplicando al clip el entrelazado de fotogramas. Cuando los 
FPS de un clip son menos que los base de tiempo y se aplica el 
entrelazado de fotogramas, Premiere crea los fotogramas intermedios 
suficientes para agilizar el movimiento. Los fotogramas nuevos creados 
por Premiere son una interpolación de los fotogramas del vídeo 
disponibles actualmente en la ventana de construcción. 

• Cuando se trabaja con audio, puede resultar de utilidad comenzar a 
reproducirlo a partir de un punto del clip de audio de origen que se 
encuentre entre dos fotogramas, pero no accesible con las divisiones 
temporales que proporciona la base de tiempo. Puede utilizar la 
visualización del tiempo Fotograma/Muestras para trabajar con estos 
fotogramas o muestras de sonido. Para más información, consulte 
Recuento de fotogramas y muestras. 

Si está preparando un programa para medios que utilizan distintos FPS, como 
la televisión y la web, puede guardar configuraciones distintas de los ajustes de 
proyecto o exportación para cada medio. Para más información sobre la forma 
de configurar los FPS del proyecto y guardar las configuraciones de proyecto y 
exportación, consulte Configuraciones de vídeo, Cómo guardar y cargar las 
configuraciones de proyecto y Exportación de archivos de vídeo.
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Duración

Cada proyecto y clip de vídeo tiene su propia duración, que describe el tiempo 
de reproducción del elemento. Antes de editar un clip, su duración es su 
longitud original. Después de editarlo, su duración está determinada por los 
puntos IN y OUT definidos. Para más información, consulte Cambio de la 
duración y velocidad del clip y Edición de un clip que se encuentra entre otros 
clips de la ventana de construcción.

Opciones de código de tiempo y visualización del 
tiempo
El código de tiempo define el modo en que se cuentan los fotogramas e influye 
sobre la forma en que se ve y se establece el tiempo de los proyectos. El estilo 
de código de tiempo se configura basándose en los medios más importantes 
para el proyecto. Por ejemplo, los fotogramas se cuentan de distinta forma 
cuando se edita vídeo para televisión y cuando se edita para una película 
cinematográfica. De forma predefinida, Premiere muestra el tiempo mediante el 
código de tiempo de la Society of Motion Picture and Television Engineers 
(SMPTE - sociedad para imágenes en movimiento e ingenieros de TV): horas, 
minutos, segundos y fotogramas. Es posible cambiar en cualquier momento a 
otro sistema, como por ejemplo el de pies y fotogramas de película de 16 o 35 
mm. El método elegido es aplicable a todas las visualizaciones de tiempo de 
Premiere. El código de tiempo no cambia nunca la base de tiempo ni los FPS 
de clips y proyectos: sólo cambia la forma de numerar los fotogramas. Además, 
el código de tiempo cuenta los fotogramas, pero no los campos. Para más 
información, consulte Comparación entre vídeo entrelazado y no entrelazado y 
Configuraciones generales. 

En las opciones de la ventana de construcción es posible elegir entre las 
siguientes opciones de visualización del tiempo:

• Códigos de tiempo drop-frame y non-drop-frame.
• Fotogramas/Muestras: Cuenta los fotogramas y las muestras de audio 

del clip individualmente.
• Pies/Fotogramas 35 mm y Pies/Fotogramas 16 mm: Cuentan los pies de 

la película cinematográfica de 35 o 16 mm, respectivamente: la película 
de 35 mm tiene 16 fotogramas por pie y la de 16 mm 40 fotogramas por 
pie. 
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Códigos de tiempo drop frame y non drop frame
La opción Visualización del tiempo de los cuadros de diálogo Configuraciones 
generales, Opciones de la ventana del monitor y Opciones de la ventana de 
construcción incluyen las opciones de Código de tiempo drop-frame 30 fps y 
Código de tiempo non drop-frame 30 fps. 

Se recomienda utilizar el código de tiempo drop-frame siempre que se edite 
vídeo NTSC que deba tener una duración determinada, como un programa de 
televisión que deba durar exactamente una hora. 

Cuando se trabaja con una composición que utiliza la norma estándar de 
NTSC, con una base de tiempo de 29,97 fps, el desajuste entre la velocidad de 
29,97 fps y la de 30 fps causa una diferencia entre la duración teórica del 
programa y la duración real. Aunque al principio es casi inapreciable, esta 
diferencia aumenta a medida que aumenta la duración del programa, 
impidiendo crear con precisión programas que tengan una duración 
determinada. El código de tiempo Drop-frame es una norma de la SMPTE que 
mantiene la precisión temporal eliminando este error. Cuando se utiliza el 
código de tiempo drop-frame, Premiere cambia la numeración de los dos 
primeros fotogramas de nueve minutos de cada diez. Por ejemplo, el fotograma 
que está después de 59:29 tiene la numeración 1:00:02. No se pierde ningún 
fotograma, porque lo que el código de tiempo drop-frame elimina en realidad 
son números de fotograma, y no fotogramas.

Premiere muestra el código de tiempo drop-frame separando con un punto y 
coma los números de la visualización de tiempo, y el código de tiempo non-
drop-frame, separando con dos puntos los números de la visualización de 
tiempo.

Cuando la duración exacta de un programa no es de vital importancia, como en 
el caso de las presentaciones de vídeo para empresas, se puede elegir un 
código de tiempo non-drop-frame 30 fps, que no cambia la numeración de los 
fotogramas. El código de tiempo drop-frame se diseñó especialmente para una 
velocidad de 29,97 fps, por lo que no se debe utilizar nunca para vídeo PAL o 
SECAM, que se reproducen exactamente a 25 fps. 
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Recuento de fotogramas y muestras
La posibilidad de contar muestras individuales de un clip de audio en la vista de 
origen puede resultar útil. (Los clips de vídeo siempre muestran los fotogramas 
uno a uno en la ventana de origen.) Esto no representa ningún problema 
cuando los FPS del clip de audio de origen es menor o igual que la base de 
tiempo, pero sí cuando es mayor. Si desea que un clip de audio comience 
desde un punto que se encuentra entre divisiones de la base de tiempo, debe 
tener una resolución mayor que la de la base de tiempo. En estos casos, puede 
utilizar la opción Fotogramas/Muestras, que cuenta fotogramas y muestras de 
audio individuales, para la visualización del tiempo.

Cuando se utiliza la opción Fotogramas/Muestras, sólo se adquiere flexibilidad 
en la definición del IN del origen de audio. El IN del clip de origen determina el 
primer fotograma o la primera muestra de audio que se reproduce del clip, y no 
el IN del programa en la ventana de construcción, que es donde se empieza a 
reproducir el audio. Cuando se añade el clip a la ventana de construcción, sus 
puntos IN y OUT originales se ajustan al IN y OUT del programa, que sólo 
pueden existir en la base de tiempo especificada. Por tanto, aunque el clip 
puede empezar a reproducirse desde cualquiera de sus fotogramas o muestras 
de origen, el último fotograma o muestra que se reproduce se redondea al 
límite de fotograma más cercano de la ventana de construcción, aunque se 
haya configurado el OUT de origen a nivel del fotograma o de la muestra. Para 
más información sobre el uso de la opción Fotogramas/Muestras para clips de 
audio, consulte Definición de un punto IN de origen de audio entre divisiones de 
base de tiempo. 
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Comparación entre vídeo entrelazado y no entrelazado
El vídeo analógico o digital puede ser entrelazado o no entrelazado 
(exploración progresiva). Los programas de vídeo que utilizan las normas 
NTSC, PAL y SECAM están entrelazados: cada fotograma consta de dos 
campos que se muestran en dos pasadas. La mayoría de las computadoras 
utiliza la exploración progresiva, donde todas las líneas del fotograma se 
muestran en una pasada, de arriba hacia abajo, antes de que aparezca el 
fotograma siguiente.
En el vídeo entrelazado, los fotogramas se dividen en dos campos. Cada 
campo contiene una de cada dos líneas horizontales del fotograma. Los 
televisores muestran el primer campo de líneas alternas en toda la pantalla y, a 
continuación, muestran el segundo campo, con las líneas restantes, para 
completar el fotograma. Un fotograma de vídeo NTSC, que se muestra 
aproximadamente a 1/30 de segundo, contiene dos campos entrelazados que 
se muestran aproximadamente a 1/60 de segundo cada uno. Los fotogramas 
de vídeo PAL y SECAM se muestran a 1/25 de segundo y contienen dos 
campos entrelazados que se muestran a 1/50 de segundo cada uno. El campo 
que contiene la primera línea de exploración del fotograma se denomina 
Campo 1, y el otro es el Campo 2. Al reproducir o exportar a vídeo entrelazado, 
hay que asegurarse de que el orden de campos especificado coincide con el 
del sistema de recepción; en caso contrario, es posible que el movimiento no 
sea fluido y el contorno de los objetos del fotograma aparezcan dentados.

El vídeo entrelazado muestra un fotograma con dos pasadas de líneas de 
exploración alternas

El vídeo de exploración progresiva muestra un fotograma con una sola pasada 
de líneas de exploración secuenciales

La señal de televisión está entrelazada a causa de los problemas de los 
primeros televisores. El fósforo que representaba la imagen perdía luminosidad 
con demasiada rapidez, de modo que al mostrar los fotogramas por exploración 
progresiva, la imagen ya se había oscurecido en la parte superior de la pantalla 
antes de que apareciera la última línea. El vídeo entrelazado, que resolvía este 
problema, se convirtió en un estándar mundial de televisión. Aun con la 
tecnología actual, el vídeo entrelazado sigue siendo útil porque puede mejorar 
la percepción del movimiento con menos ancho de banda que la exploración 
progresiva.

Cuando se empezaron a utilizar los monitores de vídeo para las computadoras, 
los problemas de permanencia de la luminosidad del fósforo y de velocidad en 
FPS ya se habían resuelto, por lo que la exploración progresiva resultaba 
práctica para dichos monitores. La película cinematográfica, aunque no se 
puede considerar técnicamente como vídeo, utiliza un método parecido al de la 
exploración progresiva porque muestra los fotogramas completos de una vez.
El entrelazado es una característica de la captura y visualización de clips, y no 
un componente estructural de los formatos de archivo o los medios de 
reproducción. Por ejemplo, es posible reproducir una película digitalizada en 
NTSC (entrelazada) en un monitor de Mac OS o Windows (exploración 
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progresiva), o mostrar un fotograma digitalizado de 35 mm de película 
(exploración progresiva) en un monitor de vídeo NTSC (entrelazado). No 
obstante, el vídeo de exploración progresiva proporciona mejor calidad final de 
imagen cuando se edita con filtros y efectos que afectan al movimiento, como 
la rotación de fotogramas o la composición de vídeo en directo con efectos 
especiales. Además, las líneas finas y el texto pequeño suelen parpadear más 
en los monitores entrelazados. Si diagnostica problemas relacionados con 
campos entrelazados, reproduzca los clips en un monitor de televisión 
entrelazado, porque el diagnóstico de problemas de campo en monitores de 
exploración progresiva no resulta fiable.

Si tiene intención de reducir la velocidad de reproducción o congelar un 
fotograma de un clip, puede evitar el parpadeo desentrelazando los 
fotogramas, con lo que los campos entrelazados se convierten en fotogramas 
completos. En el caso opuesto, si utiliza clips de origen de exploración 
progresiva (como una película cinematográfica o una animación) en un 
programa destinado a un medio entrelazado como la televisión, puede separar 
los fotogramas en campos mediante un proceso conocido como render de 
campos, para que el movimiento y los efectos queden entrelazados 
adecuadamente. Para más información sobre el desentrelazado, consulte 
Congelado de un fotograma de vídeo. Premiere puede reproducir o exportar 
vídeo como campos entrelazados sin perder calidad. Para más información 
sobre la modificación, reproducción y exportación de campos entrelazados, 
consulte Proceso de campos de vídeo entrelazados, Opciones de keyframe y 
render y Configuraciones de Keyframe y render para exportación. 

Compresión de vídeo y de audio
La edición de vídeo digital implica el almacenamiento, el desplazamiento y el 
cálculo de volúmenes de datos mucho mayores que los que utilizan otros tipos 
de archivos informáticos. El flujo de datos y el tamaño de los archivos del vídeo 
digital sin comprimir pueden sobrepasar la capacidad de muchas computadoras 
y discos duros. La compresión reduce el flujo de datos del vídeo digital, para 
que la computadora pueda gestionarlo. 
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Circunstancias que influyen sobre la compresión
Cuando se crea un programa de vídeo en Premiere, las configuraciones de 
compresión son muy importantes en la captura de vídeo original, en la 
previsualización de las ediciones, en la reproducción en la ventana de 
compresión y en su exportación. En muchos casos, las configuraciones 
elegidas varían de una situación a otra. Tenga en cuenta las siguientes 
directrices para determinar las configuraciones de compresión adecuadas: 

• Para capturar vídeo original, utilice configuraciones de compresión que 
reduzcan el flujo de datos lo suficiente para conservar la calidad máxima 
y reproducirse con fluidez en el ordenador utilizado para la edición. Si 
utiliza una tarjeta de captura de vídeo, utilice el codec que se suministra 
con ella. Las configuraciones de compresión para la captura se definen 
en el cuadro de diálogo Configuraciones de captura. 

• Cuando se previsualizan ediciones, las configuraciones de compresión 
influyen en el tiempo que tarda la edición en procesarse antes de 
reproducirse en la ventana de construcción. Establezca al principio las 
mismas configuraciones de compresión utilizadas para la captura, sobre 
todo si efectúa la captura y la edición con una tarjeta de captura de 
vídeo. Si utiliza el modo de edición QuickTime, elija Motion JPEG A o B; 
si utiliza el modo de edición de Vídeo para Windows, elija Microsoft 
Video 1. Si aun así tarda mucho en reproducirse el vídeo, puede intentar 
reducir el tamaño de fotograma o la velocidad. Las configuraciones de 
compresión para previsualización se definen en los cuadros de diálogo 
Configuraciones de vídeo y Opciones de keyframe y render. 

• Cuando se reproduce la ventana de construcción para grabar en una 
cinta de vídeo, se obtiene la mayor calidad posible definiendo las 
mismas configuraciones de compresión que para la captura del clip de 
origen. Si no ha capturado el vídeo de un proyecto con su ordenador, 
configure las configuraciones de compresión de la mayor calidad que 
pueda gestionar su equipo sin dejar de reproducir el vídeo con fluidez. 
Las configuraciones de compresión para la reproducción en la ventana 
de construcción se definen en los cuadros de diálogo Configuraciones 
de vídeo y Opciones de keyframe y render. 

• Cuando se exporta vídeo a un archivo, se recomienda utilizar 
configuraciones de compresión que permitan la reproducción fluida en el 
ordenador de destino. Para medios como la World Wide Web, puede ser 
necesario elegir configuraciones de calidad más bajas para reducir el 
flujo de datos del vídeo. Las configuraciones de compresión para la 
exportación se definen en los cuadros de diálogo Configuraciones para 
exportar y Opciones de keyframe y render. 

Puede ser muy difícil determinar cuáles son las configuraciones de compresión 
más adecuadas. El objetivo consiste en aplicar un grado de compresión que 
haga que el clip no supere el flujo de datos de destino, sin ser tampoco muy 
inferior. Si se aplica una compresión insuficiente, el flujo de datos es 
demasiado elevado para el sistema y se producen errores como los fotogramas 
mal capturados. Si se aplica una compresión excesiva, reduciendo demasiado 
el flujo de datos, no se puede aprovechar toda la capacidad del sistema, y la 
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calidad de la imagen puede resultar reducida innecesariamente. Se puede 
utilizar el Analizador del flujo de datos para evaluar cualquier archivo de vídeo;
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Acerca de la compresión de vídeo

Este tema de ayuda trata sobre los codecs de vídeo y algunas de las técnicas 
que utilizan para gestionar distintas situaciones. La comprensión de estas 
técnicas puede resultar útil para identificar las prioridades al planificar la 
compresión de un proyecto.

Compresión espacial

La compresión espacial compacta la descripción de la zona visual de los 
fotogramas buscando pautas y repeticiones entre los píxeles. Por ejemplo, en 
una imagen que incluya un cielo azul, la compresión espacial observa que 
muchos de los píxeles del cielo tienen un tono de azul parecido. En vez de 
describir los miles de píxeles uno a uno, la compresión espacial graba una 
descripción mucho más corta, como "todos los píxeles de esta zona son de 
color azul claro". La codificación por longitud de ejecución es una versión de 
esta técnica que utilizan muchos codecs. A medida que aumenta la compresión 
espacial, disminuyen el flujo de datos y el tamaño, y la imagen pierde contraste 
y definición. En muchos codecs, las opciones de Calidad y Flujo de datos 
controlan el grado de compresión espacial; si se reducen los valores de estas 
opciones, aumenta la compresión espacial. En algunos codecs, la Calidad y el 
Flujo de datos están interrelacionados, por lo que los cambios de un ajuste 
afectan al otro.

Compresión temporal

La compresión temporal busca formas de compactar la descripción de los 
cambios durante una secuencia de fotogramas. Para ello, busca pautas y 
repeticiones en el tiempo.

Por ejemplo, en un clip de vídeo en el que aparece una persona hablando con 
un fondo estático, la compresión temporal observa que los únicos píxeles que 
varían de un fotograma a otro son los que forman la cara de la persona. Los 
demás no cambian (cuando la cámara está inmóvil). En vez de describir cada 
uno de los píxeles de cada uno de los fotogramas, la compresión temporal 
describe todos los píxeles del primer fotograma, y después, en los fotogramas 
sucesivos, describe sólo los que difieren con respecto al fotograma anterior. 
Esta técnica se conoce como diferenciación de fotogramas.

Cuando la mayoría de los píxeles de un fotograma son distintos de los del 
anterior, es mejor volver a definir todo el fotograma. Los fotogramas completos, 
llamados keyframes, establecen un nuevo punto de partida para la 
diferenciación de fotogramas. Muchos codecs pueden crear keyframes a los 
intervalos especificados, y algunos también pueden insertar keyframes en las 
marcas colocadas por el usuario en la ventana de construcción de Premiere. 
Algunos codecs crean automáticamente un keyframe cuando detectan que un 
fotograma es muy distinto del anterior. Normalmente, la opción Calidad del 
codec y las configuraciones de keyframe controlan el grado de compresión 
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temporal; si se reduce el valor de estas opciones, aumenta la compresión 
temporal.

Compresión sin pérdidas y por eliminación

Algunos codecs utilizan la compresión sin pérdidas, que conserva toda la 
información del clip original. Así se mantiene la calidad al cien por cien, por lo 
que la compresión sin pérdidas resulta útil para la edición final y para mover los 
clips entre sistemas. No obstante, el mantenimiento de la calidad original limita 
la reducción del flujo de datos y el tamaño de archivo, y el flujo de datos 
resultante puede ser demasiado alto para ejecutarse correctamente en algunos 
ordenadores.

Otros métodos de compresión eliminan parte de los datos originales. Esto se 
denomina compresión por eliminación. Por ejemplo, si los píxeles que 
constituyen el cielo contienen en realidad 78 tonos de azul, un codec que utilice 
la compresión por eliminación puede guardar 60 tonos de azul. Normalmente, 
los codecs con compresión por eliminación permiten al usuario elegir el 
porcentaje de calidad de imagen que está dispuesto a perder a cambio de 
adaptar el vídeo a los ordenadores con los que se vaya a reproducir. La 
compresión por eliminación permite flujos de datos y tamaños de archivo 
mucho menores que los de la compresión sin pérdidas, por lo que normalmente 
se utiliza la compresión por eliminación para la producción final de vídeos que 
se difunden por CD-ROM o Internet. Algunos codecs, como JPEG, utilizan 
siempre la compresión por eliminación; otros, como Planar RGB, utilizan 
siempre la compresión sin pérdidas. También hay codecs que permiten al 
usuario elegir el tipo de compresión deseado, normalmente por medio de la 
configuración de las opciones Calidad y Flujo de datos. La reducción de los 
valores de estas opciones permite ahorrar más espacio, eliminando más datos.

Compresión simétrica y asimétrica

El codec elegido influye sobre el desarrollo del trabajo de producción, no sólo 
en lo que se refiere al tamaño de archivo y a la velocidad de reproducción, sino 
también en lo concerniente al tiempo que tarda un codec en comprimir una 
determinada cantidad de imágenes. La compresión rápida acelera la 
producción del vídeo y la descompresión rápida facilita la reproducción, pero 
hay muchos codecs que tardan más tiempo en comprimir los fotogramas que 
en descomprimirlos. Éste es el motivo por el que un programa de 30 segundos 
puede tardar varios minutos en procesarse antes de su reproducción. 
Comprimir vídeo es como hacer una maleta; se tarda lo mismo en hacer la 
maleta que en deshacerla si se llena de ropa de cualquier manera, pero si se 
invierte más tiempo en doblar la ropa y organizarla dentro de la maleta, se 
puede guardar más en el mismo espacio.

Así, los distintos codecs invierten distintas cantidades de tiempo en la 
compresión y la descompresión de vídeo. Los codecs simétricos tardan el 
mismo tiempo en comprimir un clip que en descomprimirlo; en los asimétricos, 
el tiempo invertido en la compresión es significativamente mayor que el que se 
invierte en la descompresión. Por ejemplo, el codec asimétrico Cinepak 
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descomprime el vídeo con relativa rapidez, por lo que resulta útil para archivos 
de vídeo que se deban reproducir bien en cualquier ordenador, de gama alta o 
baja, pero para conseguirlo es necesario invertir más tiempo en la compresión. 
La simetría varía según el codec y normalmente no se puede configurar.

Recompresión de clips

Cuando se reproduce o se exporta un programa compuesto por clips originales 
comprimidos, es posible recomprimir los clips originales que ya están 
comprimidos, o dejarlos como están. Normalmente, es mejor evitar la 
recompresión de los clips, porque no se puede ahorrar más espacio repitiendo 
la compresión con las mismas configuraciones. De hecho, dado que muchos 
compresores utilizan el método de eliminación, la recompresión de los clips 
reduce la calidad de la imagen.

Premiere intenta evitar la recompresión cuando los fotogramas no parecen 
haber experimentado cambios con respecto a los fotogramas correspondientes 
del clip original, pero en algunas ocasiones es necesario recomprimir los clips 
originales. Por lo general, la recompresión es necesaria cuando se efectúan 
acciones que alteran de forma significativa los fotogramas del clip. A 
continuación se enumeran algunas de estas acciones de edición, aplicación de 
efectos y configuración:

• Reducción de las configuraciones de Calidad o Flujo de datos. 
• Cambio de la velocidad, la profundidad del color, las configuraciones de 

keyframe, las opciones de Procesado especial, el codec o las opciones 
del codec, y en la mayoría de los casos, cambio del tipo de vídeo. 

• Cambio del contenido visual. Esto incluye el tamaño de fotograma, las 
transiciones, los filtros, el movimiento, la transparencia, las opciones de 
campo, y el congelado y entrelazado de fotogramas. 

Si se selecciona la opción Recomprimir siempre, los clips se recomprimen en 
todos los casos, independientemente de que sus fotogramas hayan cambiado o 
no.

Otros factores que influyen en el tamaño de archivo

Algunas características del vídeo pueden influir en el tamaño del archivo, tanto 
si se aplica la compresión como si no, e independientemente del codec elegido.

• Profundidad de bits: Determina el número de colores que se utilizan 
para exportar la película. Las profundidades de bits mayores crean 
archivos más grandes. Cuando se elige una profundidad de bits baja, es 
posible conservar cierto control sobre la calidad del color eligiendo una 
paleta de colores personalizada. Si esta opción no está disponible, esto 
significa que se ha elegido un codec que no acepta paletas 
personalizadas ni color de 8 bits. 

• Tamaño de fotograma: Para obtener la mayor calidad de imagen 
posible, el tamaño de fotograma del proyecto debe coincidir con el 
tamaño de fotograma del archivo de vídeo final. En los casos, como la 
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difusión por Internet, en los que el tamaño y el flujo de datos son más 
importantes que la calidad de la imagen, la reducción del tamaño de 
fotograma puede favorecer la compresión, al reducir la cantidad de datos 
que hay que comprimir. 

• Fotogramas por segundo: Para obtener el mejor resultado posible, la 
velocidad del proyecto debe coincidir con la del archivo de vídeo final. 
En los casos, como la difusión por Internet, en los que el tamaño y el 
flujo de datos son más importantes que la calidad de la imagen, la 
reducción de la velocidad puede favorecer la compresión, al reducir la 
cantidad de datos que hay que comprimir. 
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Elección del codec adecuado

Cuando se edita, el modo de edición seleccionado en el cuadro 
Configuraciones del proyecto determina los codecs disponibles. Cuando se 
exporta, es el Tipo de archivo elegido en el cuadro de diálogo Configuraciones 
para exportar película el que determina los codecs disponibles. A la hora de 
elegir el codec hay que tener en cuenta el medio de reproducción al que se 
destina el vídeo, el método de compresión del codec y la forma que tiene de 
gestionar los distintos tipos de imagen o sonido. Algunos programas, como 
Vídeo para Windows y QuickTime, se utilizan para diversas tareas relacionadas 
con el vídeo, como la videoconferencia, por lo que incluyen muchos codecs que 
no son adecuados para la edición de vídeo. Los codecs que no están 
destinados a la edición se identifican en esta sección, por lo que se puede 
evitar utilizarlos. Si su tarjeta de video cuenta con compresión por hardware y 
su software está debidamente instalado, su codec aparece en el menú 
Compresor del panel Configuraciones de vídeo del cuadro de diálogo 
Configuraciones de proyecto. También se puede acceder al codec en el cuadro 
de diálogo correspondiente a la tarjeta de captura de vídeo, que se abre 
pulsando el botón Vídeo del panel Configuraciones de captura del cuadro de 
diálogo Configuraciones de proyecto.

En todas las listas de codecs de audio y vídeo, las opciones Ninguno y Sin 
comprimir proporcionan una excelente calidad de imagen y sonido, porque no 
se aplica ninguna compresión. No obstante, no es recomendable trabajar con 
vídeo sin comprimir, porque el flujo de datos resultante requiere un ordenador 
extremadamente rápido y enormes cantidades de espacio del disco.

Nota: Los codecs que a continuación se explican son los que normalmente 
están instalados en la mayoría de los ordenadores, o se instalan con el propio 
Premiere. La lista real de codecs de cada ordenador variará dependiendo de 
las actualizaciones de vídeo para Windows y de Quicktime, así como del 
software y hardware de vídeo que se haya instalado. Esta guía por lo tanto sólo 
pretende ser indicativa, para facilitar la elección.

Temas de ayuda del próximo nivel:

Codecs de vídeo para Windows
Codecs de audio para Windows
Codecs de vídeo de QuickTime
Codecs de audio de QuickTime
Codecs DV
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Codecs de Vídeo para Windows

En la edición, se puede elegir entre los siguientes codecs de software cuando 
se selecciona Vídeo para Windows en el menú Modo de edición del panel 
Configuraciones generales del cuadro de diálogo Configuraciones de proyecto. 
En la exportación, se puede elegir entre los siguientes codecs de software 
cuando se selecciona Microsoft AVI en el menú Tipo de archivo del panel 
Configuraciones generales del cuadro de diálogo Configuraciones para 
exportar película.

• Intel Indeo: Resulta útil para distribuir por Internet vídeo para 
ordenadores con procesador MMX o Pentium II. Este codec incluye 
funciones como la compresión rápida, el control flexible de keyframe, 
máscara de croma (transparencia), efectos de playback y recorte 
instantáneo, que reducen el volumen de datos. Además, este codec 
cuenta con una función de descarga progresiva que se adapta a los 
distintos anchos de banda de las redes. Para hacer uso de todas estas 
funciones, es necesario adquirir el software necesario, distribuido por 
Intel. Este codec está diseñado para funcionar en combinación con el 
codec AdIntel Audio Software. 

• Intel Indeo Video Raw: Resulta útil para capturar vídeo sin comprimir 
con tarjetas de captura de vídeo de Intel. Este codec proporciona una 
excelente calidad de imagen, porque no aplica compresión. Sin 
embargo, los archivos de vídeo capturado ocupan menos espacio que si 
se selecciona la opción Ninguno, ya que el color se convierte del modelo 
RGB al YUV, que es más compacto. 

• Intel Indeo Video Interactive: Parecido al codec Intel Indeo, Indeo 
Video Interactive. Acepta funciones avanzadas, como la transparencia, 
las películas de versiones múltiples y los efectos de playback. Para 
hacer uso de todas estas funciones, es necesario disponer del software 
necesario, distribuido por Intel. 

• Microsoft RLE: Resulta útil para comprimir fotogramas que contengan 
grandes áreas de color plano, como los dibujos animados. Este codec 
utiliza un compresor de codificación espacial de 8 bits, con codificación 
por longitud de ejecución (RLE) y no tiene pérdidas si se ajusta la 
calidad al 100%. 

• Microsoft Video 1: Resulta útil para comprimir vídeo analógico. Este 
codec de compresión espacial por eliminación acepta profundidades de 
píxeles de 8 y 16 bits. 

•  Intel Indeo Video R3.2: Resulta útil para comprimir vídeo de 24 bits 
para la reproducción desde CD-ROM. Con este codec se obtienen 
mayores relaciones de compresión, mejor calidad de imagen y 
reproducción más rápida que con el codec Microsoft Video 1. Para 
obtener los mejores resultados, utilice el codec Indeo Video para los 
datos originales que no se hayan comprimido previamente con un codec 
de eliminación elevada. Cuando se utiliza con un flujo de datos de 
reproducción, la calidad de las películas comprimidas con este codec es 
comparable a la de las comprimidas con el codec Cinepak. 
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• Codec Cinepak, de Radius: Resulta útil para comprimir vídeo de 24 bits 
para la reproducción desde CD-ROM o para la descarga de archivos de 
la Web. Con este codec se obtienen mayores relaciones de compresión, 
mejor calidad de imagen y reproducción más rápida que con el codec 
Video. Permite ajustar el flujo de datos para la reproducción; la calidad 
de imagen disminuye de forma significativa a partir de los flujos de datos 
por debajo de 30 KBps. La compresión de Cinepak es asimétrica; 
descomprime rápidamente, pero la compresión es suficientemente lenta 
para hacer que este codec sea poco recomendable para editar. Para 
obtener los mejores resultados, utilice Cinepak sólo para exportar la 
versión final de los archivos de vídeo. 
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Codecs de audio para Windows

En la edición, se puede elegir entre los siguientes codecs de software cuando 
se selecciona Vídeo para Windows en el menú Modo de edición del panel 
Configuraciones generales del cuadro de diálogo Configuraciones de proyecto. 
En la exportación, se puede elegir entre los siguientes codecs de software 
cuando se selecciona Microsoft AVI en el menú Tipo de archivo del panel 
Configuraciones generales del cuadro de diálogo Configuraciones para 
exportar película, o Windows Waveform en el menú Tipo de archivo del panel 
Configuraciones generales del cuadro de diálogo Configuraciones para 
exportar audio.

Los codecs de audio aparecen en el menú Tipo del panel Configuraciones de 
audio del cuadro de diálogo correspondiente. Por lo general, hay que utilizar un 
codec configurado especialmente para el tipo de sonido del programa, como 
voz, música o multimedia. Es preferible evitar los códigos especiales para 
telefonía si el audio consiste casi exclusivamente en voz y está destinado a la 
difusión por un medio de baja velocidad, como la Web.

• Intel Audio Software: Resulta útil para distribuir música y voz por 
Internet. Su mayor relación de compresión es de 8:1. Este codec está 
diseñado para funcionar en combinación con Intel Video Software. 

• TrueSpeech: Resulta útil para distribuir voz por Internet con un flujo de 
datos bajo. 

• Microsoft GSM 6.10: Microsoft GSM 6.10 
• MS-ADPCM: La implementación de Microsoft de la Adaptive Differential 

Pulse Code Modulation (ADPCM), un formato de audio digital muy 
difundido, que puede guardar audio con calidad de CD. 

• Microsoft IMA ADPCM: Una implementación de ADPCM, útil para crear 
archivos de audio para multimedia compatibles con distintas 
plataformas, desarrollado por la Interactive Multimedia Association 
(IMA). 

• Lucent Technologies SX8300P: Resulta útil para distribuir voz por 
Internet con un flujo de datos bajo. 

• elemedia TM AX2400P: Resulta útil para distribuir archivos de música 
de alta calidad, sin flujo, por Internet. 

• Voxware Audio Codecs: Resulta útil para distribuir voz por Internet con 
un flujo de datos bajo. 
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Codecs de vídeo para QuickTime

En la edición, se puede elegir entre los siguientes codecs de software cuando 
se selecciona QuickTime en el menú Modo de edición del panel 
Configuraciones generales del cuadro de diálogo Configuraciones de proyecto. 
En la exportación, se puede elegir entre los siguientes codecs de software 
cuando se selecciona QuickTime en el menú Tipo de archivo del panel 
Configuraciones generales del cuadro de diálogo Configuraciones para 
exportar película.

• Component video: Resulta útil para capturar, comprimir o guardar vídeo 
provisionalmente. Tiene una relación de compresión relativamente baja, 
por lo que consume bastante espacio en el disco duro. 

• Graphics: Resulta útil para obtener una buena calidad de imagen con 
color de 8 bits. El codec Graphics está destinado ante todo a su uso con 
imágenes fijas de 8 bits, pero a veces es adecuado para vídeo. Este 
codec no alcanza altas relaciones de compresión, por lo que es 
adecuado para la reproducción desde el disco duro, pero no para CD-
ROM. 

• Video: Resulta útil para capturar y comprimir vídeo analógico. Este 
codec proporciona una calidad alta en la reproducción desde el disco 
duro y una calidad moderada desde CD-ROM. Acepta compresión 
espacial y temporal de vídeo de 16 bits. Los datos se pueden 
recomprimir o recompilar más adelante para obtener relaciones de 
compresión más elevadas, con pérdidas de calidad mínimas o 
insignificantes. 

• Animation: Resulta útil para clips con grandes áreas de colores 
uniformes, como los dibujos animados. Las configuraciones determinan 
el grado de eliminación de la compresión; si se elige una calidad del 
100% se consigue una compresión sin pérdidas. El codec Animation 
utiliza un algoritmo de compresión de Apple basado en la codificación 
por longitud de ejecución. Con el ajuste para compresión sin pérdidas, 
puede resultar útil para guardar secuencias de títulos y otros rótulos. 

• Motion JPEG A y Motion JPEG B: Resultan útiles como 
transcodificadores, para la transferencia de archivos de captura de vídeo 
a otros ordenadores equipados con tarjeta de captura de vídeo, sobre 
todo entre distintas plataformas. Estos codecs son versiones de JPEG, 
aceptado por casi todas las tarjetas de captura de vídeo. Algunas 
tarjetas incluyen chips que aceleran Motion JPEG, para que la edición 
sea más rápida. Consulte la documentación de la tarjeta de captura de 
vídeo para averiguar hasta qué punto acepta estos codecs. 

• Photo–JPEG: Resulta útil para las imágenes fijas con degradados de 
color o que no contengan un alto porcentaje de detalles de alto 
contraste, como ocurre con muchas imágenes fijas fotográficas. Photo-
JPEG comprime por eliminación, pero con las configuraciones de mayor 
calidad, la imagen comprimida no se distingue apenas de la original. 
Photo-JPEG utiliza compresión simétrica; el tiempo de compresión es 
casi el mismo que el de descompresión, aunque el tiempo de 
compresión es demasiado lento para el vídeo a tiempo real. 
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No es recomendable utilizar Photo-JPEG para imágenes que se vayan a 
editar más adelante, porque utiliza la compresión por eliminación. No 
obstante, su alto grado de compresión y calidad de imagen puede hacer 
que resulte útil para pasar archivos de un sistema a otro o para guardar 
proyectos terminados.

Nota (sólo para Mac OS): Muchas tarjetas con compresión por hardware 
utilizan JPEG. Con QuickTime 2.5 o posterior, es posible que los codecs 
de estas tarjetas no aparezcan en el menú Compresor si no se mantiene 
pulsada la tecla Opción al elegir el menú. Si se selecciona Photo-JPEG, 
se utiliza automáticamente el codec correcto. También se pueden 
encontrar opciones adicionales para algunas tarjetas si se mantiene 
pulsada la tecla Opción o Control al elegir el codec.

• H.263: Resulta útil para videoconferencia con un flujo de datos bajo; no 
está recomendado para la edición de vídeo en general. 

• Cinepak: Resulta útil para la compresión de vídeo de 24 bits con destino 
a CD-ROM o a archivos para descargar de la Web. Este codec alcanza 
una mayor proporción de compresión y una reproducción más rápida 
que el codec Video. Se puede configurar el flujo de datos para la 
reproducción; la calidad de la imagen disminuye de forma más notable 
con flujos de datos por debajo de los 30 KBps. Cinepak es asimétrico; 
descomprime rápidamente, pero la compresión es suficientemente lenta 
para que no resulte recomendable en la edición. Para obtener los 
mejores resultados posibles, utilice Cinepak sólo para exportar versiones 
finales de archivos de vídeo. 

• Sorenson Video: Resulta útil para la compresión de vídeo de 24 bits 
con destino a CD-ROM o a archivos para bajar de la Web. Parecido a 
Cinepak, está diseñado para obtener una alta calidad con flujos de datos 
inferiores a los 200 KBps. Este codec ofrece una calidad de imagen 
mejor y un tamaño de archivo menor que Cinepak. Requiere más tiempo 
de compresión que Cinepak, por lo que es adecuado para la exportación 
final pero no para la edición. Acepta escalabilidad temporal, lo que 
permite reproducir con fluidez en ordenadores de gama baja películas 
exportadas de ordenadores de gama alta. 

• Planar RGB: Codec de compresión sin pérdidas, eficaz para fotogramas 
con áreas grandes de colores uniformes, como los dibujos animados. 
Utiliza la codificación por longitud de ejecución y constituye una 
alternativa al codec Animation. 
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Codecs de audio para QuickTime

En la edición, se puede elegir entre los siguientes codecs de software cuando 
se selecciona QuickTime en el menú Modo de edición del panel 
Configuraciones generales del cuadro de diálogo Configuraciones de proyecto. 
En la exportación, se puede elegir entre los siguientes codecs de software 
cuando se selecciona QuickTime en el menú Tipo de archivo del panel 
Configuraciones generales del cuadro de diálogo Configuraciones para 
exportar película.

Los codecs de audio aparecen en el menú Tipo del panel Configuraciones de 
audio del cuadro de diálogo correspondiente. Algunos de los codecs 
enumerados a continuación utilizan una proporción de compresión determinada 
(como 2:1). Cuando es así, la proporción de compresión se muestra después 
del nombre del codec. Por lo general, hay que utilizar un codec configurado 
especialmente para el tipo de sonido del programa, como voz, música o 
multimedia. Es mejor evitar los códigos especiales para telefonía si el audio 
consiste casi exclusivamente en voz y está destinado a la difusión por un medio 
de baja velocidad, como la Web.

• mLaw 2:1: Resulta útil para el intercambio de audio entre aplicaciones 
en plataformas (como muchas estaciones de trabajo de UNIX) en las 
que el formato de audio estándar es mLaw. Este formato se utiliza para 
la telefonía digital en América del norte y Japón. (El primer carácter del 
nombre del codec es la letra griega Mi.) 

• 16-bit Big Endian y 16-bit Little Endian: Resultan útiles cuando se 
debe guardar audio con las codificaciones Big Endian y Little Endian 
(orden de bytes), como en la preparación de audio para 
microprocesadores. Estos codecs pueden ser de utilidad para los 
ingenieros de hardware y software, pero normalmente no son adecuados 
para la edición de vídeo. 

• 24-bit Integer y 32-bit Integer: Resultan útiles cuando los datos de 
audio se deben almacenar con codificación de enteros de 24 o 32 bits, 
como en la preparación de audio para microprocesadores. Estos codecs 
pueden ser de utilidad para los ingenieros de hardware y software, pero 
normalmente no son adecuados para la edición de vídeo. 

• IMA 4:1: Resulta útil en el audio para multimedia compatible con 
distintas plataformas. IMA 4:1 fue desarrollado por el IMA, por medio de 
la ADPCM. 

• 32-bit Floating Point y 64-bit Floating Point: Resultan útiles cuando 
los datos de audio se deben almacenar con codificación de coma 
flotante de 24 o 32 bits, como en la preparación de audio específico de 
microprocesadores. Estos codecs pueden ser de utilidad para los 
ingenieros de hardware y software, pero normalmente no son adecuados 
para la edición de vídeo. 

• ALaw 2:1: Parecido a mLaw, aunque se utiliza sobre todo en Europa, 
para telefonía digital. 
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• QDesign Music Codec: Resulta útil en la compresión de música de alta 
calidad para su distribución por Internet. Puede transmitir audio con 
calidad de CD (16 bits, 44,1 kHz) por una línea de 28,8 Kbps. 

• Qualcomm PureVoice: Destinado a la voz, funciona mejor con 8 kHz. 
Basado en la norma tecnológica Code Division Multiple Access (CDMA) 
para telefonía celular. 

• MACE 3:1 y MACE 6:1: Resultan útiles como codecs de audio de uso 
general. Desde hace muchos años, el Gestor de sonido de Mac OS 
incorpora el codec Macintosh Audio Compression and Expansion 
(MACE). La proporción de compresión más baja de MACE 3:1 
proporciona una calidad mejor que la de MACE 6:1. Como se suministra 
con QuickTime 3.0, también se puede acceder a este codec desde 
Windows cuando se tiene QuickTime instalado. 
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Codecs DV

Los codecs DV son los que se utilizan para generar o capturar vídeo digital 
enteramente compatible con otros dispositivos de vídeo digital como vídeo-
cámaras o vídeo-reproductores digitales.

De hecho, en sentido estricto, vídeo digital es cualquier vídeo que se encuentre 
en un fichero en nuestro ordenador (pues si está en el ordenador, tiene que ser 
necesariamente digital). Lo que ocurre es que se suele llamar vídeo digital 
exclusivamente al vídeo codificado con un codec DV.

Los codecs DV ofrecen una gran calidad de vídeo y de audio pero, a cambio, 
una gran ocupación en disco así como otras exigencias como por ejemplo:

• Sólo admiten dos resoluciones (la normal y la de pantalla ancha) 
• Sólo admiten dos frecuencias de audio 32 y 48Khz 
• Sólo admiten una velocidad de fotogramas por segundo 
• No se les puede alterar el flujo de datos 

El codec DV es útil exclusivamente si se tiene algún dispositivo digital externo y 
un puerto firewire. Disponiendo de ambos elementos, es el codec que 
necesariamente hay que utilizar para transmitir o recibir datos desde el puerto 
fire-wire.

La versión 6 de Premiere está hasta tal punto orientada al vídeo digital, que no 
trata a los codecs DV como verdaderos codecs, sino como tipos de vídeo. Por 
eso los codecs DV no aparecen en el menú de codecs cuando se elige vídeo 
para windows, sino que para que un proyecto utilice estos codecs debe 
elegirse, como modo de edición "DV playback".

No obstante sí hay disponibles codecs DV cuando se elige como tipo de vídeo 
el de QuickTime.

Existen varios codecs DV. Unos para QuickTime y otros para Windows. 
Premiere proporciona los de QuickTime, pero de los existentes para Windows 
Premiere sólo proporciona el codec denominado AVI tipo 2, aunque Premiere 
puede también trabajar con el AVI tipo 1.

Avi tipo 1 y Avi tipo 2

Microsoft define dos métodos para almacenar datos de vídeo DV en archivos 
AVI, a los cuales nos referiremos como tipo-1 y tipo-2. Entre ambos no hay 
diferencias de calidad, sino que las diferencias se encuentran en ciertos 
aspectos técnicos:

• En el llamado tipo 1 El flujo nativo DV entrelazado que se produce y 
utiliza en las entradas y salidas del dispositivo DV contiene vídeo 
comprimido y datos de audio PCM (pulse code modulated, modulación 

465



por codificación de pulsos). Este único flujo entrelazado puede 
almacenarse en un archivo AVI como un flujo "ivas"( por interleaved 
video/audio stream, flujo entrelazado de audio/vídeo). Microsoft 
denomina a este formato como archivo AVI DV tipo -1. 

Debido a que el formato tipo-1 almacena los datos como un solo flujo 
AVI, los archivos AVI DV tipo -1 no son compatibles con VfW. 
DirectShow, sin embargo, maneja con facilidad los flujos de datos de 
tipo-1, haciendo un pequeño truco: dirige el flujo hacia un filtro Splitter 
(separador) que proporciona en su salida un flujo de vídeo DV y otro o 
varios flujos de audio PCM para su reproducción o procesado posterior.

• Por el contrario, en el DV de tipo 2 los datos DV entrelazados pueden 
también dividirse en un flujo de video y otro o varios de audio que se 
guardarán en un archivo AVI. Microsoft denomina a este formato de 
almacenar vídeo DV como tipo-2. Este formato tiene la ventaja de ser 
compatible con VfW, porque contiene un flujo estándar de video y otro 
de audio. 

El pequeño inconveniente es que este formato requiere que los datos de 
audio se almacenen redundantemente como flujo de vídeo, porque el 
fjujo de "vídeo" es realmente el video nativo DV entrelazado (por lo 
tanto, conteniendo tanto datos de vídeo como los de audio originales) re-
etiquetado como flujo de vídeo. El decodificador DV de vídeo toma este 
flujo, decodifica el vídeo e ignora el audio. La cantidad de datos 
redundantes es igual a la cantidad de datos de audio (por ejemplo, 192 
KB/seg para 48-kHz, 16-bit estéreo). Aunque los datos de audio son 
redundantes, la redundancia puede considerarse despreciable, al ser un 
pequeño porcentaje del ancho de banda total de los datos DV (3.7 
MB/seg) y dada la gran cantidad de aplicaciones existentes que pueden 
editar los datos almacenados.

Nota de Quinurio: La información sobre el funcionamiento interno de los dos 
tipos de avi la he obtenido de www.shopicardia.com. Lo que se dice a 
continuación es una conclusión mía. No la he leído en ninguna parte, y de 
hecho, Pixelmann (que de esto sabe más que yo) opina lo contrario.

Premiere y el tipo 1

Algunos programas de edición, como Ulead Media Studio, admiten ambos tipos 
de DV. Premiere, sin embargo, como antes he dicho, sólo trabaja con el tipo 2, 
hasta el punto de que no permite elegir como codec el tipo 1 (de hecho, ni 
siquiera hay mención alguna en sus menús de que exista más de un tipo).

No obstante eso no quiere decir que Premiere sea totalmente incompatible con 
el tipo 1, sino simplemente que no puede trabajar directamente con él; es 
decir: cuando Premiere captura, lo hace en tipo 2; cuando exporta, exporta a 
tipo 2.
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Pero se puede incluir un clip capturado en tipo 1 en un proyecto de Premiere, lo 
que ocurre es que Premiere tendrá que renderizarlo para generar ficheros 
temporales del tipo 2 que le permitan trabajar con él.
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Opciones del menú principal

La ayuda de Premiere no contiene una referencia de los comandos del menú, 
lo cual suele, sin embargo, ser habitual: Cuando uno se aproxima por primera 
vez a un programa, ojear la explicación de los comandos es un buen método 
para aprender qué se puede hacer con el programa.

El presente apéndice intenta suplir esta omisión. Podría haberlo hecho 
simplemente explicando cada opción del menú para qué sirve. Pero he 
preferido seguir otro procedimiento: Para cada opción del menú de Premiere he 
recogido los enlaces a los temas de ayuda en donde dicha opción se utiliza.

A veces el tema de ayuda no la menciona expresamente, sino que se refiere a 
un botón que hace lo mismo. Ya expliqué al principio de la ayuda que una de 
las características de Premiere es que hay muchos procedimientos para 
obtener un mismo resultado; y la ayuda no siempre se refiere a todos ellos.

Hay, por otra parte, opciones del menú de Premiere que ni siquiera son 
mencionadas en la ayuda. A estas opciones no me referiré en las próximas 
páginas, salvo que esté yo muy seguro de para qué sirven, en cuyo caso 
pondré una pequeña explicación.

El menú principal de Premiere dispone de las siguientes opciones:

File
Edit
Project
Clip
Timeline
Window
Title
Help 

Para ver las opciones correspondientes a cada uno de estos menús, pulse en 
su enlace.
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Opciones del menú File
Nota: Si en el menú File aparece alguna opción no mencionada en esta página, 
es porque dicha opción ha sido incorporada mediante un plug-in. Consulte la 
documentación del mismo. 

New Proyect

Creación de un nuevo proyecto.

New

Bin

Organizar los clips usando contenedores.

Storyboard

Creación de un StroryBoard.

Title

Creación de un título desde Premiere.

Universal counting leader

Creación de una cuenta atrás.

Bars and tone

Creación de barras de color y de un tono de 1 Khz.

Black video

Creación de vídeo negro.

Color Matte

Adición de un fondo de color.

Offline File

Uso de archivos de referencia.

Open

Guardar manual y automáticamente un proyecto.
Abrir un proyecto y localizar los ficheros que lo componen.
Organizar los clips usando contenedores.
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Usar librerías de versiones previas de Premiere.
Registro de clips en una lista de captura.
Cómo guardar, exportar e importar listas de captura.
Uso de audio CD en Mac OS.

Open Recent file

No se menciona específicamente en ningún tema de ayuda, pero 
permite localizar rápidamente los últimos ficheros abiertos.

Open Recent Project

No se menciona específicamente en ningún tema de ayuda, pero 
permite localizar rápidamente los últimos proyectos abiertos.

Close

No se menciona específicament en ningún tema de ayuda, pero permite 
cerrar el fichero seleccionado, o la ventana donde se encuentre dicho 
fichero.

Save

Guardar manual y automáticamente un proyecto.
Registro de clips en una lista de captura.
Cómo guardar, exportar e importar listas de captura.
Creación de una lista de captura para volver a digitalizar clips de 
proyecto.

Save as

Guardar manual y automáticamente un proyecto.
Registro de clips en una lista de captura.
Cómo guardar, exportar e importar listas de captura.
Análisis de las propiedades y flujo de datos de un clip.
Creación de un StroryBoard.
Creación de un título desde Premiere.

Save a copy

Guardar manual y automáticamente un proyecto.

Revert

Corrección de errores.
Uso de la paleta History.

Capture

Batch capture
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Registro de clips en una lista de captura.
Cómo guardar, exportar e importar listas de captura.
Creación de una lista de captura para volver a digitalizar clips de 
proyecto.

Movie capture

Captura de clips sin control de dispositivo.
Captura de clips con control de dispositivo.
Registro de clips en una lista de captura.

Stop Motion

Captura de una animación de cámara de truca.

Audio capture

Captura de audio analógico.

Import

File

Captura de vídeo desde una lista de captura.
Importación de clips.
Importación de ficheros de Adobe Illustrator.
Importación de una animación o secuencia de imágenes fijas.
Creación de un StroryBoard.
Adición de un título a un proyecto.

Folder

Importación de clips.

Project

Importación de otro proyecto.

Export clip

Las entradas de este menú tienen el mismo efecto que las de Export 
Timeline, pero, en lugar de referirse a toda la ventana de construcción, 
se refieren sólo al clip seleccionado.

Export timeline

Movie
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Exportación de un vídeo.
Exportación de una secuencia de imágenes fijas.
Exportación de un archivo filmstrip para su edición en Photoshop.

Frame

Exportación de imágenes fijas.

Audio

Captura de audio analógico.

File list

Creación de un listado de los archivos del proyecto.

Print to video

Reproducción de vídeo a pantalla completa.
Exportación a vídeo-cinta.

Export to tape

Exportación a vídeo-cinta.

EDL

Exportación de una EDL.

Save for Web

Creación de un archivo de vídeo para su reproducción en CD-
ROM.
Exportación de un vídeo.

Get properties for

Análisis de las propiedades y flujo de datos de un clip.

Page setup

Imprimir el contenido de una ventana.

Print

Imprimir el contenido de una ventana.

Exit
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No se menciona específicamente en un tema, pero sirve para terminar la 
ejecución del programa.
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Opciones del menú Edit

Undo

Corrección de errores.

Redo

No es mencionado en los temas de ayuda, pero, lógicamente, significa 
repetir la última acción.

Cut

Cortar y pegar clips y configuraciones de los clips.

Copy

Cortar y pegar clips y configuraciones de los clips.
Aplicación y control de efectos.

Paste

No es mencionado en los temas de ayuda, pero esta opción es general 
en Windows: Pegar último objeto copiado o cortado.

Paste to fit

Cortar y pegar clips y configuraciones de los clips.

Paste attributes

Cortar y pegar clips y configuraciones de los clips.
Aplicación y control de efectos

Paste attributes again

No es mencionado en los temas de ayuda. Literalmente significa Pegar 
atributos de nuevo.

Clear

No es mencionado en los temas de ayuda. Pero esta opción borra todos 
los objetos que estuvieran seleccionados (equivale a pulsar Supr).

Duplicate clip

Uso de clips duplicados con nombre y de copias de clips sin nombre.
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Deselect All

No es mencionado en los temas de ayuda, pero esta opción hace que no 
quede ningún objeto seleccionado.

Select All

No es mencionado en los temas de ayuda, pero esta opción selecciona 
a todos los objetos de la ventana activa.

Find

Renombrar, buscar y borrar elementos.

Locate clip

Búsqueda del origen de un clip del programa.
Anidado de ediciones mediante clips virtuales.

Edit original

Edición de un clip en su aplicación original.

Preferences

General and still image

Cómo usar los tool tips.
Configuración de los discos de trabajo de Premiere.
Modificación de la ventana de inicio.
Importación de clips.
Importación de imágenes fijas.
Visualización de un clip.
Controles de la ventana Monitor.

Autosave and undo

Guardar, manual y automáticamente, un proyecto.
Corrección de errores.

Scratch disk and device control

Configuración de los discos de trabajo de Premiere.
Preparación de la captura de DV.
Captura de clips con control de dispositivo.
Captura de audio analógico.
Trabajo con ficheros de previsualización.
Exportación a vídeo-cinta.

Online settings
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Cómo usar Adobe Online.
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Opciones del menú Project

Project settings

General

Configuración general del Proyecto.
Preparación de la captura de DV.
Exportación a vídeo-cinta.

Video

Cónfiguración de vídeo.
Establecimiento de la proporción de aspecto de píxel.

Audio

Cónfiguración de audio.
Trabajo con ficheros de previsualización.

Keyframe and rendering

Opciones de Keyframe y renderización.
Previsualización con la velocidad de reproducción final.
Enviar la previsualización a la pantalla.
Previsualización desde RAM.

Settings viewer

Comparar configuraciones usando el visor de configuraciones
Acerca de las configuraciones de exportación.

Remove Unused Clips

Renombrar, buscar y borrar elementos.

Replace clips

Uso de archivos de referencia.

Automate to timeline

Adición de múltiples clips mediante un proceso automatizado.

Export bin from project

Organizar los clips usando contenedores.
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Utilities

Batch processing

Exportación de varios proyectos mediante proceso por lotes.

Project trimmer

Depurar un proyecto eliminando los fotogramas no usados.
Creación de una lista de captura para volver a digitalizar clips de 
proyecto.
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Opciones del menú Clip

Properties

Ver la información de un clip en la ventana de proyecto.

Set Clip name alias

Renombrar, buscar y borrar elementos.

Add Clip to project

Importación de clips.

Insert at edit line

Adición de un clip a la ventana de construcción.

Overlay at edit line

Adición de un clip a la ventana de construcción.

Enable Clip on timeline

Activación y desactivación de los clips.

Look clip on timeline

Bloqueo y desbloqueo de clips.

Unlink audio and video

Víncular clips de vídeo y audio en la ventana de construcción.

Video options

Maintain aspect ratio

Importación de imágenes fijas.
Conservación de la proporción original de un clip.

Aspect fill color

Conservación de la proporción original de un clip.

Transparency
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Uso de transparencias para superposiciones y para crear 
composiciones.
Uso de Difference Matte (Máscara de diferencia).
Uso de Track Matte (Máscara en pista aparte).
Creación de máscaras para ocultar partes no deseadas.
Creación de pantallas divididas.

Motion

Ajuste de la escala de un clip.
Desplazamiento de un clip en la pantalla.

Frame Hold

Modificación de los fotogramas por segundo de un clip.
Congelado de un fotograma.
Fotogramas por segundo en relación a la base de tiempo.

Field Options

Proceso de campos de vídeo entrelazados.

Audio options

Audio Gain

Cómo procesa Premiere el audio.
Ajuste de ganancia.

Normal

Utilización de un solo canal en estéreo (derecho o izquierdo).
Silenciar un canal en un clip stéreo.
Intercambio de canales en un clip stéreo.

Duplicate left

Utilización de un solo canal en estéreo (derecho o izquierdo).

Duplicate Right

Utilización de un solo canal en estéreo (derecho o izquierdo).

Mute left

Silenciar un canal en un clip stéreo.

Mute Right

Silenciar un canal en un clip stéreo.
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Swap Channels

Intercambio de canales en un clip stéreo.

Advanced options

Timecode

Ajuste manual de código de tiempo de un clip.

Pixel aspect ratio

Establecimiento de la proporción de aspecto de píxel.
Importación de imágenes fijas.

Interpret Footage

Modificación de los fotogramas por segundo de un clip.

Duration

Importación de imágenes fijas.
Adición de un título a un proyecto.
Cambio de la duración y velocidad del clip.

Speed

Cambio de la duración y velocidad del clip.
Fotogramas por segundo en relación a la base de tiempo.

Open clip

Búsqueda del origen de un clip del programa.

Open master clip

Uso de clips duplicados con nombre y de copias de clips sin nombre.

Set clip marker

Uso de marcas.
Congelado de un fotograma.

Go to clip marker

Marcado y búsqueda de puntos In y Out.
Uso de marcas.

Clear clip marker

481

file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c03ev21.htm
file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c03ev17.htm
file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c03ev35.htm
file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c03ev21.htm
file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c03ev20.htm
file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c03ev34.htm
file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\Meditemp03.htm
file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c03ev28.htm
file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c03ev28.htm
file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c06ct13.htm
file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c02pi40.htm
file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c03ev29.htm
file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c02pi40.htm
file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c02pi37.htm
file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c02pi31.htm
file:///D:\Archivos de programa\Adobe\Premiere 6.5\Help\Manual de Adobe Premiere en Castellano\c05ma14.htm


Uso de marcas.
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Opciones del menú Timeline

Preview

Previsualización con la velocidad de reproducción final.

Render Work area

Previsualización del programa de vídeo.

Razor at edit line

División de un clip.

Ripple Delete

Supresión de espacios entre clips.
Supresión de un clip o de un grupo de fotogramas del programa.
Transiciones en el modo de edición de una sola pista.

Apply default transition

Especificar y añadir una transición por defecto.

Transition settings

Cambio de la configuración de las transiciones.

Zoom In

Navegación por la ventana de construcción.

Zoom Out

Navegación por la ventana de construcción.

Snap to edges

Desplazamiento de clips en el tiempo.

Add video track

Añadir, renombrar y borrar pistas.

Add audio track

Añadir, renombrar y borrar pistas.
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Track options

Añadir, renombrar y borrar pistas.

Hide shy tracks

Ocultar y excluir pistas.

Set timeline marker

Uso de marcas.
Congelado de un fotograma.

Go to timeline marker

Marcado y búsqueda de puntos In y Out.
Uso de marcas.

Clear timeline marker

Uso de marcas.

Edit timeline marker

El cuadro de diálogo de marcas.
Uso de marcas, en la ventana de construcción, para comentarios.
Creación de enlaces Web.
Creación de enlaces a capítulos.
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Opciones del menú Window

Todas las opciones de esta ventana que he marcado como Show/Hide se 
refieren a paletas. Si la paleta en cuestión se está mostrando, la opción dirá 
Hide y permitirá ocultarla. Si la paleta no está a la vista, la opción del menú 
será Show para mostrarla.

Window options

Project window options

Vistas y personalización de la ventana de proyecto.

Timeline window options

Personalización de la ventana de construcción.

Monitor window options

Definición de un punto In de origen de audio entre divisiones de 
base de tiempo.

Audio mixer window options

La ventana del mezclador de audio.

Clip window options

Definición de un punto In de origen de audio entre divisiones de 
base de tiempo.

Title window options

Adición de un título a un proyecto.
Configuración de las opciones de la ventana de título.

Workspace

Seleccionar un área de trabajo inicial.
Selección de un estilo de edición.
Gestión del área de trabajo.

Timeline

Esta opción del menú abre la ventana de construcción, si estaba 
cerrada, y, si estaba abierta, la coloca en el primer plano.

Monitor
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Esta opción del menú abre la ventana de monitor, si estaba cerrada, y, si 
estaba abierta, la coloca en el primer plano.

Audio mixer

Esta opción del menú abre la ventana del mezclador, si estaba cerrada, 
y, si estaba abierta, la coloca en el primer plano. Además, se habla de 
esta opción en:

Ajuste de balance en el mezclador mediante automatización.
Ajuste del nivel de audio en el mezclador con automatización.

Show/Hide Navigator

Uso de la paleta Navigator.

Show/Hide History

Corrección de errores.
Uso de la paleta History.

Show/Hide Commands

Uso de la paleta Command.

Show/Hide Transitions

Uso de la paleta de transiciones.

Show/Hide Audio Effects

Uso de las paletas de efectos de audio y vídeo.
Aplicación y control de efectos.

Show/Hide Video Effects

Uso de las paletas de efectos de audio y vídeo.
Aplicación y control de efectos.

Show/Hide effects controls

Aplicación y control de efectos.

Show/Hide Info

Uso de la paleta de transiciones.
Uso de la paleta Info.
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Opciones del menú Title

El menú Title sólo aparece en la barra de menús cuando una ventana de título 
está activa.

Font

Creación de objetos de texto.

Size

Creación de objetos de texto.

Style

Creación de objetos de texto.

Justify

Creación de objetos de texto.

Leading

Creación de objetos de texto.

Orientation

Cambio de la orientación del texto.

Rolling Title options

Creación de texto con desplazamiento vertical u horizontal.

Shadow

Adición de una sombra.

Smooth polygon

Creación de objetos gráficos.

Copy type style

No se menciona esta opción en la ayuda, pero sirve para copiar el estilo 
de un objeto de texto.

Paste type style
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No se menciona esta opción en la ayuda, pero sirve para aplicar al 
objeto de texto seleccionado, el estilo que se copió de otro objeto de 
texto mediante la opción Copy type Style.

Create Filled/Framed object

Creación de objetos gráficos.

Convert to Filled/Framed

Creación de objetos gráficos.

Bring to front

Ordenación de los objetos de texto y gráficos.

Send to back

Creación de objetos gráficos.
Ordenación de los objetos de texto y gráficos.

Center horizontally

Ordenación de los objetos de texto y gráficos.

Center vertically

Ordenación de los objetos de texto y gráficos.

Position in lower third

Ordenación de los objetos de texto y gráficos.

Remove background clip

Importación de un fotograma de ejemplo.
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Opciones del menú Help

Contents

Cómo usar la ayuda en línea.

Search

En teoría esta opción debería abrir la ayuda por la pestaña de 
Búsqueda, pero a mí no me lo hace.

Keyboard

Esta opción abre la ayuda por el apéndice relativo al teclado.

How to use Help

En teoría esta opción debería abrir la ayuda por la página relativa a 
cómo usar la ayuda, pero a mí no me lo hace.

Adobe online

Cómo usar Adobe Online.
Recursos adicionales de atención al cliente.

Support

Abre la página web de adobe dedicada a la resolución de dudas y 
soporte al cliente (http://www.adobe.com/support/?awe_001004)

Updates

Abre Adobe Online, sección de updates, y busca modificaciones, 
actualizaciones o parches para Premiere.

Registration

Abre la página web de adobe de Registro en línea del programa, no la 
recomiendo si no se tiene una versión legal del producto.

Adobe links

Muestra varios enlaces relativos a Adobe.

About Premiere

Muestra el cuadro de diálogo con los títulos de crédito de Adobe. Para 
cerrarlo hay que hacer click con el ratón.
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Glosario

El presente Glosario contiene una explicación de algunos términos que en la 
traducción se han dejado en inglés, así como otros conceptos útiles para 
entender tanto la edición de vídeo como los temas de ayuda. Cuando sobre 
algún término exista un tema de ayuda especialmente dedicado a él, habrá un 
enlace.

Asímismo, la primera vez que en un tema de ayuda se mencione alguno de los 
términos del glosario, aparecerá en color verde. Esto tiene excepciones con 
términos como clip que aparecen en prácticamente todos los temas de ayuda.

Area de trabajo: En Premiere se denomina área de trabajo a la parte de la 
ventana de construcción que será incluída en una previsualización. Consulte La 
barra de área de trabajo.

BitRate: Cantidad de datos por segundo que son procesados en un vídeo. Este 
es uno de los parámetros de los que en mayor medida depende la calidad final 
del vídeo digital así como el tamaño del fichero: a mayor bit-rate, más calidad y 
fichero más grande. Los bits rates muy altos requieren un ordenador potente.

Clip: En edición de vídeo un clip es un fichero que contiene vídeo, sonido o 
imágenes utilizables para la edición. En Premiere un Proyecto contiene una 
referencia a los clips que se utilizarán para generar un vídeo, así como la forma 
en que efectivamente se utilizan. Véase Concepto y clases de clip.

Codec: Acrónimo de COmpresor-DECompresor. Los codecs son usados en la 
edición de vídeo para comprimir las imágenes y ahorrar espacio en disco. 
Consisten en un pequeño programa que se ocupa de comprimir las imágenes 
(para generar el fichero de vídeo) y descomprimirlas en el momento de la 
reproducción. Prácticamente todos los ficheros de vídeo digital de formato AVI 
ha sido construido con un codec determinado, y sólo puede reproducirse en un 
ordenador donde dicho codec haya sido previamente instalado. El formato 
MOV lleva el codec específico de quick-time, y el formato MPEG (ficheros con 
extensión mpg) no lleva propiamente hablando un codec sino un standard de 
compresión reconocible --se supone-- por la mayor parte de los ordenadores.

Código de tiempo: En las cintas de vídeo digital además de las pistas para 
grabar vídeo y audio, existe una pista en la que se graba el código de tiempo 
de los fotogramas. Esto permite identificar de manera inconfundible cada 
fotograma en la cinta, y por lo tanto es posible la captura por lotes y el control 
de dispositivo desde un programa informático. Todo ello siempre que el código 
de tiempo esté correctamente grabado. Se entiende que está correctamente 
grabado cuando al primer fotograma de la cinta le corresponde el código de 
tiempo 00:00:00:00, y a partir de ahí, cada fotograma lleva el código siguiente, 
sin interrupciones.

El código de tiempo se graba en el formato 
Horas:Minutos:Segundos:Fotogramas. Así el código 00:07:03:14 se 
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corresponde con el fotograma número 14 del tercer segundo del séptimo 
minuto de la grabación.

Data Rate: Flujo de datos. Véase Bit-rate.

DV: Iniciales de Vídeo Digital en inglés (Digital Vídeo). En realidad todo vídeo 
que ha pasado al ordenador en forma de fichero es vídeo digital. Pero se suele 
reservar esta denominación para el que se ha grabado con un codec 
específico: el codec DV. Este codec es el que utilizan las vídeo-cámaras 
digitales y por ello las grabaciones hechas en este tipo de cámaras son 
directamente transportables al ordenador sin pérdida de calidad a través de un 
puerto fire-wire.

Estilo de trabajo: En terminología de Premiere, se denomina estilo de trabajo 
a la disposición de las ventanas con que se trabaja: Cuáles son, dónde se 
encuentran, cómo han sido personalizadas, etc. Consulte Selección de un 
estilo de edición.

Exploración progresiva: Véase vídeo entrelazado.

Fire-Wire: Puerto de comunicaciones utilizado para conectar un dispositivo de 
almacenamiento óptico y el ordenador. Es por este tipo de puerto por el que se 
conectan las cámaras digitales. En un ordenador en donde no se haya 
instalado un puerto Fire-Wire no será posible editar vídeo digital (DV).

A diferencia de otros puertos de ordenador (como los puertos serie y paralelo), 
los puertos firewire son bidireccionales. Es decir: tanto reciben información 
como la transmiten. Por eso con un puerto fire-wire es posible controlar el 
dispositivo conectado desde el ordenador.

Los puertos fire-wire también se conocen con los nombres IEEE 1394 y puertos 
i.link.

Fps: Siglas de Fotogramas Por Segundo. El número de fotogramas por 
segundo que se muestran en un vídeo determina su velocidad. Un fragmento 
de vídeo se verá a velocidad normal si se reproduce con la misma velocidad 
con la que se grabó. Pero si se reproduce emitiendo más fotogramas por 
segundo de los grabados, el vídeo se verá a cámara rápida; y si se emiten 
menos fotogramas por segundo de los originalmente grabados, el vídeo se verá 
a cámara lenta.

En un sistema PAL standard la velocidad es de 25 fotogramas por segundo.

IEEE 1394: Véase Fire-Wire.

I.Link: Véase Fire-Wire.

KeyFrame: Este término se utiliza en dos sentidos, uno estricto y otro amplio: 
En sentido estricto un keyframe es un fotograma que en el fichero de vídeo 
tiene una compresión especial, o del que, de alguna manera, dependen los 
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fotogramas que le rodean por almacenar información que éstos necesitan. En 
este sentido los keyframes están relacionados con los codecs y los sistemas de 
compresión de vídeo en los que hay fotogramas que se almacenan enteros y 
otros que se almacenan sólo en parte. Un keyframe es un fotograma 
almacenado entero y que sirve de referencia a los fotogramas que le rodean. 
Por ello cuantos más keyframes haya en un fichero de vídeo, mayor será la 
calidad de éste, más rápido su acceso por el ordenador pero, al mismo tiempo, 
será necesario un mayor espacio en disco y la compresión será menos 
efectiva.

Normalmente puede obtenerse una calidad muy buena colocando sólo un 
keyframe cada 10 o 15 fotogramas. Aunque es una buena idea que siempre 
que empiece una escena, su primer fotograma sea un keyframe. Consúltese 
Codecs y Keyframes, y Opciones de Keyframe y de renderización.

Junto a este sentido Premiere utiliza también la denominación de keyframe 
para referirse a aquellos fotogramas en los que se inicia, termina o cambian los 
valores de un determinado efecto de vídeo. Sobre los keyframes en este último 
sentido véase Qué son los Keyframes.

En realidad no hay tanta diferencia entre los dos sentidos del término como 
puede parecer. Porque el sentido estricto se refiere a cómo se construye 
internamente un fichero de vídeo; y el sentido amplio a cómo lo editamos y le 
añadimos modificaciones. Pero, si el programa de edición de vídeo está bien 
construído, cuando se encuentre un Keyframe en sentido amplio, normalmente 
generará un keyframe en sentido estricto en el momento de renderizar.

MPEG: Siglas de Motion Picture Expert Group. Es un formato de vídeo 
especial, porque, a diferencia de los ficheros AVI, que pueden ir internamente 
comprimidos de muchas maneras, MPEG es en realidad un conjunto de 
especificaciones, de tal manera que cualquier programa que las conozca puede 
reproducir un fichero MPEG, aunque este se haya construido con un programa 
distinto. Es decir: el MPEG es mucho más transportable que los ficheros AVI. 
Además las especificaciones MPG consiguen una mayor compresión que los 
codecs de AVI, porque se basan en la idea de que en una secuencia de 
imagen, cada imagen es básicamente igual a la anterior, de tal forma que en el 
fichero hay que almacenar la primera imagen y, para las restantes sólo deben 
almacenarse las diferencias.

Existen tres tipos de ficheros MPEG: MPEG1, MPEG2 y MPEG4. Los dos 
primeros llevan como extensión de fichero MPG, mientras que MPEG4, aun 
siendo un fichero MPEG, tiene como extensión AVI. MPEG1 constituye el 
standard para el CD-Vídeo, y MPEG2 constituye el standard para la televisión 
por satélite y el DVD.

NTSC: Sistema de televisión existente en Estados Unidos y Japón. Difiere del 
sistema de televisión utilizado en Europa y América Latina (PAL) en varios 
aspectos. Especialmente en la resolución (tamaño del fotograma) que es 
inferior a la resolución standard del sistema PAL y en el número de fotogramas 
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por segundo que es superior. Asimismo el sistema NTSC soporta un menor 
rango de colores que el sistema PAL.

Un vídeo construido según el formato NTSC no se reproducirá en un aparato 
que siga la especificación PAL. Como en Europa y América Latina la televisión 
y el vídeo siguen el formato PAL, normalmente deberemos siempre editar y 
generar ficheros PAL.

OHCI: Especificación técnica que se refiere al funcionamiento interno de un 
puerto fire-wire. Premiere sólo reconoce y puede manejar los puertos Fire-Wire 
que se adapten a la especificación OHCI.

OverScan: Proceso en virtud del cual los televisores ajustan el tamaño de una 
imagen de vídeo a las proporciones de la pantalla, cortando aquellas zonas que 
caen fuera de las esquinas de la pantalla. Este recorte de pantalla se produce 
tanto en los sistemas NTSC como en los sistemas PAL, aunque las zonas 
recortadas son distintas. Las utilidades que trae Premiere para determinar la 
zona que tal vez caiga fuera de la pantalla, están pensando en sistemas NTSC, 
por lo que en edición de vídeo PAL no son enteramente seguras.

PAL: Sistema de televisión existente en Europa y América Latina. Difiere del 
utilizado en Estados Unidos, que es NTSC. Véase lo dicho a propósito del 
sistema NTSC.

Pixel: El pixel se define como la unidad más pequeña en un monitor o pantalla. 
Un pixel es un punto de luz o de color.

En informática normalmente el tamaño de las imágenes se mide en Pixeles. De 
esta manera se puede generar una imagen que se reproducirá correctamente 
en cualquier monitor, pues el software del dispositivo se encargará de dibujarla 
de acuerdo con las características del monitor.

En Premiere el tamaño de los fotogramas (o resolución) se define en pixeles.

Plug-in: Literalmente enchufe. En informática se suele denominar plug-in a un 
programa que se inserta o conecta en otro programa, dotándole de utilidades 
adicionales a las inicialmente previstas.

Los programas que, como Premiere, pueden soportar plug-ins son muy 
versátiles y potentes, puesto que cualquier fabricante de software puede 
añadirle utilidades nuevas.

Existen numerosos plug-ins para Premiere. Algunos para hacer que Premiere 
funcione correctamente con ciertos dispositivos de hardware (sobre todo 
tarjetas capturadoras), otros para hacer que Premiere reconozca ciertos 
formatos de archivo y pueda importarlos directamente, otros para hacer que 
Premiere pueda manejar codecs específicos, etc.

Punto In: En edición de vídeo se denomina Punto In de un clip al fotograma en 
el que dicho clip empieza. La determinación del punto In es muy importante 
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puesto que lo normal es que, al capturar un clip, no se capture exactamente la 
parte que se quiere utilizar, sino algo más. Ello a veces es así porque el 
dispositivo capturador carece de precisión de fotograma (por ejemplo, toda 
captura analógica) y para estar seguros de capturar la parte que queremos 
utilizar, hay que conceder ciertos márgenes. En otras ocasiones, aunque se 
pueda tener precisión de fotograma para la captura, se prefiere capturar 
material adicional al principio y al final del clip para luego tener cierto margen 
de maniobra durante la edición. Una vez capturado el clip, en el momento de 
editarlo, hay que fijar con precisión sus puntos In y Out.

Punto Out: En edición de vídeo se denomina Punto Out de un clip al fotograma 
en donde dicho clip termina. Véase, refiriéndolo al punto Out, lo dicho para el 
Punto In.

Renderización: Proceso de construcción de un fichero de vídeo. Este proceso, 
que puede llevar mucho tiempo, implica varias tareas entre las que se 
encuentran fundamentalmente las de generar los fotogramas necesarios y 
aplicarle, a cada fotograma, el codec elegido. Normalmente donde más tiempo 
se tarda al renderizar es en: A) Los clips a un tamaño distinto del tamaño fijado 
para el fotograma; B) Los clips de vídeo que se encuentren a una velocidad o 
con un codec distintos de la velocidad y codec con que se pretende generar el 
programa; C) Los clips a los que se ha aplicado alguna transición y D) Los clips 
a los que se ha aplicado algún filtro o transparencia.

Resolución de vídeo: La resolución de vídeo es el tamaño de la imagen (o del 
fotograma). En televisión normalmente se mide en líneas; pero en informática 
se mide en pixeles. Como los fotogramas son de forma rectangular, la 
resolución se suele indicar expresando en primer lugar la medida horizontal y 
después la medida vertical. Así por ejemplo, cuando se dice que la resolución 
standard del vídeo PAL es de 720 x 576 se quiere decir que cada fotograma 
tendrá 720 pixeles de ancho y 576 de alto (es decir: un total de 414.720 
pixeles).

En contra de lo que pudiera parecer, en muchos formatos de vídeo la 
resolución no es el indicador más importante de la calidad ni del tamaño del 
fichero. Asimismo la mayoría de las tarjetas de captura sólo pueden trabajar 
con ciertas resoluciones; y aunque esas resoluciones no sean las standard del 
sistema PAL, ello no impide la exportación del vídeo, pues el software de la 
tarjeta se ocupa de hacer las conversiones precisas en el momento de exportar 
a la cinta.

RGB: Siglas de Red, Green, Blue (Rojo, Verde, Azul). Es una forma de indicar 
los colores en sistemas informáticos. En el color de tipo RGB, cada color se 
define por su contenido en rojo, en verde y en azul. Cada uno de estos 
componentes puede tener un valor que oscila entre 0 y 255, con lo que el rango 
de colores que se pueden representar es de 256 elevado a 3, es 
decir: 16.777.216.

Esta forma de representar el color es quizás la más corriente en informática.
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Timeline: En Premiere se denomina Timeline a la ventana donde se realiza la 
mayor parte de la tarea de edición. En esta ayuda he traducido Timeline por 
"ventana de construcción", aunque la traducción exacta sería más bien "línea 
temporal" o "línea de tiempo". Pienso que "ventana de construcción" (que era el 
término utilizado por versiones previas de Premiere en castellano) es más 
claro, porque hace referencia a para qué sirve. Pero el nombre en inglés hace 
referencia a cómo funciona, y eso también es importante: En esa ventana los 
clips se representan por su lugar en el tiempo.

Tool-Tip: Pequeño rótulo de color amarillo que aparece bajo el cursor del ratón 
cuando éste se detiene durante unos momentos sobre un botón o herramienta 
de una ventana. El rótulo suele indicar el nombre del control, así como la 
combinación de teclas que equivale a su pulsación con el ratón.

Vídeo entrelazado (y desentrelazado): Los sistemas tradicionales de 
televisión utilizan el denominado vídeo entrelazado, lo cual significa que cada 
fotograma se divide en dos subfotogramas que se entrelazan cuando deben ser 
mostrados. Cada uno de los subfotogramas se considera un campo. El campo 
A o campo 1, contiene la primera parte del fotograma, y el campo B o campo 2 
contiene la segunda parte.

Las razones de que esto se haga así tienen que ver con el diseño técnico de 
los primeros monitores de televisión. Para lo que a nosotros nos interesa, lo 
cierto es que este tipo de vídeo ofrece una peor calidad que el desentrelazado, 
también denominado "exploración progresiva". Pero sólo algunas sistemas de 
vídeo digital pueden proporcionar la exploración progresiva: el vídeo que se 
muestra por televisión (y el que se captura de ella) siempre es entrelazado.

Cuando el vídeo está entrelazado uno de los dos campos (normalmente el 
primero) es el campo dominante; es decir: en él se contiene la información 
básica del fotograma, y por lo tanto debe ser mostrado el primero para 
conseguir la máxima calidad (en teoría, pues yo nunca he notado diferencias 
significativas de calidad). En Premiere se puede desentrelazar el vídeo 
entrelazado y determinar, si el vídeo es entrelazado, que campo será el 
dominante.
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Copyright

© 2000 Adobe Systems Incorporated. Todos los derechos reservados. 
Pendiente de patente.

Todas las imágenes PhotoDisc: © 1997 PhotoDisc, Inc.

Este manual, junto con el software descrito en él, se suministra bajo licencia y 
sólo puede ser usado o copiado de acuerdo con los términos de dicha licencia. 
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ser cambiado sin previo aviso, y no debe ser interpretado como un compromiso 
de Adobe Systems Incorporated. Adobe Systems Incorporated no asume 
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tienen prohibido realizar cualquier acción tendente a obtener el código fuente 
de QuickHelp, incluyendo la ingeniería inversa o la compilación inversa.

Escrito y diseñado por Adobe Systems Incorporated, 345 Park Avenue, San 
Jose, CA 95110-2704, USA
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cláusula en 252.227-7013.
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reproducción o divulgación queda sujeto a las restricciones establecidas por los 
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Copyright de la traducción y 
descarga de responsabilidad

La presente traducción ha sido realizada por Quinurio de Liguria (nick para 
navegar por Internet). Para ello he utilizado los ficheros de ayuda de Adobe, 
tanto para la versión 6 como para la versión 5.1. 

No creo que con ello haya violado ninguna ley, puesto que, de un lado, los 
ficheros utilizados proceden de copias legales (y pagadas) de los programas, y 
además, traduciendo, entiendo que no daño a Adobe sino más bien al 
contrario.

En cuanto a mi traducción, autorizo expresamente a cualquiera a modificarla 
libremente y, si es posible, mejorarla. Sólo le solicito que me haga llegar una 
copia de la traducción mejorada, o que me diga donde la puedo conseguir. 
Puede hacerme llegar el mensaje en el foro de edición de vídeo digital 
dependiente de la página http://www.imagendv.com. Si esta página fuera 
clausurada o cerrada, y no se me puede localizar, mala suerte.

RESPONSABILIDAD: El traductor no asume responsabilidad por el hecho de 
que la traducción sea errónea. Bastante trabajo me ha llevado. Si alguien 
detecta un fallo, en lugar de criticar, que lo corrija y me lo diga por el 
procedimiento antes descrito.

Aunque el presente sistema de ayuda lo he diseñado para sustituir al de 
Premiere, recomiendo antes de instalarlo que se haga una copia de seguridad 
de los ficheros de ayuda originales, a fin de que si la traducción resultara ser 
una porquería, pudieran recuperarse tales ficheros en inglés.

Nada más: Hasta pronto.
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